Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protective Earth" /></td>
<td>This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="image" alt="Notice" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation which, if not avoided, may result in major or minor equipment damage or a situation which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Hazardous Voltages" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated &quot;dangerous voltage&quot; within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="image" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

**Warning**

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.

8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The QMD-X, MD-X, QMD, or MD (Live Production Engine) chassis is to be rack mounted only.

18) **Warning**

**Indoor Use: WARNING:** To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **Caution:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

22) **Caution:** These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis’ rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26) To reduce the risk of fire, replacement fuses must be the same type and rating.

27) The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

EMC Notices

United States of America

FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice**

Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

Canada

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

Europe

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

International

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

**Notice**

This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

General Handling Guidelines

- Careful handling, using proper ESD precautions, must be observed.
- Power down the system before PCB removal.
A Word About Static Discharge

Throughout the many procedures in this Engineering Manual, please observe all static discharge precautions.

⚠️ **Notice**

Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

An extended warranty is available. Contact your dealer or Ross Video for details.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
## Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>Canada</td>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

- **General Business Office:** (+1) 613 • 652 • 4886
- **Fax:** (+1) 613 • 652 • 4425
- **Technical Support:** (+1) 613 • 652 • 4886
- **After hours emergency:** (+1) 613 • 349 • 0006

- **E-mail (Technical Support):** techsupport@rossvideo.com
- **E-mail (General Information):** solutions@rossvideo.com
- **Website:** http://www.rossvideo.com
Contents

Volume I

Introduction 1

A Word of Thanks ................................................................. 1-1
About This Manual ............................................................... 1-2
Documentation Conventions ................................................... 1-3
Documentation Terms ............................................................ 1-4
Abbreviations ......................................................................... 1-5
Related Publications .............................................................. 1-6
Product Overview ............................................................... 1-7
    Product Highlights ............................................................ 1-7
    Standard Features .............................................................. 1-10
    System Options ............................................................... 1-17
A Word about Technical Support ........................................... 1-27

System Architecture 2

In This Chapter ......................................................................... 2-1
    Block Diagram ......................................................................... 2-2
    Front Frame Layout ............................................................. 2-3
    Rear Frame Layout .............................................................. 2-4
System Boards .......................................................................... 2-5
    Frame CPU Board (4800A-001) ........................................... 2-5
    Input Board (4400A-060, 4400AR-062, 4800A-060) ................. 2-5
    Output Board (4800A-064) ................................................... 2-5
    Video Processor Board (4800A-040) ...................................... 2-5
    XFX Extra Effects Card(4800AR-042) .................................... 2-5
    Midplane (4400A-010, 4400AR-019) ........................................ 2-6
    Squeeze & Tease Carrier Board (4800A-047) ......................... 2-6
    Squeeze & Tease MD Card (4800AR-048) ............................. 2-6
    Squeeze & Tease MD WARP Card (4800AR-045) ................... 2-6
Buses and Video Routing ....................................................... 2-7
    Crosspoint Matrix .............................................................. 2-7
    Video Processor ................................................................. 2-8
    Squeeze & Tease MD ........................................................... 2-9
    Aux Buses ........................................................................... 2-10
    Reference and PLL ............................................................ 2-10
Video Formats .......................................................................... 2-12
    Horizontal Scan Lines ....................................................... 2-12
    Interlaced vs. Progressive .................................................. 2-12
    Frequency ........................................................................... 2-14
CPU Structure .......................................................................... 2-16
    A Note About CPU Architecture ........................................ 2-17
Board Labeling ......................................................................... 2-18
Physical Installation

3

In This Chapter .................................................................................................................. 3-1
Static Discharge .............................................................................................................. 3-1
Getting Started .............................................................................................................. 3-2
Unpacking ........................................................................................................................ 3-2
A Word about Serial Numbers ..................................................................................... 3-2
Equipment Overview .................................................................................................... 3-3
Synergy Q/MD Control Panels .................................................................................. 3-3
Installation at a Glance ................................................................................................. 3-10
Hardware Installation .................................................................................................. 3-11
Installing the Control Panel ......................................................................................... 3-11
Installing the Electronics Frame ................................................................................. 3-14
Removing or Installing the Frame Door ..................................................................... 3-16
QMD/X Frame .............................................................................................................. 3-16
MD/X Frame ................................................................................................................. 3-17
Removing/Installing Circuit Boards ............................................................................. 3-19
Front Frame Circuit Boards ......................................................................................... 3-19
Rear Frame Circuit Boards .......................................................................................... 3-21
Connecting Frame Power ............................................................................................ 3-25
Power Fail Indicators .................................................................................................... 3-25
Power Failure ................................................................................................................ 3-26
Installing Peripheral Equipment ............................................................................... 3-27
Installing Remote Aux Panels .................................................................................... 3-28
Remote/Peripheral Control Connections .................................................................... 3-30
Tally Connections ........................................................................................................ 3-32
Synergy 1 Q/MD Tally Connections .......................................................................... 3-32
Synergy 1.5 through 2.5 Q/MD Tally Connections ....................................................... 3-33
GPI I/O and System Fail Relay Connections ................................................................. 3-36

Preliminary Cabling and Video Installation

4

In This Chapter .................................................................................................................. 4-1
Cabling ............................................................................................................................. 4-2
Control Cable Installation ............................................................................................ 4-3
Keyboard Cabling .......................................................................................................... 4-4
Remote Aux Panel Cabling ............................................................................................ 4-4
Reference Signal Connection ....................................................................................... 4-7
Monitor Connections ..................................................................................................... 4-7
Power Up .......................................................................................................................... 4-9
Resetting the Switcher ................................................................................................... 4-10
Full Restart ....................................................................................................................... 4-10
Software Reset ............................................................................................................... 4-10
Global-Store Restart ...................................................................................................... 4-12
Updating Panel Data ..................................................................................................... 4-13
Shutting Down the Switcher .......................................................................................... 4-14
Powering Off the Switcher ............................................................................................. 4-14
Preliminary Functional Check ....................................................................................... 4-16
Basic Troubleshooting .................................................................................................. 4-18
Switcher Timeout ............................................................................................................ 4-18
Installing Video Input Board ......................................................................................... 4-19
Input Worksheet .............................................................................................................. 4-20
Connecting and Verifying Inputs .................................................................................. 4-23
Input Connection .......................................................................................................... 4-23
Input Verification .......................................................................................................... 4-23
Pushbutton Inserts ................................................................. 4-25
Control Panel Pushbutton Inserts ........................................ 4-25
Remote Aux Panel Pushbutton Inserts ............................... 4-26

Using the Menu System .......................................................... 5
In This Chapter ........................................................................ 5-1
About the System Control Display .......................................... 5-2
Menu System Basics ............................................................... 5-3
Using the Keyboard in System Control Menus ......................... 5-5
Positioner Icons ..................................................................... 5-6
Adjusting the Display ............................................................... 5-7
Help Features .......................................................................... 5-8
Help Menu ............................................................................. 5-8
Screen Capture ......................................................................... 5-10

Software Upgrades and Options ............................................... 6
In This Chapter ........................................................................ 6-1
Network Setup ......................................................................... 6-2
Synergy MD/X Web Interface .................................................. 6-4
Accessing the Synergy MD/X Web Interface ......................... 6-4
System Info ........................................................................... 6-6
Software Upgrade .................................................................. 6-8
  Preparing the Switcher Before an Upgrade .............................. 6-8
  Performing the Upgrade ..................................................... 6-9
  Rebooting the Switcher After an Upgrade .............................. 6-15
Changing the Synergy MD/X Web Interface Account .............. 6-17
Saving and Loading Setup Files ............................................. 6-19
  Backing Up Setups to an External Computer ......................... 6-19
  Restoring Setups from an External Computer ....................... 6-20
Deleting Existing Setups .......................................................... 6-22
Working with Port Monitor Files ............................................ 6-23
Installed Options .................................................................... 6-27
  Accessing the Installed Options Menus .................................. 6-27
  Installing Serial Numbers ................................................... 6-29
  Installing Software Options .............................................. 6-29
  Backing Up and Restoring Option Codes ............................... 6-33

BNC Configuration and Check .................................................. 7
In This Chapter ........................................................................ 7-1
BNC Configuration ................................................................. 7-2
  Naming Input BNC ............................................................. 7-2
  Restoring Default BNC Names ........................................... 7-4
  Setting Up Mnemonics Displays for BNC Names .................. 7-5
  Setting Up BNC Types ..................................................... 7-7
  Setting Up Tallies ............................................................. 7-10
  Setting Up Alphas ............................................................ 7-11
  Setting Up Auto Keys ....................................................... 7-13
  Setting Up N/S Disable ..................................................... 7-15
Setting Up Panel Buttons ....................................................... 7-17
  Editing a Bus Map ............................................................. 7-17
  Shifted Crosspoint Buttons ............................................... 7-20
  Naming a Bus Map ............................................................ 7-21
  Copying a Bus Map ........................................................... 7-22
Additional Installation Setups

In This Chapter ....................................................................................................... 11-1
Aux Bus Setup ......................................................................................................... 11-2
  Modifying Aux Bus Names .................................................................................. 11-2
  Setting Up Local Aux Panels ........................................................................... 11-4
  Assigning Aux Bus Tallies ................................................................................. 11-5
  Setting Up Remote Aux Panels ....................................................................... 11-6
Remote Aux Panel GPI Setup .................................................................................. 11-9
  Remote Aux Panel GPI Input Worksheet .......................................................... 11-9
  Remote Aux Panel GPI Connection ................................................................ 11-11
  Remote Aux Panel GPI Programming .............................................................. 11-12
  Setting Up CCU Joystick Aux Control .............................................................. 11-13
  Monitoring CCU Joystick Selections ............................................................... 11-15
Standard GPI Setup ............................................................................................... 11-17
  Standard GPI Input Worksheet ......................................................................... 11-17
  Standard GPI Output Worksheet ..................................................................... 11-18
  Programming Standard GPI Inputs ................................................................. 11-19
  Programming Standard GPI Outputs ............................................................... 11-22
  Tally on GPIs .................................................................................................... 11-25
  GPI Information ................................................................................................. 11-25
Reference .............................................................................................................. 11-26
  Compatible Video Formats ............................................................................... 11-26
  Reference Setup ............................................................................................... 11-27
Recalling Factory Default Settings ....................................................................... 11-32
  Recall Factory Procedure ................................................................................ 11-33
Lock/Unlock Installation ....................................................................................... 11-38
Set System Time .................................................................................................... 11-40

Completing Setup

In This Chapter ....................................................................................................... 12-1
About Synergy Q/MD File Storage ....................................................................... 12-2
Saving Configurations ......................................................................................... 12-4
Recalling Configurations ..................................................................................... 12-6
Favorite CG Setup ................................................................. 12-8

SmartConversion™ 13

In This Chapter ........................................................................................................13-1
SmartConversion Overview ............................................................................... 13-2
Converting Video .............................................................................................. 13-2
Creating Conversion Loops ................................................................. 13-3
Planning Your Conversion Loops ............................................................. 13-3
Cabling Your Conversion Loops ............................................................... 13-5
Configuring Your Switcher .......................................................................... 13-6
Configuring SmartConversion .......................................................................... 13-7
Configuring Aux Bus Output Formats ..................................................... 13-7
Configuring Inputs .............................................................................................. 13-8
Activating Conversion Loops ........................................................................... 13-10
Selecting Output Video Formats of External Converters ......................... 13-10
Configuring Conversion Options ............................................................... 13-12
Displaying Available Converters ................................................................. 13-15

Glossary of Terms GL

Index IX
# Volume II

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>VTR (Betacam)</td>
<td>14</td>
</tr>
<tr>
<td>Audio Servers</td>
<td>15</td>
</tr>
<tr>
<td>Video Servers (VDCP)</td>
<td>16</td>
</tr>
<tr>
<td>Routers</td>
<td>17</td>
</tr>
<tr>
<td>External Still Stores</td>
<td>18</td>
</tr>
<tr>
<td>Audio Mixers</td>
<td>19</td>
</tr>
<tr>
<td>Robotic Cameras</td>
<td>20</td>
</tr>
<tr>
<td>Character Generators</td>
<td>21</td>
</tr>
<tr>
<td>Monitor Walls</td>
<td>22</td>
</tr>
<tr>
<td>Editors/OverDrive</td>
<td>23</td>
</tr>
<tr>
<td>Calibration and Diagnostics</td>
<td>24</td>
</tr>
<tr>
<td>Power Supplies and Fans</td>
<td>25</td>
</tr>
<tr>
<td>Frame Boards</td>
<td>26</td>
</tr>
<tr>
<td>Control Panel Boards</td>
<td>27</td>
</tr>
<tr>
<td>Hardware Options</td>
<td>28</td>
</tr>
<tr>
<td>Control Panel Maintenance</td>
<td>29</td>
</tr>
<tr>
<td>Appendix A. Specifications</td>
<td>30</td>
</tr>
<tr>
<td>Appendix B. Installation Worksheets</td>
<td>31</td>
</tr>
<tr>
<td>Appendix C. IP and Web Issues</td>
<td>32</td>
</tr>
<tr>
<td>Appendix D. Custom Device Protocols</td>
<td>33</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>GL</td>
</tr>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Introduction

A Word of Thanks

Congratulations on choosing the Ross Synergy Q/MD multi-definition digital video production switcher. You have purchased the power and versatility of a digital Multi-Level Effects (MLE) switcher that is ready to take on all creative challenges in today’s competitive broadcast environment. You will be pleased at how easily your Synergy Q/MD switcher fits into your overall working environment.
About This Manual

This manual covers the installation of the following Synergy Q/MD switchers:

- **Synergy 1 Q/MD** (1 MLE)
- **Synergy 1.5 Q/MD** (1 and a half MLE)
- **Synergy 2 Q/MD** (2 MLE)
- **Synergy 2.5 Q/MD** (2 and a half MLE)

If, at any time, you have a question pertaining to the installation of your Ross Synergy Q/MD switcher, please contact us at the numbers listed in the front of this manual. Our technical staff are always available for consultation, training, or service.
Documentation Conventions

The following conventions are used throughout this manual:

- Rear panel connectors are indicated in bold-faced upper case letters. For example:
  
  The **AUX 1** connector is …

- Control Panel buttons are indicated in bold-faced upper case letters, using a sans-serif font. For example:
  
  Press **WIPE** to …

- Menu names on the integral display panel are indicated in bold-faced text. For example:
  
  The **Aux Bus Setup Menu** allows you to …

- Menu navigation procedures in this manual set state the buttons you are to press followed by the “⇒” symbol. For example, the following navigation procedure shows you how to navigate from the **Main Menus** to the **Installation Menus**. In this case, you press **Setup** on the **Main Menu 2-2**, then you press **Installation** on the **Setup Menu**.
  
  Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation**.

- Softkey labels on the integral display are indicated in bold-faced text, using a sans-serif font. They are not indicated by the function key below the display that you press. For example:
  
  Press **Accept New Name** to register …

- Groups of buttons that make up and areas that is dedicated to a specific function, or set of functions, on the control panel are referred to as groups and shown in bold-faced text. For Example:
  
  Press the **UNDO** button in the **Global Memory System Group** to …

- The “**Operating Tip**” and “**Note**” boxes are used throughout this manual to provide customers with additional useful information. For example:

  **Operating Tip**
  
  You can press the desired crosspoint button on the PGM bus directly to select that button. This applies to both shifted and unshifted crosspoints.

  **Note**
  
  Press **Cancel Recording** to terminate the programming procedure. The macro will *not* be recorded.
### Documentation Terms

The following terms are used throughout this guide:

- **Switcher**” refers to the entire Synergy Q/MD Live Production Engine, consisting of its electronics frame and control panel.
- **Frame**” and **Electronics Frame** both refer to the electronics chassis of Synergy Q/MD Live Production Engine.
- **Operator**” and **User**” refer to the person who uses the Synergy Q/MD Live Production Engine.
- **Control Panel**” both refer to the large multi-button control panel of the Synergy Q/MD Live Production Engine.
- **SDI**” refers to Serial Digital Video, a digital video signal that is distributed via a single coaxial cable with BNC connectors.
- **Video System**” refers to the mix of interconnected digital equipment (including the edit controller, VTRs, Video Servers, etc.) in which the Synergy Q/MD Live Production Engine is included.
- **Storage device**” refers to the hardware used to save and recall setups, configurations and registers of the Synergy Q/MD Live Production Engine. Examples of storage devices are the internal hard drive and a USB Drive.
- **Bottom MLE”** refers to the lowest, or Program/Preset, MLE on each switcher. This MLE is typically the MLE to provides the main program output of the switcher, and includes the Downstream Keyers. On a **Synergy 2 Q/MD**, for example, this would be MLE 2.
- **Half MLE”** refers to the bottom, or Program/Preset, MLE on the **Synergy 1.5 and 2.5 Q/MD Switchers**. The Mix/DSK option is applied to this MLE.
- **Full MLE”** refers to the full featured MLEs of a switcher. On a **Synergy 2.5 Q/MD**, for example, **MLEs 1 and 2** are Full MLEs, because they are fully functional, but **MLE 3** is a Half MLE.
# Abbreviations

The following abbreviations are used throughout the text:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-D</td>
<td>Analog-to-Digital</td>
</tr>
<tr>
<td>AUX</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>CG</td>
<td>Character Generator</td>
</tr>
<tr>
<td>D-A</td>
<td>Digital-to-Analog</td>
</tr>
<tr>
<td>DA</td>
<td>Distribution Amplifier</td>
</tr>
<tr>
<td>DDR</td>
<td>Digital Disk Recorder</td>
</tr>
<tr>
<td>DSK</td>
<td>Downstream Keyer</td>
</tr>
<tr>
<td>DVE</td>
<td>Digital Video Effects</td>
</tr>
<tr>
<td>DVR</td>
<td>Digital Video Recorder</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>HD</td>
<td>High Definition</td>
</tr>
<tr>
<td>MD</td>
<td>Multi-definition</td>
</tr>
<tr>
<td>MLE</td>
<td>Multi-level Effects</td>
</tr>
<tr>
<td>PGM</td>
<td>Program Bus</td>
</tr>
<tr>
<td>PST</td>
<td>Preset Bus</td>
</tr>
<tr>
<td>PST PATT</td>
<td>Preset Pattern</td>
</tr>
<tr>
<td>PV</td>
<td>Preview</td>
</tr>
<tr>
<td>RU</td>
<td>Rack Unit</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Definition</td>
</tr>
<tr>
<td>TD</td>
<td>Technical Director</td>
</tr>
<tr>
<td>VCR</td>
<td>Video Cassette Recorder</td>
</tr>
<tr>
<td>VDCP</td>
<td>Video Disk Communications Protocol</td>
</tr>
<tr>
<td>VTR</td>
<td>Video Tape Recorder</td>
</tr>
</tbody>
</table>
Related Publications

All Synergy Q/MD switchers come with a complete set of system documentation that includes an Operator’s Manual and an Engineering Manual.

For a complete operational overview of the Synergy Q/MD product line, refer to the following publication:

- *Synergy Q/MD/X Operator’s Manual Volume I*, Ross Part Number: 4800DR-003
- *Synergy Q/MD/X Operator’s Manual Volume II*, Ross Part Number: 4800DR-003A
Product Overview

This section provides an overview of the Synergy Q/MD switcher and available options. The Q/MD chassis is used in conjunction with the Synergy 1, 2, and 3 control panels to create the Synergy 1, 1.5, 2, and 2.5 Q/MD Switchers.

Product Highlights

The following list summarizes the key features of the Synergy Q/MD line:

- **Fully Digital System.** All switchers in the series are fully digital. This unique concept simplifies the design, minimizes the power requirements, and reduces the overall cost. By requiring all A-D and D-A conversion to be performed outside the system, digital noise stays out of the converters. In addition, customers are guaranteed the latest converter technology, without burdening the cost of the switcher, and with the added option to use those converters for other purposes — as they gradually convert to the digital domain.

- **Multi-Definition.** The Synergy Q/MD switcher allows you to work in either Standard Definition or High Definition, supporting 480i (SD 525), 576i (SD 625), 720p, 1080i, and 1080pSF video formats.

- **Flexible Input Matrix.** The Synergy Q/MD frame can be loaded with your choice of 16, 26, or 32 multi-definition video inputs.

- **Compact Size.** The rack-saving 3 RU (Rack Unit) Synergy Q/MD frame can house 32 multi-definition inputs, 16 multi-definition configurable outputs, 2.5 MLEs, 8 DVE channels, 13 internal keyers, 2 WARP generators, 11 internal Ethernet-connected Media Stores, and 19 classes of external interfaces. Also available, either as standard features or as options, are Proc Amps, RGB Color Correctors, Utility Buses, FlexiClean, Preview Overlay, Linux OS, and a whole lot more.

- **Mnemonics.** Synergy mnemonics are perfect for mobile and other applications that require different source names from one production to another. Mnemonics are available for every MLE on the Synergy 1.5, 2, and 2.5 Q/MD control panels, as well as the Custom Control button row. Every display can have individual settings for display color, text size, and backlighting to provide clear naming and source group separation.

- **Preview Overlay.** This powerful option presents a VTR and video server time code, a count up/down timer, source ID, safe title, and more on the preview monitor output. With the exception of the Synergy 1 panel, which provides access through the switcher menu system, each feature is individually selectable via handy control panel buttons.

- **Squeeze & Tease MD.** Squeeze & Tease MD is a high quality, powerful multi-definition 3D DVE that can be built into every full MLE. Great for sophisticated looking boxes, it allows every type of key to be squeezed or zoomed, cropped, repositioned, and rotated in 3D space. It can also perform 3D Key or Background transitions, build sequences with complex timelines, Keyframe editing, and quick “shot box” sequence recall. Squeeze & Tease MD comes equipped with a positionable light source, preprocessor effects such as defocus, mosaic, posterization, colorization, strobe, picture frame borders, timeline sequences with holds, and a lot more. Up to 4 channels of Squeeze & Tease MD can be added to every full MLE.

- **Squeeze & Tease MD WARP.** Squeeze & Tease MD WARP adds extensive curvilinear effects to an MLE with Squeeze & Tease MD installed. These effects can be applied to transitions or keys where a planar channel is being used. WARP effects include Globe,
Heart, Lens Flare, Page Roll, Ripple, Split, Star, and many more. Creative possibilities are endless as WARP effects can be easily combined with preprocessor, planar transformation, and other effects.

- **UltraChrome™ Advanced Chroma Keying.** Our new UltraChrome chroma Keyer uses new Ross technology to perform detailed keying in the most demanding applications. Each full MLE includes two UltraChrome chroma keyers as a standard feature.

- **3 Channel Global-Store™ and Optional 4 Channel MLE-Store.** Three independent channels of stills are available switcher-wide and an additional 4 more per MLE are optionally available. Thousands of stills and logos can be stored in the hard drive, located on the frame CPU Board, and are transferable to other control-room devices via Ethernet using the WebDAV protocol.

- **MediaCache™.** In addition to the 3 Channel Global-Store that comes standard with Synergy Q/MD systems, animated logos, moving graphics, and short uncompressed clips can be played out of the Global-Store.

- **Ethernet Connectivity.** Upgrades can be done from a PC using an Ethernet port on the rear of the frame. Images and animations can be copied from a PC to the hard drive, located on the frame CPU Board, for use by the still stores and MediaCache throughout the switcher. The Ethernet port can also be used to transfer images and animations from the frame hard drive to a PC. This allows images captured on the switcher to be used elsewhere in the studio.

- **Networked Still and Clip Server.** Imagine hours of video storage, virtually unlimited stills, and animations all playing out with their companion key channels. Next, combine live video and key capture with Ethernet drag and drop capability, and you have the perfect marriage of video and networkability. Even better, this solution comes bundled with the powerful Video Server Control of the Synergy Q/MD.

- **AuxKeys™.** Brand or add titles to Auxiliary Bus outputs or mix between Aux Buses. Feed the result to external monitors or send them back into the switcher to further increase switcher production power. This revolutionary option adds mixing and keying capability to Aux Bus outputs. Mix and Key sources are fed from adjacent Aux Buses that have access to every signal in the switcher. Of particular interest in this application are Global-Store outputs that, with MediaCache enabled, can provide animated logo capability.

- **MultiDSK™.** Time, temperature, and bug logos are often added downstream. This option adds two more downstream keyers to the Synergy Q/MD system, bringing the total number of DSKs in the system to four (two on the Synergy 1 Q/MD). The keyers have full access to the internal crosspoint matrix making every source available as a downstream key.

- **Powerful MLEs.** Synergy Q/MD packs major effects and keying power into every full MLE. Every full MLE has two fully featured keyers with luminance, linear, preset pattern, and advanced UltraChrome chroma Keyers. Each full MLE has a utility bus input for video-in-border and garbage mask applications and a repositionable clean feed output. Two advanced pattern generators per full MLE include rotary wipes, matrix wipes, heart, star, and pattern rotation. Two additional pattern generators are dedicated to color wash generators. The lower Program/Preset MLE offers basic mix/key capabilities, with two independent linear DSKs.

- **VTR Control.** Select a VTR on the PST bus, display its current time code on the preview monitor, roll it from the transition area, and take it to air. Fast forward, rewind, and cue to time code are also available at the touch of a button on the control panel.
• **Video Server Control.** Select, play, and monitor server clips by name right from the control panel. The clip menu keeps track of clips and allows instant recall and cue.

• **Audio Server Control.** Dial up the desired clip and see the name and duration. Use a Custom Control macro button to link audio clips to a switcher or DVE transition.

• **Monitor Wall Control.** This option allows you to perform scene recalls from a monitor wall system with your Synergy Q/MD switcher.

• **Router Control.** This option makes your plant router sources easily selectable directly from the Synergy Q/MD system control area. Any number of 32 inputs on the Synergy Q/MD can be fed from a router output. Router mnemonics are supported, with the router 8-character source name being displayed on the system control area, mnemonic displays, and Preview Overlay source ID text.

• **Serial Tally Interface.** Interfacing to Under Monitor Display and Tally Systems is easy with this option. The Serial Tally Interface uses industry standard tally protocols to communicate tally information on an RS-422 serial port to other devices.

• **Peripheral Bus II Interface.** This option provides support for Thompson GVG™ Peripheral Bus II Protocol for external device integration. It can Coordinate the store and recall of the settings of some still stores, CGs, and device controllers with the store and recall of your Synergy settings.

• **Audio Mixer Interface.** Large or small mixers can be controlled serially from your Synergy Q/MD control panel, making an integrated A/V production possible.

• **Robotic Camera System Interface.** Pan, tilt, zoom, focus, shot recall and more, are directly controllable from your control panel when this option is added to Synergy Q/MD.

• **Custom Control Macro Buttons.** Several dedicated macro buttons have been positioned close to the operator for powerful single touch control. Recall any combination of switcher memories, button presses, and external device control with our editable macro system.

• **Growth Path.** The same video-processing frame is used for the Synergy 100, 1, 1.5, 2, and 2.5 Q/MD switchers. You have the option of buying a smaller system now, and adding another MLE and a larger control panel as your needs grow.

• **Compatible with Synergy SD Panels.** The Synergy Q/MD frame connects to the same control panels as the economical Synergy SD frame.

• **Compatible with the Synergy Q/MD Rack Frame.** Most boards used in the 3RU Synergy Q/MD rack frame also plug into the 8RU Synergy Q/MD rack frame. This allows for consistent operation, maintenance, and spare parts across the entire product line.

• **Hot Swappable Cards.** All cards in the Synergy Q/MD frame can be safely removed with the power on. If any card is plugged into the wrong slot, the card and system hardware will not be damaged. In addition, Synergy Q/MD was designed to support emergency swapping of some circuit boards even during live operation.

• **Upgrades from the Web.** Software, and even some hardware, can be upgraded by downloading files from the Ross Video website.

• **Affordable.** A powerful switcher at a great price!

• **Built to Last.** Ross warranties save thousands in operational costs over competitive products. It is no secret that Ross products are tough. They’re built to handle years of demanding, continuous use. The Synergy Q/MD series is backed by a comprehensive
3-year transferable warranty. The design of our fourth generation fader bars is so good that they are guaranteed for life.

**Standard Features**

The following features are standard in *all* Synergy Q/MD switchers:

**16 Multi-Definition Serial Digital Inputs**

Synergy Q/MD Switchers come standard with 16 multi-definition serial digital inputs (optionally expandable to either 26 or 32 inputs). All inputs can be used direct to air, as key alpha channels, or as chroma key sources. They can also be “locked out” if they are not used. Any input can be assigned to any control panel pushbutton or shifted pushbutton, thus simplifying installation and your ability to customize the panel layout. Note that if Mnemonics are purchased, different shows can use completely different sets of inputs optimally arranged on the control panel with labeling that follows.

In addition to the 16 standard inputs, there is a dedicated analog reference input. Refer to the section “Analog Reference Input” on page 1-11 for details.

**16 Configurable Multi-Definition Serial Digital Outputs**

All Synergy Q/MD switchers come standard with 16 timed digital outputs. Outputs are fully configurable and can be used as MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, MultiDSK, Aux Bus, or AuxKey.

The output signals shown in the following table are available from the crosspoint matrix to the output cards in a standard system with no additional I/O cards installed. Each of these output signals can be mapped to any number of Output BNCs. For example, the MLE 1 Program signal can be mapped to BNCs B12, B13, and B14 if desired.

### Crosspoint Matrix Signals Chart

<table>
<thead>
<tr>
<th>Crosspoint Matrix Video Signals</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>1</td>
</tr>
<tr>
<td>Standard Primary Inputs</td>
<td>16</td>
</tr>
<tr>
<td>Global-Store (and optional MediaCache)</td>
<td>3</td>
</tr>
<tr>
<td>MLE PGM</td>
<td>up to 3 (1 per MLE)</td>
</tr>
<tr>
<td>MLE PV</td>
<td>up to 3 (1 per MLE)</td>
</tr>
<tr>
<td>MLE FlexiClean Clean Feeds</td>
<td>up to 3</td>
</tr>
<tr>
<td>MLE Look Ahead Preview</td>
<td>up to 3</td>
</tr>
<tr>
<td>Preview Overlay (&quot;Preview Matrix&quot;)</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total Sources available:</strong></td>
<td><strong>up to 35</strong></td>
</tr>
</tbody>
</table>

Not included in the above tally are signals generated by the following:

- The optional MultiDSKs DSK 3 and DSK 4
- Processed Aux Bus feeds when the optional AuxKeys are activated
• Additional primary inputs (up to 16 more), if an additional video input card is installed

Every output is fully timed to provide consistent and adjustable output phasing.

**Analog Reference Input**

All Synergy Q/MD switchers use an analog reference that consists of a pair of looping reference BNC connectors, in addition to the standard 16 inputs, on the rear panel of the Video Input Board. Tri-level sync is recommended for HD applications. The same looping connector will accept standard color black as a reference in SD applications.

**Note**

If the reference loop is not used, it is recommended that the loopback BNC be terminated.

**3 Channel Global-Store**

Three independent channels of stills are available switcher-wide. Thousands of full screen stills and logos can be stored in the on-board hard drive and are transferable to other control-room devices over Ethernet using drag and drop.

Global-Store comes standard with 256 Megabytes of RAM storage. This translates to at least 30 full screen 1080i images with key or 189 full screen 480i images with key. The number of images stored increase considerably when smaller, non-full screen images like logos are stored. Thousands of additional images can be loaded quickly from the system hard drive. When the optional MediaCache™ for Global-Store is enabled, the playout capabilities and storage capacity of the Global-Store are increased considerably.

**Full Multi-Definition MLE Effects Systems**

**Note**

This section does not apply to the PGM/PST MLE on the Synergy 1.5 and 2.5 Q/MD.

Standard equipment on the Synergy Q/MD switcher includes full MLE (Multi-Level Effect) systems. Both keyers in a full MLE can matte fill, key invert, pattern mask, box mask, garbage mask, self-key, linear key, and preset pattern key. UltraChrome advanced chroma keying is standard on key 1 and optional on key 2. Each full MLE has a dedicated utility bus for video-in-border applications. All full MLEs have powerful internal DVE send/return paths. Up to four channels of optional 3D DVE can be dedicated to each full MLE. Each full MLE provides two wash generators that incorporate extensive wash patterns, matte video effects, and noise effects. Full preview is always available to reduce on-air surprises.

**Added Flexibility with a Half MLE!**

**Note**

This section applies to the PGM/PST MLE on the Synergy 1.5 Q/MD and 2.5 Q/MD.

The Synergy Q/MD family offers either a fully functional MLE (refer to the section “Full Multi-Definition MLE Effects Systems” on page 1-11), or a convenient program/preset area on the bottom rows of the control panel. The configuration that you choose really comes down to the switching preference of your TDs. Many TDs will switch just above the program/preset most of the time, leaving the program/preset as a quick way to exit out of complex MLE effects. Other TDs prefer instead to switch on the very bottom row, and appreciate the added effects capability that a full MLE provides.
The Synergy 1.5 Q/MD program/preset MLE is easily upgradeable to a full MLE at a later date. However, the Synergy 2.5 Q/MD is not, as it requires switching to the larger Q/MD-X frame.

**Advanced Copy and Swap Functions**

The following convenient copy and swap functions are available as standard:

- **Copy MLE** — allows you to copy the contents of an MLE to another MLE location on the switcher.
- **Copy/Swap Key** — allows you to copy or swap the contents of a keyer with another key location (in the same MLE, or on a different MLE).
- **Copy Matte** — allows you to copy the contents of a matte generator to any other matte location.
- **Copy Wipe** — allows you to copy a wipe pattern (and all wipe pattern modifiers) from one MLE to another.

**Pattern Generators**

Each switcher includes, as standard, both advanced and additional pattern generators that are used for wipe transitions and preset patterns:

- **Synergy 1 and 1.5 Q/MD**: Two advanced and two additional
- **Synergy 2 and 2.5 Q/MD**: Four advanced and four additional

Half of the advanced generators are used for wipe transitions and PST PATT 1, while the other half are used for PST PATT 2. The additional pattern generators are used for wash generators that are available as MLE inputs or anywhere a matte is used.

The advanced wipe generators come equipped with classic, matrix, rotary, heart, and star wipes. All wipe types can be rotated, bordered, and repositioned. The additional wipe generators are identical to the advanced wipe generators except that matrix capability has been removed.

**Matte Generators**

Each full MLE has three simple color generators and two complex ones capable of multi-color washes. Any one of the color generators can be assigned to COLOR BKGD1 or 2, key fill 1 or 2, key border 1 or 2, or wipe pattern edges. Each full MLE has its own dedicated COLOR BKGD video inputs to make memory recalls of individual MLEs simple and predictable.

**FlexiClean™ Clean Feed Outputs**

Each MLE can have its own fully programmable clean feed output. This provides a second “program” output that is derived from a different location than the standard program output. Typical applications include:

- Bilingual and live-to-tape productions
- Recording shows for later airing without “call in” phone numbers inserted.

The clean feed output can come from before or between the keyers in the MLE. Each MLE has its own, independently configured clean feed output separate from all other clean feed outputs.

The diagram below illustrates the clean feed output configurations available on the Synergy 1 Q/MD with the MultiDSK (DSK 1 and DSK 2) option installed.
Clean Feed Modes for Synergy 1 Q/MD with MultiDSK

The diagram below illustrates the possible clean feed configurations for the output of the full MLEs on the Synergy 1.5, 2, and 2.5 Q/MD switchers.

Clean Feed Modes for full MLEs

The diagram below illustrates the clean feed output configurations available on the bottom PGM/PST MLE of the Synergy 2 Q/MD with the MultiDSK (DSK 3 and DSK 4) option installed.

Clean Feed Modes for MultiDSK

The following diagram illustrates the clean feed output configurations available on the bottom PGM/PST MLE of a Synergy 1.5 and 2.5 Q/MD switcher with the MultiDSK (DSK 3 and DSK 4) option installed.

Clean Feed Modes for PGM/PST .5 MLE with MultiDSK

Preview Overlay

This feature makes it possible to display various types of useful information on the preview output. This information is color-coded, and can be positioned and resized according to user preferences. On the Synergy 1 Q/MD, you can access the Preview Overlay through the menu system. On all other
Synergy Q/MD control panels, there are eight buttons in the Preview Overlay area on the switcher control panel that enable display and control over the following types of information:

**Source Identification**

Source ID displays the name of the current background video, current preset video, and transition type. When the **Routing Switcher Interface** option is installed, router source names are displayed. For example:

\[ \text{VTR 1 -W-> CAM 2} \]

The program source is shown in red letters, while the preview source is shown in green letters.

**VTR Time Code**

If a VTR, disk recorder, video server, or other device using a time code is the current background of your main preview output, its current time code will be displayed (for example, 12:59:59:23). The remote port of the device must be connected to the switcher, and the **VTR Remote Control** option and/or **Video Server Control** option must also be purchased.

If the color of the timecode overlay is yellow, the video that is selected on the **Preset Bus** is the source device itself. If the color of the timecode overlay is gray, the video that is selected on the **Preset Bus** does not match the timecode of the overlay — a different source has been selected, however, the system continues to update and display the timecode value.

The **VTR Timecode** overlay is made up of three elements, the input BNC of the clips, the timecode of the clips, and the time remaining in the clips.

**Configurable Safe Title, Safe Area, and Center Cross Hairs**

This places a SMPTE standard safe title, safe area, and center indication over the main preview output, all of which can then be adapted to fit your specific application.

- **Safe Title** — a box that outlines the area within which the vast majority of home TV sets will be able to read text.
- **Safe Area** — a box that outlines the region within which viewers should be able to follow action.
- **Center Cross Hairs** — indicate the center of the picture. This is useful in the alignment of text and other information.

**Time Clock**

This places a configurable count-down/count-up timer on the main preview output to time shows, commercial durations, or other events. Custom Control buttons on the panel can be assigned to reset, start, stop, or set the clock. This timer can also be made to restart every time a background transition occurs on air.

**Mask Preview**

This places a thin outline on the main preview output around the current active box mask.

**Intuitive Control Panel with Keyboard Port**

The Synergy Q/MD control panel, that comes standard with all Synergy Q/MD systems, has a PC-compatible PS/2 keyboard port that allows you to connect a standard keyboard to your system. The keyboard allows you to complete switcher setups and still management more easily.
**Hard Drive, USB Port and System Control Area**

This feature makes it possible to store and recall complete switcher setups including memory functions, switcher personalities, installation parameters, and more, to a USB Drive or the System Hard Drive. This allows operators and technical staff to backup their switcher setups and easily transfer these settings to other Synergy Q/MD switchers.

The system hard disk drive is located on the CPU Board in the Synergy Q/MD frame. Switcher settings can also be stored here for quick recall. This is the same hard disk drive that is used to store stills, logos, animated logos, and short video clips. Memories and graphics files are accessible over the 10/100 Ethernet network port for easy remote load and backup.

Also included in this feature is the large crisp display with dedicated soft-buttons and soft-knobs that are used to configure the switcher and to provide advanced operational features.

**Custom Control Macros**

This feature brings the power of macros to the switcher operator. A series of button presses can be easily recorded and attached to any of the dedicated buttons that are positioned close to the operator on the control panel. Step through complex show openings as easily as pressing one or two Custom Control buttons. This feature eliminates confusing timeline programming.

Custom Control buttons can also be used to control remote devices or other optional switcher features such as:

- Trigger a GPI to advance to the next page of your still store
- Play, stop, or shuttle, up to eight VTRs or video servers
- Set, start, reset, or automate the integrated switcher time-clock
- Trigger a DigiCart™ audio server and tie sound effects to wipes
- Recall a robotic camera scene along with a switcher memory
- Recall an audio mixer setting for an integrated audio-follow-video production
- Any number of pauses, holds, and events can be added to any macro

Custom Control macros can be viewed and edited directly on the switcher menu.

When the **Mnemonics for Custom Control Macros** option is installed, color-coded macro names are presented directly above the buttons. This is especially useful when several banks of macros are in use.

**Note**  
The Mnemonics for Custom Control Macros option is not available for the **Synergy 1** control panel.

**100 Event Memory System**

Each switcher comes standard with storage for 100 complete switcher snapshots. They are easily stored and recalled at the touch of a single button. If you don’t want to recall the entire switcher at once, you can recall any area of the switcher from a keypad dedicated to that MLE.

All of these memories, including associated attributes, can be stored to disk providing custom tailored memories for every operator and every show.

For convenience, memories can also be named, such as “SPORTS”. An alphanumeric display in each MLE will tell you what you’ve recalled, or what you’re about to recall.
Displays and Indicators

The Synergy Q/MD switchers always let you know what is going on. Bright red lights at the end of every bus quickly show what is on air. Yellow non-sync lights warn you that an input is untimed and might cause problems. Lights under the key transition buttons and in the keyers glow red when the key is on air or green when they are active, but the MLE is not on air.

Every auto transition rate is constantly visible, including the main transition rates, the dedicated keyer rates, and the fade to black rate. The last memory number recalled per MLE is also displayed along with an associated eight-character memory name.

General Purpose Interface

All Synergy Q/MD switchers are equipped with ten dedicated GPI inputs and ten dedicated GPI outputs.

- **GPI inputs** — these allow the switcher to interface with peripheral equipment such as editors. Each GPI input can be assigned to perform simple editing and switching functions such as fade-to-black or an MLE auto-transition, or to trigger Custom Control macros. For more complex serial editing capabilities, the Editor and Automation Interface option is available.

- **GPI outputs** — these are used to trigger remote events such as “Still Store Next Page”. They are activated through the Custom Control macro system.

Tally Outputs

The Synergy Q/MD system includes 36 tally relays located in the control panel. Any tally can be assigned to any video input (or MLE program output), and more than one tally can be assigned to the same source. This can simplify system cabling in situations such as when camera tallies must be supplied to both the camera itself and the control room monitor wall.

An optional 36 additional tallies can be ordered for red/green preview tally systems and Aux Bus tally systems that require twice as many tallies, or for cases where more than 36 inputs must be tallied. Refer to the “System Options” section below for details.

### Note

The Synergy 1 has a maximum of 16 standard tallies and cannot be upgraded with the 36 additional tallies option.

10 Meter Control Cable

A 10-meter, 8-pin flat-shielded Telco cable, using high speed RS-422 communication, comes as standard to connect the Synergy control panels and Q/MD rack frame. If cable lengths other than 10 meters are needed, a custom cable can be ordered (by the meter). The maximum cable length between the control panel and its rack frame is 1,000 feet or 305 meters.

UltraChrome™ Advanced Chroma Keying

Chroma keying is available to every keyer in the switcher, except DSK1 and DSK2 on the Synergy 1.5 and 2.5 Q/MD. For example, the Synergy 2.5 Q/MD is capable of putting up to four different UltraChrome chroma keys on air at the same time. Two UltraChrome chroma keyers per full MLE come standard.

The Ross UltraChrome™ (patent pending) uses advanced video processing technology to provide exceptional spill reduction and clean edges, even with difficult source material. Glass, smoke, translucent materials, and natural shadows are handled superbly. The single-touch auto chroma keying
feature allows you to quickly obtain the best automatic chroma key for a selected color, and intuitive touch-up controls provide further adjustment capabilities, if required.

A “chroma key memory” button is also available on the panel that instantly recalls a previously stored chroma key setup.

**System Options**

This section lists the options available for the Synergy Q/MD switchers. Note that all options can be easily installed in the field.

| Note | Refer to the section “Installed Options” on page 6-27 for instructions on how to verify the status of your installed hardware and software options. |

**Additional Q/MD Inputs**

The Synergy Q/MD switcher comes standard with 16 multi-definition serial digital inputs plus re-entries. All digital inputs can be used direct to air, as key alpha channels, or as chroma key sources. An additional 10 or 16 inputs can be purchased, for a total of 26 or 32 multi-definition digital inputs.

Inputs can be freely assigned to any panel pushbutton or shifted pushbutton. They can also be “hidden” and accessed only as alpha channels or they can be “locked out” if they are not used. Note that if Mnemonics for MLE Sources are purchased, different shows can use completely different sets of inputs optimally arranged on the control panel with labeling that follows.

**MediaCache™ for Global-Store™**

MediaCache enables the playout of animated logos, moving graphics, and short uncompressed clips from the Global-Store. Each output is capable of playing full bandwidth clips independently and simultaneously.

The duration of the clips depend upon the size of the clips being used. Full screen 1080i images will take 5 times the storage of a 480i clip. However, a small, animated logo in 1080i will take much less storage than a full screen 480i clip. Purchase of the MediaCache for Global-Store increases the RAM capacity from 256MB to 1GB. This allows storage of up to 4 seconds of uncompressed 1080i playout or 25 Seconds of 480i playout.

Clips and animations are loaded from the system hard disk to the local Still Store RAM at power-up or when new clips are requested. Clips can be dragged and dropped from external computers to Synergy Q/MD over Ethernet.

**Panel Serial Port Expander (Adds 3 RS-422 Ports)**

This option connects to any one of the remote ports on the control panel, and provides four serial port outputs, effectively increasing the number of available ports by three. This “smart” port expander (BSS4) works with the Synergy Q/MD control panel to seamlessly manage external device traffic.

The additional ports provided by the remote port expander can be assigned and configured for virtually any devices supported. For example, you can assign a VTR, Router, Robotic Camera and an Audio Mixer to a single remote port expander.

| Note | The 360 Systems DigiCart and DigiCart/E cannot be operated from a remote port expander. |
Multiple Serial Port Expander (BSS4) units can be connected to a Synergy Q/MD control panel at the same time.

The unit is about 4 inches by 6 inches and is designed to easily mount under the console near the Synergy Q/MD control panel.

**Network Still & Clip Server Option**

This option adds a fully integrated Still and Clip Server to the system.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Network Still &amp; Clip Server Option is only available in Standard Definition.</td>
</tr>
</tbody>
</table>

The following features are included:

- 48 or 100 hours of clip storage (dependent upon the option purchased) at 12Mb/s in MPEG-2 compression
- Virtually unlimited still storage, incorporating both key and fill
- Video animation playout with synchronized key and fill
- Animated logo playout with synchronized key and fill
- 2 dedicated playout channels
- 1 record/play channel for live capture and/or additional playout
- Ethernet connectivity allowing drag and drop of stills and clips over a network
- Included Synergy Video Server Control Interface

**Video Server Control** is included with this option and does not need to be purchased separately. Any number of control panel ports are now activated to control this and any other video server that can be controlled using VDCP (Harris/Louth) Protocol.

Unlike other systems on the market, this solution allows synchronized key and fill playout of clips, animations, and stills, and enables the user to drop in graphics and animations over a network using simple MPEG or Targa files.

**AuxKeys, System Wide**

This revolutionary option turns Aux Buses into A/B mixers or mixer/keyers.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If MultiDSK is purchased and activated, the maximum possible number of AuxKeys is reduced.</td>
</tr>
</tbody>
</table>

The use of a single AuxKey can free up an entire MLE in many applications. This is a highly recommended option. Key and mix sources are fed from adjacent Aux Buses that have access to every signal in the switcher. Of particular interest in this application are Global-Store outputs that, with MediaCache enabled, can provide animated logo capability.

AuxKeys can be used two ways:

- Mixer (mix between two inputs on an Aux Bus)
- Mixer/Keyer (mix and Key)

Switcher outputs are assigned to AuxKeys in groups of four. Mix or Key operations can be previewed and clean feed is also available — this acts very much like a standard MLE.
AuxKeys significantly increase the Keying power of the switcher but do so without tying up an MLE. AuxKeys are controlled via configuration menus, Custom Control macro buttons, or by temporarily using the buttons of an MLE.

Applications for AuxKeys include the following:

- **Downstream bug insertion.** This can ensure that a logo remains inserted regardless of what is being done in the MLEs. *This frees up MLE keyers.*

- **Multi-language applications.** Add CG keys to clean feed outputs. *This often frees up one or more MLEs.*

- **Multi-client applications.** Add keys to MLE outputs that present a variation on the main program output. *This often frees up one or more MLEs.*

- **Multicasting.** Produce programming for two regions simultaneously but brand them differently without consuming MLE keyers and adding production complexity. *This frees up MLE keyers.*

- **Stadium concourse and box seat monitors.** Add different sponsor branding to different stadium locations. *This frees up MLEs and eliminates the need for external keyers.*

- **Pre-keying.** Add keys to sources before they are brought into the switcher MLEs. Time the AuxKeys early and the MLEs late and sources can be fed back into the switcher as inputs. *This frees up MLEs or unwieldy external keyers.*

- **Pre-mixing.** Mix between two sources before they are brought into the switcher MLEs. This makes it possible to dissolve inside any number of DVE boxes while only consuming a single MLE. *This effect would normally take one MLE for every DVE box.*

- **Studio Plasmas.** If your set has multiple live plasma displays with images that require keys to be inserted, AuxKeys are an ideal, cost-effective solution. *This frees up MLEs or external keyers.*

### MultiDSK (DSK 3 and DSK 4)

This option adds a third and a fourth linear Downstream Keyer to the pair of standard internal DSKs. These Downstream Keyers have access to every video source, and are fully integrated into the PGM/PST MLE transition system with full preview.

The hardware for this option resides on the Video Output Board where the PGM/PST MLE Program and Preview outputs have been assigned, and will consume four additional multi-format outputs in order to supply the DSKs with video and key sources.

### Squeeze & Tease MD and Carrier

The **Squeeze & Tease MD Carrier** is equipped with a high performance DSP (Digital Signal Processing) module. This board must be purchased in order to install the Squeeze & Tease MD option.

One **Squeeze & Tease MD** option provides two channels of 3D planar effects. Each MLE can have up to two of these options. The option is available for *all* MLEs including the PGM/PST MLE (except the PGM/PST MLE on the **Synergy 1.5** and **2.5 Q/MD switchers**).
• The **Synergy 1** and **1.5 Q/MD** can have up to two of these options, providing an impressive four channels of 3D DVE.

• The **Synergy 2** and **2.5 Q/MD-X** can have up to four of these options, providing an impressive eight channels of 3D DVE.

**Note**
The Squeeze & Tease MD Carrier Board is required to install the Squeeze & Tease MD options.

The popular Squeeze & Tease MD option is sold with almost every Ross digital switcher. Some of the features of Squeeze & Tease are as follows:

**Fly ANY kind of key**
Pressing the **FLY KEY** button easily activates Squeeze & Tease MD, allowing you to transform any key type. A comprehensive and intuitive menu is available to set up your desired effects. If you prefer, the 3-axis joystick can also be used to adjust parameters.

**Preprocessor Effects**
Preprocessor effects include a wide range defocus with separate H and V controls, mosaic, posterization, colorization, and a strobe effect that allows you to vary the number of on and off frames to provide enhanced creative possibilities. All preprocessor effects can be applied simultaneously.

**Planar Transforms with Lighting**
Squeeze & Tease MD has dedicated circuitry incorporating 10-bit processing, superb filtering, and full sub-pixel resolution to manipulate 2D images in 3D space with crystal clear quality.

Planar transforms include squeeze or zoom, crop, reposition, aspect, and rotate. These effects can be applied to images and keys.

All images and keys can also have realistic natural lighting applied to them, with “quick presets”, a positionable light source, and powerful ambient and min/max lighting controls.

**Advanced Picture Frame Border Generator**
Squeeze & Tease MD can add a picture frame to border over-the-shoulder boxes, instantly adding a polished, professional look to your squeeze backs. This picture frame can be the simple, single color type, or one of many advanced picture frame effects including roman column, tubular, beveled, computer style, and tri-color. This variable width border perfectly tracks all image resizing and special effects.

Picture frame effects have the following adjustable controls:

• hard or variable edge softness
• edge width/scaling
• inside/outside edge softness symmetry
• diagonal, horizontal, and vertical corner joint selection
• full control of all three picture frame color generators

**Advanced Planar Controls**
The following advanced controls make building the ideal look for your show just that much easier:

• **Front Side/Back Side.** When you look at the backside of an effect, you can have it automatically select a different video signal on the key bus. This makes it possible, for example, to rotate between 2 channels of still store in an over-the-shoulder box in a single keyer, using only 1 channel of Squeeze & Tease MD.
• **Auto Flip.** When you rotate an image in normal mode, the backside appears upside down or mirrored. Turning on Auto Flip ensures that the front side of an image is always presented. This is great for the manipulation of still store and CG text.

• **Internal Key Combiner.** Squeeze backs can be combined and displayed in a single keyer. This effectively adds additional keyers to the MLE.

• **Key Combiner Priority Control.** When several squeeze backs are combined in a single keyer, you can choose fixed priorities, auto-priority, or intersecting planes. Fixed priorities allow you to manually set the priority as Channel 1 or Channel 2 on top. Auto-priority automatically calculates the channel priority based on their relative positions in 3D space. With the intersecting planes choice, channels will literally cut into one another, with one channel hiding the portion of the other channel that is behind it.

**Pre-Built Effects, User-Built Timelines, and Key Sequences**

Squeeze & Tease MD ships with dozens of prebuilt effects that are ready to take to air. More effects can be downloaded from the Ross Video website. All of these effects can be easily modified to meet your needs. You can also build entirely new effects of your own from scratch.

Effects can be built to start when a macro button is pressed, when an auto transition is pressed, or can be run under manual fader control. Effects can be used as a transition, or as a sequence of keyframes running inside one or more keyers.

**Squeeze & Tease MD WARP**

Squeeze & Tease MD WARP adds extensive curvilinear effects to an MLE with Squeeze & Tease MD installed. These effects can be applied to transitions or keys where a planar channel is being used. WARP effects include Globe, Heart, Lens Flare, Page Roll, Ripple, Split, Star, and many more. Creative possibilities are endless as WARP effects can be easily combined with preprocessor, planar transformation, and other effects.

**Mnemonics Controllers and Displays**

This option consists of one or two controller boards, depending on the Synergy control panel you have, and the actual mnemonics displays. Only one set of controller boards is required to control all mnemonics across the entire control panel. The displays can be installed for any combination of MLEs and custom control macro row desired.

| Note | This option is only available for the Synergy 1.5, 2, and 2.5 control panels. |

Mnemonics are available for each of your MLEs and your Custom Control buttons. Each individual display is completely modifiable — change the display color, text size, and backlighting to customize your source names for different applications. When the **Routing Switcher Interface** option is installed, switcher source names are replaced by router source names.

This option is perfect for applications that require different crosspoint names from one production to another, or when you wish to show only those sources that will be used in that production instead of all sources connected to the switcher.

**XFX Board with MLE-Store, MediaCache, and Dual Border Generator**

This option adds an **XFX Extra Effects Processor Daughter Card** to the **Video Processor Board**. Each card adds the Multi-Def **MLE-Store** and **Dual Border Generator** options to the selected full MLE. You need a single XFX Card per full MLE.
The **MLE-Store** option adds four channels of Still Store per MLE. These channels are available from the Program, Preset and Key Buses on that MLE. Still Store channels can be paired for video plus Key operation.

**MLE-Store** comes standard with 256MB of RAM storage, enough for at least 30 full screen 1080i images with Key or 189 full screen 480i images with Key. The number of images stored increase considerably when smaller, non-full screen images like logos are stored.

Thousands of additional images can be loaded from the system hard drive. When the optional **MediaCache for MLE-Store** is installed, the playout capabilities and storage capacity of the **MLE-Store** is increased considerably. All images stored in this memory are available simultaneously to all **MLE-Store** outputs in the MLE.

**MediaCache for MLE-Store**, like **MediaCache for Global-Store**, upgrades the 256MB MLE-Store RAM with a 1GB MediaCache RAM. Each **MLE-Store** output is capable of playing full bandwidth clips independently and simultaneously. When upgraded to MediaCache, this allows storage of up to 4 seconds of uncompressed 1080i playout or 25 Seconds of 480i playout.

**Dual Border Generator** option provides border, shadow, and outline effects to both Keyers in a full MLE with either hard or “glowing” edges. You can move the border to any position on the screen, even above the Key. Borders are “flown” in real time with the positioner in the same manner as wipe patterns and DVE effects.

The **Dual Border Generator** can be applied to any kind of Key including **Self Keys**, **Auto-Select Keys**, **Chroma Keys**, and **Preset Pattern Keys**. Borders are particularly effective for enhancing Squeeze & Tease over-the-shoulder boxes making them appear to “float” over their backgrounds.

**Assignable Remote Aux Panels**

A **Remote Aux Panel** is a self-contained switching unit that has its own power supply. It mounts in a 19-inch rack and fills one RU (Rack Unit).

- An **Assignable Remote Aux Panel** controls multiple Aux Bus outputs. The Assignable Panel for the **Synergy 2.5 Q/MD** is shown below:

  ![Synergy 2.5 Q/MD Assignable Remote Aux Panel](image)

There are a variety of Aux panels available in the product line. *All panels* include dedicated buttons for Preview, Program, Clean Feed, and for accessing multiple Aux Bus Outputs — plus a bright “on-air” LED.
The primary difference between the panels is in the number of source and MLE buttons:

- **Synergy 1 Q/MD** — the panel includes 16 source buttons plus **SHIFT**.
- **Synergy 1.5 Q/MD and 2 Q/MD** — each panel includes 17 source buttons plus **SHIFT**, and a button for **MLE 1**.
- **Synergy 2.5 Q/MD** — the panel includes 30 source buttons plus **SHIFT**, and buttons for **MLE 1** and **MLE 2**.

The remote panel is connected to the rear of the switcher control panel via a single six-conductor Telco control cable that can run up to 1000 feet (305 meters) from the control panel. Typical applications include routing signals to one or more DVE channels, and switching a monitor between various signals (including MLE outputs) — outputs that are *not* the main program output.

Although an unlimited number of Aux panels can be connected to each of the Aux connectors of the control panel, a *practical limit* (and to minimize delay) of 8 Aux panels daisy-chained on each connector is recommended.

The following features will affect the positioning of remote Aux panels in relation to the control panel:

- The **Assignable** Aux panel options include a 33-foot (10 meter) cable, but custom lengths, up to a maximum of 1000 feet or 305 meters (as limited by RS-422 specifications), between panels is possible. Contact Ross Video for details.
- The communications signal is re-buffered at each Aux panel.
- Aux panel assignments are performed using the control panel and menu system. Refer to the section “**Setting Up Remote Aux Panels**” on page 11-6 for more information.

**Note**

You can control up to 12 Aux Buses from a Remote Aux Panel.

**Editor and Automation Interface**

**Editor and Automation Interface Option** allows a Synergy Q/MD switcher to interface with all popular editing systems. The option itself is comprised of software plus security codes.

Any MLE or combination of MLEs can be controlled using an RS-232 or RS-422 interface and industry standard GVG 100, 200, or 4000 editor protocol. The editor can be used to read and write switcher functions including video input selection, pushbutton enable and disable, control settings, and memory registers. If GPI control is not sufficient, and complete control of all switcher parameters from an editor is necessary, this option is required. Refer to the section “**General Purpose Interface**” on page 1-16 for additional details on GPI triggers.

**Note**

The Synergy 1 control panel does not have an Aux Port, instead, a converter must be installed in **Remote Port 5** and this port assigned to Aux. The converter is included in the Installation Kit.

**Note**

The **Assignable** remote Aux panels provide 8 GPI input ports per panel. These GPIs are *in addition* to those already provided on the frame. This feature allows the manual override of the Aux panel selection via GPI trigger. Refer to the section “**Aux Bus Setup**” on page 11-2 for more information.
VTR Remote Control
The VTR Remote Control Option enables control of VTRs, disk recorders, or other devices that use the near-universal Sony BVW-75 Betacam protocol directly from the switcher panel. The option consists of software plus security codes.

The Global Memory System area of the control panel includes the VTR CLIP button which allows you to recall VTR clips (segments) from selected VTRs that are connected to Synergy. In addition, VTR remote control can be tied into the Custom Control buttons. Any Custom Control button can be attached to functions such as play, stop, rewind, fast forward, frame advance, auto edit and standby off.

Still Store (Chyron Aprisa™) Interface
This option enables serial ports for control over the Chyron Aprisa Still & Clipstore. It allows a user to randomly access any still or clip under control from Synergy Q/MD. Custom Control macros can also be created for quick and direct access to clips and switcher scene recalls.

Small Audio Mixer Interface (16 and fewer Inputs)
This option enables serial control for enhanced audio-follow-video from Synergy Q/MD over small audio mixers. It allows for easy audio over, audio voice-over control, attachment of several audio sources to one video source, and quick level control of master and individual audio levels.

You can purchase the small but powerful Yamaha 01V96 audio mixer console through any Ross Video distributor. This mixer has up to 16 analog inputs, 16 digital inputs, and a proven interface to our production switchers.

Large Audio Mixer Interface (more than 16 Inputs)
This option enables serial control for enhanced audio-follow-video from Synergy Q/MD over large audio mixers, making an integrated A/V production possible. It allows for easy audio over, audio voice-over control, easy attachment of several audio sources to one video source, and quick level control of master and individual audio levels.

Robotic Camera System Interface
This option enables serial control over robotic camera systems including pan, tilt, zoom, focus, and scene recalls.

Routing Switcher Interface
This option adds routing switcher interface capability to your Synergy Q/MD switcher.

Any number of the 32 inputs on the Synergy Q/MD can be assigned as a router input. When you select a source fed by a router on the program or preset bus, the router control menu automatically appears. The router menu shows Synergy assigne name for the source (e.g., ROUTER1) and the router assigned name for the source (e.g., VTR12). The router menu also displays every source available on that router by name and by router input number. The menu knobs allow for fast access to every available source. A single button push automatically assigns the chosen source to Synergy.

With the Mnemonics option installed, Synergy replaces the pre-programmed Synergy name (ROUTER 1) with the router name for the source (VTR 12) on the mnemonic display. This provides easy identification of all inputs coming from your router.
Synergy can connect to up to eight different routers, and even eight different brands of routers, simultaneously. Several router protocols are available, and are selectable via the switcher menu system. Contact Ross Video Technical Support for a full list.

**Serial Tally Interface**

The Contribution Serial Tally Protocol Option allows you to set up communication parameters with tally system interface equipment using industry standard protocols. Note that the standard parallel tally interface will continue to operate normally when this option is enabled.

**Peripheral Bus II Interface**

This option enables support for Thomson GVG™ Peripheral Bus II Protocol for external device integration. Devices that support this protocol (such as some still stores, CGs, and device controllers) will be directed to store their settings when the Synergy Q/MD stores its settings, and then do a coordinated recall when Synergy Q/MD performs a recall.

**Video Server Control**

The Video Server Control Option enables control of video servers directly from the switcher panel. Interfaced servers must use either the Harris (Louth) VDCP, or the Sony (Betacam) protocol.

Using the **VTR Clips** menu, you can set up a list of server clips that you want to use on air. You can name them, preview them, trim clip heads and tails and enable (or disable) each clip for use. The menu also includes a timeline that lets you visually review clip parameters, and add in points and out points on Synergy Q/MD without affecting the original clip on the server.

Once your clips are set up, you can choose a clip register from the **Global Memory System** area, select the video server on Preset and perform preview and cue operation with full transport control capability. On the display in the System Control area, in addition to the clip timeline, you can select any of your preset clips for use — in any order desired. Clip names and duration are displayed for you convenience.

Just like VTR Remote Control, Video Server Control can be tied into the **Custom Control** buttons.

**Audio Server Control**

The Audio Server Control Option enables control of 360 Systems DigiCart™ audio servers directly from the switcher panel. The interface uses the Digicart native protocol, and allows the Synergy Q/MD operator to dial up the hard drive, directory, and clip number.

Using the **VTR Clips** menu, you can set up a list of Digicart audio clips that you want to use on air, name them, preview them and enable (or disable) each clip for use. You can then choose a Digicart clip register from the **Global Memory System** area, and perform preview, cue and “run” operation directly from the display in the System Control area, which shows the clip name and duration.

Just like VTR and Video Server remote control, Audio Server Control can be tied into the **Custom Control** buttons. This is the preferred way to utilize Audio Server clips, with the ability to associate sound effects with transitions (such as DVE moves), and store them on custom control buttons for single-button audio/video effects.

**Monitor Wall Interface**

This software option adds the ability to interface between Synergy and a multi-image display system, providing advanced monitoring capabilities.

Using the Custom Control macro buttons, you can perform scene recalls from your control panel.
Extended Tallies

The Synergy 1 Q/MD has a maximum of 16 standard tallies and cannot be upgraded with the 36 additional tallies option.

The Synergy 1.5, 2 and 2.5 Q/MD system includes 36 configurable tally relays, each of which can be assigned to any video input or MLE program output. The Extended Tallies option provides an additional 36 tallies, bringing the total number to 72. These additional tallies are equally configurable and can be added for red/green preview tally systems that require twice as many tallies, or for cases where every single input requires a tally.

A preview tally system has a “red” output indicating that a source is on air and a “green” output indicating that a source has been selected on a preset bus. This gives the talent an additional warning as to the director’s next move. “Green” tallies require the Extended Tallies option.

The Extended Tallies option is comprised of hardware relays that are installed in the control panel tub.

Redundant Power

The Redundant Power Supply option provides protection against the failure of an individual power supply shutting down the entire frame. In the standard configuration, if the power supply in the Synergy Q/MD frame fails, the system will shut down immediately. With the Redundant Power option installed, you gain a second power supply to allow the frame to operate in a N+1 mode. In this mode, any one of the power supplies can power the entire frame if the second power supply fails. The N+1 mode allows for the hot-swapping of any one power supply without the interruption of the system and can even be done during live broadcasts.

There are two Power Fail indicator lights, one each for panel and frame, on the main control panel that will illuminate to show a failure or a problem with a power supply. The status of a frame power supply can be determined by the position of the individual power supply switch and the illumination of the green, yellow and red LEDs on each power supply.

Installing the Redundant Power option does not increase the amount of rack space required by the switcher. The extra power supply mounts in a provided slot inside the frame.

Note that redundant power is also available for the control panel. Contact your Ross Video representative for details.

Spare Parts Kit

A Spare Parts Kit is available that provides switcher parts according to the following criteria:

- the part comes into frequent contact with the user
- the part can be easily damaged or may wear out with excessive use
- the part can be lost easily

Parts that fall outside of the above criteria are not included.
A Word about Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24 Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross personnel. During business hours (eastern standard time), technical support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support personnel who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. These people are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

For Technical Support, call (+1) 613-652-4886 and, for After Hours Emergency, dial (+1) 613-349-0006.
System Architecture

In This Chapter

This chapter describes the layout of the boards in the Synergy Q/MD switcher frame, the overall system block diagram, and provides an explanation of how video flows through the unit.

The following topics are discussed:

- System Boards
- Block Diagram
- Front Frame Layout
- Rear Frame Layout
- Buses and Video Routing
- Crosspoint Matrix
- Video Processor
- Squeeze & Tease MD
- Aux Buses
- Reference and PLL
- Video Formats
- Horizontal Scan Lines
- Interlaced vs. Progressive
- Frequency
- Video Formats
- CPU Structure
- A Note About CPU Architecture
- Board Labeling
- CPU Structure

Refer to the section “Equipment Overview” on page 3-3 for a detailed discussion of the frame front panel, back panel connectors, internal board layout, and control panel connectors.
**Block Diagram**

Use the block diagram below for reference throughout this chapter.

---

**Synergy Q/MD Block Diagram - 48 x 48 Crosspoint**

Note the following important points regarding the previous diagram:

- 32 external inputs are routed into two 16-input boards.
- The 4400AR-062 Video Input board has a 72 x 72 crosspoint matrix but functions as a 48 x 48 crosspoint matrix.
- The following signals are available from the crosspoint matrix to the Video Output Boards:
  - up to 32 primary inputs
  - 3 Global-Store (and optional MediaCache)
  - 4 MLE-Store
  - up to 3 MLE PGMs
  - up to 3 MLE PVs
  - up to 3 MLE FlexiClean Clean Feeds
  - up to 2 MLE Look Ahead Previews
  - 1 Preview Overlay ("Preview Matrix")
  - signals generated by the optional MultiDSKs DSK 3 and DSK 4 (DSK 1 and DSK 2 on the **Synergy 1 Q/MD**)
  - processed Aux Bus feeds when the optional AuxKeys are activated

- Video is routed from card to card through the midplane.
- Most video connects via a central 48 x 48 crosspoint switch.
- An optional Squeeze & Tease MD Carrier has provisions for six optional modules, which provides 4 channels per MLE of Squeeze & Tease MD functionality to two full MLEs.
• All outputs are routed from the central crosspoint, and therefore, are fully configurable to be Program, Preview, Clean feed, or Aux Bus outputs. These are routed to the output BNC connectors through a 16-output board (4800A-064).

• All outputs include a line synchronizer, making them “timed” outputs.

**Note**

The following three sections provide diagrams of the front and rear frame of the Synergy Q/MD switcher. For more detailed descriptions of the components listed in the diagrams, refer to the section “Equipment Overview” on page 3-3.

### Front Frame Layout

The figures on the following pages illustrates the location of each main circuit board in the Synergy Q/MD frame. The figure below illustrates the front of the frame, with the doors removed.

#### Front Frame Boards

<table>
<thead>
<tr>
<th>Slot</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 0</td>
<td>Fan Board</td>
<td>Fan Board</td>
</tr>
<tr>
<td>Slot 1</td>
<td>Video Processor Board</td>
<td>Video Processor Board</td>
</tr>
<tr>
<td>Slot 2</td>
<td>Squeeze &amp; Tease Carrier</td>
<td>Squeeze &amp; Tease Carrier</td>
</tr>
<tr>
<td>Slot 3</td>
<td>Video Processor Board</td>
<td>Power Supply</td>
</tr>
</tbody>
</table>

*Board Slots in the Front of the Q/MD Frame*
Rear Frame Layout

The figure below illustrates the rear connector panel of the electronics frame. The Frame CPU Board must be installed in Slot A.

1) Frame CPU Board
2) Input Board in QMD, Unused in MD
3) Power Connectors
4) Input Boards
5) Output Boards

Synergy Q/MD Frame — Rear View
System Boards

The following system boards are referred to throughout this chapter:

**Frame CPU Board (4800A-001)**

The CPU Board resides in Slot A at the rear of the frame, and is connected to the midplane. It contains the Hard Disk, the system memory, and the main system microprocessor, and is responsible for the high-level control functions and all Ethernet and remote serial communication for the frame and between the frame and control panel.

**Input Board (4400A-060, 4400AR-062, 4800A-060)**

The Input Board comes in four configurations:

- a 48 x 48 crosspoint with an analog reference loop (4400A-060B),
- a 72 x 72 crosspoint with an analog reference loop (4400AR-062),
- a straight video input with no reference input (4800A-060B), and
- a 10-input straight video input with no reference input (4800A-060C).

All versions of the boards except the 4800A-060C have a total of 16 video inputs per board, but the 4400A series boards contain 2 additional BNC inputs for the reference connections.

**Important**
The 4400AR-062 input board with 72 x 72 crosspoint is only compatible with the 4400AR-019 midplane.

The Synergy Q/MD frame can support up to two Input boards. Inputs are configured and assigned through the menu system.

**Output Board (4800A-064)**

The Synergy MD frame supports one Output Board, in Slot B on the rear of the frame. This board contains 16 fully configurable multi-definition video outputs that can be used as Aux Buses, MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, MultiDSK, or AuxKeys.

**Video Processor Board (4800A-040)**

The Video Processor Board performs all of the basic video effects in the Synergy Q/MD system. Functions such as the interface to the Squeeze & Tease MD boards, Chroma keying, patterns and wipes, and transitions are all generated on this card.

The Video Processor board includes two slots to support future hardware options.

**XFX Extra Effects Card(4800AR-042)**

The XFX Extra Effects Card performs different functions depending on the options you purchase. Current options include a dual-border generator and MLE-Store.

The dual-border generator option provides visually dynamic border, shadow, and outline effects to both linear MLE keyers, with either hard or soft edges. The option can also enhance Self Keys, Chroma Keys, and Preset Pattern Keys.
The MLE-Store option provides four channels of still images per MLE. Each MLE can have separate images loaded and images with embedded alpha channels are supported by dedicating one of the MLE-Store channels to the alpha channel.

**Midplane (4400A-010, 4400AR-019)**

The Midplane is a non-removable board that provides the interconnects between the system frame boards, the power supplies, and the fan assembly, as well as the routing through which all video signals, communication, and control commands pass. The board has no active components.

**Squeeze & Tease Carrier Board (4800A-047)**

The Squeeze & Tease Carrier Board provides four slots for the Squeeze & Tease MD Cards and two slots for the Squeeze & Tease WARP MD Cards. The board also provides local control as well as video routing and power to these cards.

Refer to Chapter 27, “Frame Boards” for more information on these system boards.

**Squeeze & Tease MD Card (4800AR-048)**

The Squeeze & Tease MD Card performs all the Squeeze & Tease video manipulation for the system. It provides all the planar processing, pre-processing, lighting, bordering and filtering. Each card supports up to ten high-speed digital channels for SDI or HD-SDI video signals. Two of these channels are routed to the rest of the frame, two are routed to the previous Squeeze & Tease MD Cards, two are routed to the next Squeeze & Tease MD Cards and another two are routed to the optional Squeeze & Tease MD WARP Cards. These channels are synchronized using a single-ended V-Sync signal.

**Squeeze & Tease MD WARP Card (4800AR-045)**

The Squeeze & Tease MD WARP Card performs all the 3D WARP effects for the system. There are two high-speed digital channels for SDI or HD-SDI video between the WARP card and the Squeeze & Tease MD card.
Buses and Video Routing

The Synergy Q/MD switcher has a 48 x 48 full crosspoint matrix. Each input is routed through the Midplane (4400A-010 or 440AR-019) to the Input Board (4400A-060 or 4400AR-062), which in turn distributes them throughout the system. The crosspoint matrix on the Input Board, in effect, functions as a 48 x 48 routing switcher (the 72 x 72 crosspoint on the 4400AR-062 input board currently operates as a 48 x 48 crosspoint). Any input can be routed to one or all of the outputs except as indicated in the note below.

Note

If you have the MultiDSK or Mix/DSK, or both, options installed, certain Output BNCs will be locked to specific output types. The Aux Mixer, and Aux Mixer/Keyer options will also lock Output BNCs, but you can select which ones are locked.

Crosspoint Matrix

Inputs to the Crosspoint Matrix are as follows:

- 16 external inputs (16 x 1 Input Board in Slot C)
- 16 external inputs (16 x 1 Input Board in Slot D)
- 8 from the Video Processor board
- 3 from the Global-Store
- 4 are reserved for future expansion

Output buses from the Crosspoint Matrix are as follows:

- 16 to the Video Processor board
- 16 external outputs (16 x 1 Output Board in Slot B)
- 2 to the Global-Store
- 14 are reserved for future expansion

Video Flow Through 48 x 48 Crosspoint Matrix
Video Processor

Inputs are routed from the crosspoint matrix to the Video Processor Board (4800A-040) where all of the basic video effects are performed. The following diagram provides a closer look at the video path through the Video Processor.

Video Flow Through Video Processor

Inputs to the Video Processor are as follows:
- 2 × BKGD (one from each MLE)
- 2 × PST (one from each MLE)
- 2 × Key 1 Video (one from each MLE)
- 2 × Key 1 Alpha (one from each MLE)
- 2 × Key 2 Video (one from each MLE)
- 2 × Key 2 Alpha (one from each MLE)
- 1 × Utility 1
- 1 × Utility 2

Outputs from the Video Processor are as follows:
- 2 × PGM (one from each MLE)
- 2 × PV (one from each MLE)
- 2 × Clean Feed (one from each MLE)
• 1 × DVE Video
• 1 × DVE Alpha

Inputs to the XFX Extra Effects Card are as follows:
• 1 × Key 1 Video
• 1 × Key 2 Alpha
• 1 × Key 2 Video
• 1 × Key 2 Alpha

Outputs from the XFX Extra Effects Card are as follows:
• 4 × MLEStore Video
• 1 × Key 1 Video
• 1 × Key 2 Video
• 1 × Key 1 Alpha
• 1 × Key 2 Alpha
• 1 × Key 1 Border
• 1 × Key 2 Border

**Squeeze & Tease MD**

If you have Squeeze & Tease MD installed in your switcher, video signals are routed from the Video Processor board to the Squeeze & Tease Carrier and daughter boards, where they are manipulated, and then fed back to the Video Processor. Refer to the following diagram for details.
Inputs to the Squeeze & Tease Carrier are as follows:

- 8 Inputs (can be either video or alpha)

Outputs from the Squeeze & Tease Carrier are as follows:

- 8 Alpha out
- 8 Video out

**Aux Buses**

Synergy Q/MD has a total of 48 “timed” Aux Buses, with each having access to all 48 possible inputs of the crosspoint matrix. Outputs for each reside on the **Output Board** (4800A-064), and are configured through the menu system. Refer to the section “**Aux Bus Setup**” on page 11-2 for more information.

- **Note** Synergy Q/MD switchers have 16 output BNCs so not all Aux Buses can be assigned to outputs simultaneously.

**Reference and PLL**

The Synergy Q/MD switcher uses a distributed clocking strategy. This means that each board that processes video generates its own clock source, ensuring high-quality, low-jitter timing within the system. A pair of oscillators are used on each module to ensure optimal performance in each video.
mode: 148.5MHz is used for 1080i/60, 720p/60, 480i/59.94 and 576i/50; 148.352MHz is used for 1080i/59.94 and 720p/59.94. The clock generator on each board is locked to a master reference.

Note
The internal reference signals are bused, so that the input reference may be sourced from any input card slot.

On the Video Input Board with Reference (Ross Part Number 4400A-060B or 4400AR-062) there is an analog Reference input, consisting of a pair of BNCs which can be looped. This input can accept Composite/Black Burst or Tri-Level Sync.

Note
For optimal performance, it is recommended that tri-level sync be used for HD video modes.

The reference processor includes a PLL (Phase-locked Loop) which locks the internal clock source to the incoming video reference. This clock source is then used to generate master vertical sync and clock reference signals which are passed on to the rest of the system. When the PLL acquires lock with the applied reference signal, the green “Lock” indicator on the rear panel, beside the reference BNCs will illuminate.

Note
If the analog reference signal is removed, the system will continue to run nominally at the desired video rate, but may drift out of phase with the original analog reference source. The system will re-lock if the reference source is re-applied.

It is possible for the system to run in a format which differs from the format of the incoming analog video reference. It is, however, necessary for the analog reference format and the video format in the switcher to be frame locked. For example, it is possible to provide a reference at 1080i/59.94, and run the switcher at 720p/59.94 or 480i/59.94; but it would not be possible to run the video at 1080i/60.

Note
You can only use a 720p reference if the switcher is operating in 720p. The standard 720p reference signal does not include the field information required for referencing interlaced video.
Video Formats

The Synergy Q/MD switcher can operate in a number of different video formats, at different frequencies in either interlaced or progressive scan mode. When you switch between these formats, various displays and settings automatically change to show the new information. To better understand what is being displayed, you must first understand what the information for the different video formats means.

The video formats that are displayed on the Synergy Q/MD switcher provide three pieces of information about the video format. This information is the number of horizontal Scan Lines, whether the scan lines are Interlaced (i) or Progressive (p), and the Frequency that the scan lines are drawn at.

### Horizontal Scan Lines

The number of horizontal scan lines is related to the pixel resolution of the image on screen. For example, if you have a 720p 59.94 video signal, the 720 is the number of vertical scan lines. A video signal with 720 scan lines usually corresponds to a 1280×720 (H×V) pixel image. This means that the image is comprised of 1280 columns of pixels and 720 rows of pixels. The reason the vertical resolution, the 720, is used to denote the video format is because of how it is drawn on a standard television. With Cathode-Ray Tube (CRT) television monitors, the image is created, or drawn, one pixel at a time, in rows, from the left side of the screen to the right, to create one scan line.

Since each scan line starts from a vertical pixel, there are 720 rows of pixels, or scan lines, being drawn horizontally. The same is true of a video signal with 1080 vertical scan lines, which corresponds to a 1920×1080 pixel image.

### Interlaced vs. Progressive

In the previous section we learned that a video signal is made up of a number of horizontal scan lines that are drawn from left to right on the screen. Although these scan lines are always drawn from left to right, they can be drawn in either an Interlaced or Progressive pattern.

#### Interlaced

An Interlaced video format starts at the top of the screen and draws all the odd number scan lines and then all the even number scan lines in sequence. This results in half the image being drawn in one pass...
and the other half of the image being drawn in the second. These two passes are called Fields, where
the first pass is called Field 1 and the second pass is called Field 2. When both Field 1 and Field 2
have been drawn, resulting in a complete image, you have a single Frame.

Both Field 1 and Field 2 must be drawn to create Frame 1. If you are using field or frame numbers as
a counter, you should remember that you must double the number if you are converting from Frames
to Fields. For example, a 4 Frame delay is equal to an 8 Field delay.

**Progressive**

A Progressive scan video format draws each scan line in sequence, starting from the top of the screen
and working to the bottom. Unlike Interlaced, with Progressive scan the entire image is drawn at one
time, in a single pass. This means that there are no fields in a Progressive scan image.

Because there are no fields in a Progressive scan video signal, you cannot use it as a reference signal
for an Interlaced video signal. Because the Interlaced video format requires information about when
each field is being drawn, you must use a Progressive scan video format as reference for a Progressive
scan video signal.

**Progressive Segmented Frame**

A Progressive Segmented Frame video is similar to a Progressive scan video format in that both draw
each scan line in sequence, starting from the top of the screen and working to the bottom. Unlike
Progressive, Progressive Segmented Frame transmits the video signal as if it were an interlaced
image: first the odd scanlines are transmitted and then the even scanlines. The even scanlines are
delayed for one “field” on the transmitting end and the odd scanlines are delayed one “field” on the
receiving end. This allows transmission of Progressive images via equipment that was designed to handle interlaced images only.

Because there are no true fields in a Progressive Segmented Frame video signal, you cannot use it as a reference signal for an Interlaced video signal.

**Frequency**

In the previous sections we learned that a video image is comprised of a number of horizontal scan lines that are drawn in either a progressive or interlaced format. The length of time it takes to draw the scan lines from the top of the screen to the bottom in a single pass is called the frequency, and is measured in Hertz (Hz). With a Progressive scan video format this will be the time it takes to draw the entire image. With an Interlaced video format this will be the time it takes to draw 1 field, or half, of the image.

For example, an interlaced format of **1080i 50 Hz** draws **50 fields** per second. Compare this to a progressive scan format of **720p 50 Hz** which draws **50 frames** per second. Notice that the interlaced format is actually only drawing **25 frames** (*Field 1* plus *Field 2*) per second, where the progressive scan format is drawing the full **50 frames** per second.

**Using Frame and Field Information**

Frame and Field rates become very important when you are setting up custom control pauses, transition rates or any other system that counts a period of time in frame or fields on the switcher. Remember from the previous section that in a progressive scan format, running at **50 Hz**, the switcher will draw **50 frames** per second. In an interlaced format, also running at **50 Hz**, the switcher will draw **25 frames** per second.

The Synergy Q/MD switcher uses Frames to measure transition rates and custom control pauses. The amount of time that this represents will depend on the frequency and format you are operating the switcher in. For example, if you are operating the switcher in **1080i 59.94 Hz**, the default MLE transition rate is set at **15 Frames**. Since the frequency for an interlaced format is shown in fields, you must divide this number by **2** in order to get the number of Frames per second, **30**. By comparing the transition rate (**15 frames**) and the video format frame frequency (**30 frame per second**) you can calculate that the transition rate is **½ a second.**
If you were operating the switcher in **720p 59.94 Hz**, the default MLE rate is set at **30 Frames**. Since the frequency for a progressive scan format is shown in frames, no conversion is required. By comparing the transition rate (30 frames) and the video format frame frequency (60 frames per second) you can calculate that the transition rate is \( \frac{1}{2} \) a second.

**Important**

When you switch reference formats, you must perform a soft reset (**ALL + ALL**) in order to load the default rates for the format you have set.
CPU Structure

This section describes the Synergy Q/MD CPU structure, in terms of which areas are controlled by which specific microprocessors. Effectively, the CPU structure functions as a master/slave multi-processor system, where the master processor controls high level functionality, and delegates other tasks to slave processors.

Processor distribution and functionality is as follows:

- One “PowerPC 440GX” on the **Frame CPU Board** is responsible for performing high level functions, and issuing commands to the remaining microprocessors. This processor manages all serial channels to and from the frame, manages communications with the control panel, and manages communications with all other peripheral devices connected to the frame.

  The Frame Processor also controls non-MLE functions, including all **Aux Bus** functions and all crosspoint switching on the **Crosspoint** module. It does not control the **Preview Overlay** module, but it does issue commands to that module, in terms of what text and graphics to display.

- One “PowerPC 440GX” on the **Video Processor Board** processes high-level information from the Frame CPU board that pertains to the current state and specific commands issued on each MLE.

  This high level information includes which functions are enabled or disabled, and what configurations have been set up by the user on the control panel. The Video Processor board translates that information, and sets the required bits in the hardware to complete the command request.

  Following are several examples:

  - If you press **WIPE** in an MLE and select the circle wipe in the **Pattern Control Group**, that information goes to the Frame CPU — which in turn tells the selected Video Processor that a circle wipe has been requested. The Video Processor then draws the proper tables required to make the image.

  - If you pull the **Fader** from Program to Preset, the Frame Processor receives that information and analyzes how it affects the high level structures within the switcher — e.g., which buses are moving, what type of effect has been requested (Dissolve, Wipe, DVE Send, etc.). The Frame Processor passes the current state of a particular field to the MLE Processor, which then writes the specific effect values to the video processing circuitry.

  - If you press the **AUTO TRANS** button, that command goes from the Control Panel to the Frame Processor, which in turn keeps track of which state the transition is in. Commands are then issued to the MLE Processor to perform the transition at (for example) 4% in one field, 8% in the next field — until complete. The MLE Processor in turn does not process the video itself, but rather issues commands to the hardware on the MLE Board to set the mixer to the requested ratio and manipulate the pixels accordingly.

- One “PowerPC 405EP” on the **Output Board** is used for local control of this card. It also provides internal ethernet access, program store, and still store images.

- One “PowerPC 405EP” on the **Squeeze & Tease MD Carrier Board** governs the on-board communication and control, as well as the communication with the midplane and the daughter cards mounted on the board.

  The Squeeze & Tease MD Carrier board also contains 1 TI TMS320C6414, which performs all the mathematical calculations required for the DVE effects.
One “Control Panel Processor” (within the control panel itself) oversees the large User Display, the small MLE displays, and also translates button presses into serial protocol that is sent to the frame — indicating which buttons have been selected. The processor also tracks which functions have been selected in which MLEs, and at a very high level, provides the frame with specific information that removes the need for the frame to know precisely what the panel looks like.

For example, the panel does not say that button 32 has been pressed, rather, it says that there is a request to select a circle wipe on MLE 2, pattern generator 2. The frame processes the command and sets the new state of the MLE and pattern generator. In the case of a knob or the Positioner, the panel alerts the frame that the control is increasing or decreasing in value. Disk storage and recall information is also handled by the panel processor, but the data ends up in the frame.

All boards in the Synergy Q/MD frame also contain a TI MSP430 microcontroller to manage upgrades, system booting, and other housekeeping functions.

A Note About CPU Architecture

Virtually all of the lookup tables and all of the bits that are used to configure the hardware and map the crosspoints are set every field. The system is in effect performing a complete memory recall operation every single field, always guaranteeing that the control panel is set properly. In terms of the architecture, there is no difference between a requested memory recall operation and the way that the switcher updates the panel normally — every field.

In addition to increasing system reliability, this functionality also allows you to return to the exact state of the panel, should a power failure occur.
Board Labeling

The figure below illustrates a typical circuit board label:

![Circuit Board Labeling Scheme](image)

For all system circuit boards, the following data is listed:

- Ross Logo
- Board name
- Board number
- Board revision (ISS = Issue)

Where a white square is present in the label string, letters may be written within the square to indicate a minor variation on the board itself.
Physical Installation

In This Chapter

This chapter provides instructions for installing Synergy Q/MD switcher hardware. The following topics are discussed:

- Static Discharge
- Getting Started
- Equipment Overview
- Installation at a Glance
- Hardware Installation
- Installing the Control Panel
- Installing the Electronics Frame
- Removing or Installing the Frame Door
- Removing/Installing Circuit Boards
- Connecting Frame Power
- Power Fail Indicators
- Installing Peripheral Equipment

Operating Tip

Refer to Appendix C, “Installation Worksheets” for worksheets you can use to record switcher installation and wiring connections.

Static Discharge

Throughout this chapter, please heed the following cautionary note:

ESD Susceptibility

Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the switcher circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame and exercise proper grounding precautions when working on circuit boards.
Getting Started

The following topics are covered in this section:

- Unpacking
- A Word About Serial Numbers

Unpacking

A complete Synergy Q/MD switcher system is typically shipped in three (or more) boxes, as outlined below. Your shipping configuration may vary.

- **Box 1** contains the electronics frame, with circuit boards installed inside the frame itself.
- **Box 2** contains the control panel — including its power supply.
- **Box 3** contains the remote Aux panels, manuals, and all other options and accessories.

**Caution**

The control panel and frame are heavy units, which are both top-loading. It is highly recommended that you use two people to lift and unpack each unit.

Once the boxes are unpacked, check the contents against the packing list to ensure that all items are included. If any items are missing or damaged, contact your sales representative or Ross Video Limited immediately.

A Word about Serial Numbers

Serial numbers have been implemented to allow Ross Video to properly track which options have been purchased by each customer. Switchers have serial numbers installed (in flash memory) at the factory. Refer to the section “Installing Serial Numbers” on page 6-29 for detailed instructions.
Equipment Overview

This section provides a hardware overview of the Synergy Q/MD switchers.

Synergy Q/MD Control Panels

The following three figures show a top view of each Synergy Q/MD control panel. Full details on each control panel are provided in the Synergy Q/MD/X Operator’s Manual.

Synergy 2.5 Control Panel

The Synergy 2.5 control panel has 2.5 MLEs and 16 inputs standard.
**Synergy 2 Control Panel**

The Synergy 2 control panel has 2 MLEs and 16 inputs standard. This is the same control panel that is used with the Synergy 1.5 Q/MD Live Production Engine.

![Synergy 2 Control Panel](image)

**Synergy 1 Control Panel**

The Synergy 1 control panel has 1 MLE and 16 inputs standard.

![Synergy 1 Control Panel](image)

The next three diagrams show details of the rear connector section of each Synergy Q/MD control panel. The layout is identical on the Synergy 2 and Synergy 3 control panels, with the exception of the power connector placement. The same circuit board is used on each. The rear connector layout of the Synergy 1 control panel, on the other hand, is distinct, as is the CPU board contained within.
**Synergy 1 Control Panel Connectors**

1. **Primary Power Inlet**
   One AC connector is provided for **PRIMARY POWER** on the control panel. It includes a power lock which is designed to retain the cable.

2. **Primary Power Switch and Fuse**
   One **SWITCH** and **FUSE** assembly is provided for primary control panel power. The fuse rating is screened adjacent to the fuse holder.

3. **Redundant Power Inlet**
   One AC connector is provided for the optional **REDUNDANT POWER** on the control panel. It includes a power lock which is designed to retain the cable. The connector is always installed, whether or not you have the **Redundant Power Supply** option mounted inside the panel.

4. **Redundant Power Switch and Fuse**
   One **SWITCH** and **FUSE** assembly is provided for redundant control panel power. The fuse rating is screened adjacent to the fuse holder.

5. **Frame Connector**
   One 8-pin shielded RJ-45 connector (**FRAME**) is provided for communications between the frame (**PANEL** connector) and the **Synergy 1** control panel.

**Important**

The cable for connecting the Synergy Control Panel to the Synergy Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

6. **Remote Control Connectors**
   Five 9-pin “D” **REMOTE** connectors (RS-422) are provided for serial communication with peripheral devices such as VTRs, disk recorders, video servers or other serial controlled devices.

**Note**

You must use **Remote 5** with a **RJ-12 to DB9 Male Adaptor** to connect a remote Aux Panel to the **Synergy 1** control panel. If you intend to connect a Remote Aux Panel to the switcher, you will have to leave the Remote 5 port open.
7. **PS/2 Keyboard Connector**
   One PS/2 Keyboard connector is provided for communication between a keyboard and the control panel.

8. **Tally Connector**
   One 25-pin “D” TALLY connector provides 16 optional tally relays.

**Synergy 2 and Synergy 2.5 Control Panel Connectors**

---

**Note**
All connectors are present, whether or not you have options installed.

---

**Synergy 1.5, 2 and 2.5 Control Panels — Rear View, Connector Section**

1. **Panel Communications**
   Four connectors are provided for panel communications.
   - **FRAME** — One 8-pin shielded RJ-45 connector is provided for communications between the frame (PANEL connector) and the control panel.

   **Important**
   The cable for connecting the Synergy Control Panel to the Synergy Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

   - **AUX 1 and 2** — Two 6-pin shielded Telco connectors are provided for communications between the control panel and remote Aux panels.
   - **Keyboard** — One PS/2 Keyboard connector is provided for communication between a keyboard and the control panel.

2. **Remote Control**
   Eight 9-pin “D” serial connectors (RS-422) are provided for serial communication with remote peripheral devices, such as VTRs, disk recorders, video servers, or other serial controlled devices.
3. Tally Connectors

Four 25-pin “D” connectors are provided for tallies.

- The functionality of connectors 1 and 2 is standard, providing 36 tally relays.
- The functionality of connectors 3 and 4 is optional, providing an additional 36 tally relays. The Extended Tallies option must be installed.

The next figure illustrates the dual power connectors on the rear of the Synergy 3 control panel. The labeling and placement of these two connectors will differ, depending upon the size of your specific Synergy Q/MD switcher.

Please note:

- Each AC connector includes a power lock to retain the power cable connector.

The connector marked REDUNDANT POWER is always installed, whether or not you have the Redundant Power Supply option mounted inside the control panel tub.

Synergy Q/MD Frame

The following figure illustrates the rear connector panel of the electronics frame.

1. Power Connectors

Two AC connectors are provided for frame power. Note that the Synergy Q/MD frame comes standard with one AC power supply, which is factory-installed in the top slot. Refer to the section “Connecting Frame Power” on page 3-25 for complete instructions on connecting your AC power sources. Refer to Chapter 16, “Power Supplies and Fans” for full details on the power supplies and indicators.
2. **Input Section**

Depending on your switcher configuration, 16, 26, or 32 BNC connectors are provided for a maximum of 32 digital video inputs. Sixteen inputs come standard with all models of the Synergy Q/MD switchers, but each switcher can be expanded to accept either 26 or 32 inputs.

Each input is identified by the uppercase letter that appears at the end of each row of inputs (e.g. C, D, etc.), and the number, from 1 to 16 inclusive, at the upper-left corner of the BNC connector (e.g. D4, C12, etc.). The analog reference inputs, if present on the card, are identified by the **REF** label that appears between the two BNC connectors.

Even though an input is *physically* connected to a numbered input connector, you can electronically place that input anywhere on a control panel MLE bus row. All input configuration is performed through the menu system.

3. **Main Output Section**

Sixteen BNCs are provided for the main switcher outputs. Each output is identified by the uppercase letter that appears at the end of the row of outputs (i.e. B), and the number, from 1 to 16 inclusive, at the upper-left corner of the BNC connector (e.g. B4, B16).

All outputs are fully configurable, multi-definition video outputs that can be used as Aux Buses, MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, MultiDSK, or AuxKeys.

4. **LAN Connectors**

Two industry-standard 10/100 Base TX Ethernet connectors are provided for connection of the frame to a network hub or switch. This connection is used for upgrades, and to transfer images and animations from a PC to the switcher hard drive for use by the Still Stores and optional MediaCache.

5. **GPI I/O Connector**

One 25-pin “D” connector labeled **GPI I/O** is provided for connection of an interface device that will trigger cut, auto transition, Custom Control button, and memory recall functions. Please note:

- As standard, the connector provides one common ground, 10 GPI outputs, and 10 GPI inputs.
- The remaining 4 pins are used as power-fail relays. These normally closed relays open in the event of a power failure, or other system fault that prevents a reliable program output.

6. **Peripheral 1 - 4 Connectors**

Four 9-pin “D” type connectors, labeled **PERIPH1**, **PERIPH2**, **PERIPH3**, and **PERIPH4**, are provided for connection to and interface with external edit controllers. These ports support both RS-232 and RS-422 standards. Please note:

- The appropriate software must be installed in order to properly interface with these devices.
- The ports are configured through the switcher menu system.
7. **Control Panel Connector**
   One RJ-45 eight-pin shielded Telco connector labeled **PANEL** is provided for communications between the Synergy Q/MD frame and the control panel.

   **Important**
   The cable for connecting the Synergy Control Panel to the Synergy Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

8. **USB Ports**
   The two integrated USB ports are reserved for future use.

9. **Time Code Input**
   The Time Code Input allows the system to be synchronized to an external time reference.
Installation at a Glance

The following section presents a brief overview of the installation process. The exact steps taken in installing your switcher will depend on the specific options that you have purchased.

**Note**

All cautionary rules regarding static discharge apply. Refer to the section “A Word About Static Discharge” at the beginning of this manual for details.

Experienced installers may wish to work from this outline as required.

- Install the control panel.
- Install the electronics frame in an equipment rack.
- Install the frame power supplies.
- Perform the basic cabling:
  - control panel to frame interconnection
  - keyboard to control panel cabling
  - remote Aux panel cabling
  - reference input(s)
  - switcher interconnections
  - connections to preview and program monitors
- Power up and do a quick video check on the switcher.
- Decide on inputs and install push-button inserts accordingly.
- Connect inputs.
- Connect output monitors as required for your installation.
- Make connections to external equipment. The ways of connecting such sources will depend on personal preference as well as on the combination of options purchased with the switcher.
- Connect character generator key (alpha) and video input signals.
- Connect the tallies.
- Connect and set up the general purpose interface, configuring the editor GPIs and the Aux Bus GPI inputs and outputs.
- Configure the switcher personality according to your installation requirements and personal preferences. The many operational parameters include editor related functions, auto keying selections, Aux Bus and memory configuration, and various button assignments and operational shortcuts.

**Note**

The previous steps cover switcher installation and configuration. Additional appendices at the end of this manual provide information on installing hardware options.
Hardware Installation

This section describes procedures for installing the following components of the Synergy Q/MD switcher system:

- Control panel
- Electronics frame

This equipment is to be installed and serviced by qualified personnel only. To ensure safe installation of your switcher, refer to the section “Important Regulatory and Safety Notices to Service Personnel” on page 2-3.

Note

The frame and control panel have separate power supplies.

Installing the Control Panel

The control panel is shipped with all its circuit boards and power supply in place — you only have to install the control panel tub itself and some push-button inserts. Each tub is designed to be set into a desk or console cutout.

Note

For information on connecting the control panel to the frame, refer to the section “Control Cable Installation” on page 4-3.

Use the following procedure to install the control panel:

1. Measure your console according to the appropriate cutout measurements, as illustrated below:
2. In addition to the cut-out measurement, ensure that there is sufficient clearance under the desktop for connectors and cables on the rear of the control panel. Approximately four inches (10.1 cm) of clearance should be sufficient for each switcher, as shown below.

---

Operating Tip

When measuring for the cutout, it is recommended that you place the front lip of the panel within two inches (5.0 cm) of the console front (as shown in the diagrams above). This placement is designed for the convenience of the operator.
3. Install the control panel in your console. Each tub drops into the cut-out from above and rests on edge supports at the sides.

4. Remove the two tie-down bolts that are located on the underside of the tub. The control panel tub will not open until these bolts are removed. Once the bolts are removed, it is recommended that you re-install them from the top — making sure that they do not protrude through the bottom of the tub.

**Note**

Once the panel is fully installed, you may also consider re-installing the bolts from the bottom — to prevent unauthorized access to the inside of the tub. If you elect to do this, ensure that the power switch (inside the tub) is in the ON position.

5. Normally, fasteners are not required to hold the control panel in place. However, if your installation requires it (particularly for remote trucks), you can attach the tub to the desk using the pre-drilled mounting slots on each side of the tub. Wood screws are not supplied.

6. Install control panel power. Use the following figure for reference. Connections are identical for all switchers except the Synergy 1 control panel. Refer to the section “Equipment Overview” on page 3-3 for more information.
• Connect the **PRIMARY POWER** connector to an AC outlet.

• If the Redundant Power Supply option is installed, connect the **REDUNDANT POWER** connector to an AC outlet.

---

**Caution**

Refer to the section “**Important Regulatory and Safety Notices to Service Personnel**” on page 2-3 for important safety information.

**Note**

For control panel redundancy, it is recommended that two independent AC sources be used to feed the control panel power supplies.

This completes the control panel installation.

**Installing the Electronics Frame**

The electronics frame is designed to be rack mounted. Note the following installation requirements:

• **Rack Units:** 3 RU

• **Height:** 5.25 inches (13.34 cm)

• **Depth:** 25 inches (63.5 cm)

• **Rack:** standard 19 inch wide equipment rack

---

**Caution**

Ensure that you leave space around the electronics frame for adequate ventilation. Both sides of the frame must be kept clear so that switcher airflow is not restricted in any way. Failure to provide adequate ventilation could result in overheating and damage to your switcher may occur.

Install the frame for maximum stability during operation and, if possible (but not required) leave a 1RU space above the frame to facilitate installation and removal of the frame door. The frame should be stalled in an accessible, dry, and dust free location.

To ensure maximum stability, the Synergy Q/MD frame is mounted to the rack using two support brackets that are located at the rear of the frame. These brackets are included in your Installation Kit.

Use the following procedure to secure the support brackets to the frame:

---

**Notice**

Failure to install the support brackets as instructed will void the warranty.

1. Remove the front door from the frame. Refer to the section “**Removing or Installing the Frame Door**” on page 3-16 for more information.

2. Remove the support brackets from the Installation Kit that you received with your shipment.

3. Using standard rack mounting screws (not supplied), attach the support brackets to the Rear Panel Mounting Flange as per the following diagram. The support brackets are adjustable, for your convenience.
4. Install the frame into the rack, as desired, and secure the support brackets to the rack rails.

5. Re-install the frame door.

This completes the procedure for securing the support brackets to the frame.

Please note:

- The system is shipped with the door on.
- The system is shipped with all circuit boards, the requested quantity of input and output boards, and the power supply already installed. If you have reason to remove or install additional printed circuit boards, refer to the section “Removing/Installing Circuit Boards” on page 3-19. Most boards are hot-swappable, and the circuit board extractors on the sides of the boards allow easy installation and removal.
- As a precaution after installation, ensure that all boards are tightly pushed into their midplane connectors.
- Some of the daughter boards may have come loose during shipping. Check, and if necessary reseat, Squeeze & Tease Channel, WARP, DSP, and XFX cards. Refer to the section “Removing/Installing Circuit Boards” on page 3-19 and Chapter 27, “Frame Boards” for information on removing and installing circuit boards.
Removing or Installing the Frame Door

If you are installing hardware options, or replacing circuit boards or power supplies, you will be required to remove and re-install the frame door.

**Caution**
The frame door must be installed on the frame for proper cooling. Leaving the frame door off may cause the frame to overheat, resulting in unexpected behavior or damage to equipment.

**QMD/X Frame**
The door on the QMD-X and QMD frames swings open, allowing for quick access to the boards and cards in the frame. The door can also be completely removed for greater access into the frame.

Use the following procedure to open the door of the QMD-X or QMD frame:

1. Gently pull the door latch out and rotate it to release the door. The QMD-X door has two latches.

2. Swing the door open, as shown.

**Operating Tip**
To remove the door from the frame completely, open the door to its full extent. The door will be perpendicular to the front of the frame. Lift the door directly up to unhook it from the hinge pins and remove the door from the frame.

This completes the procedure for opening the door of the QMD-X or QMD frame.
**MD/X Frame**

---

**Caution**

The MD frame door is *completely* removable and quite heavy. Care must be taken when performing these procedures.

---

**Opening and Removing the Frame Door**

Use the following procedure to remove the frame door:

1. Gently pull the door latch out and up, releasing the door from the top of the frame. The door retainer prevents the door from falling.

2. With both hands, grasp the sides of the door, and gently lift it. Rotate the bottom towards you until the bottom edge clears the pivoting tongue on which it rests, and the door retainer is free of the frame top plate.

3. Move the door away from the frame, and place it on a clean, flat surface.

This completes the procedure for removing the frame door.

---

**Installing and Closing the Frame Door**

Use the following procedure to install the frame door:

1. With both hands, grasp the sides of the frame door, and, ensuring that the door retainer is under the top of the frame, hook the grooved bottom edge over the pivoting tongue on the bottom front ledge of the frame.
2. When you are satisfied that the door is resting properly, firmly press the top of the door until the latch pops into place and is secure.

This completes the procedure for installing the frame door.
Removing/Installing Circuit Boards

The Synergy Q/MD frame comes standard with all the circuit boards already installed. If daughter cards or boards need to be installed, or replaced, you will have to go into the Synergy Q/MD frame and either remove and install or install the boards you need.

When a new board is installed, the switcher checks the current version of software on the board and tries to upgrade it the current version of the switcher. If the software on the board is the same as the software on the switcher, there is no change. If the board has a software version that is different than the version on the switcher, the switcher will upgrade the board to the same version as the switcher. For this reason it is important that you upgrade your switcher to the latest version of Synergy Q/MD software prior to installing a new board into the frame.

Refer to the section “Software Upgrade” on page 6-8 for more information on upgrading your switcher.

If you are installing one of the following options, refer to Chapter 29, “Hardware Options” for detailed instructions:

- Squeeze & Tease MD
- Squeeze & Tease MD WARP
- XFX Extra Effects Card

Front Frame Circuit Boards

The circuit boards at the front of the Synergy Q/MD frame manipulate video coming from the Video Input Board at the back of the frame. These boards can be removed and replaced as needed by removing the front door of the frame and sliding the desired boards out.

Front Board Locations

The front of the frame is where most of the video processing boards are located. The location and number of boards that are installed in the frame depends on the number of MLEs, and Squeeze & Tease DVE channels you require per MLE-pair. Refer to the following table, and the illustrations of the frame, for information on which slot each front frame board should be installed in.

<table>
<thead>
<tr>
<th>Slot</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 0</td>
<td>Fan Board</td>
<td>Fan Board</td>
</tr>
<tr>
<td>Slot 1</td>
<td>Video Processor Board</td>
<td>Video Processor Board</td>
</tr>
<tr>
<td>Slot 2</td>
<td>Squeeze &amp; Tease Carrier</td>
<td>Squeeze &amp; Tease Carrier</td>
</tr>
<tr>
<td>Slot 3</td>
<td>Video Processor Board</td>
<td></td>
</tr>
</tbody>
</table>
Removing Front Frame Circuit Boards

**Important**  
If you remove a board that is providing a resource that is being used on-air, that resource will no longer be available when that board is removed.

Use the following procedure to remove circuit boards from the front of the Synergy Q/MD frame:

1. Backup any system setup configurations you have on the switcher. Refer to the section “Backing Up Setups to an External Computer” on page 6-19 for more information.

2. Remove the front door from the frame. Refer to the section “Removing or Installing the Frame Door” on page 3-16 for more information.

3. Locate the board you want to remove. Refer to the section “Front Board Locations” on page 3-19 for board locations.

4. If a tie wrap has been used to secure the extractor tabs on the sides of the board, remove the tie wrap.

5. Locate the two locking tabs at either side of the board you want to remove.

6. Grasp both locking tabs and rotate them towards you and out towards the outer sides of the frame. This will unseat the board from the midplane.

7. Gently slide the board out of the frame and place it on a clean, flat, static free surface.

This completes the procedure for removing a front frame board.

**Installing Front Frame Circuit Boards**

Use the following procedure to install printed circuit boards in the front of the Synergy Q/MD frame:

1. With the frame door removed, locate the slot into which you will be installing the circuit board. Refer to the section “Removing Front Frame Circuit Boards” on page 3-20 to ensure proper configuration.

2. Inspect the Power Connector Blades on the edge of the board to ensure that they are not bent or damaged.
3. Align the board with the guide rails and push the board in. When the board stops sliding freely, push firmly to seat the board, and secure it with the ejector tabs.

4. The switcher will now upgrade the board you have installed if required.

5. Perform a hard restart of the switcher to initialize the new software on the board. Refer to the section “Rebooting the Switcher After an Upgrade” on page 6-15 for more information on this.

6. Locate the two small holes on the front edge of the board, near the extractor tabs, marked SCR1 and SCR2. If you wish, you can further secure the board by threading tie wraps through these holes and fastening them around the extractor tabs.

7. Install the frame door as per the section “Removing or Installing the Frame Door” on page 3-16.

This completes the procedure for installing printed circuit boards in the front of the frame.

Rear Frame Circuit Boards

The Synergy Q/MD frame comes standard with 1 Video Input Board and 1 Video Output Board, but is expandable to 2 Video Input Boards. If an additional board is purchased, it must be installed in the proper slot at the back of the frame in order for the switcher to function properly.

Rear Board Locations

The rear of the frame is where input and output BNCs boards are located. The number of boards that are installed in the frame depends on the number of inputs and outputs you require. Refer to the following table, and the illustration of the frame, for information on which slot each rear frame board should be installed in.
Board Slots in the Rear of the Q/MD Frame

Removing Rear Frame Circuit Boards

**Important** If you remove a board that is providing a resource that is being used on-air, that resource will no longer be available when that board is removed.

Use the following procedure to remove printed circuit boards from the rear of the Synergy Q/MD frame.

**Note** The switcher must be powered down before removing the Frame CPU Board. Refer to the section “Shutting Down the Switcher” on page 4-14 for more information on how to shut down the switcher.
1. Locate the board you want to remove. Refer to the section “Rear Board Locations” on page 3-21 for board locations.

2. Label and remove any cables connected to the board.

3. Loosen the locking screws on either side of the circuit board face plate.

4. Gently pull on the locking screws to unseat the board, and slide the board out of the frame. Do not pull on any of the connectors.

5. Place the board on a clean, flat, static free surface.

This completes the procedure for removing a frame board.

**Installing Rear Frame Circuit Boards**

Use the following procedure to install printed circuit boards in the rear of the Synergy Q/MD frame. Refer to the above diagram for reference.

**Note**

Throughout this procedure, take care not to damage the bronze-colored EMI gaskets located on the top of the circuit board face plates.

1. Locate the slot into which you will be installing the circuit board. The slots are labeled with letters from A to E inclusive. Refer to the section “Removing Rear Frame Circuit Boards” on page 3-22 for more information.

2. Inspect the Power Connector Blades on the edge of the board to ensure that they are not bent or damaged.

3. Align the board with the guide rails and slide the board into the slot. When the board stops sliding freely, push firmly to seat the board.

4. Unscrew the Locking Screws located at either end of the rear panel of the board, or blank spacer, above or below the new board you are installing.

5. Pull the board you just unscrewed the Locking Screws from out of the frame about 1/4” (6mm).
6. Push firmly and evenly on each side of the new board to seat it.

**Important**  
DO NOT use the Locking Screws to seat or force the board into the slot. If you have trouble seating the new board, contact Ross Video Technical Support.

7. Seat the board above or below the new board, and screw in the **Locking Screws** on both boards.

8. The switcher will now upgrade the board you have installed if required.

9. Perform a hard restart of the switcher to initialize the new software on the board. Refer to the section “**Rebooting the Switcher After an Upgrade**” on page 6-15 for more information.

10. Reconnect any cables as required.

This completes the procedure for installing a frame board.
Connecting Frame Power

**Warning**

This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

Use the following procedure to install frame power:

1. Connect the **PS 1** connector to an AC outlet.
2. If the **Redundant Power Supply** option is installed, connect the **PS 2** connector to an AC outlet.

This completes the procedure for installing frame power.

Please note:

- Each AC connector includes a power lock, which is designed to retain the power cable connector.

**Note**

Refer to the section “Important Regulatory and Safety Notices to Service Personnel” at the beginning of this manual for correct line cord information.

**Power Fail Indicators**

Note that two important **POWER FAIL** indicator LEDs on the control panel mirror the condition of the frame “Power” LEDs and the panel power supply:

- **PANEL**: when lit, indicates that there is a fault with the primary or redundant control panel power supply.
- **FRAME**: when lit, indicates that there is a fault with the primary frame power supply, the redundant supply, or the fans.
Power Failure

When the Synergy Q/MD switcher loses power, the frame and control panel react in the following fashion:

- A loss of control panel power only has no effect on the frame, because the frame stores the current video state. When control panel power is restored, your setups will return to their previous state.

  **Note** Refer to the section “Important Regulatory and Safety Notices to Service Personnel” at the front of this manual for correct line cord information.

- If the frame is turned off, the panel indicates a frame power failure on the POWER FAIL indicator LEDs. In addition, the control panel menu displays the Splash Screen. When frame power is restored, the power failure status indicator clears, and the panel returns to the main menu with all control panel settings in factory default state. Refer to the section “Preliminary Functional Check” on page 4-16 for factory default settings.

- When power returns after a loss to both the frame and the control panel, control panel setting will return to the factory default state. Refer to the section “Preliminary Functional Check” on page 4-16 for factory default settings.
Installing Peripheral Equipment

Several connectors are provided on the rear of both the control panel and the frame for integration with various types of external equipment. Refer to the section “Equipment Overview” on page 3-3 for the location and description of these connectors. Refer to Appendix A, “Specifications” for pinouts.

This section will provide you with information on connect your peripheral equipment. The following topics are included:

- Installing Remote Aux Panels
- Remote/Peripheral Control Connections
- Tally Connections
- GPI I/O and System Fail Relay Connections
Installing Remote Aux Panels

Remote Aux panels are self-contained units that have their own power supply. Each panel controls the switcher Aux Buses via a single control cable.

Even though an unlimited number of Aux panels can be connected to the Synergy Q/MD control panel, a practical limit of 16 Aux panels should be observed. This limit minimizes delay, and allows eight panels to be daisy-chained on each of the two AUX connectors.

**Note**

The **Synergy 1** uses a DB9 to RJ-12 **Aux Adapter** to connect a Remote Aux Panel to the Remote 5 port on the back of the control panel. As this provides only one AUX port, a practical limit of 8 Remote Aux Panels should be observed.

The Remote Aux Panels require one rack unit of space for installation and their own power as the following figure illustrates.

![Aux Panel Rear Layout and Connection](image)

**Aux Panel Rear Layout and Connection.**

<table>
<thead>
<tr>
<th>1) Power Connectors</th>
<th>3) Switcher (MAIN) Connector</th>
<th>5) AC Adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>2) GPI Connector</td>
<td>4) Remote (ECHO) Connector</td>
<td>6) Cable Retainer</td>
</tr>
</tbody>
</table>

Connector layout is identical for all remote Aux panels.

1. **Power Connector**
   
   One DC connector is provided for +5 VDC panel power.

2. **GPI Connector**
   
   One 9-pin “D” GPI connector is provided for special GPI triggers that allow a camera operator to manually override the Aux panel selection. Refer to the section “Remote Aux Panel Cabling” on page 4-4 for connection details. Refer to the section “Aux Bus Setup” on page 11-2 for setup details.

3. **Main Connector**
   
   One 6-pin RJ-12 Telco connector is provided for connecting to the Aux connectors on the rear of the Control Panel. Refer to the section “Remote Aux Panel Cabling” on page 4-4 for connection details. Refer to Appendix A for pinouts.
4. **Echo Connector**
   One 6-pin RJ-12 Telco connector is provided for daisy-chaining the remote panel to the next remote Aux panel in line. Refer to the section “**Remote Aux Panel Cabling**” on page 4-4 for connection details. Refer to Appendix A for pinouts.

5. **AC Adapter**
   One AC Adapter (90 - 264 VAC) is provided with each remote Aux panel as a source of +5 VDC. Please note:
   - 90 - 264 VAC adapter, p/n **103-012**
   Refer to the section “**Remote Aux Panel Cabling**” on page 4-4 for connection details.

6. **Cable Retainer**
   Loop the cable from the AC adaptor through the cable retainer on the back on the panel for better security.

   Please note:
   - There are no user-settable jumpers in the Aux panels.
   - Assignable Aux panels are configured using the control panel menu system. A special programming mode allows you to assign “rights” for each of the available Aux outputs to an assignable Aux panel.
   - Dedicated Aux panels are also configured using the control panel menu system. A special programming mode allows you to assign one specific Aux output to each dedicated panel.

   Refer to the section “**Aux Bus Setup**” on page 11-2 for instructions for both assignable and dedicated Aux panels.

**Installation Procedure**

Use the following procedure to install remote Aux panels:

1. Install the appropriate panels in the desired locations for your facility.
2. Connect the supplied AC adapter to a suitable source of line voltage.
3. Plug the DC connector into the rear of the remote Aux panel.
4. Repeat steps 2 and 3 for each Aux panel.

This completes the remote Aux panel installation procedure.
Remote/Peripheral Control Connections

The Synergy Q/MD control panels and frames provide a 8 remote ports (4 on the Synergy 1) and 4 peripheral ports to allow the serial control of a number of different devices, such as VTRs, disk recorders, video servers, audio boards, and other serial controlled devices.

Synergy 1 Control Panels — Remote Ports

Synergy 2 and 3 Control Panels — Remote Ports

Synergy Q/MD Frame CPU Board — Peripheral Ports

Note
You can only control Editors from the Peripheral Ports on the Frame CPU Board.

To enable control over these devices, the following options must be purchased and installed:

- For VTR control, the VTR Remote Control Option must be installed.
- For video server control, the Video Server Control Option must be installed.
- For audio server control, the Audio Server Control Option must be installed.
- For robotic camera control, the Robotic System Option must be installed.
- For router control, the Router Option must be installed.
- For audio mixer control, the Small or Large Audio Mixer Option must be installed.
- For Still Store control, the Still Store (Aprisa) Option must be installed.
- For control of serial tally equipment, the Serial Tally Option must be installed.
- For Peripheral Interface II Protocol control, the Peripheral Bus II Option must be installed.
- For Editor control over the Synergy Q/MD Live Production Engine, the Editor Interface Option must be installed.
Refer to the section “Communications Overview” on page 9-2 for more information on configuring your switcher to enable peripheral control. Refer to Appendix A, “Specifications” for pinout details.
Tally Connections

Each Synergy Q/MD switcher, with the exception of the Synergy 1, includes **36 configurable** tally relays, each of which can be assigned to any video input. The Synergy 1 includes **16** tally relays. The **Extended Tallies** option, which is only available with the Synergy 1.5, 2, and 2.5 Q/MD, provides an additional **36** tallies (bringing the total number to **72**).

**Synergy 1 Q/MD Tally Connections**

The Synergy 1 Q/MD Switcher has a single DB25 tally connector to provide the **16** tally relays.

---

**Synergy 1 Control Panels — Tally Port**

The single Tally port on the Synergy 1 control panel has the following pinout that correspond to the Tallies indicated in the table “**Synergy 1 Tally Port Pinouts**” on page 3-32.

---

**Synergy 1 — Tally Port Pinout**

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tally 1</td>
<td>14</td>
<td>Tally 2</td>
</tr>
<tr>
<td>2</td>
<td>Tally 3</td>
<td>15</td>
<td>Tally 4</td>
</tr>
<tr>
<td>3</td>
<td>Tally 5</td>
<td>16</td>
<td>Tally 6</td>
</tr>
<tr>
<td>4</td>
<td>Tally 7</td>
<td>17</td>
<td>Tally 8</td>
</tr>
<tr>
<td>5</td>
<td>Tally 9</td>
<td>18</td>
<td>Tally 10</td>
</tr>
<tr>
<td>6</td>
<td>Tally 11</td>
<td>19</td>
<td>Tally 12</td>
</tr>
<tr>
<td>7</td>
<td>Tally 13</td>
<td>20</td>
<td>Tally 14</td>
</tr>
<tr>
<td>8</td>
<td>Tally 15</td>
<td>21</td>
<td>Tally 16</td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td>22</td>
<td>n/c</td>
</tr>
<tr>
<td>10</td>
<td>Common</td>
<td>23</td>
<td>Common</td>
</tr>
<tr>
<td>11</td>
<td>Common</td>
<td>24</td>
<td>Common</td>
</tr>
<tr>
<td>12</td>
<td>Common</td>
<td>25</td>
<td>Common</td>
</tr>
<tr>
<td>13</td>
<td>Common</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Synergy 1.5 through 2.5 Q/MD Tally Connections

The Synergy 1.5 through 2.5 Q/MD Switchers have two DB25 tally ports to provide the 36 standard tally relays, plus two additional DB25 ports to provide 36 additional tally relays with the Extended Tallies option.

Synergy 1.5 through 2.5 Control Panels — Tally Ports

The four Tally ports on the Synergy 1.5 through 2.5 control panels have the following pinouts that correspond to the Tallies indicated on the tables below.

The Tallies are listed as follows:

- Tallies 1-18 — Refer to the table “Synergy TALLY 1 Port Pinouts” on page 3-34.
- Tallies 19-36 — Refer to the table “Synergy TALLY 2 Port Pinouts” on page 3-34.
- Tallies 37-54 — Refer to the table “Synergy Optional TALLY 3 Port Pinouts” on page 3-35.
- Tallies 55-72 — Refer to the table “Synergy Optional TALLY 4 Port Pinouts” on page 3-35.

Note: Tally Connectors 3 and 4 are provided as standard, but the associated tally electronics is provided with the Extended Tallies option. Refer to the section “Installed Options” on page 6-27 for more information on determining if the Extended Tallies option is installed.

Operating Tip: Prior to wiring each tally, ensure that you have completed the Input Worksheet found in Appendix C, “Installation Worksheets”, in the Synergy Q/MD Engineering Manual. You will need the information in the Tally column as a reference.
### Synergy TALLY 1 Port Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 1</td>
<td>14</td>
<td>TALLY 2</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 3</td>
<td>15</td>
<td>TALLY 4</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 5</td>
<td>16</td>
<td>TALLY 6</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 7</td>
<td>17</td>
<td>TALLY 8</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 9</td>
<td>18</td>
<td>TALLY 10</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 11</td>
<td>19</td>
<td>TALLY 12</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 13</td>
<td>20</td>
<td>TALLY 14</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 15</td>
<td>21</td>
<td>TALLY 16</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 17</td>
<td>22</td>
<td>TALLY 18</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Synergy TALLY 2 Port Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 19</td>
<td>14</td>
<td>TALLY 20</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 21</td>
<td>15</td>
<td>TALLY 22</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 23</td>
<td>16</td>
<td>TALLY 24</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 25</td>
<td>17</td>
<td>TALLY 26</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 27</td>
<td>18</td>
<td>TALLY 28</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 29</td>
<td>19</td>
<td>TALLY 30</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 31</td>
<td>20</td>
<td>TALLY 32</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 33</td>
<td>21</td>
<td>TALLY 34</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 35</td>
<td>22</td>
<td>TALLY 36</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Please note:

- All relay contacts are normally open.
- Tally relay contacts are rated to a max. of 10 VA (100 $V_{\text{max}}$, 0.5 $A_{\text{max}}$) into a non-inductive load.
- Make connections straight on. Leave 4 inches of clearance behind the control panel.
- Be sure to fasten the clips to hold each connector in place. Run all tally cables in accordance with good engineering practice, and ensure that the cable will not be subjected to physical abuse.

### Synergy Optional TALLY 3 Port Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 37</td>
<td>14</td>
<td>TALLY 38</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 39</td>
<td>15</td>
<td>TALLY 40</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 41</td>
<td>16</td>
<td>TALLY 42</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 43</td>
<td>17</td>
<td>TALLY 44</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 45</td>
<td>18</td>
<td>TALLY 46</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 47</td>
<td>19</td>
<td>TALLY 48</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 49</td>
<td>20</td>
<td>TALLY 50</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 51</td>
<td>21</td>
<td>TALLY 52</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 53</td>
<td>22</td>
<td>TALLY 54</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Synergy Optional TALLY 4 Port Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 55</td>
<td>14</td>
<td>TALLY 56</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 57</td>
<td>15</td>
<td>TALLY 58</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 59</td>
<td>16</td>
<td>TALLY 60</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 61</td>
<td>17</td>
<td>TALLY 62</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 63</td>
<td>18</td>
<td>TALLY 64</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 65</td>
<td>19</td>
<td>TALLY 66</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 67</td>
<td>20</td>
<td>TALLY 68</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 69</td>
<td>21</td>
<td>TALLY 70</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 71</td>
<td>22</td>
<td>TALLY 72</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
GPI I/O and System Fail Relay Connections

In this section, you will wire each GPI port that you have assigned to source and destination devices, respectively.

**Note**
The System Fail Relays are not yet implemented.

Synergy Q/MD Frame CPU Board — GP I/O Port

- Using the “Standard GPI Pinout Table” provided in Appendix B and the data from your “Standard GPI Input Worksheet”, wire GPI input ports 1-10 (or simply the number of ports that you assigned) to each source device. Refer to the Installation Manual that came with your device for GPI output port pinout information.

- Using the “Standard GPI Pinout Table” provided in Appendix B together with the data from your “Standard GPI Output Worksheet”, wire GPI output ports 1-10 (or simply the number of ports that you assigned) to each destination device. Refer to the Installation Manual that came with your device for GPI input port pinout information.

In Appendix B, refer to the section, “Standard GPI I/O Connector Pinouts” for standard GPI connector specifications.

Please note:

- Standard GPI Connector type: 25-pin “D” SUB Female
- GPI Out 1-10: active drive 5V TTL-compatible signals
- GPI In 1-10: 5V TTL-compatible edge or level trigger
- System Fail and System Fail Return relays: 0-24VDC, normally-closed contact-closure FET relays.
- Run all GPI cables in accordance with good engineering practice, and ensure that the cable will not be subjected to physical abuse.
Preliminary Cabling and Video Installation

In This Chapter

This chapter outlines procedures for making basic control panel, frame, reference, and monitor connections. It also describes the connections required to provide video and key signals to all areas of the switcher. You will complete input and output worksheets, connect inputs and alpha signals, install all pushbutton inserts, and connect your switcher outputs. A preliminary functional check procedure is also provided. The following topics are discussed in this chapter:

- Cabling
- Control Cable Installation
- Keyboard Cabling
- Remote Aux Panel Cabling
- Reference Signal Connection
- Monitor Connections
- Power Up
- Resetting the Switcher
- Software Reset
- Full Restart
- Shutting Down the Switcher
- Preliminary Functional Check
- Basic Troubleshooting
- Switcher Timeout
- Input Worksheet
- Connecting and Verifying Inputs
- Input Connection
- Input Verification
- Pushbutton Inserts
- Control Panel Pushbutton Inserts
- Remote Aux Panel Pushbutton Inserts
Cabling

In this section, the following connections are made:

- Control Cable Installation
- Keyboard Cabling
- Remote Aux Panel Cabling
- Reference Signal Connection
- Monitor Connections

Once these basic connections have been completed, a preliminary functional check can be performed to ensure that the switcher is passing video.
Control Cable Installation

Use the following procedure to install the control cable between the electronics frame and the control panel:

1. Ensure that you have the correct **8-pin** shielded Telco cable, with **RJ-45, 8-pin** connectors at each end. Because of their small size, all Telco connectors look quite similar.

2. Using an 8-pin shielded Telco cable, connect the communications port labeled **PANEL** (on the electronics frame) to the communications port labeled **FRAME** (on the rear of the control panel).

This completes the procedure for installing the control cable between the electronics frame and the control panel.

Please note:

- The maximum cable length is 1000 feet (305 meters).
- The cable must be run in accordance with good engineering practice. Ensure that there is sufficient room for the cable and that enough slack is left in the cable run to permit long, gentle bends. Always install cables so that they will not be subjected to physical abuse.
Keyboard Cabling

Connect a standard PC keyboard to the PS/2 port at the back of the Synergy Q/MD control panel.

**Note**

Ross Video Limited does not supply the keyboard.

Remote Aux Panel Cabling

This section provides instructions for cabling Remote Aux Panels. The following topics are discussed:

- Remote Aux Panel Cabling
- Aux Panel Cabling Notes

If your system includes remote Aux panels, one serial cable is shipped with each panel. There are two types of cable available:

- Aux panel cables with standard 10 meter lengths.
- Non-standard cables with lengths specified by the customer.

For standard length cables, refer to the packing list provided with your switcher; the length will be given there. For custom length cables, the length is given on a label attached to the cable.

**Note**

Refer to the section “Synergy 1 Q/MD Remote Aux Panel Cabling” on page 4-5 for information on setting up and cabling a Remote Aux Panel to a Synergy 1 Q/MD Switcher.

Once you have located the appropriate cables for each remote Aux panel, make the connections according to the following figure:
Remote Aux Panel Interconnection — Synergy 2 and 2.5 Control Panels

Use the following procedure to install the control cables between the control panel and each remote Aux panel:

1. Ensure that you have the correct 6-pin shielded Telco cable, with a 6-pin RJ-12 connector at each end.
2. Connect a 6-pin shielded Telco cable (of the supplied or custom length) between the AUX 1 connector on the control panel and the connector labelled MAIN on the rear of the first Aux panel in line.
3. To daisy-chain additional Aux panels (up to 8), connect a 6-pin shielded Telco cable between the Aux panel connector labeled ECHO and the connector labeled MAIN on the next Aux panel in line.
4. Repeat step 3 for all additional Aux panels in the AUX 1 daisy-chain (up to the maximum of 8 panels per chain).

This completes the procedure for installing the control cables of a Remote Aux Panel to the Synergy Q/MD control panel. Repeat this procedure to connect additional Remote Aux Panels to the AUX 2 port.

Synergy 1 Q/MD Remote Aux Panel Cabling

Unlike the Synergy 1.5, 2 and 2.5 Q/MD Switchers, the Synergy 1 Q/MD does not have a dedicated AUX port. Instead, the provided RJ-12 to DB9 Aux Adapter must be installed and setup in the Remote 5 port on the rear of the control panel in order to connect a Remote Aux Panel to the switcher.

Synergy 1 Q/MD Remote 5 Port Setup

Use the following procedure to assign the Remote 5 port on the rear of the Synergy 1 Q/MD control panel to an Aux port:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press **Type** to display the **Type Menu**.

   ![Type Menu](image)

   **Communications — Type Menu**

3. Assign the **Remote 5** port as the **Aux Port** as follows:
   - Use the **Com Port** knob to select **REMOTE 5 (R5)**.
   - Use the **Device** knob to select **RemAux->AUX**.

4. Press **HOME** and **Confirm** if the **Confirm Change Screen** is displayed.

   This completes the procedure for assigning the Remote 5 port as an Aux Port.

**Synergy 1 Q/MD Remote 5 Aux Panel Cabling**

Use the following procedure to install the control cables between the **Synergy 1** control panel and a Remote Aux Panel:

1. Connect the **DB9** end of the **Aux Adapter** to the **REMOTE 5** port on the rear of the **Synergy 1** control panel.
2. Ensure that you have the correct **6-pin** shielded Telco cable, with **6-pin RJ-12** connectors at each end.

**Note**

If you have a device already assigned to the Remote 5 port you will have to set this device up on another Remote port.

**Remote Aux Panel Interconnection — Synergy 1 Control Panel**

**Note**

As the **Synergy 1** control panel does not have a dedicated **AUX** port, an **RJ-12 to DB9 Aux Adapter** is required when connecting remote Aux panels to the **Synergy 1** control panel. This adapter is included in the **Installation Kit** for your **Synergy 1 Q/MD Switcher**.
3. Connect a 6-pin shielded Telco cable (of the supplied or custom length) between the Aux Adapter installed in the REMOTE 5 port and the connector labelled MAIN on the rear of the first Remote Aux Panel in the chain.

4. To daisy-chain additional Aux panels (up to 8), connect a 6-pin shielded Telco cable between the Remote Aux Panel connector labelled ECHO and the connector labelled MAIN on the next Remote Aux Panel in the chain.

This completes the procedure for installing the control cables of a Remote Aux Panel to the Synergy I control panel.

**Aux Panel Cabling Notes**

Please note the following points regarding all remote Aux panels:

- All Aux outputs are timed.
- Aux panel configuration (assignment to specific outputs and assignment of “rights”) is performed using the menu system. Refer to the section “Aux Bus Setup” on page 11-2 for instructions.
- Aux panel crosspoint labels are provided with each panel. Refer to the section “Pushbutton Inserts” on page 4-25 for labeling instructions.

**Reference Signal Connection**

An analog Tri-Level Sync or Composite reference signal must be connected to the reference loop BNCs on one of the Video Input Boards on the switcher.

Connect the reference signal to one of the 2 REF connectors on the Video Input Board in Slot C. If an additional reference is needed, only a Video Input Board without crosspoint (Ross Part Number 4800A-060A) can be used in Slot D.

The following points should be considered when connecting a reference signal to your Synergy Q/MD switcher:

- Always use a stable signal that is low in jitter, and that preferably originates from a reliable analog test signal generator.

**Monitor Connections**

Virtually any Output BNC of the switcher can be assigned as your program or preview output; however, if you have the Mix/DSK or MultiDSK™ options installed, Output BNCs B01 through B06 will be locked to specific output types. These outputs should be used to maximize your outputs. Refer to the section “Mix/DSK Option” on page 8-10 or the section “MultiDSK Option” on page 8-12 for more information.
If you are using a serial digital monitor, connection is direct. If you are using an analog monitor, one of three D-A converters is required:

- Serial Digital to NTSC
- Serial Digital to PAL
- Serial Digital to Analog Component

For more information on the full line of Ross Video conversion equipment, contact your sales representative or Ross Video Limited.
Power Up

Use the following procedure to power up the system:

1. Ensure the following power pre-requisites are met:
   - All power cables are fastened and secure.
   - For control panel redundancy (if installed), ensure that two independent AC sources are used to feed the control panel power supplies.

2. *(For Synergy 2 and 2.5 Control Panels Only)* Control panel power switches are located inside the control panel tub, on the right-hand side. Open the panel tub and turn on the Primary and (if installed) the Redundant power switches.

3. *(For Synergy 1 Control Panels Only)* Control panel power switches are located on the rear of the control panel, one on either side. Turn on the Primary and (if installed) the Redundant power switches.

4. *(For Synergy 2 and 2.5 Control Panels Only)* Close the control panel tub.

5. Remove the front door from the frame. Refer to the section “Removing or Installing the Frame Door” on page 3-16 for more information.

6. Locate the frame power supply power switches, which are situated on the left-hand side of the power supplies. Turn on the primary and, if installed, the redundant power switches.

7. On the control panel, ensure that the PANEL LED under the POWER FAIL heading is not lit.
   - If it is lit, turn the control panel off and check all power connections.
   - Turn the unit back on and recheck the PANEL LED. If the LED is still lit, contact Ross Video Technical Support.

8. On the control panel, ensure that the FRAME LED is not lit.
   - If it is lit, turn all power supplies off and check all power connections.
   - Turn all power supplies back on and recheck the FRAME LED. If the LED is still lit, refer to Chapter 25, “Power Supplies and Fans” for information on diagnosing power supplies. If you require further assistance, contact Ross Video Technical Support.

This completes the procedure for powering up the system.

Please note:

- The order in which you power up the frame and control panel is not important — either can be powered up first.
- Powering up the switcher causes the system to restore the previous condition that existed before power down. In the absence of a valid condition, a “reset” condition is presented, with the BLACK crosspoint selected on all buses. Switcher memory contents are retained.
Resetting the Switcher

If required, the Synergy Q/MD can be reset manually from the control panel. There are three types of resets:

- A **Full Restart** affects hardware and software simultaneously
- A **Software Reset** affects software only
- A **Global-Store Restart** affects the Global-Store and video processor only.

**Full Restart**

This function performs both a hardware and a software reset simultaneously. Switcher memory registers, personality registers, installation registers, and custom control registers are not affected by the reset, but all other switcher parameters (for example, the current state of the panel) are reset. **BLACK** will be selected on all buses.

**Important**

Do not turn the switcher frame power off until you have completed the proper shutdown procedure or you may damage the hard disk. Refer to the section “Shutting Down the Switcher” on page 4-14 for this procedure.

Use the following procedure to perform a full restart of the switcher:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press HOME ⇒ MORE ⇒ System Shutdown.

2. Press **Restart**.
   
The system will prompt you to confirm the restart. Once confirmed, the frame will power down and boot up again.

**Software Reset**

The software reset function can be performed from either the Global Memory System Group or any individual MLE Memory System Group on the control panel. Both methods are described below.

**Resetting the Switcher from the Global Memory Group**

From the Global Memory System Group you can reset either all the MLEs on the system, or each MLE individually. Use the figure below for reference:
Use one of the following procedure to reset a Synergy 1.5 through 2.5 from the Global Memory System Group:

- **All MLEs** — To perform a full reset on all control panels, simultaneously press **ALL** in the **RECALL** column and **ALL** in the **STORE** column.
- **MLE 1** — To reset MLE 1, simultaneously press **MLE 1** in the **RECALL** column and **MLE 1** in the **STORE** column.
- **MLE 2** — To reset MLE 2, simultaneously press **MLE 2** in the **RECALL** column and **MLE 2** in the **STORE** column.
- **MLE 3** — To reset MLE 3, simultaneously press **MLE 3** in the **RECALL** column and **MLE 3** in the **STORE** column.

Use the following procedure to reset a Synergy 1 control panel from the Global Memory System Group:

- To perform a full reset on the control panel, simultaneously press the **STORE** and **RECALL** buttons in the Global Memory System Group.

**Resetting the Switcher from an Individual MLE**

From each individual MLE Memory System Group you can reset the MLE individually. Use the figure below for reference:

**Note**

This feature is only available on the Synergy 2.5 control panel.
Synergy 2.5 — Individual MLE Reset Function

- **MLE 1** — To reset MLE 1, from the MLE 1 Memory System Group, simultaneously press **STORE** and **RECALL**.
- **MLE 2** — To reset MLE 2, from the MLE 2 Memory System Group, simultaneously press **STORE** and **RECALL**.

**Note**

On the **Synergy 2.5** control panel there is no **MLE Memory System Group** for the **Program/Preset MLE** (MLE 3). This MLE must be reset from the **Global Memory System Group**.

**Global-Store Restart**

This function resets the Synergy Q/MD switcher Global-Store and video processor. Use this procedure if you are experiencing difficulties with the preview overlay, Global-Store, or as directed by Ross Video Technical Support.

Use the following procedure to perform a Global-Store restart:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press **HOME** \(\Rightarrow\) **MORE** \(\Rightarrow\) **System Shutdown**.

2. Press **Restart Global-Store**.
   
The system will prompt you to confirm the restart. Once confirmed, the restart will occur and the switcher will not pass video for a few seconds while the restart takes place.

This completes the procedure for performing a Global-Store restart.
Updating Panel Data

This function synchronizes the Synergy Q/MD control panel and frame. Use this function after a communication loss between the control panel and frame if your switcher does not appear to recover once communication is restored or as directed by Ross Video Technical Support.

Use the following procedure to update panel data:

1. Navigate to the System Shutdown Menu as follows:
   - Press HOME ⇒ MORE ⇒ System Shutdown.

   ![System Shutdown Menu]

2. Press Update Panel Data.

   The system will prompt you to confirm the update. Once confirmed, the switcher control panel and frame will synchronize.

This completes the procedure for updating panel data.
Shutting Down the Switcher

This function shuts down the switcher, placing the CPU Board into a hibernation mode. In this mode it is safe to turn off all your power supplies and remove the CPU Board.

**Important**

| Do not turn the switcher frame power off until you have completed this shutdown procedure or you may damage the hard disk.

Use the following procedure to shutdown the switcher:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press HOME ⇒ MORE ⇒ System Shutdown.

2. Press **Shut Down**.

**Caution**

| Even though the switcher has been shut down, the power supplies are still active until they have been physically switched off.

The system will prompt you to confirm the shutdown. Once confirmed, the frame will shut down.

This completes the procedure for shutting down the switcher.

Powering Off the Switcher

Once your switcher has been shut down, it is safe to turn the power off.

Use the following procedure to power off your switcher:

1. Look for the flashing status indicators on the front of the switcher frame next to the embossed Ross logo. If the indicators are not flashing between green and amber, **do not** proceed with this procedure. Refer to the section “Shutting Down the Switcher” on page 4-14 for information on shutting down your switcher.

2. Remove the switcher frame door. Refer to the section “Removing or Installing the Frame Door” on page 3-16 for information on removing the frame door.

**Important**

| The Frame Door must be re-installed on the frame for proper cooling when your switcher is running. Leaving the frame door off may cause the Frame to overheat.

3. Turn off the **Primary** and (if installed) the **Redundant** power switches.
Control panel power switches are located inside the control panel tub, on the right-hand side. Open the panel tub and turn off the Primary and (if installed) the Redundant power switches. *(For Synergy 1 Control Panels Only)* Control panel power switches are located on the rear of the control panel, one on either side.

This completes the procedure for powering off your switcher.
Preliminary Functional Check

At this point, the basic connections have been completed. With the switcher powered up, a preliminary functional check can be performed to ensure that the switcher is passing video. A variety of tests can be performed, including:

- Dissolves between **BLACK** and **COLOR BKGD**
- Wipes between **BLACK** and **COLOR BKGD**
- Fade to black

All Ross Video products undergo thorough quality control and testing before shipment. The following preliminary check ensures that no damage has occurred during transit, and that all boards are correctly installed. Once the preliminary check is complete, the remaining installation procedures can be performed.

With your video monitor properly connected, perform the following procedure for a preliminary check:

1. Perform a full software reset, as outlined in the section “Software Reset” on page 4-10. This sets the panel to a full reset state.

2. Check the status of the control panel. In a reset (or “default”) condition, the following buttons and indicators will be lit:
   - The first input (typically **BLACK**) is selected on all MLE buses.
   - The first input (typically **BLACK**) is selected on the **Aux Bus**.
   - The red LED at the right edge of the **PGM** (Program) **Bus** is lit. This indicates that the **PGM Bus** is on air.
   - In the **Preview Bus** group, **MLE# PV** is lit. This will be the preview for your **BKGD/PST** bus
   - In the **Aux Bus Assign** group, **BANK 1, AUX 1** is lit.
   - In each MLE **Transition** group, the **BKGD** and **DISS** buttons are lit. A background dissolve is the default transition.
   - In the **Program/Preset Transition** group, the **BKGD** and **DISS** buttons are lit.
   - *(Synergy 3 control panel only)* In each MLE **Memory System** group, the **RECALL** button is lit and the display shows the following information (for the specific MLE):
     - **REG:00** — Memory register 00 is preset
     - **Memory0** — Memory register 00 was last recalled
     - **MLE:015** — MLE transition rate is 15 frames
     - **Key:008** — Key transition rate is 8 frames
   - In the **Global Memory System** group, under the “**Recall**” heading, the following buttons are lit:
     - **Synergy 1 Q/MD: RECALL**
     - **Synergy 2 Q/MD: MLE 2**
     - **Synergy 2.5 Q/MD: MLE 3**
• The default display in the **Global Memory System** of the **Synergy 1.5, 2 and 2.5 Q/MD switchers** indicates the following information (for the DSK and the Program/Preset MLE):
  ~ REG:00 — Memory register 00 is preset
  ~ Memory0 — Memory register 00 was last recalled
  ~ M:015 — MLE transition rate is 15 frames
  ~ D:008 — DSK transition rate is 8 frames
  ~ F:20 — DSK fade-to-black transition rate is 20 frames

• In the **Global Memory System** group of the **Synergy 1 Q/MD**, the display shows the following information:
  ~ REG:00 — Memory register 00 is preset
  ~ Memory0 — Memory register 00 was last recalled
  ~ M:015 — The MLE transition rate is 15 frames
  ~ K:008 — The key transition rate is 8 frames
  ~ F:20 — The fade-to-black transition rate is 20 frames

• In each MLE **Key 1** and **Key 2** group, the **AUTO SELECT** button is lit.

• **(Not applicable on the Synergy 1 control panel)** In each switcher **Downstream Keyer** group, source 1 is selected.

• **(Not applicable on the Synergy 1 control panel)** At the far right edge of each MLE **Key Bus**, the green **KEY 1** LED is lit. This indicates that the **Key 1 Bus** is active.

• In the **Positioner** group, the **MLE 1** and **PATT** buttons are lit. Note that the **MLE 1** button does not exist on the **Synergy 1** control panel.

• In each switcher **Mattes** group, there is no default selection. Therefore the last buttons selected will be lit.

• In the **Pattern Control** group, the **MLE 1, PP1, NORM, and Vertical Wipe** (upper left wipe) buttons are lit. Note that the **MLE 1** button does not exist on the **Synergy 1** control panel.

• **(Synergy 3 control panel only)** In the **DVE Send** group, the **MLE 1** button is lit.

3. Select sources for the transition:
   • Ensure that **BLACK** is selected on the **PGM Bus**.
   • Select **COLOR BKGD 1** on the **PST** (Preset) **Bus**.
     ~ **Color Background 1** is factory preset to red.
     ~ **Color Background 2** is factory preset to blue.

4. Ensure that **DISS** is selected in the **PGM/PST MLE Transition** group.

5. While watching the monitor, move the fader from one limit to the other, and verify that the video dissolves from black to color.

**Note**

When lit, the Up/Down arrows adjacent to the fader indicate which direction to move the fader to complete the transition.
6. In the MLE Transition group, press WIPE.

7. While watching the monitor, move the fader from one limit to the other, and verify that the video wipes between color and black.

8. On the active bus, switch between two or three crosspoints (such as COLOR BKGD 1 and COLOR BKGD 2) to ensure that “cuts” are taking place.

9. (Not applicable on the Synergy 1 control panel) On the PGM Bus, press a re-entry crosspoint (MLE 1, MLE 2, or MLE 3, depending on the switcher model).

10. (Not applicable on the Synergy 1 control panel) On the selected re-entry bus, repeat steps 4 through 9. Instead of the PGM and PST bus, use the BKGD and PST buses of each MLE.

11. Repeat steps 9 and 10 for each MLE in your system.

This completes the preliminary check. Once you are satisfied that video is switching and mixing, continue with the remaining connection procedures.

**Basic Troubleshooting**

Note the following basic troubleshooting points:

- If you experience any problems with knobs, faders, or the joystick during the preliminary functional check, there may be a problem with switcher calibration or MLE communications. Refer to the the section “Switcher Calibration” on page 24-2 for instructions.

- If the system is not switching and is not outputting video, there may be a problem with the reference connection. Check that a valid analog reference is connected to the reference input. The system will not output video if the reference signal is invalid or not present.

For other switcher problems, please contact Ross Video Technical Support.

**Switcher Timeout**

If no control panel buttons are touched and no fader arms are moved for a period of 30 minutes, the switcher goes into a “sleep” mode and all lights are automatically turned off. If this timeout occurs, press any button or move any fader (or joystick) to “wake” the switcher and turn on all lights. Please note:

- The switcher does not act on a button push when it is coming out of “sleep” mode.

- The factory default timeout interval is 30 minutes but can be changed as desired. Refer to the section, “Switcher Personality”, in the chapter, “Switcher Basics”, of the Synergy Q/MD/X Operator’s Manual for details.
Installing Video Input Board

The Synergy Q/MD frame comes standard with 1 Video Input Board, but is expandable to 2 Video Input Boards in the MD frame and 3 Video Input Boards in the QMD frame. If an additional board is purchased, it must be installed in the proper slot at the back of the frame in order for the switcher to function properly.
Input Worksheet

Complete the following worksheet for all of your video inputs, including primary sources, keys, and fills. To avoid marking up the Engineering Manual, you can also use the worksheet provided in Appendix C, “Installation Worksheets” to make extra copies.

Following are basic input recommendations:

- Connect your analog reference to the reference input (as outlined earlier in this chapter).

**Important**

Until you connect the reference input, your switcher will not output video.

- Connect your primary video sources to inputs C01, C02, C03 (etc.), and then continue forward in sequence.

On the control panel, by default, input C01 is mapped to pushbutton 2, input C02 is mapped to pushbutton 3, etc. This association will minimize subsequent re-mapping of your inputs, and make it very easy for you to locate inputs on the panel during the initial cabling procedure.

- Connect your Key signals (alphas) to your highest available input number, and then continue backwards in sequence. The starting point will be determined by the number of input boards installed in your system. For example:
  - If your system has only the 16 standard inputs, start alphas at input C16, then C15, C14, etc.
  - If additional inputs have been installed, start alphas at input D10 or D16, depending on your configuration, and continue backwards from there. (e.g., D16, then D15, D14, etc.)

In each case, use the your highest available input number. This association will allow you to view each alpha during preliminary cabling, and will also assist in the subsequent alpha-to-video re-mapping procedure.

Using the above recommendations, complete the following input worksheet. The majority of this data will be used in the section “BNC Configuration” on page 7-2 to complete the configuration of each input.

For each input (moving from left to right in the worksheet columns):

- Fill in the actual source name. For example:
  ~ VTR 1

- Fill in the input name (up to 8 characters), as you would like to see it displayed throughout the menu system (and on the Preview Overlay). For example:
  ~ VTR Blue

- Fill in the type of input. Choose between:
  ~ Off
  ~ VTR
  ~ Alpha
  ~ Router
~ Extern Still
~ Robotic Cam
~ Video

- Fill in the input tally number.
- If the input is an alpha, choose between:
  ~ **Shaped** keying mode
  ~ **Unshaped** keying mode
- If the input is a key fill, choose the alpha with which you want the key fill to be associated. List the BNC number of the primary source.

### Input BNC Worksheet

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td>VTR 1</td>
<td>Remote 1</td>
<td>VTR Blue</td>
<td>VTR</td>
<td>12</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Sample 2</td>
<td>CG Alpha</td>
<td>Remote 2</td>
<td>CG Alpha</td>
<td>Alpha</td>
<td>—</td>
<td>Shaped</td>
<td>C10</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>C01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Input BNC Worksheet

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>D07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E08</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Connecting and Verifying Inputs

This section covers the following topics:

- Input Connection
- Input Verification

**Input Connection**

Using the data from the previous worksheet, connect your reference input, primary inputs, and all alpha inputs to the appropriate connectors on the rear of the frame. Remember that there are no specific “key” inputs — with the exception of the reference inputs, any input can be used for any purpose. All connectors are located in the “Input” section on the rear of the frame as shown below. Each input is identified by the letter (C, D, or E) at the end of the row, and the number (1 to 16 inclusive) at the top left of the connectors.

Use cabling techniques in accordance with good engineering practice.

**Note**

The Synergy Q/MD switcher passes all embedded audio and ancillary data signals, including “closed captioning” that are present on the background video. Individual MLE program outputs have the ancillary data for the background video output by that MLE.

**Input Verification**

For verification of your inputs, ensure that a monitor is connected to BNC output **B01** or **B02** on your switcher. Remember that, at this point in the installation, default mapping is still in effect. The
above-mentioned outputs are defaulted to **Program** out. Re-mapping of inputs will be performed in Chapter 7, “**BNC Configuration and Check**”. Configuration of outputs will be performed in Chapter 8, “**Output Configuration**”. During these procedures, you can map *any input* to any button on a bus row, and configure the outputs to be program, preview, clean feed, or Aux Bus outputs.

On the unshifted row, default mapping is as follows:

- **BLACK** is mapped to button 1.
- **GLOBAL-STORE 1** is mapped to the fourth-to-the-last button.
- **GLOBAL-STORE 2** is mapped to the third-to-the-last button.
- **GLOBAL-STORE 3** is mapped to the second-to-the-last button.
- **SHIFT** is mapped to the last button in a bus row.

On the shifted row, default mapping is as follows:

- **COLOR BKGD 1** is mapped to the first *shifted* button.
- **COLOR BKGD 2** is mapped to the second *shifted* button.

You can now verify input video signals as they are connected. The following check assumes a *default* switcher condition.

- **Synergy 1 Control Panel**
  ~ To view the first 11 inputs (inputs **C01** through **C11**), press button 2 through 12, respectively. (Buttons 1, 13, 14, 15, and 16 are already mapped as indicated above).
  ~ To view the next 13 inputs (inputs **C12** through **D08**), press **SHIFT** + buttons 3 through 15, respectively. (Shifted buttons 1 and 2 are already mapped as indicated above, and button 16 is mapped to **SHIFT**).
  ~ The remaining 8 inputs (inputs **D08** through **D16**) cannot be verified unless re-mapped.

- **Synergy 2 Control Panel**:
  ~ To view the first 12 inputs (inputs **C01** through **C12**), press buttons 2 through 13, respectively. (Buttons 1, 14, 15, 16, and 17 are already mapped as indicated above).
  ~ To view the next 14 inputs (inputs **C13** through **D10**), press **SHIFT** + buttons 3 through 16, respectively. (Buttons 1 and 2 are already mapped as indicated above, and button 17 is mapped to **SHIFT**).
  ~ The remaining 6 inputs (inputs **D11** through **D16**) cannot be verified unless re-mapped.

- **Synergy 3 Control Panel**:
  ~ To view the first 25 inputs (inputs **C01** through **D09**), press buttons 2 through 26, respectively. (Buttons 1, 27, 28, 29, and 30 are already mapped as indicated above).
  ~ To view the next 7 inputs (inputs **D10** through **D16**), press **SHIFT** + buttons 3 through 9, respectively. (Buttons 1 and 2 are already mapped as indicated above, and button 30 is mapped to **SHIFT**).
Pushbutton Inserts

Once your inputs and alpha signals are connected, install the pushbutton designation inserts to identify the sources for your inputs. Please note:

- All pushbutton inserts are printed on full-sized sheets of transparent plastic. For best results when cutting out the button inserts, use a sharp X-Acto® knife and a steel-edged ruler.
- All inserts are easily installed under the lens caps — for both control panel and Aux panel pushbuttons.

If you have trouble removing a control panel button, use a pair of wide-tipped pliers (1/2 inch) with masking tape wrapped around the ends. For best results, wiggle the button side to side while extracting.

Note that there are four typical ways of labeling Synergy Q/MD pushbuttons:

- Use our standard inserts.
- Ask us to make custom inserts.
- Make your own inserts using transparency material.
- Use a Brother® labeler to create your own labels.

Ross Video will make custom inserts for your facility at a very reasonable price. Please call us for details.

Standard films with common input designations are provided to all customers. If a designation that you require has not been included on a certain film, and it is a type likely to be needed by other switcher users, Ross Video would be pleased to consider adding it to the standard film.

Control Panel Pushbutton Inserts

Use the following procedure to install all control panel pushbutton inserts. Use the diagram below for reference.

1. Cut out the designation film inserts for the primary input pushbuttons.
2. Remove the lens assembly from the primary input switch by pulling straight upward on the lens cap.
3. Remove the lens cap from the lens, and place the desired input designation under the lens cap.

This completes the procedure for installing control panel pushbutton inserts.

Please note:

• When reinstalling the lens assembly, line up the locating lugs on the lens with the locating slots in the primary input switch. Otherwise, the lens cap may pop off when the switch is pressed and released.

• The designation film must read correctly with the lens locating lugs at the sides, not at the top and bottom.

**Important**

Perform this procedure for all buttons on each PGM, PST, BKGD, and KEY bus on your switcher. In addition, install pushbutton inserts for each of the eight Key Bus crosspoints in each Downstream Keyer (Synergy 2 and 3 control panels only).

**Remote Aux Panel Pushbutton Inserts**

Use the following procedure to install all remote Aux panel pushbutton inserts. Use the diagram below for reference.

1. Cut out designation film inserts for remote Aux panel pushbuttons in all remote Aux panels. Note that the inserts used will be the same as those used for the switcher primary inputs, with the exception that Aux panels do not have Color Background labels.

2. Remove the lens cap by placing a fingernail under the side of the cap and gently pulling upward.

3. Position the insert in the lens cap.

4. Replace the paper background, then replace the lens cap on the switch and button assembly.

5. Press down firmly to re-seat the cap.

This completes the procedure for installing all remote Aux panel pushbutton inserts.
Using the Menu System

In This Chapter

This chapter introduces the Synergy Q/MD menu system. The following topics are discussed:

- About the System Control Display
- Menu System Basics
- Positioner Icons
- Adjusting the Display
- Help Features
- Screen Capture
About the System Control Display

Each Synergy Q/MD switcher includes a System Control Group in its top panel.

This group is similar on all Synergy Switchers. At the center of the group is the System Control Display, a bright LCD screen that provides a variety of clear menus for various system setup and operational functions. All these menus are interconnected in various branches of the system menu tree.

There are two ways that the display can change:

- The display changes automatically, depending on certain functions that you select on the panel. In this way, additional parameters are instantly available to you, as soon as you press a control panel button.
- You can also navigate the menu tree manually to reach the desired menu — simply by following the desired path through the menu tree.

The following section provides details on all buttons and functions in the System Control Group.
Menu System Basics

The figure below illustrates the **System Control Group**, which is identical on all Synergy Q/MD control panels — in both appearance and function. At the center of the group is the **System Control Display**, a bright LCD screen that provides a variety of clear menus for various system setup and operational functions.

1. **Menu Name**

   Each menu is named in the upper left corner. If numbers in parentheses appear after the name, for example **Main Menu (1-2)**, it indicates that the current menu is number one of two — and that there are more functions available than can be displayed at one time.

   On the **Main Menu** (accessible by pressing **HOME**), note that the software version and video mode are displayed below the menu name.

   When parentheses are shown, the **MORE** button lights. Press **MORE** to display the second menu in the series. If the numbers **2-2** appear, it indicates that the current menu is number two of two. Press **MORE** to return to the first menu in the series.

   **Note**

   In this manual, multiple menus will be referred to using 1-2 or 2-2 to distinguish the various menus. For example, **Main Menu 1-2** and **Main Menu 2-2**.

2. **Main Area**

   The large center area of the display is your main working area for each specific menu. It is typically reserved for status, text, mini “help” messages, descriptions of parameters, entry fields, etc.
3. **Label Area**

Labels on the bottom rows represent *functions*, or will route you to further sub-menus. These labels change depending upon the selected mode and menu. A menu function is activated by pressing the corresponding *Softkey*.

**Note**

In this manual, display functions are referred to by their *actual label names*, and not by the soft key that is pressed (below the display). For example, the phrase “... press *Disk* ...” is used, rather than “... press *Softkey #2* ...”

- A label that is underlined indicates that a sub-menu is available for that function. Pressing the button takes you one level down.
- Non-underlined labels are simply functions that you can activate by pressing the associated soft key, or other screens that you can access within the same menu.

4. **Softkeys**

The six *Soft Key* buttons below the display correspond to labels that appear in the *Label Area* of the display. Pressing a *Softkey* activates the selected function, or switches to the selected menu.

5. **Scroll Area**

The right-hand section of the display (adjacent to the three *Scroll Knobs*) is reserved for functions that you can adjust conveniently with the scroll knobs. Up to three different adjustable parameters can appear in this section, each of which will be labeled accordingly.

When the three “*Positioner Icons*” appear in this area, you can adjust the selected function or parameter either with the *Scroll Knobs* or with the *Positioner* — for your convenience. Refer to the section “*Positioner Icons*” on page 5-6 for details.

6. **Scroll Knobs**

The three scroll knobs are assignable. Depending upon the selected mode (and menu), the functions of the knobs *change* just like the display labels. When a function requires a knob to adjust a parameter, up to three labels (and their associated functions) will appear in the right-hand section of the display — arranged vertically. Turn the appropriate knob to adjust the associated parameter.

In terms of knob “hierarchy” the top knob is the *master* and the bottom two knobs are *slaved* to it. When you change the top knob (e.g., scrolling through inputs), the bottom knobs change in sync, showing the parameters for each selection chosen by the top knob. When you change one of the bottom two knobs, only *that* parameter changes.

7. **Menu Control Buttons**

To the left of the display, three buttons are provided to assist with navigating the menu system.

- **HOME** — Press to return the display to the top of the menu tree. *Main Menu 1-2* will be displayed.
- **UP ONE** — Press to take the display up one level in the menu tree. For example, if you press *Disk* to go one level down to the *Disk Menu*, press **UP ONE** to return up one level to the *Main Menu 1-2*. 


• **LOCK MENU** — Press to lock the display on the current menu. It will still be possible to go down levels of the menu tree, but you will not be able to go up past the level at which you pressed the **LOCK MENU** button.

8. **MORE Button**

The **MORE** button lights to indicate that additional menus (and functions) are available on the current level. The numbers in the menu name (**Main Menu 1-2**) will indicate how many additional menus are available. While the **Softkeys** move you vertically through the menu system, **MORE** moves you horizontally.

Press **MORE** to display the next menu in the series, or to return to the first menu from the last.

### Using the Keyboard in System Control Menus

The keyboard that plugs into the PS/2 port at the back of the control panel can be used in the place of the panel buttons and knobs to navigate through the menus and select values.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

The following table illustrates the functions of the keys on the keyboard as they relate to the control panel buttons:

<table>
<thead>
<tr>
<th>System Control Menus</th>
<th>Keyboard</th>
<th>Panel Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>F1 – F6</td>
<td>F1 – F6</td>
<td>Performs whatever the softkey function is above the panel key.</td>
</tr>
<tr>
<td></td>
<td>SysRq &amp; Break</td>
<td>HOME</td>
<td>Returns to the <strong>Main Menu 1-2</strong> from whatever menu is currently displayed.</td>
</tr>
<tr>
<td></td>
<td>Esc</td>
<td>UP ONE</td>
<td>Back one menu.</td>
</tr>
<tr>
<td></td>
<td>Tab</td>
<td>MORE</td>
<td>Next screen in selected menu.</td>
</tr>
<tr>
<td></td>
<td>Insert &amp; Delete</td>
<td>Top Knob (1) Horizontal</td>
<td>Small incremental movement of knob.</td>
</tr>
<tr>
<td></td>
<td>Home &amp; End</td>
<td>Middle Knob (2) Vertical</td>
<td>Small incremental movement of knob.</td>
</tr>
<tr>
<td></td>
<td>Page Up &amp; Page Down</td>
<td>Bottom Knob (3)</td>
<td>Small incremental movement of knob.</td>
</tr>
</tbody>
</table>
Positioner Icons

When you select specific installation and operational menus, **Positioner Icons** appear in the right-hand **Scroll Area**. Typically, two or three icons are shown, depending upon the selected menu and function.

When these icons appear, you can adjust the selected function or parameter either with the **Scroll Knobs** or with the **Positioner**. In addition, when the **Positioner Icons** appear, the **MENU** button automatically lights in the **Positioner Group** — indicating that **Positioner** control is temporarily assigned to the display, rather than to a selected MLE and positionable function.

A sample menu that includes the three icons is shown below.

![Border Menu — with Positioner Icons](image)

A) When the left-right **Positioner Icon** appears, you can use the top **Knob** to adjust the selected function, or you can move the **Positioner** left and right.

B) When the up-down **Positioner Icon** appears, you can use the middle **Knob** to adjust the selected function, or you can move the **Positioner** up and down.

C) When the circular **Positioner Icon** appears, you can use the bottom **Knob** to adjust the selected function, or you can twist the **Positioner** knob clockwise and counter-clockwise.

When you turn the **MENU** button off, the **Positioner** once again is assigned to the current panel function and location.

Refer to the “**Positioner Group**” section in Chapter 8 of the **Synergy Q/MD/X Operator’s Manual** for additional information on the **Positioner** itself, and the three **Positioner Icons**.
Adjusting the Display

Use the following procedure to adjust the contrast of the display, for user preference as desired:

1. Navigate to the Display Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Display.

   **Note**
   The Synergy 1 control panel is not equipped with mnemonics. Therefore, in the Display Menu, the Mnemonic Displays soft key is grayed out, and not selectable.

2. Press Large Display to adjust contrast of the menu display.
   • Use the Contrast knob to adjust the contrast.

3. *(Synergy 1.5, 2, and 2.5 control panels only)* Press Mnemonics Displays to display the Mnemonics Display Menu.

4. Adjust the brightness and contrast of the mnemonic displays as follows:
   • Use the Brightness knob to adjust display brightness.
   • Use the Contrast knob to adjust display contrast.

This completes the procedure for adjusting the contrast of the display.
Help Features

Two help features provide convenient on-line assistance as you operate your Synergy Q/MD switcher:

- Help Menu
- Pop-up Help

Help Menu

Use the following procedure to access the Help Menu:

1. Navigate to the Help Menu as follows:
   - Press HOME ⇒ Help.

   **Note**
   
   Note that the menu displays the current software version.

<table>
<thead>
<tr>
<th>Help Menu</th>
<th>Press</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>BKCD</td>
<td>BKCD</td>
<td>copies MLE</td>
</tr>
<tr>
<td>Key type</td>
<td>Key type</td>
<td>copies keyer</td>
</tr>
<tr>
<td>Key type</td>
<td>DSK crosspoint</td>
<td>copies keyer</td>
</tr>
<tr>
<td>Key 1/Key 2</td>
<td>Key 1/Key 2</td>
<td>copies keyer</td>
</tr>
<tr>
<td>DSK crosspoint</td>
<td>DSK crosspoint</td>
<td>copies keyer</td>
</tr>
<tr>
<td>Wipe</td>
<td>Wipe</td>
<td>copies wipe</td>
</tr>
<tr>
<td>Matte area</td>
<td>Crosspoint</td>
<td>copies color</td>
</tr>
</tbody>
</table>

   More Info Menu

   Use Knob 2 to scroll list.

<table>
<thead>
<tr>
<th>More Info</th>
<th>Press</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>BKCD</td>
<td>BKCD</td>
<td>copies MLE</td>
</tr>
</tbody>
</table>

   To copy a full MLE, hold down the destination MLE’s ‘BKCD’ button (in the Transition area), and hit the source MLE’s ‘BKCD’ button.

   More Info Menu

<table>
<thead>
<tr>
<th>More Info</th>
<th>Press</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>BKCD</td>
<td>BKCD</td>
<td>copies MLE</td>
</tr>
</tbody>
</table>

   This completes the procedure for accessing the Help Menu.
**Pop-up Help**

The **Pop-up Help** feature is designed to alert the operator when an illegal function is attempted. When the illegal button or combination of buttons is pressed, the **Pop-up Help** window is displayed. This window provides a brief explanation of why the operation cannot be performed, and a reference number that can be used when contacting Ross Technical Support.

The following is an example of a Pop-up window.

---

**Note**

The **Pop-up** window will *only* display while the related button is pressed. If a button related function is not operating properly, hold down the button to see if there is a related Pop-up window.
### Screen Capture

Switcher users can take screen captures of the Synergy Q/MD panel menus. The switcher saves the screen capture as a 16K bitmap file, which you can then import into other applications on your computer.

Use the following procedure to capture an image of the large menu display on the control panel:

1. Insert a USB key into the USB Port on the Synergy Q/MD control panel. You must wait 5 seconds after inserting the USB key into the USB Port before you can save a screen capture to it.

2. Navigate to the menu you wish to capture.

3. Take a screen capture as follows:
   - On a **Synergy 2, 3 or 4** control panel, simultaneously press **FADE RATE** and **ALL** in the **Store Area** of the **Global Memory System Group**.
   - On a **Synergy 1** control panel, simultaneously press **STORE** and **FADE RATE** in the **Global Memory System Group**.

   The **Busy** LED will come on, the current menu freezes, and a popup message is displayed indicating that a **SCREENXX.BMP** file is saved to the USB key.

4. Remove the USB key from the USB Port.

5. On your computer, insert the USB key and open the files in any graphics application that supports bitmap files to view, rename, and reformat the menu screen captures.

This completes the procedure to capture an image of the large menu display on the Synergy control panel.

**Caution**

Do NOT remove the USB key from the Synergy control panel before the LED on the USB Port goes out. Doing so may destroy the data on your USB key, as well as the data on the next one you insert into the switcher.
Software Upgrades and Options

In This Chapter

This chapter provides instructions for upgrading system software, and verifying and installing various software options. The following topics are discussed:

- Network Setup
- Synergy MD/X Web Interface
- System Info
- Software Upgrade
- Changing the Synergy MD/X Web Interface Account
- Saving and Loading Setup Files
- Installed Options
Network Setup

This section provides instructions for configuring your network setup for your Synergy Q/MD system software. Before proceeding, refer to Appendix C, “IP and Web Issues”, to familiarize yourself with some Ethernet security considerations.

Software upgrades are performed from a computer using the LAN 1 Ethernet port on the rear of the Synergy Q/MD frame. Prior to performing the upgrade, it is necessary to configure the network setup for the Synergy Q/MD switcher.

Important

If DIP Switch 1 on the frame CPU board is set to ON, the network IP address is forced to 192.168.1.1 and the netmask to 255.255.0.0. Network changes will still take effect but a warning message will be displayed and if you restart the switcher with DIP Switch 1 still ON, the network address will revert to 192.168.1.1 and the netmask to 255.255.0.0. Refer to the section “CPU Board” on page 27-14 for more information.

Use the following procedure to configure the network setup of your switcher:

1. Ensure that the switcher is connected to your local network.
2. Navigate to the Setup Menu 2-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ MORE.
3. Press Network Setup to display the Network Setup Menu.

<table>
<thead>
<tr>
<th>Network Setup</th>
<th>Address:</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address: 192.168.1.1</td>
<td>IP Address:</td>
</tr>
<tr>
<td>Subnet Mask: 255.255.0.0</td>
<td>Subnet Mask:</td>
</tr>
<tr>
<td>Gateway: 10.0.1.1</td>
<td>Gateway:</td>
</tr>
</tbody>
</table>

   These settings are not recalled with installation. Use keypad to edit values. Press ENTER to switch fields.

   Save Refresh

4. Set the IP Address as follows:
   • Use the Address knob to select IP Address.
   • Enter the IP Address using the keypad in the Global Memory System group or with a PS/2 keyboard attached to your switcher. If you use the keypad, press ENTER to move between fields as there is no decimal (.) key.

   Note

   Do not use an IP address in the range 169.254.X.X to avoid conflicts with some of the internal boards and cards in the frame. Ross Video recommends using an IP address in the range of 10.0.X.X for static addressing.

5. Set the Subnet Mask as follows:
   • Use the Address knob to select Subnet Mask.
   • Enter the Subnet Mask using either the Global Memory System keypad or a PS/2 keyboard attached to your switcher. If you use the keypad, press ENTER to move between fields.
6. Set the Gateway as follows:
   • Use the Address knob to select **Gateway**.
   • Enter the Gateway Address using either the Global Memory System keypad or a PS/2 keyboard attached to your switcher. If you use the keypad, press **ENTER** to move between fields.

   ![Operating Tip]
   If you do not want to save your changes, press **Refresh** to restore the original network settings.

7. Press **Save** to store the new network settings. A confirmation popup is displayed.
   
   This completes the procedure to configure the network setup of your switcher.
**Synergy MD/X Web Interface**

The **Synergy MD/X Web Interface** is included with the Synergy Q/MD software. You use the Synergy MD/X Web Interface to obtain system information from your switcher, perform software upgrades, manage switcher file-sets, and configure user access to the Synergy MD/X Web Interface.

**Accessing the Synergy MD/X Web Interface**

You access the Synergy MD/X Web Interface via a web browser on a computer that has network access to your Synergy Q/MD switcher.

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the **Synergy MD/X Web Interface Splash Screen**.
2. Wait a few seconds or click on the logo and the login window appears.
3. In the **Name** field enter the Synergy MD/X Web Interface user name.
4. In the **Password** field enter the password.
5. Click **OK** to start the Synergy MD/X Web Interface and display the **System Info Page**.

**Note**

- The current versions of Internet Explorer, Mozilla and Netscape are supported. If you have any problems, please contact Ross Video Technical support.
- If your computer is not on the same network as your switcher or has no network route to that network, the Synergy MD/X Web Interface will not be available. Contact your IT department for assistance.
- If you do not know the user name or password contact your IT department or Ross Video Technical Support.

Before using the Synergy MD/X Web Interface, you need a user account. The Synergy MD/X Web Interface supports a single user name and password which can be changed from within the Synergy MD/X Web Interface. Refer to the section “**Changing the Synergy MD/X Web Interface Account**” on page 6-17 for information on creating and managing the user account.
System Info Page

Use the menu at the top of the screen to access different Synergy MD/X Web Interface pages. Those pages are discussed in the following sections:

- **System Info** — see “System Info” on page 6-6
- **Upgrade** — see “Software Upgrade” on page 6-8
- **Admin** — see “Changing the Synergy MD/X Web Interface Account” on page 6-17
- **File Sets** — see “Saving and Loading Setup Files” on page 6-19
System Info

The System Info Page is the first page that is displayed after you log in to the Synergy MD/X Web Interface. It shows the status of every card installed in your switcher frame as well as information on hard drive and flash memory usage. Use the System Info Page to monitor the progress of a system upgrade or to obtain information about the installed cards and disk space in your switcher.

Use the following procedure to access the System Info Page:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the Splash screen and the Synergy MD/X Web Interface Login window.
2. In the Name field enter the Synergy MD/X Web Interface user name.
3. In the Password field enter the password.
4. Click OK to start the Synergy MD/X Web Interface and display the System Info Page.

The System Info Page is divided into two sections:

~ System Info – This section lists all the installed board and cards and their version and upgrade status (if applicable). Boards and Cards are presented in a table with the following columns:

- Card – The name of the board or card.
− **Func** – The type of board or card.
− **Slot** – The switcher frame slot the board is installed in.
− **Version** – The software version installed on the board (ideally, all boards should be running the same software version).
− **Date** – The date of the software build installed on the board or card.
− **Status** – The status should typically be reported as **Done**. During a software upgrade, the status of each board and card will change as the upgrade progresses. Refreshing the System Info page allows you to monitor the upgrade.

~ **Storage Capacity** – This section details the switcher hard drive and flash memory usage. Information is presented in a table with the following columns:

− **Device** – The storage device being reported (either **Hard disk**, **System flash**, or **Application flash**).
− **Total Size** – The total size of the hard disk or flash RAM. Hard disk size is reported in gigabytes and flash RAM storage is reported in megabytes.
− **Current Usage** – The amount of memory currently being used on the storage device.
− **Remaining Capacity** – The amount of memory still available for use.
− **Percent Used** – The percentage of total storage space that is being used on the storage device

This completes the procedure for accessing the **System Info Page**.
Software Upgrade

Software upgrades for your Synergy Q/MD switcher are provided free of charge from Ross Video. Upgrading your switcher requires you to copy the upgrade file provided by Ross from your computer to your switcher and then initiate the upgrade process. You do this via the Upgrade Page of the Synergy MD/X Web Interface.

**Important**

This upgrade procedure does not apply when upgrading from certain software versions. Contact Ross Video Technical Support before performing an upgrade for information on any alternate procedures that you may need to follow when performing your switcher upgrade.

Keep the following notes in mind before upgrading your switcher to a newer software version (contact Ross Video Technical Support before reverting to an older software version):

- **VDCP Extra Options** (port number and sub-address) are not retained when upgrading from version 4.1 or prior. The VDCP Extra Options must be re-entered after an upgrade.
- Software versions 6.0 and higher handle external device control differently than pre-6.0 versions. If you revert to a pre-6.0 software version, you may lose any external device settings you have made.
- Remove any XFX and WARP cards from your system before reverting to a pre-5.0 software version.

**Important**

Because the software upgrade process automatically returns the switcher to default values, it is important that you back up all switcher registers to the hard drive or USB flash drive at this point.

Before you can perform the upgrade, you must perform a hard reboot of the switcher to ensure that all components are in a known state. This reboot includes both the control panel and the frame, and must be performed both before and after the upgrade.

Preparing the Switcher Before an Upgrade

Recalling the factory default settings for the switcher before the upgrade ensures that all the boards, cards, and modules on the switcher are in a known state, and are ready to accept an upgrade. However, the factory default procedure reset the reference format. You must set the reference back to the input reference that is connected to the switcher, and reboot the switcher before starting the upgrade.

Use the following procedure to prepare the switcher before performing an upgrade:

1. Perform a recall of all factory default settings. Refer to the section “Recalling Factory Default Settings” on page 11-32 for information on performing a factory default.
2. Set the reference format back to the input reference that is connected to the switcher. Refer to the section “Reference” on page 11-26 for information on reference setup.
3. Shut down the switcher. Refer to the section “Shutting Down the Switcher” on page 4-14 for information on shutting down the switcher.
4. Wait at least 6 seconds for the System Status Indicators to go out.
5. Power up the switcher. Refer to the section “Power Up” on page 4-9 for information on powering up the switcher.
This completes the procedure for preparing the switcher before performing the upgrade. Ensure that the switcher is fully powered up before attempting to perform the upgrade.

**Performing the Upgrade**

After you have performed the factory default, you must unseat the Video Processor Boards and Squeeze & Tease Carriers, upgrade the switcher core and ensure that it is working, and then propagate the upgrade to each of the boards you unseated individually.

Depending on the number of boards, cards and modules in the switcher, and the current version of software on them, it will take between 15 and 40 minutes to complete the upgrade.

**Unseating Front Frame Boards**

Refer to the following table and the illustrations of the Q/MD frames for information on which slot each front frame boards are installed in.

<table>
<thead>
<tr>
<th>Slot</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 0</td>
<td>Fan Board</td>
<td>Fan Board</td>
</tr>
<tr>
<td>Slot 1</td>
<td>Video Processor Board</td>
<td>Video Processor Board</td>
</tr>
<tr>
<td>Slot 2</td>
<td>Squeeze &amp; Tease Carrier</td>
<td>Squeeze &amp; Tease Carrier</td>
</tr>
<tr>
<td>Slot 3</td>
<td>Video Processor Board</td>
<td></td>
</tr>
</tbody>
</table>

**Warning**

Hazardous voltages are present in the frame as long as any of the power supplies are connected to the AC power.

Use the following procedure to unseat the front frame boards:

1. Open the frame door to gain access to the front frame boards.
2. Identify the Video Processor Boards and Squeeze & Tease Carriers in the frame. Only these boards need to be unseated.
3. If a tie wrap has been used to secure the extractor tabs on the sides of the board, remove the tie wraps from the required boards.
4. Locate the two locking tabs at either side of the board you want to unseat.
5. Grasp both locking tabs and rotate them towards you and out towards the outer sides of the frame. This unseats the board from the midplane.
6. Gently slide the board about 2 inches (5 cm) out from the front of the frame. This ensures that no pins can make contact.
7. Repeat this procedure for all the **Video Processor Boards** and **Squeeze & Tease Carriers** in the frame.

This completes the procedure for unseating the front frame boards. With the boards unseated, you can upgrade the switcher core.

**Upgrading the Switcher Core**

To upgrade the switcher core, you must log into the Q/MD/X Web Interface and upload the new software package.

> **Important**
> Ensure that the switcher is fully powered up before attempting the upgrade. When the switcher is fully powered up, it is able to pass video normally and, if you have the Squeeze & Tease MD option installed, you are able to fly a key.

Use the following procedure to upgrade the switcher:

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The **MD/X Web Interface Splash Screen** is displayed.

2. When the **Login Dialog Box** appears, enter your username and password as follows:
   - In the **Name** field, enter the username for the MD/X Web Interface account.
   - In the **Password** field, enter the password for the MD/X Web Interface account.
   - Click **OK** to display the **System Information Page**. This page shows a list of all the upgradable components on the boards, cards, and modules installed in the control panel and frame. Refer to the section “**System Info**” on page 6-6 for more information on this page.

3. Click **Upgrade** to display the **Upgrade Page**. The **Upgrade Page** lists all the previous upgrade packages that were stored on the hard drive of the frame.
4. Revert to a previous software version as follows:
   • Select the software upgrade package that you want to install.
   • Select s1234 as the Panel type.
   • Click Upgrade selected version to install the software version on the switcher.
   • Wait while the switcher installs the software version. This may take a few minutes.
   • When the selected software version has been installed, the System Information Page is displayed.
   • Proceed to Step (6.) to complete the procedure.

5. Upload and install a new upgrade package as follows:
   • Enter a name for the upgrade package in the New_Name field. This must be unique and descriptive enough to allow you to easily identify it at a later point. Upgrade package names can only include numbers, letters, and underscores or dashes. Spaces and other symbols are not allowed.
   • Click Browse. A file selection dialog box is displayed.
   • Locate the upgrade package file you want to upload to the switcher on your computer. The file is named mdx-<version>-<build>.tar.gz.
   • Click Open/Choose to select the file. The file path and name appears in the Select File to Upload field.
   • Select s1234 as the Panel type.

Important Consult a Ross Video Technical Support representative before attempting to revert to a previous version of software. Reverting to a previous version of software may disable certain features or processes that were not present in that previous version of software and cause switcher Setups to not be recalled properly.
• Click **Upgrade Selected Version**. The **Upgrade Page** is displayed.

![Upgrade Page](image)

**Note**

The **Check if there are additional Ross supplied files to upload after this one** should only be selected if you are advised to upload an additional file by Ross Video Technical Support.

• Wait while the switcher installs the software version. This may take a few minutes.
• When the software version has been installed, the **Additional Files Page** is displayed.

![Additional Files Page](image)

6. Click **Reboot Now** to perform a soft restart of the switcher. The soft restart will propagate the upgrade to all the boards, cards and modules on the switcher.

![Important](image)

**Important**

If a message asking you to **Reboot** the control panel appears on the menus of the Touchscreen display, click Cancel. You will be rebooting the entire switcher in a later step.

7. Allow the switcher to propagate the upgrade to all the boards and cards installed in the frame by waiting at least **20 minutes** before proceeding to the next step.

8. Wait for the **System Information Page** to be displayed.

• Periodically reload/refresh the **System Information Page** until all the items listed have **Done** as their **Status**.
• Verify that the switcher is passing video properly by selecting different crosspoints. This ensures that the upgrade has completed. If the switcher is not passing video properly, check the **System Information Page** again to ensure all items are done.

This completes the procedure for upgrading the switcher core. Next you must re-seat and upgrade the Video Processor Boards.
**Re-seat and Upgrading the Video Processor Boards**

After the switcher core has been upgraded, you must propagate the upgrade to all of the Video Processor Boards, one at a time.

Use the following procedure to re-seat and upgrade the Video Processor Boards:

1. Gently push the Video Processor Board into the slot. When the board stops sliding freely, push firmly to seat the board, and secure it with the ejector tabs.

   **Important** If there is significant resistance when seating the board, remove the board from the frame and inspect the connectors for bent pins or other damage to the connectors (Figure 6.2).

![Figure 6.2 Power Connector Blade Inspection](image)

2. The switcher upgrades the board you have installed. Refresh the System Information Page until all the Video Processor Board functions, and any XFX DSP Card functions, have Done as their Status.

   **Important** If the blades in the power connectors are bent or damaged, contact Ross Video Technical Support. Do not attempt to install a damaged board.

![System Information Page](image)

3. Verify that the Video Processor Board is passing video properly by selecting different crosspoints on the MLE(s) that the Video Processor Board is providing. This ensures...
that the upgrade has completed. If the MLE is not passing video properly, check the System Information Page again to ensure all items are done.

4. Locate the two small holes on the front edge of the Video Processor Board, near the extractor tabs. If you wish, you can further secure the board by threading tie wraps through these holes and fastening them around the extractor tabs.

5. Repeat this procedure for all remaining Video Processor Boards.

This completes the procedure for re-seating and upgrading the Video Processor Boards. Next you must re-seat any Squeeze & Tease Carriers. If you do not have any Squeeze & Tease Carriers, proceed to reboot the switcher. Refer to the section “Rebooting the Switcher After an Upgrade” on page 6-15.

Re-seat and Upgrading the Squeeze & Tease Carriers

After the Video Processor Boards have been re-seated and upgraded, you must propagate the upgrade to all of the Squeeze & Tease Carriers, one at a time. If you do not have any Squeeze & Tease Carriers, proceed to reboot the switcher. Refer to the section “Rebooting the Switcher After an Upgrade” on page 6-15.

Use the following procedure to re-seat and upgrade the Squeeze & Tease Carriers:

1. Gently push the Squeeze & Tease Carrier into the slot. When the board stops sliding freely, push firmly to seat the board, and secure it with the ejector tabs.

   **Important**
   
   If there is significant resistance when seating the board, remove the board from the frame and inspect the connectors for bent pins or other damage to the connectors (Figure 6.3).

   ![Power Connector Blade Inspection](image)

   **Important**
   
   If the blades in the power connectors are bent or damaged, contact Ross Video Technical Support. Do not attempt to install a damaged board.

2. The switcher upgrades the board you have installed. Refresh the System Information Page until all the Squeeze & Tease Carrier functions, and any Squeeze & Tease WARP Card functions, and Squeeze & Tease DSP Card functions, have Done as their Status.
3. Verify that the Squeeze & Tease Carrier is passing video properly by flying a key on the MLE that the Squeeze & Tease Carrier is supporting. This ensures that the upgrade has completed. If the key is not flying properly, check the System Information Page again to ensure all items are done.

4. Locate the two small holes on the front edge of the Squeeze & Tease Carrier, near the extractor tabs. If you wish, you can further secure the board by threading tie wraps through these holes and fastening them around the extractor tabs.

5. Repeat this procedure for all remaining Squeeze & Tease Carriers.

This completes the procedure for re-seating and upgrading the Squeeze & Tease Carriers. Next you will power down the switcher and power it back up in order to initialize the new software on all the boards and cards in the frame.

Rebooting the Switcher After an Upgrade

Rebooting the switcher after the upgrade ensures that all the boards, cards, and modules on the switcher are properly upgraded and initialized. If a board, card or module was not properly upgraded, the switcher attempts to upgrade and initialize it again with the reboot.

Caution  If the switcher has not finished propagating the upgrade before you proceed to shut-down the switcher, you may damage the switcher.

Use the following procedure to shutdown and restart the switcher after performing an upgrade:

1. Shut down the switcher. Refer to the section “Shutting Down the Switcher” on page 4-14 for information on shutting down the switcher.

2. Wait at least 6 seconds for the System Status Indicators to go out.

3. Power up the switcher. Refer to the section “Power Up” on page 4-9 for information on powering up the switcher.
This completes the procedure for restarting the switcher after an upgrade. You have now completed the upgrade procedure and should now recall any Switcher Setups you stored before the upgrade. Refer to the section “Recalling Configurations” on page 12-6 for more information on recalling Setups.
Changing the Synergy MD/X Web Interface Account

Accessing Synergy MD/X Web Interface requires a user account. The Synergy Q/MD software ships with a default user account:

- User Name: user
- Password: password

For security reasons, you should change the user name and password as soon as possible. You may also wish to periodically change the user account to maintain secure access to your switcher.

Use the following procedure to change the Synergy MD/X Web Interface account:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the Splash screen and the Synergy MD/X Web Interface Login window.
2. In the Name field enter the Synergy MD/X Web Interface user name (user if the default user account is still being used).
3. In the Password field enter the password (password if the default user account is still being used).
4. Click OK to start Synergy MD/X Web Interface and display the System Info Page.
5. Click Admin to display the Admin Page. This page allows you to change the user account.

6. If you wish to change the user name, click in the New Username field and then type the new user name. If you wish to leave the user name the same, leave this field blank.
7. If you wish to change the password, click in the New Password field and then type the new password. If you do not wish to change the password, leave this field blank.
8. If you are changing the password, click in the Confirm Password field and then re-type the new password that you used in step 7.

Note

Only alphanumeric, - (dash), _ (underscore), and. (period) characters are permitted for user names and passwords.
9. Click the **Apply Changes** button to apply your new user name and password settings.

**Note**

If you type different passwords in steps 7 and 8 above, you will receive an error message and the user account information will **not** change.

This completes the procedure for setting up and managing accounts.
Saving and Loading Setup Files

Switcher file sets can be copied onto an external computer for backup purposes (refer to the section “Saving Configurations” on page 12-4 for information on creating switcher file sets).

Backing Up Setups to an External Computer

You use Synergy MD/X Web Interface to copy switcher file sets between your Synergy Q/MD switcher and your computer.

Use the following procedure to save a setup to an external computer:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the Splash screen and the Synergy MD/X Web Interface Login window.
2. In the Name field enter the Synergy MD/X Web Interface user name.
3. In the Password field enter the password.
4. Click OK to start Synergy MD/X Web Interface and display the System Info Page.
5. Click File Sets to display the File Sets Page.

   Note
   If you do not know the user name or password contact your IT department or Ross Video Technical Support.

6. If you wish to hide the setup names and display only the setup numbers, click Hide Name. Click Show Name to display the setup names again.
7. Click on the number of the setup that you wish to save to your computer.

File Sets Page

The setup names and numbers in parentheses (00 - 99) correspond to the 100 setups that can be saved on your Synergy Q/MD switcher. Any of the setups that have been saved will be underlined and colored blue.
8. When the save dialog box appears, click **Save** and then use the file requester to save the setup to a location on your computer. The file will be saved as `set##.tar.gz`, where ## is the number of the setup you are saving.

**Note**

When a Setup is downloaded from the switcher, it is compressed into a single file that contains all the switcher files that were stored in that setup location. You must use Synergy MD/X Web Interface to reload the file to the switcher.

This completes the procedure for saving a setup on an external computer.

**Restoring Setups from an External Computer**

Switcher file sets that have been copied to an external computer can be uploaded back to the switcher. This is especially useful after you have performed a switcher software upgrade or replaced your switcher hard drive as your switcher will be in a default configuration. You can upload the setups that you stored on an external computer to the switcher, and then recall the setups on the switcher.

Use the following procedure to upload a setup to your switcher:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the **Splash screen** and the **Synergy MD/X Web Interface Login Window**.

2. In the **Name** field enter the Synergy MD/X Web Interface user name.

3. In the **Password** field enter the password.

**Note**

If you do not know the user name or password contact your IT department or Ross Video Technical Support.

4. Click **OK** to start Synergy MD/X Web Interface and display the **System Info Page**.

5. Click **File Sets** to display the **File Sets Page**.

- **File Sets Page**
The setup names and numbers in parentheses (00 - 99) correspond to the 100 setups that can be saved on your Synergy Q/MD switcher. Any of the setups that have been saved will be underlined and colored blue.

**Important**

Uploading to a location that has a currently saved setup will cause that setup to be overwritten.

6. If you wish to hide the setup names and display only the setup numbers, click **Hide Name**. Click **Show Name** to show the setup names again.

7. Click in the **Number** field and enter the two-digit location (00-99) where you wish to upload the switcher setup.

8. Click the **Browse...** button and use the file requester to select the setup file on your computer that you wish to upload to the switcher.

**Important**

The Setup file will be called `set##.tar.gz`, where ## is the number of the setup. Uploading any other file to the switcher may corrupt your setup location.

9. Click the **Open** button. The **Filename** field will contain the path to the setup file you just selected.

10. Click the **Upload set** button to upload the file to the switcher.

This completes the procedure for uploading a setup to the switcher. Next, you will have to recall the switcher files from the setup location.

**Recalling Registers From a Storage Device**

Use the following procedure to recall registers from a storage device:

**Note**

For more information on file storage, refer to the section “About Synergy Q/MD File Storage” on page 12-2.

1. Ensure that new Synergy Q/MD software version is properly installed. If not, refer to the section “Software Upgrade” on page 6-8 for more information.

2. Navigate to the **Disk Menu** as follows:
   - Press **HOME** ⇒ **Disk**.

3. Press **Dest/Source** to display the **Dest/Source Menu**.

<table>
<thead>
<tr>
<th>Current Switcher Setup Chosen: Hard Drive - SETUP (05)</th>
<th>Hard Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Names:</strong></td>
<td><strong>USB</strong></td>
</tr>
<tr>
<td></td>
<td>SETUP (04)</td>
</tr>
<tr>
<td></td>
<td>SETUP (05)</td>
</tr>
</tbody>
</table>

**Dest/Source Menu**
4. Select the storage device that you want to use to recall the files from as follows:
   - Use the top knob to select the storage device you want to recall the files from. You can select between the following:
     - **Hard Drive** — This option will allow you to recall the files from the internal hard drive.
     - **USB** — This option allows you to name the files on a USB key plugged into the switcher panel USB port.
   - If you are recalling from the hard drive, use the **Set Names** knob to select a Setup, or location, from which to recall the files. There are 100 (00 through 99) setups available from which to recall files.

5. Press **Recall** to display the **Disk Recall Menu 1-2**.

6. Select the category of registers that you want to store as follows:
   - Press **All** to recall all categories of registers from a storage device.
   - Press **Memories** to recall only Memory Registers from a storage device.
   - Press **Custom Controls** to recall only Custom Control Registers from a storage device.
   - Press **Personality** to recall only Personality Registers from a storage device.
   - Press **VTR Clips** to recall only VTR Clip Registers from a storage device.
   - Press **Installation** to recall only Installation Registers from a storage device.
   - Press **3D Sequences** to recall only 3D Sequence Registers from a storage device.
   - Press **Bus Maps** to recall only Bus Maps from a storage device.

This completes the procedure for recalling your setups from a storage device.

### Deleting Existing Setups

Switcher file sets that have been copied to an external computer can be deleted to allow for more storage space for newer setups.

Use the following procedure to delete an existing setup on an external computer:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher to display the **Splash screen** and the **Synergy MD/X Web Interface Login Window**.
2. In the **Name** field enter the Synergy MD/X Web Interface user name.
3. In the **Password** field enter the password.

   **Note**
   If you do not know the user name or password, contact your IT department or Ross Video Technical Support.

4. Click **OK** to start Synergy MD/X Web Interface and display the **System Info Page**.

5. Click **File Sets** to display the **File Sets Page**.

   ![File Sets Page](image)

   **File Sets Page**

   The setup names and numbers in parentheses (00 - 99) correspond to the 100 setups that can be saved on your Synergy Q/MD switcher. Any of the setups that have been saved will be underlined and colored blue.

   6. In the **Delete Sets** area, select the set you wish to delete using the drop-down list provided.

   7. Click **Delete Set**.

   8. Click **OK** in the confirmation dialog.

   The setup is now deleted from the **File Sets** list.

   This completes the procedure to delete an existing setup on an external computer.

**Working with Port Monitor Files**

   **Note**
   Port Monitor files are used primarily for troubleshooting and diagnostic purposes. Do not use this interface unless instructed to do so by Ross Video Technical Support.

   The **TX/RX Test Menu** allows you to test communications with various remote control and communications ports. This data is stored to a file on the switcher hard drive, and may be retrieved via the Synergy Q/MD/X Web Interface.
Each port will have a corresponding file for control panel and frame ports, named as follows:

- *pan##rx.txt* or *pan##tx.txt* for control panel ports
- *frm##rx.txt* or *frm##tx.txt* for frame ports

Refer to the section “TX/RX Test” on page 24-10 for information on how to configure your switcher to stream data into a port monitor file.

**Opening the Port Monitor File Browser**

Use the following procedure to access the Web Interface for Port Monitor files:

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher, with the addition of /cgi-bin/pmbrowser to display the Splash screen and the Synergy MD/X Web Interface Login Window.
   
   For example, enter 10.0.2.200/cgi-bin/pmbrowser.

2. In the **Name** field enter the Synergy MD/X Web Interface user name.

3. In the **Password** field enter the password.

4. Click **OK** to start Synergy MD/X Web Interface and display the Port Monitor File Browser.

   ![Port Monitor File Browser](image)

**Note**

If you do not know the user name or password, contact your IT department or Ross Video Technical Support.

This completes the procedure to access the Web Interface for Port Monitor files. Next, you will view port monitor files within the web interface.
Viewing a Port Monitor File

**Note** Port Monitor files cannot be copied and saved from the Web Interface. To save a local copy, copy and paste the content of the Port Monitor file into a text editor.

Port Monitor files can be viewed directly from the Web Interface via the **Port Monitor File Browser**. Use the following procedure to view a port monitor file:

1. In the **Port Monitor File Browser**, click on the port monitor file you wish to open. The Port Monitor file is displayed in the Web Interface.

2. Click **Port Monitor Files** to return to the **Port Monitor File Browser** and choose another port monitor file to view.

This completes the procedure to view a port monitor file.

Deleting Port Monitor Files

**Note** Stopping and restarting the streaming process will overwrite the existing port monitor files.

Port Monitor files may be deleted from the Web Interface. Use the following procedure to delete a port monitor file from the **Port Monitor File Browser**.

1. On your computer, open your Web Browser and, in the address bar, type in the IP address of your switcher, with the addition of /cgi-bin/pmbrowser to display the **Splash screen** and the **Synergy MD/X Web Interface Login Window**.

   For example, enter 10.0.2.200/cgi-bin/pmbrowser.

2. In the **Name** field enter the Synergy MD/X Web Interface user name.

3. In the **Password** field enter the password.

4. Click **OK** to start Synergy MD/X Web Interface and display the **Port Monitor File Browser**.

5. Click **Delete** beside the port monitor file you wish to delete.
6. Click **OK** in the confirmation dialog that displays.

The port monitor file is deleted from the **Port Monitor File Browser**.

This completes the procedure to delete a port monitor file from the **Port Monitor File Browser**.
Installed Options

Several menus are available that allow you to verify all of the standard and optional boards and software present in your Synergy Q/MD switcher. The menus also display the serial number, allow you to install additional software options, and store and recall option codes.

The following topics are discussed in this section:

- Accessing the Installed Options Menu
- Software Options Menu
- Panel Boards Menu
- Frame Boards Menu
- Installing Serial Numbers
- Installing Software Options
- Storing and Recalling Option Codes

**Important**

Serial numbers allow Ross Video to properly track which options have been purchased by each customer. Switchers have serial numbers installed in flash memory at the factory.

### Accessing the Installed Options Menus

These procedures enable you to navigate through the various menus on the Synergy Q/MD control panel. The menus are provided for information only — no action can be taken. Use the information provided to verify which options are currently installed on your frame and panel boards.

**Installed Options Menu**

Use the following procedure to display the **Installed Options Menu 1-2**:

1. Navigate to the **Installed Options Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options.
2. Press **Software Options** to display the **Software Options Menu**.

![Installed Options Menu](image)

3. Use the middle knob to scroll the list of options.
   - The **Option** column lists the available options for installation on the switcher.
   - The **Enabled** column indicates if the option has been installed (enabled) or not.

This completes the procedure for displaying the **Installed Options Menu**.
Panel Boards Menu

Use the following procedure to display information on the installed Panel Boards:

1. Navigate to the **Installed Options Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options.
2. Press Panel Boards to display the Panel Boards Menu.

<table>
<thead>
<tr>
<th>Installed Options (1-2)</th>
<th>Frame Serial Number:5276245</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board</td>
<td>Rev</td>
</tr>
<tr>
<td>4216-833 Panel CPU</td>
<td>5</td>
</tr>
<tr>
<td>4216-838 Xpt Switch</td>
<td>X</td>
</tr>
<tr>
<td>4216-839 Key Switch</td>
<td>Z</td>
</tr>
<tr>
<td>4216-835 Trans Switch</td>
<td>1</td>
</tr>
<tr>
<td>4216-836 Pattern Switch</td>
<td>A</td>
</tr>
<tr>
<td>4216-837 Function Switch</td>
<td></td>
</tr>
</tbody>
</table>

**Installed Options — Panel Boards Menu**

The main area provides three columns of information that pertain to the boards installed in the panel:

- The **Board** column lists each circuit board by part number and name.
- The **Rev** column lists the hardware revision number of each board.
- The **FPGA Rev** column lists the software revision number of each board.

This completes the procedure for displaying information on control panel boards.

Frame Boards Menu

Use the following procedure to display information for all installed Frame Boards:

1. Navigate to the **Installed Options Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options.
2. Press Frame Boards to display the Frame Boards Menu.

<table>
<thead>
<tr>
<th>Installed Options (1-2)</th>
<th>Frame Serial Number:5276245</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot</td>
<td>Board</td>
</tr>
<tr>
<td>A Frame CPU</td>
<td>2a</td>
</tr>
<tr>
<td>A Panel(S1)</td>
<td>7a</td>
</tr>
<tr>
<td>B Output</td>
<td>3a</td>
</tr>
<tr>
<td>C Input(Crosspoint)</td>
<td>2a</td>
</tr>
<tr>
<td>D Input(NO Sync)</td>
<td>3b</td>
</tr>
<tr>
<td>1 Video Processor</td>
<td>11</td>
</tr>
</tbody>
</table>

**Installed Options — Frame Boards Menu**

The main area provides five columns of information that pertain to the boards installed in the frame:

- The **Slot** column lists each slot on the frame. The slots at the back of the frame are identified with letters (A-E), and the slots at the front of the frame are identified with numbers (1-4).
- The **Board** column lists each circuit board by name, including any daughter cards that may be installed on that board.
The **HWRev** column lists the hardware revision number of each board and card in the frame.

The **SWRev** column lists the revision number of the software that is currently installed on each board or card in the frame.

The **BuildInfo** column lists the build, or software compile, date of the software that is currently installed on each board or card in the frame.

This completes the procedure for displaying information on frame boards.

### Installing Serial Numbers

If the label “000000” appears at the top of the **Installed Options Menus**, a serial number is required. Use the following procedure to install a serial number:

1. Navigate to the **Installed Options Menu 1-2** as follows:
   
   • Press **HOME** ⇄ **MORE** ⇄ **Setup** ⇄ **Installed Options**.

2. Press **Enter Serial Number** to display the **Serial Number Menu**.

   ![Serial Number Menu]

   **Serial Number Menu**

   **Note**
   
   Note that an **Encrypt Code** is listed. The code is a *random number* that is generated each time the switcher is powered up. Its purpose is to prevent unauthorized installation of software options. The code remains valid until the switcher is powered down or reset. The next time the switcher is powered up, a *new* Encrypt Code is generated.

3. Call **Ross Video Technical Support** at the number listed on the menu.

4. When you speak to our Technical Support representative, tell them your name, your facility name, and the **Encrypt Code** as listed on the menu.

5. You will be given a numeric code.

   • Enter the code using the keypad in the **Global Memory Area** of your switcher.

   • To complete the process, press **ENTER** on the keypad or press **Finished** on the **Serial Number Menu**.

This completes the procedure for entering the serial number.

### Installing Software Options

Use the following procedure to activate your software options (after entering a new serial number) or to install a new software option that you have just purchased.

1. Ensure that your serial number is properly entered.
2. Navigate to the Installed Options Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options.
3. Press Software Options to display the Software Options Menu.

<table>
<thead>
<tr>
<th>Installed Options (1-2)</th>
<th>Frame Serial Number: 00000000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Rankd</td>
</tr>
<tr>
<td>Editor Interface</td>
<td>No</td>
</tr>
<tr>
<td>VTR Remote Control</td>
<td>No</td>
</tr>
<tr>
<td>DVE Send and Remote CTRL</td>
<td>No</td>
</tr>
<tr>
<td>Audio Server Control</td>
<td>No</td>
</tr>
<tr>
<td>Video Server Control</td>
<td>No</td>
</tr>
<tr>
<td>Router</td>
<td>No</td>
</tr>
</tbody>
</table>

***Installed Options — Software Options Menu***

The following options are shown:

- **Editor Interface** — This option allows you to use an external editor to control your Synergy Q/MD switcher. Refer to Chapter 23, “Editors/OverDrive”, for information on how to install an editor after you have installed the option.

- **VTR Remote Control** — This option allows you to control a VTR from the Synergy Q/MD switcher. Refer to Chapter 14, “VTRs (Betacam)”, for information on how to install a VTR after you have installed the option.

- **Audio Server Control** — This option allows you to control an audio server from the Synergy Q/MD switcher. Refer to Chapter 15, “Audio Servers” for information on how to install an audio server after you have installed the option.

- **Video Server Control** — This option allows you to control a video server from the Synergy Q/MD switcher. Refer to Chapter 16, “Video Servers (VDCP)” for information on how to install a video server after you have installed the option.

- **Router** — This option allows you to control a router from the Synergy Q/MD switcher. Refer to Chapter 17, “Routers” for information on how to install a router after you have installed the option.

- **Serial Tally** — This option allows you to control a device using the serial tally protocol from the Synergy Q/MD switcher. Refer to the section “Serial Tally Protocol Setup” on page 9-14 for information on how to install a serial tally device after you have installed the option.

- **Peripheral Bus II** — This option allows you to control a device using the PIP-II interface protocol from the Synergy Q/MD switcher. Refer to the section “Pbus Protocol Setup” on page 9-11 for information on how to install a PIP-II device after you have installed the option.

- **Still Store (Aprisa)** — This option allows you to control an external Still Store from the Synergy Q/MD switcher. Refer to Chapter 18, “External Still Stores” for information on how to install a still store after you have installed the option.

- **Small Audio Mixer** — This option allows you to control a small audio mixer from the Synergy Q/MD switcher. Refer to Chapter 19, “Audio Mixers” for information on how to install a small audio mixer after you have installed the option.

- **Large Audio Mixer** — This option allows you to control a large audio mixer from the Synergy Q/MD switcher. Refer to Chapter 19, “Audio Mixers” for information on how to install a large audio mixer after you have installed the option.

- **Robotic System** — This option allows you to control a robotic camera from the Synergy Q/MD switcher. Refer to Chapter 20, “Robotic Cameras” for information on how to install a robotic camera after you have installed the option.
• **MLE 1 MD Option** — This option allows you to control MLE 1 on your Synergy Q/MD switcher.

• **MLE 2 MD Option** — This option allows you to control MLE 2 on your Synergy Q/MD switcher.

• **Extra Half MLE** — This option allows you to control the bottom Program/Preset MLE on a Synergy 1.5, or 2.5 Q/MD Switcher.

• **MediaCache™** — The MediaCache™ for Global-Store™ option allows you to store large stills and animation in your Global-Store. Refer to Chapter 29, “Hardware Options” for information on how to install the MediaCache for Global-Store after you have installed the option.

• **Proc Amps** — This option allows you to control Processing Amplifiers for every input on the switcher.

• **RGB Color Corrector 1** — This option allows you to control 1 floating input-based color corrector.

• **RGB Color Corrector 2** — This option allows you to control a second floating input-based color corrector.

• **RGB Color Corrector 3** — This option allows you to control a third floating input-based color corrector.

• **RGB Color Corrector 4** — This option allows you to control a fourth floating input-based color corrector.

• **AuxKeys** — The AuxKeys™ option allows you to control an Aux Mixer/Keyer from the Aux bus. Refer to the section “AuxKeys Option” on page 8-15 to learn how to set up your AuxKeys option.

• **SmartConversion** — This option allows you to utilize external Up/Down Converters to convert between video resolutions on-the-fly. Refer to Chapter 13, “SmartConversion™” for more information.

• **MultiDSK** — This option allows you to add two additional Downstream Keyers for your Program/Preset MLE. Refer to the section “MultiDSK Option” on page 8-12 for information on how to set up your MultiDSK option.

• **Monitor Wall** — This option allows you to control a monitor wall from the Synergy Q/MD switcher. Refer to Chapter 22, “Monitor Walls” for information on how to install a monitor wall after you have installed the option.

• **MLE 1 XFX MLE-Store** — The XFX MLE-Store option allows you to store and display four channels of still images on MLE 1. Refer to Chapter 29, “Hardware Options” for information on how to install the XFX card with MLE-Store after you have installed the option.

• **MLE 2 XFX MLE-Store** — The XFX MLE-Store option allows you to store and display four channels of still images on MLE 2. Refer to Chapter 29, “Hardware Options” for information on how to install the XFX card with MLE-Store after you have installed the option.

• **MLE 3 XFX MLE-Store** — The XFX MLE-Store option allows you to store and display four channels of still images on MLE 3. Refer to Chapter 29, “Hardware Options” for information on how to install the XFX card with MLE-Store after you have installed the option.

• **MLE 4 XFX MLE-Store** — The XFX MLE-Store option allows you to store and display four channels of still images on MLE 4. Refer to Chapter 29, “Hardware Options” for information on how to install the XFX card with MLE-Store after you have installed the option.
• **MLE 1 XFX MediaCache** — The XFX MediaCache™ for MLE-Store option allows you to store large stills and animation in the MLE-Store for **MLE 1**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the MediaCache for MLE-Store after you have installed the option.

• **MLE 2 XFX MediaCache** — The XFX MediaCache™ for MLE-Store option allows you to store large stills and animation in the MLE-Store for **MLE 2**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the MediaCache for MLE-Store after you have installed the option.

• **MLE 3 XFX MediaCache** — The XFX MediaCache™ for MLE-Store option allows you to store large stills and animation in the MLE-Store for **MLE 3**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the MediaCache for MLE-Store after you have installed the option.

• **MLE 4 XFX MediaCache** — The XFX MediaCache™ for MLE-Store option allows you to store large stills and animation in the MLE-Store for **MLE 4**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the MediaCache for MLE-Store after you have installed the option.

• **MLE 1 XFX Borders** — The XFX Borders option allows you to apply borders, drop shadows, glows and other effects to keys on **MLE 1**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the XFX card with Borders after you have installed the option.

• **MLE 2 XFX Borders** — The XFX Borders option allows you to apply borders, drop shadows, glows and other effects to keys on **MLE 2**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the XFX card with Borders after you have installed the option.

• **MLE 3 XFX Borders** — The XFX Borders option allows you to apply borders, drop shadows, glows and other effects to keys on **MLE 3**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the XFX card with Borders after you have installed the option.

• **MLE 4 XFX Borders** — The XFX Borders option allows you to apply borders, drop shadows, glows and other effects to keys on **MLE 4**. Refer to Chapter 29, “**Hardware Options**” for information on how to install the XFX card with Borders after you have installed the option.

4. Press **Add Option** to display the **Enter Option Number Menu**.

5. Call **Ross Video Technical Support** to obtain the software option code for the option you want to install. Have the following information ready when you contact Ross Video Technical Support:
   • Your name.
   • The name of the facility that the switcher is installed in.
• The serial number of the switcher you want to install the option on.
• The name of the options you want to install on the switcher.

6. You will be given a 4 to 6 digit numeric code.

7. Enter the option code into the switcher as follows:

   ![Important]
   You must enter all characters, including any leading zeros.

• Enter the code using the keypad in the Global Memory System Group.
• To complete the process, press ENTER on the keypad or press Finished on the Add Option Menu.
• Once entered, the menu indicates “Installed,” and the system displays the Software Options Menu to confirm.

This completes the procedure for activating software options.

**Backing Up and Restoring Option Codes**

The following procedures allow you to make a backup of your option codes and restore them if necessary.

**Backing Up Option Codes**

Use the following procedure to create a backup of your option codes:

1. Navigate to the Installed Options Menu 2-2 as follows:

   ![Installed Options Menu 2-2]

   1. Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options ⇒ Software Options ⇒ MORE.

2. Press Backup Option Codes. A backup of the option codes is created.

   ![Note]
   The Delete All SW Options and Delete Selected SW Option functions are reserved for factory use only. Do not use these functions unless instructed to do so by Ross Video Technical Support.

This completes the procedure for creating a backup of your option codes.
Recalling Option Codes

In case the option codes are accidentally erased or deleted, use the following procedure to recall option codes:

1. Navigate to the Installed Options Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options ⇒ Software Options ⇒ MORE.

   ![Installed Options Menu 2-2](image)

2. Press Restore Option Codes to recall your option codes from the backup.

This completes the procedure for recalling your option codes.
BNC Configuration and Check

In This Chapter

This chapter provides instructions for setting up and checking your Input BNCs. By following these procedures, you, in effect, build a database to be used by the switcher to provide the names, sources, Key and fill associations, and functionality of all Input BNCs. The following topics are discussed:

- BNC Configuration
- Naming Input BNC
- Setting Up Mnemonics Displays for BNC Names
- Setting Up BNC Types
- Setting Up Tallies
- Setting Up Alphas
- Setting Up Auto Keys
- Setting Up Still-Store Auto Keys
- Setting Up Panel Buttons
- Setting Up N/S Disable
- Checking Inputs
- Checking Keys

Note

Before you begin, ensure that you have completed your Input Worksheet. Refer to the section “Input Worksheet” on page 4-20 for instructions.
BNC Configuration

The following procedures will be discussed in this section:

- Naming Input BNC
- Setting Up Mnemonics Displays for BNC Names
- Setting Up BNC Types
- Setting Up Tallies
- Setting Up Alphas
- Setting Up Auto Keys
- Setting Up N/S Disable

Naming Input BNC

In Chapter 4, you connected your physical switcher inputs, including reference, primary inputs, and alpha inputs. In this section, you will name each physical Input BNC using the BNC Names Menu. This allows you to use actual input names throughout the menus. Additionally, the names that you choose will appear on the Preview Overlay output.

You can assign an Input BNC to a UMD Input address to provide the mnemonic names. If an Input BNC is assigned to a UMD Input address, any BNC name you enter is replaced with the UMD Input name for all the mnemonics and menus.

Note: During the procedure, refer to the Input Name column on your Input Worksheet. These names will be entered on the BNC Names Menu.

Use the following procedure to name your inputs:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Names to display the BNC Names Menu 1-2. This menu is specifically designed for naming inputs.

BNC Names Menu 1-2 with Optional Mnemonic Field

BNC Names Menu 1-2 with Optional Mnemonic Field

Note: The Mnemonic option is not available for the Synergy 1.

- The Main Area provides an array of letters and numbers. The reverse video highlight indicates the “selected” character — the position of which is controlled by
the top and middle scroll knobs. The **Current Name**, **Mnemonic**, and **New Name** fields are located below the array.

**Operating Tip**

A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs. Refer to the section “Using the Keyboard in System Control Menus” on page 5-5 for details.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

In the **New Name** field, the *reverse video highlight* indicates the “active” character — the one that you are changing.

- **(Synergy 1.5, 2 and 2.5 control panels only)** If the mnemonic option is purchased and installed, the **Mnemonic** field displays the BNC name as it will appear in the associated mnemonic display. Refer to the section “Setting Up Mnemonics Displays for BNC Names” on page 7-5 for more information.

- The **Label Area** provides an array of tools for naming and editing your BNC names.

- The **Scroll Area** provides three functions that are controlled by their respective knobs:
  - The **Horizontal** knob moves the highlight horizontally.
  - The **Vertical** knob moves the highlight vertically.
  - The **BNC Number** knob selects the input that you want to name. As you scroll through your inputs, the **Current Name** field tracks each name.

3. To name a BNC, use the **BNC Number** knob to select the desired BNC — the one that you want to name. Please note:

- BNC numbers on the display correspond to *physical* BNC connectors on the rear of the chassis, from **C01** - **D16**.
- As you rotate the knob, the **Current Name Field** changes to show the BNC name (as stored in switcher memory).
- The factory default format for *all BNC names* is:

  \[
  \text{[BNC]} \ [\text{space}] \ [\text{number}] \text{ (eg. BNC C01 or BNC D16)}
  \]

This format makes it easy to associate names with actual connectors.

4. There are two ways to begin editing the BNC name:

- You can begin by choosing a *preset* name (a prefix) from a list of typical BNC names. To start in this manner, continue to the next step.
- You can begin *editing* the name immediately, by changing the default characters to your custom characters. To start in this manner, continue with step 6.

**Note**

If you start editing the name, and then decide at some point to choose a *preset* name instead, *all characters* in the custom name will be replaced by the preset name.
5. Press **Preset Names** to display the **Preset Names Menu**.

![Preset Names Menu]

- Use the middle knob to scroll the list of preset names.
- Press **Select** to accept the preset name, or press **Cancel** to return.
- If you select a preset name, you automatically return to the **BNC Names Menu**, where your selection appears in the **New Name Field**, with the cursor positioned after the name.

6. To name your input (or to add additional characters after a preset name), use the **Horizontal** and **Vertical** knobs and the soft keys listed below to select the desired character. The highlighted position in the **New Name Field** changes as you select each character. Please note:
   - The maximum number of characters allowed is eight.
   - Press **Space** to add a space at the current position. If a letter is in the active position, it will be deleted.
   - Press **Prev Letter** to move the highlight one space to the left.
   - Press **Next Letter** to move the highlight one space to the right.

![Operating Tip]

7. When the name entered is as desired, press **Accept New Name**.

8. Repeat steps 3 through 7 for each additional input that you want to name. It is recommended at this point that you name each input to the switcher.

![Note]

This completes the procedure for naming inputs.

### Restoring Default BNC Names

The factory default format for all BNC names is: **[BNC] [space] [number]** (eg. **BNC C01** or **BNC D16**). When setting the BNC name to its default format, the change applies only to the selected BNC number. If you have more than one BNC name to change, you must repeat the procedure for each one.
Use the following procedure to restore the default BNC name:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Names to display the BNC Names Menu 1-2.

3. Use the BNC Number knob to select the desired BNC number.
   - As you rotate the knob, you will notice the Current Name Field changes to show the current name (as stored in switcher memory) of the BNC connector.
4. Press Default to change the BNC name to the default format.
5. Press Accept New Name.

This completes the procedure for restoring default names.

Setting Up Mnemonics Displays for BNC Names

A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs. Refer to the section “Using the Keyboard in System Control Menus” on page 5-5 for details.

Operating Tip

If the Mnemonic Display option is purchased and installed, use the following procedure to customize the appearance of the display:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Names to display the BNC Names Menu 1-2.

Note

3. Press **MORE** to display the **BNC Names Menu 2-2**.

   ![BNC Names Menu 2-2](image)

4. Use the **BNC Names Menu 2-2** to alter how the BNC names will appear in their associated mnemonic displays.

   In the main area, the **Personality Menu** global settings for the mnemonic display font and color are indicated. In this naming menu, they are referred to as the **Standard** settings.

5. To adjust the mnemonic display style of a BNC name, rotate the **BNC Number** knob. The selected BNC name/number appears in the mnemonic display area of the menu as you select BNCs from the list.

6. To adjust the size of the font that will appear in an individual mnemonic display, use the **Font** knob to select from the following choices:
   - **Standard**, which represents the option listed in the main menu area, as selected in the **Personality Menu**.
   - **Small**, which permits up to 6 characters per line.
   - **Small Invert**, which permits up to 6 characters per line, and draws light text on a dark background.
   - **Medium**, which permits up to 4 characters per line.
   - **Medium Invert**, which permits up to 4 characters per line, and draws light text on a dark background.
   - **Large**, which permits only 2 characters.
   - **Large Invert**, which permits only 2 characters, and draws light text on a dark background.

   The selected mnemonic display changes on the switcher when you exit the **Installation Menus**.

7. You can select which character of the BNC name will be the first one to appear in the mnemonic display.
Use the **Prev Start Pos** and **Next Start Pos** softkeys to move the cursor (highlight) through the BNC name. The selected character will be the first one in the name to appear in the display. This function is especially useful if you are using one of the large font options.

8. To adjust the color that will appear in the mnemonic display, rotate the **Color** knob to select from the following choices:
   - **Standard** — Select this option to use the default mnemonic format as set from the **Personality Menu**.
   - **Green** — Select this option to use green as the display color.
   - **Yellow** — Select this option to use yellow as the display color.
   - **Orange** — Select this option to use orange as the display color.
   - **None** — Select this option to use no background color for the display color.

The selected mnemonic display changes on the switcher when you exit the **Installation Menus**.

9. When you have completed your mnemonic adjustments, press **Accept New Name** to register the new display style in memory.

10. Repeat steps 3 through 7 for each additional mnemonic display that you want to adjust.

   **Note**
   If you exit the installation menus without first pressing **Accept New Name**, an error message is displayed.

This completes the procedure for customizing the mnemonic display.

### Setting Up BNC Types

The **BNC Type Menu** allows you to associate physical Input BNC connectors with input types. These associations play important roles throughout the system, particularly with regard to **filtering** subsequent BNC setup menus based on specific input types.

**Note**
During the procedure, refer to the **Input Type** column in your **Input Worksheet**. These “types” will be entered on the **BNC Type Menu** for each input connected to the frame.

Use the following procedure to set your input types:

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.

2. Press **BNC Type** to display the **BNC Type Menu**.

   **BNC — BNC Type Menu**
The **Main Area** provides a mini “help” message, plus a **Status Box** that lists the following information for the selected BNC:

- **BNC** — Current name and physical BNC connector (in parentheses). All lines below refer to this BNC.
- **Maps to** — Physical control panel button to which the BNC is mapped.
- **Type** — Input “type” for the selected BNC.
- **Tally** — Tally assignment for the selected BNC.
- **Auto Key** — Auto-Key association for the selected BNC. Every BNC input has an associated auto-Key, which can be an input (such as an alpha signal), or black (for inputs such as VTRs or cameras).
- **Video Mode** — Video format for the selected BNC.

The **Label Area** provides access to additional BNC setup menus.

---

### Note

Use the above information as a reference throughout this chapter, as the **Status Box** appears on all **BNC Setup Menus**.

---

3. Use the **BNC** knob to select an Input BNC to assign a type to. It is best to proceed in ascending order (lowest to highest numbered connector).

As you scroll through the **BNC** list, the **Status Box** and the **Type** and **Video Format** knobs will show the current setting for the selected BNC.

---

### Note

Input BNCs that appear gray are on Video Inputs Boards that are not installed. If you select one of those BNCs, a message will appear indicating it is not installed.

---

4. Use the **Type** knob to select the desired input type. You can select from the following:

---

### Important

All Input BNC types must be assigned to **Video** or **Alpha** unless the device connected to that Input BNC is controlled by the Synergy Q/MD switcher.

---

### Note

When you assign a remote device to a BNC crosspoint, pressing that crosspoint button will display the corresponding device control menus. If it is on a Key bus, pressing the button will cycle through the device control menus and the Key Type Menu.

---

- **Off** — Select this option when there is no input physically connected to the associated BNC. Selecting **Off** filters the input out of subsequent menus and eliminates menu “clutter.”
- **VTR** — Select this option when a VTR is connected. Any combination of the device types can be connected to Synergy Q/MD.

You must have the **VTR Remote Control Software Option** in order to control the VTR you are connecting to the selected Input BNC. You may also need the additional **Video Server Control Software Option** or **Audio Server Control Software**, depending on the device you are connecting. Contact your Ross Video Representative for more information on purchasing this option.
• **Alpha** — Select this option when an alpha signal (also known as a “Key” signal) is connected to the frame. Devices such as Character Generators, Graphics (Paint) Systems, and Still Stores typically provide unique alpha signals.

• **Router** — Select this option when a routing switcher output is connected to Synergy Q/MD.

  You must have the **Routing Switcher Interface Software Option** in order to control the Router you are connecting to the selected Input BNC. Contact your Ross Video Representative for more information on purchasing this option.

• **External Still** — Select this option when an external, Synergy Q/MD-controlled Still Store output is connected to Synergy Q/MD. (Note: for use in conjunction with the **Still Store (Aprisa)** software option).

  You must have the **Still Store Interface Software Option** in order to control the Still Store you are connecting to the selected Input BNC. Contact your Ross Video Representative for more information on purchasing this option.

• **Robotic Cam** — Select this option when a Synergy Q/MD-controlled robotic camera controller is connected to the switcher. (Note: for use in conjunction with the **Robotic System** software option)

  You must have the **Robotic Camera System Interface Software Option** in order to control the Robotic Camera you are connecting to the selected Input BNC. Contact your Ross Video Representative for more information on purchasing this option.

• **Char Gen** — Select this option when a Synergy Q/MD-controlled character generator is connected to the switcher. (Note: for use in conjunction with the **Character Generator** software option)

  You must have the **Character Generator Interface Software Option** in order to control the Character Generator you are connecting to the selected Input BNC. Contact your Ross Video Representative for more information on purchasing this option.

• **Video** — This is the default option. Use this option unless an alpha signal, reference signal, or a device listed above is connected to that BNC and controlled by the switcher.

  5. Use the **Video Format** knob to select the format of the input video of the associated BNC. You can select between the following:

    | Note |
    |------|
    | Assigning a **Video Format** to an **Input BNC** that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an **Aux Bus**. Refer to the section “**Configuring the Outputs**” on page 8-3 for more information on assigning outputs to Aux Buses. Video formats may be converted to the operating video format using **Smart Conversion**. Refer to Chapter 13 “**SmartConversion™**” for more information. |
6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up Input BNC types.

**Setting Up Tallies**

Each Synergy Q/MD switcher, with the exception of the **Synergy 1**, includes **36** configurable tally relays, each of which can be assigned to any video input. The **Synergy 1** includes **16** tally relays. The **Extended Tallies** option is available with the **Synergy 1.5**, **2**, and **2.5** control panels, and provides an additional **36** tallies (bringing the total number to **72**).

The **Tally Menu** allows you to select the tally relays that will be activated when control panel buttons are pressed. The associations on this menu affect the tally connectors (and associated relay electronics) on the control panel.

**Note**
During this procedure, refer to the **Tally Number** column in your **Input Worksheet**. These numbers will be entered on the **Tally Menu** for each input connected to the frame.

Use the following procedure to assign tallies:

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **BNC**.
2. Press **Tally** to display the **Tally Menu**.

```
<table>
<thead>
<tr>
<th>Type</th>
<th>Tally 1</th>
<th>Tally 2</th>
<th>Global Store 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC CBI (CBI)</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Mode</td>
<td>1080i 59.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC CBI (CBI)</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Mode</td>
<td>1080i 59.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC CBI (CBI)</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Mode</td>
<td>1080i 59.94</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

BNC — Tally Menu
```
The **Scroll Area** provides three functions that are controlled by their respective knobs:

- The **Tally** knob scrolls the tally list. As you scroll through your tallies, the **Status Box** data and current BNC and type data (adjacent to the **BNC/MLE** and **Type** labels in the **Scroll Area**) tracks each tally and its associated settings.

- The **BNC/MLE** knob selects the physical Input BNC connector, the MLE, or the Global-Store channel that you want to assign a tally to.

- The **Type** knob allows you to select the type of tally required. You can choose between the traditional “On Air” tally, a Preview tally, or a tally for any one of the Aux Bus outputs.

3. Use the **Tally** knob to select the tally that you want to associate an Input BNC with. This tells the switcher logic to close the selected relay circuit when the associated input forms part of the switcher output (as dictated by the selection made with the **Type** knob).

4. Use the **BNC/MLE** knob to select an Input BNC, MLE, or Global-Store to associate with the tally relay. If you don’t want to associate a BNC or MLE with the tally, select **NONE**. By default, all inputs are assigned to tallies in ascending order, i.e. Tally 1 is associated with BNC number C01, Tally 2 is associated with BNC number C02, etc. You can only assign a tally relay to one input.

5. Use the **Type** knob to select the type of tally to assign to the MLE, BNC, or Global-Store channel.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up tallies. Refer to the section “**Tally Connections**” on page 3-32 for tally wiring instructions.

### Setting Up Alphas

The **Alpha Menu** allows you to select the specific Keying mode for the selected alpha (Key) signal. These mode selections determine how the Key is processed electronically, and how it appears visually.

- **Note**: During the procedure, refer to the **Alpha Type** column in your **Input Worksheet**. These modes will be entered on the **Alpha Menu** for each alpha input connected to the frame.
Use the following procedure to set up your alpha inputs:

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press **BNC Type** to display the **BNC Type Menu**.

   ![BNC Type Menu](image)

3. Assign an Input BNC as an alpha as follows:
   - Use the **BNC** knob to select the Input BNC you want to assign as a Key Alpha.
   - Use the **Type** knob to select **Alpha**.
     When you select **Alpha** as the **Type**, the **Auto Key** item in the **Status Box** changes to **Alpha**, indicating whether the new alpha is Shaped or Unshaped.
   - Use the **Video Format** knob to select the input video format of the associated BNC.

   **Note**
   Assigning a **Video Format** to an **Input BNC** that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an **Aux Bus**. Refer to the section “**Configuring the Outputs**” on page 8-3 for more information on assigning outputs to Aux Buses.

4. Press **Alpha** to display the **Alpha Menu**.

   ![Alpha Menu](image)

5. Define the alpha as shaped or unshaped as follows:
   - Use the **Alpha** knob to select the Input BNC you want to configure.
   - Use the **Mode** knob to select the desired Key Alpha mode. You can choose between the following:
Setting Up Auto Keys

The BNC Auto Key Setup Menu allows you to associate alpha (Key) signals with their primary (fill) video inputs (e.g., associating CG Fill with CG Alpha). This association completely simplifies the Keying process on the switcher. When you punch up a Key source on the Key bus, its alpha and fill are automatically selected.

Use the following procedure to set up your auto Keys:

1. Navigate to the BNC Menu 1-3 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press Auto Key Setup to display the Auto Key Setup Menu.

Note: During the procedure, refer to the Auto Key column on your Input Worksheet. Enter the alpha input numbers on the BNC Auto Key Setup Menu for each associated fill video signal.
3. Assign the Input BNC with the alpha video signal to the BNC with the fill video signal as follows:
   - Use the BNC knob to select the Input BNC with the video signal that you want to use as the Fill for the Auto Key.
   - Use the Alpha knob to select the Input BNC with the video signal that you want to use as the Key Alpha for the Auto Key. For example:

```
~ Match CG Fill (C12) with CG Alpha (G12).
~ Match VTR 1 (C05) with BLACK.
```

4. Press HOME to display the Installation Change Confirmation Screen.

5. Accept or reject the changes you have made as follows:
   - Press Confirm to accept the changes.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up an Auto Key.

**Setting Up Still-Store Auto Keys**

You can associate one Still-Store channel as the alpha for another Still-Store channel. This means that if you load a still that has alpha information in the file, the switcher will use the associated channel to load the alpha still.

Use the following procedure to set up a Still-Store Auto Key:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.

2. Press Auto Key Setup to display the Auto Key Setup Menu.

   ```plaintext
   BNC — Auto Key Setup Menu
   ```
   ```plaintext
   BNC: Global Store 1
   Auto Key: Global Store 2
   Alpha: Global Store 1
   ```

   ```plaintext
   BNC: Global Store 2
   Auto Key: Global Store 1
   Alpha: Global Store 2
   ```
   ```plaintext
   BNC: Global Store 3
   Auto Key: Global Store 2
   Alpha: Global Store 3
   ```

   ```plaintext
   BNC — Auto Key Setup Menu
   ```

   Note: Select BLACK for Input BNCs with no associated alpha. This is the default setting.
3. Assign the Still-Store channel that you want to use for the alpha signal to the Still-Store channel with the fill signal as follows:
   • Use the BNC knob to select the Still-Store channel that will have the fill signal. This will be the Global-Store or MLE-Store channel that you will load the still into.
   • Use the Alpha knob to select the Still-Store channel that will have the alpha signal. This will be the Global-Store or MLE-Store channel that the alpha will be loaded into.

4. Press HOME to display the Installation Change Confirmation Screen.

5. Accept or reject the changes you have made as follows:
   • Press Confirm to accept the changes.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a Still-Store Auto Key.

Setting Up N/S Disable

The N/S Disable Menu gives the user the option to disable the non-sync indicators for selected BNCs, if desired. When a BNC has the N/S Disable set to ON, the non-sync indicator on the panel will not light for this BNC, even if this source is mistimed.

Use the following procedure to disable the non-sync indicators:

1. Navigate to the BNC Menu 2-3 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC ⇒ MORE.

2. Press N/S Disable to display the N/S Disable Menu.

3. Use the BNC knob to select the Input BNC that you want to turn the N/S Disable feature On or Off for.

4. Use the N/S Disable knob to turn the Non-Sync Disable feature On or Off as follows:
   • OFF — Select this option if you want to turn the N/S Disable feature Off. When the feature is turned off, the switcher will use the N/S indicators on the control panel to show when a source selected on that bus is out of sync with the switcher.
   • ON — Select this option if you want to turn the N/S Disable feature On. When the feature is turned on, the switcher will not indicate if the source selected on a bus is out of sync with the switcher.

5. Use the N/S Control knob to select between the following:
   • Individual — Select this option to turn the N/S Disable feature On or Off for the selected Input BNC only.
• **All OFF** — Select this option to turn the N/S Disable feature Off for all Input BNCs. This will override all individual N/S Disable settings, and return the Input BNCs to a N/S Disable **OFF** mode.

• **All ON** — Select this option to turn the N/S Disable feature On for all Input BNCs. This will remove the overrides that were set by selecting the **All OFF** option on any other BNC.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for disabling the non-sync indicators.
Setting Up Panel Buttons

As the last step in the BNC configuration process, you must map video signals to physical buttons on the control panel.

Synergy Q/MD switchers allow you to map any Input BNC, internal video signal or special function, such as Shift, to each physical crosspoint button on each bus. Up to 17 different button maps (the default map and 16 user-configurable maps) can be stored on your switcher and each bus can use a different map.

Note During the procedure, refer to your Button Map Worksheet. This worksheet gives you a convenient place to write down button map information.

In order to assign a function to a crosspoint button, you must first add the function to the button map you want to use, and then assign the bus map to the crosspoint bus you want to use it on.

Editing a Bus Map

Bus maps define the functions of each crosspoint button on a video bus. Your switcher can store up to 16 different mappings at a time and more can be stored on the switcher hard drive or a USB key for later recall.

Use the following procedure to edit a Bus Map:

1. Navigate to the Edit Bus Maps Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ MORE ⇒ Edit Bus Maps.
2. Press Edit Map to display the Edit Maps Menu.

   Edit Bus Maps — Edit Map Menu

<table>
<thead>
<tr>
<th>Map</th>
<th>Button</th>
<th>BNC</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)Map1</td>
<td>Button 1</td>
<td>ILE 1</td>
</tr>
<tr>
<td>(2)Map2</td>
<td>Button 2</td>
<td>HKCD 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Use the Map knob to select the map you want to edit (you can select any of the 16 editable mappings).

4. Use the Button knob to select the button you wish to assign a function to. You can also press the crosspoint button on the Program bus that you want to edit. The Button knob will show all possible crosspoint buttons on any Synergy Q/MD control panel. This allows you to create portable bus maps that can be used on any control panel. If you are defining a button that does not exist on your control panel, a warning message will appear, but you will still be able to define the button.

Note If the Bus Map you are editing does not have a SHIFT button defined, you must use the Button knob to access the shifted crosspoint buttons.
5. Use the **BNC** knob to select the Input BNC, internally generated signal, or function that you want to assign to the crosspoint button. You can select between the following:

- **NONE** — Select this option to assign no input to the selected crosspoint button. When pressed, the button will light, but it will not stay lit.
- **BKGD 1** — Select this option to assign **Color Background 1** to the selected crosspoint button.
- **BKGD 2** — Select this option to assign **Color Background 2** to the selected crosspoint button.
- **BLACK** — Select this option to assign **Black** to the selected crosspoint button.

**Note**

You cannot select a crosspoint button assigned to **MLE #** on that MLE. For example, you cannot select a crosspoint button assigned to **MLE 2** on **MLE 2**, as this will cause a feedback loop.

- **MLE 1** — Select this option to assign the **Program** output of **MLE 1** to the selected crosspoint button.
- **MLE 2** — Select this option to assign the **Program** output of **MLE 2** to the selected crosspoint button.
- **MLE 3** — Select this option to assign the **Program** output of **MLE 3** to the selected crosspoint button.
- **MLE 4** — Select this option to assign the **Program** output of **MLE 4** to the selected crosspoint button.
- **SHIFT** — Select this option to assign the **Shift** function to the selected crosspoint button. Refer to the section “**Shifted Crosspoint Buttons**” on page 7-20 for more information on using the **SHIFT** button and defining its behavior.

**Note**

Buttons assigned to the **Shift** function do not have a separate “shifted” assignment. For example, if **Shift** is assigned to button 5 on a Synergy 2, then button 22 (shifted button 5) is not available and a warning message is displayed if you try to assign a function to it.

- **GlobalStore 1** — Select this option to assign **Global-Store Channel 1** to the selected crosspoint button.
- **GlobalStore 2** — Select this option to assign **Global-Store Channel 2** to the selected crosspoint button.
- **GlobalStore 3** — Select this option to assign **Global-Store Channel 3** to the selected crosspoint button.

**Important**

If you assign an MLE-Store channel to a crosspoint button and you do not have the MLE-Store option on every MLE in your switcher, then that crosspoint button will be inoperable on the MLEs that do not have the MLE-Store option.

- **MLE-Store 1** — Select this option to assign **MLE-Store Channel 1** to the selected crosspoint button.
- **MLE-Store 2** — Select this option to assign **MLE-Store Channel 2** to the selected crosspoint button.
- **MLE-Store 3** — Select this option to assign **MLE-Store Channel 3** to the selected crosspoint button.
• **MLE-Store 4** — Select this option to assign **MLE-Store Channel 4** to the selected crosspoint button.

• **MLE Cln Fd 1** — Select this option to assign the **Clean Feed** output from **MLE 1** to the selected crosspoint button.

• **MLE Cln Fd 2** — Select this option to assign the **Clean Feed** output from **MLE 2** to the selected crosspoint button.

**Note**

On a **Synergy 1.5 Q/MD**, the **MLE 2 Clean Feed** is not supported. Only BNCs B05 and B06 provide a dedicated Clean Feed for the bottom, Program/Preset MLE.

• **MLE Cln Fd 3** — Select this option to assign the **Clean Feed** output from **MLE 3** to the selected crosspoint button.

**Note**

On a **Synergy 2.5 Q/MD**, the **MLE 3 Clean Feed** is not supported. Only BNCs B05 and B06 provide a dedicated Clean Feed for the bottom, Program/Preset MLE.

• **MLE Cln Fd 4** — Select this option to assign the **Clean Feed** output from **MLE 4** to the selected crosspoint button.

• **MLE Preview 1** — Select this option to assign the **Preview** output from **MLE 1** to the selected crosspoint button.

• **MLE Preview 2** — Select this option to assign the **Preview** output from **MLE 2** to the selected crosspoint button.

• **MLE Preview 3** — Select this option to assign the **Preview** output from **MLE 3** to the selected crosspoint button.

• **MLE Preview 4** — Select this option to assign the **Preview** output from **MLE 4** to the selected crosspoint button.

• **PRV w/ OVL** — Select this option to assign the main **Preview** output with **Overlay** to the selected crosspoint button.

**Important**

Selecting the **Preview with Overlay** on the **Preset Bus** of the bottom MLE will cause a feedback loop. This feedback loop does not apply if you have the **Mix/DSK** or **MultiDSK** option installed.

• **AuxKeyCut** — Select this option to assign an AuxKey Cut to the selected crosspoint button. The AuxKeyCut allows you to perform a cut of the AuxKey keyer on the selected Aux Bus.

• **AuxKeyTrans** — Select this option to assign an AuxKey Transition to the selected crosspoint button. The AuxKeyTrans allows you to perform a transition of the AuxKey keyer on the selected Aux Bus.

• **AuxBkgdCut** — Select this option to assign an AuxKey Background Cut to the selected crosspoint button. The AuxBkgdCut allows you to perform a cut of the AuxKey background on the selected Aux Bus.

• **AuxBkgdTrans** — Select this option to assign an AuxKey Background Transition to the selected crosspoint button. The AuxBkgdTrans allows you to perform a transition of the AuxKey background on the selected Aux Bus. Refer to the section “**AuxKeys Setup**” on page 8-15 for information on setting the AuxKey transition rate.
• **AuxB+KCut** — Select this option to assign an AuxKey Background and Key Cut to the selected crosspoint button. The AuxB+KCut allows you to perform a cut of the AuxKey background and keyer on the selected Aux Bus.

• **AuxB+KTrans** — Select this option to assign an AuxKey Background and Key Transition to the selected crosspoint button. The AuxB+KTrans allows you to perform a transition of the AuxKey background and keyer on the selected Aux Bus. Refer to the section “AuxKeys Setup” on page 8-15 for information on setting the AuxKey transition rate.

• **Bus Hold** — Select this option to assign a Bus Hold to the selected crosspoint button. The Bus Hold allows you to have the currently selected source, on the bus that you select the Bus Hold for, not change when a memory recall is performed. This is the same as holding the crosspoint button when performing a memory recall.

• **BNC XXX** — Select the desired Input BNC to assign it to the selected crosspoint button.

6. Set the Reverse Key Shift behavior as follows (refer to the section “Reverse Key Shift” on page 7-21 for information on this feature):

   - **On** — Toggle the Rev KeyShift button to On to enable Reverse Key Shift.
   - **Off** — Toggle the Rev KeyShift button to Off to disable Reverse Key Shift.

7. Press HOME to display the Installation Change Confirmation Screen.

8. Accept or reject the changes you have made as follows:

   - Press Confirm to accept the changes.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for editing a bus map.

**Bus Map Tips**

The following tips may be helpful when defining a bus map:

- You can map an input to more than one crosspoint.
- Associate your primary inputs first, followed by your shifted inputs.
- To save a crosspoint button, you may wish to assign Color Background 2 as the shifted function of Color Background 1.
- For convenience, you can place alphas as the shifted button of the associated fill. However, if you are short on inputs, it is not necessary to place alphas on the panel — because the auto-Key association calls them up automatically when you punch up a Key fill.

**Shifted Crosspoint Buttons**

There are two types of shifted crosspoint buses, Standard Shift crosspoint buses and Reverse Key Shift crosspoint buses. Both of these types are discussed in this section.
**Standard Shift Crosspoint Buses**

The **Shift** function allows you to access a second layer of crosspoint buttons. For example, on a **Synergy 2 Q/MD** control panel, the last button in a bus row is **17**. When the **Shift** function is applied to this button, pressing and holding it will allow you to access crosspoint buttons **18** through **33**.

The **Shift** function allows you to access the following crosspoint buttons:

- **Synergy 1 Q/MD**: Button **17** through **31**
- **Synergy 1.5 Q/MD**: Button **18** through **33**
- **Synergy 2 Q/MD**: Button **18** through **33**
- **Synergy 2.5 Q/MD**: Button **31** through **59**

**Note**

It is possible to assign the **Shift** function to any crosspoint button(s). If you assign multiple **SHIFT** buttons, they will be lit when a shifted crosspoint is used.

Use the following procedure to access a shifted crosspoint:

1. Press and hold the **SHIFT** button on the crosspoint bus you want to access the shifted crosspoint on.
2. Press the **Crosspoint** button you want to select.
3. Release both buttons.

Both the **Crosspoint** button and **SHIFT** buttons will remain lit.

**Note**

If you press another **Crosspoint** button, you will select an unshifted crosspoint and the **SHIFT** button will not be lit.

This completes the procedure for accessing a shifted crosspoint.

**Reverse Key Shift**

Reverse Key Shift provide access to the shifted crosspoint bus, just as the Standard Shift function does, but for the Key buses, it makes the **SHIFT** button act as if it is always being pressed. For example, on **MLE 1** of a **Synergy 2 Q/MD** switcher, if you press **Button 1** on the **BKGD** bus, you will be selecting **Crosspoint Button 1** (typically Black). If you press the corresponding button on the **Key** bus, you will be selecting **Crosspoint Button 18**, and the **SHIFT** button on the **Key** bus will be lit.

**Note**

When using Reverse Key Shift, the crosspoints on the Key bus are Shifted, and the ones on the BKGD and PST buses are not. The name **REV SHIFT** is shown on the mnemonic for the **SHIFT** button when Reverse Key Shift is active.

**Naming a Bus Map**

By default, the user configurable bus maps have names such as **Map001**. It is good practice to rename your edited bus maps to something more meaningful to help you identify specific mappings at a later date.
Use the following procedure to rename a bus map:

1. Navigate to the **Edit Bus Maps Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ MORE ⇒ Edit Bus Maps.
2. Press **Rename Mapping** to display the **Rename Mapping Menu**.

   ![Rename Mapping Menu](image)

3. Enter (or edit) the desired bus map name as follows:
   - Use the **Horizontal** knob to move the highlight horizontally.
   - Use the **Vertical** knob to move the highlight vertically.
   - Use the **Space**, **Prev Letter**, and **Next Letter** softkeys to edit the name as required.
4. Press **Accept New Name** to conclude the process (if you decide you do not want to change the name, press **UP ONE** to exit the menu without renaming the bus map).

This completes the procedure for renaming a bus map.

### Copying a Bus Map

You can copy a bus map from one bus map location to another. This allows you to organize or group your bus maps together.

Use the following procedure to copy a Bus Map:

1. Navigate to the **Edit Bus Maps Menus** as follows:
   - Press HOME ⇒ Setup ⇒ More ⇒ Edit Bus Maps ⇒ Copy Map.

   ![Copy Bus Maps Menu](image)

**Operating Tip**

An standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section “Using the Keyboard in System Control Menus” on page 5-5 for details.

- Use the **Horizontal** knob to move the highlight horizontally.
- Use the **Vertical** knob to move the highlight vertically.
- Use the **Space**, **Prev Letter**, and **Next Letter** softkeys to edit the name as required.
2. Use the **Copy From** knob to select the bus map location you want to copy from.

3. Use the **Copy To** knob to select the bus map location you want to copy to. Any bus map information in this location will be lost.

4. Press **Copy Map** on the **Copy Bus Maps Menu** to copy the bus map information from the one location to the other.

This completes the procedure for copying a bus map.

### Defaulting a Bus Map

You can reset a single bus map or all 16 user-configurable bus maps to their default settings if you wish to quickly remove any changes you have made.

Use the following procedure to return one or all bus maps to the default layout:

1. Navigate to the **Edit Bus Maps Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ MORE ⇒ Edit Bus Maps.

   ![Edit Bus Maps Menu 1-2](image)

   **Edit Bus Maps Menu 1-2**

2. Default a **Single Bus Map** as follows:
   - Use the **Map** knob to select the bus map you want to default.
   - Press **Default Map** to default the selected map. A confirmation screen is displayed asking you to confirm the defaulting procedure.
   - Accept or reject the changes you have made as follows:
     - Press **Confirm** to accept the changes.
     - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

3. Default **All Bus Maps** as follows:
   - Press MORE to display the **Edit Bus Maps Menu 2-2**.
   - Press **Default All Mappings**. A confirmation screen is displayed asking you to confirm the defaulting procedure.
   - Accept or reject the changes you have made as follows:
     - Press **Confirm** to accept the changes.
     - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

4. Press HOME to display the **Installation Change Confirmation Screen**.

5. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for returning one or all bus maps to the default layout

**Assigning a Bus Map to an Individual Bus**

By default, each bus on your switcher is assigned the default bus map. However, you can choose to assign any of the user-configurable mappings to any bus you choose. This is particularly useful for having Aux or Key buses mapped differently than the Program bus.

**Important**
The **OverDrive Production Control System** requires that all buses on your switcher are assigned to the same bus map. OverDrive does not support different bus maps on different buses.

Use the following procedure to assign a bus map to a bus:

1. Navigate to the **Personality Menu 3-3** as follows:
   • Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality** ⇒ **MORE** ⇒ **MORE**.
2. Press **Assign Bus Map** to display the **Assign Bus Maps Menu**.
3. Press **Individual Buses** to display the **Assign Individual Bus Maps Menu**.
4. Use the **Bus** knob to select the bus you wish to assign the map to. You can assign bus maps to all possible MLEs (1-4), even if your switcher does not have 4 MLEs. You can select from the following:
   - **MLEx Pgm/Pst** — Select this option to assign the mapping to the Program and Preset bus of the indicated MLE.
   - **MLEx Key 1** — Select this option to assign the mapping to the Key 1 bus of the indicated MLE.
   - **MLEx Key 2** — Select this option to assign the mapping to the Key 2 bus of the indicated MLE.

**Note**

Buses not available on your control panel appear gray but are still selectable. For example, MLE 4 buses are gray on all control panels except the **Synergy 4 Q/MD-X**.

**Note**

- If you are assigning a map to a **Downstream Keyer**, only the first 8 button mappings from the Bus Map will be applied to the **Source** buttons in the **Downstream Keyer Group**.
Synergy Q/MD Engineering Manual (v9.1 MD)  BNC Configuration and Check • 7–25

5. Use the Map knob to select the Bus Map you want to assign to a bus. You can select the default mapping or any of the 16 user-configurable mappings.

6. Press Perform Assign to assign the selected map to the bus.

This completes the procedure for assigning a bus map to a bus.

Assigning a Bus Map to Multiple Buses

If you need to assign a bus map to all buses on your switcher, all MLE buses, or all Aux Buses, you do not have to do so on an individual basis.

Important

The OverDrive Production Control System requires that all buses on your switcher are assigned the same bus map. OverDrive does not support different bus maps on different buses.

Use the following procedure to assign a bus map to multiple buses simultaneously:

1. Navigate to the Personality Menu 3-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality ⇒ MORE ⇒ MORE.

2. Press Assign Bus Maps to display the Assign All Bus Maps Menu.

3. Select which buses you want to assign a bus map to as follows:

   - **MLEx Utility** — Select this option to assign the mapping to the Utility bus of the indicated MLE.
   - **MultiDSK 3** — Select this option to assign the mapping to the MultiDSK bus of your switcher.
   - **MultiDSK 4** — Select this option to assign the mapping to the MultiDSK bus of your switcher.
   - **BnkxAuxx(x:x)** — Select this option to assign the mapping to the specified Aux bus of your switcher.
   - **RmtAuxPnl AX** — Select this option to assign a bus map to the Remote Aux Panel(s) connected to the **Aux Port X**, where “X” is the number of the Aux Port.
   - **RmtAuxPnl PX** — Select this option to assign a bus map to the Remote Aux Panel(s) connected to the **Peripheral Port X**, where “X” is the number of the Peripheral Port.

   Note

   If you are assigning a map to a **MultiDSK Keyer**, only the first button mapping from the Bus Map will be applied to the **Source** button in the **Downstream Keyer Group**.

   - **RmtAuxPnl A** — Select this option to assign a bus map to the Remote Aux Panel(s) connected to the **Aux Port X**, where “X” is the number of the Aux Port.
• **Entire Switcher** — Select this option to assign a new Bus Map to all buses on the switcher.

• **All MLE Buses** — Select this option to assign a new Bus Map to only the MLE buses of the switcher. MLE buses include the Program/Background, Preset, Key 1, Key 2 and Utility buses.

• **All Aux Buses** — Select this option to assign a new Bus Map to all of the Aux buses.

4. Use the **Map** knob to select the bus map you want to assign to the selected buses.

   **Note**
   If all buses on your switcher are not assigned to the same bus map, the **Map** knob will be initially set to **Different**.

5. Press **Perform Assign**. The selected bus map is assigned to the selected buses.

This completes the procedure for assigning a bus map to multiple buses simultaneously.
Checking Inputs

At this point in the installation process, ensure that you have performed the following tasks for each Input BNC to your Synergy Q/MD switcher:

- Named the input.
- Set up the BNC type.
- Set up the tally.
- Set up the alpha parameters (if the input is an alpha signal).
- Set up the Auto Key association (if the input is an alpha signal).
- Set up the control panel crosspoint bus map.

Use the following procedure to check your inputs:

1. Ensure that the program monitor is connected to the Output BNC (on the rear of the frame) that has been configured as the Program output type. Refer to the section “Configuring the Outputs” on page 8-3 for information on configuring outputs.

2. Ensure that each source device connected to the switcher is putting out a signal. This includes cameras, VTRs, routers, still stores, etc.

3. Using your “Input Worksheet” as a guide, press each crosspoint button on the Program (PGM) bus (the Background (BKGD) Bus on the Synergy 1), starting with crosspoint 1. Verify that each signal is present on the crosspoint (as mapped), and that it matches each connected signal as written on your worksheet.

4. For each shifted crosspoint, press and hold the SHIFT button, then press the desired button on the PGM bus (the BKGD Bus on the Synergy 1).

If any signal does not match, check your “Input Worksheet” against the settings that you made on the Panel Setup Menu.
Checking Keys

Once your inputs have been checked, you can now check each Auto-Key association that you have made. This procedure allows you to verify that each alpha-fill combination is working properly, and generating a proper linear Key.

Synergy 1

Use the following procedure to check your Keys:

1. Select a background source on the Background (BKGD) Bus.
2. Press KEY1 in the Assign Group on the Aux/Key Bus.
3. Select your first Key source on the Aux/Key Bus. The following figure is a sample selection.

![Sample Key Selection](image)

Note

In the figure above, the Key Bus sources do not match the BKGD and PST bus sources. This is because this particular user has elected to use the PRG/Key SHIFT, or Reverse Shift, function, thus making the Key Bus shifted all the time. Refer to the section, “Setting Up Panel Buttons” earlier in this chapter for instructions.

4. In the Key 1 Group:
   - Press AUTO SELECT to select a linear Key type.
   - Press CUT to take the Key on-air. The CUT button lights momentarily and the red ON indicator lights to show that the selected Key is on-air.
5. Visually check the appearance of the Key on the monitor:
   • The assigned alpha signal should be properly cutting the hole in the background.
   • The selected fill signal should be properly filling the hole.
   • The Key edges should be clean.

6. If the Key does not appear visually correct, check the display. The **Auto Key Setup Menu** appears automatically each time you take a Key on-air. The following figure is a sample menu:

   ![Auto Key Setup Menu](image)

   **Auto Key Setup Menu**

   In the **Main Area** of the menu, ensure that:
   • The correct Keyer is shown.
   • The correct Key fill source name and BNC number are displayed.
   • The correct Key alpha source name and BNC number are displayed.

7. If the Key Alpha and Fill sources are incorrectly paired or improperly assigned, check the associations for the alpha and fill signals on the following setup menus:
   • BNC Names Menu
   • BNC Type Menu
   • Alpha Setup Menu
   • Auto Key Setup Menu
   • Panel Setup Menu
8. If the Key Alpha and Fill sources are correct, but the Key does not appear correct visually, check the following “mode” assignments:
   - If you selected Unshaped and the alpha signal is actually Shaped, you will see black edges around the Keyed image.
   - If you selected Shaped and the alpha signal is actually Unshaped, you will see illegal video and other spikes on the waveform monitor.

Re-assign the mode if required and re-check the visual appearance of the Key.

9. If the Key Alpha and Fill sources are correct, but the edges or shadows of the Key do not appear correct visually (as compared to the direct CG output), you may need to adjust the factory default Clip and Gain settings as shown in the Scroll Area of the Auto Key Setup Menu.

By default, the labels in the Scroll Area both indicate Locked for the selected Key. This shows that the factory default settings for the selected alpha-fill pair are being used and that the Clip knob and Gain knob are both disabled.

To change the factory default settings for the selected Key:
   a) Press KEY MEM. The Locked labels disappear as shown below.

   ![Auto Key Setup Menu](image)

   Auto Key Setup Menu — Clip and Gain Enabled

   b) Use the Clip knob to adjust the clip threshold of the Key, until the desired visual appearance is achieved.

   c) Use the Gain knob to adjust the gain of the Key until the desired visual appearance is achieved.

   d) To store the new settings in memory, press and hold AUTO SELECT, press KEY MEM and release both buttons. Then press KEY MEM.

   The Locked labels reappear, the clip and gain controls are locked at the new settings and each setting is stored in switcher Key memory. These settings will now be used each time the selected auto Key is used on air.

10. Repeat steps 2 through 9 for each alpha-fill pair assigned on your Key Bus.

This completes the procedure for checking your keys.
**Synergy 1.5, 2 and 2.5**

Use the following procedure to check your Keys:

1. On the **Program (PGM) Bus**, select the **MLE 1** re-entry crosspoint. Note that sample crosspoint names are used below.

   ![Sample PGM/PST Bus](image)

2. Select a background source on the **Program (PGM) Bus** of **MLE 1** (such as a camera or VTR), and select your first Key source on the **KEY Bus** of **MLE 1**. A sample selection is shown below.

   ![Sample MLE Selections](image)

**Note** In the figure above, the **Key Bus** sources do not match the **BKGD** and **PST** bus sources. This is because this example uses the **Reverse Key Shift** function, thus making the **Key Bus** shifted *all the time*. Refer to the section “**Setting Up Panel Buttons**” on page 7-17 for instructions.

3. In the **MLE 1 Key 1 Group** select the following:
   - Press **AUTO SELECT** to select a linear Key type. The **KEY MEM** button will automatically light.
   - Press **CUT** to take the Key on-air. The **CUT** button lights momentarily, and the red **ON** indicator lights to show that the selected Key is on-air.
4. Visually check the appearance of the Key on the monitor:
   - The assigned Alpha signal should be properly cutting the hole in the background.
   - The selected Fill signal should be properly filling the hole.
   - The edges of the Key should be clean.

5. If the Key does not appear correct, check the display. The Auto Key Setup Menu appears automatically each time you take a Key on-air. A sample menu is shown below:

   ![Auto Key Setup Menu]

   In the Main Area of the menu, ensure that:
   - The correct MLE and Keyer are shown.
   - The correct Key Fill source name and BNC number are shown.
   - The correct Key Alpha source name and BNC number are shown.
   - The correct Key Attributes are shown (e.g., shaped).

6. If the Key Alpha and Fill sources are incorrectly paired or improperly assigned, check the associations for the alpha and fill signals on the following setup menus:
   - BNC Names Menu
   - BNC Type Menu
   - Alpha Setup Menu
   - Auto Key Setup Menu
   - Panel Setup Menu

   Refer to the appropriate sections earlier in this chapter for instructions.
7. If the Key alpha and fill sources are correct, but the Key does not appear correct visually, check the following “mode” assignments that you made on the Alpha Setup Menu:
   - If you selected Unshaped and the alpha signal is actually Shaped, you will see black edges around the Keyed image.
   - If you selected Shaped and the alpha signal is actually Unshaped, you will see illegal video and other spikes on the waveform monitor.

Reassign the mode if required, and visually recheck the Key.

8. If the Key alpha and fill sources are correct, but the edges or shadows of the Key do not appear correct visually (as compared to the direct CG output), you may need to adjust the factory default Clip and Gain settings as shown in the Scroll Area of the Auto Key Setup Menu.

By default, the labels in the Scroll Area both indicate Locked for the selected Key. This shows that the factory default settings for the selected alpha-fill pair are being used, and that the Clip knob and Gain knob are both disabled.

To change the factory default settings for the selected Key:
   a) Press KEY MEM. The Locked labels disappear as shown below.

   ![Auto Key Setup Menu — Clip and Gain Enabled]

   b) Use the Clip knob to adjust the clip threshold of the Key until the desired visual appearance is achieved.

   c) Use the Gain knob to adjust the gain of the Key until the desired visual appearance is achieved.

   d) To store the new settings in memory, press and hold AUTO SELECT, press KEY MEM, and release both buttons. Then press KEY MEM.

The Locked labels reappear, the Clip and Gain controls are locked at the new settings, and each setting is stored in switcher Key memory. These settings will now be used each time the selected auto Key is used on air.

9. Repeat steps 2 through 8 for each alpha-fill pair assigned on your Key Bus.

This completes the procedure for checking your keys.
Output Configuration

In This Chapter

This chapter provides instructions for configuring and checking your BNC outputs. As you follow each procedure, you are in effect building a *database* that is used by the switcher to provide the desired names, sources, key and fill associations, and overall switcher functionality.

The following topics are discussed:

- Output Worksheet
- Configuring the Outputs
- Connecting and Verifying Outputs
- Mix/DSK Option
- MultiDSK Option
- Mix/MultiDSK
- AuxKeys Option
- Additional Output Setup
- Clean Feed Setup
- Fade To Black Setup
- MLE Tally Setup
- Ancillary Data Setup
- Switch on Field Setup
Output Worksheet

Complete the following worksheet for all of your video outputs. To avoid marking up the Engineering Manual, you can also use the worksheet provided in Appendix C, “Installation Worksheets” to make extra copies.

For each output (moving from left to right in the worksheet columns):

- Check whether the output is locked because of an option.
- Fill in the output type.
- Fill in the destination of the output.

Note

If you have the MultiDSK or Mix/DSK, or both, options installed, certain Output BNCs will be locked to specific output types. The Aux Mixer, and Aux Mixer/Keyer options will also lock Output BNCs, but you can select which ones are locked.

<table>
<thead>
<tr>
<th>BNC Output Connector #</th>
<th>Locked Output (Mix/DSK or MultiDSK)</th>
<th>Locked Output (Mix/DSK and MultiDSK)</th>
<th>Output Type</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>e.g.</em> 1 <em>B01</em></td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td><em>e.g.</em> 1 <em>B13</em></td>
<td></td>
<td></td>
<td>AuxBus 1:3</td>
<td>Monitor 6</td>
</tr>
<tr>
<td>B01</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B02</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B03</td>
<td>Preview without Overlay</td>
<td>Preview without Overlay</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B04</td>
<td>Preview without Overlay</td>
<td>Preview without Overlay</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B05</td>
<td>Clean Feed 1</td>
<td>Clean Feed 1</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B06</td>
<td>Clean Feed 2</td>
<td>Clean Feed 2</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B07</td>
<td>Preview with Overlay (not locked)</td>
<td>Clean Feed 3</td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B08</td>
<td>Clean Feed 4</td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B09</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B10</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B11</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B12</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B13</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B14</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B15</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
<tr>
<td>B16</td>
<td></td>
<td></td>
<td>Program</td>
<td>Master Control</td>
</tr>
</tbody>
</table>
Configuring the Outputs

Note
Before you begin, ensure that you have completed your Output Worksheet. Refer to the section “Output Worksheet” on page 8-2 for instructions.

Every Synergy Q/MD switcher comes standard with 16 multi-definition serial digital outputs. Outputs are configured using the Synergy Q/MD menu system, and can be used as MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, MixDSK, MultiDSK, Aux Buses, or AuxKeys. Your configuration will depend largely on which options have been purchased.

Setting Up General Outputs

The Output Menu allows you to associate physical BNC connectors with output types. These associations play important roles throughout the system, particularly with regard to filtering subsequent output setup menus based on specific output types.

Use the following procedure to set your Output BNCs:

1. Navigate to the Output Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output.
2. Press Output BNCs to display the Output BNCs Menu.

Note
If you have the Mix/DSK, MultiDSK or AuxKeys options installed, certain Output BNCs will be locked to specific outputs. In some cases, only these outputs can be used for the output of this option. Refer to the section “Mix/DSK Option” on page 8-10, the section “MultiDSK Option” on page 8-12, the section “Mix/MultiDSK” on page 8-14, or the section “AuxKeys Option” on page 8-15 for more information.

Note
Output BNCs on Video Output Boards that are not installed on the frame appear gray. You can still select one of those BNCs but a warning message will appear indicating it is not installed.

Output BNCs Menu

3. Use the Output knob to select an Output BNC to assign a type to. It is best to proceed in ascending order (lowest to highest numbered connector).
4. Use the **Type** knob to select the output type you want to assign to the Output BNC. You can choose between the following:

**Note**: If you have Mix/DSK (or Mix/DSK and MultiDSK) installed, the **Clean Feed** and **Cln FD MLE x** (where x is the number of your PGM MLE) options are not available. The only available clean feeds in this case are the locked **Clean Feed BNCs**. Refer to the section “**Mix/DSK Option**” on page 8-10 for details on which BNCs are locked to Clean Feed.

- **Program** — Select this option to have the main Program output, the output of the Program/Preset MLE, routed to the selected Output BNC.
- **PRV w/ OVL** — Select this option to have the main Preview output with Preview Overlay output routed to the selected Output BNC.
- **PRV w/o OVL** — Select this option to have the main Preview output *without* Preview Overlay output routed to the selected Output BNC.
- **MLE 1 PGM** — Select this option to have the MLE 1 Program output routed to the selected Output BNC.
- **MLE 1 PRV** — Select this option to have the MLE 1 Preview output routed to the selected Output BNC.
- **MLE 1 LkAhd** — Select this option to have the MLE 1 Look Ahead Preview output routed to the selected Output BNC.
- **Cln Fd MLE 1** — Select this option to have the MLE 1 Clean Feed output routed to the selected Output BNC.
- **MLE 2 PGM** — Select this option to have the MLE 2 Program output routed to the selected Output BNC.
- **MLE 2 PRV** — Select this option to have the MLE 2 Preview output put out on the selected Output BNC.
- **MLE 2 LkAhd** — Select this option to have the MLE 2 Look Ahead Preview output routed to the selected Output BNC.
- **Cln Fd MLE 2** — Select this option to have the MLE 2 Clean Feed output routed to the selected Output BNC.

**Note**: On a **Synergy 1.5 Q/MD**, the **MLE 2 Clean Feed** only outputs Clean Feed 1. Clean feed between keys is not supported. BNCs **B05** and **B06** provide a dedicated Clean Feed for the bottom MLE.

- **MLE 3 PGM** — (**Synergy 2.5 Q/MD** only) Select this option to have the MLE 3 Program output routed to the selected Output BNC.
- **MLE 3 PRV** — (**Synergy 2.5 Q/MD** only) Select this option to have the MLE 3 Preview output routed to the selected Output BNC.
- **MLE 3 LkAhd** — (**Synergy 2.5 Q/MD** only) Select this option to have the MLE 3 Look Ahead Preview output routed to the selected Output BNC.
- **Cln Fd MLE 3** — (**Synergy 2.5 Q/MD** only) Select this option to have the MLE 3 Clean Feed output routed to the selected Output BNC.

**Note**: On a **Synergy 2.5 Q/MD**, the **MLE 3 Clean Feed** only outputs Clean Feed 1. Clean feed between keys is not supported. BNCs **B05** and **B06** provide a dedicated Clean Feed for the bottom MLE.
• **Clean Feed** — Select this option to have the main Clean Feed output routed to the selected Output BNC.

**Note** On a Synergy 1.5 or 2.5 Q/MD, the **Clean Feed** output can only output Clean Feed 1. Clean feed between Keys is not supported. BNCs **B05** and **B06** provide a dedicated Clean Feed for the bottom MLE.

**Note** If the **MultiDSK** option is installed, the **Clean Feed** output can still only output Clean Feed 1 (clean feed before Keys). Clean feed between keys is not supported. However, BNCs **B05** and **B06** will provide a dedicated Clean Feed for these Downstream Keyers.

• **GlobalStore X** — Select this option to assign the output of the selected Global-Store to the selected Output BNC, where “X” represents the Global-Store channel you are selecting.

• **Aux Bus Outputs 1:1 through 6:8** — Select this option to assign the output of an Aux Bus to the selected Output BNC. You can select between **Bank1**, **Aux1** through **Bank6**, **Aux8**.

**Note** If you are using **Aux Buses** to pass non-native video format signals through the switcher, **Output BNC C03** and **C04** cannot be used. **Output BNCs C03 and C04** cannot pass video that is of a format other than what the switcher is operating in.

5. Assign each Output BNC as desired.

6. Press **HOME** to display the **Installation Change Screen**.

7. Accept or cancel these changes as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting your Output BNC types.
Connecting and Verifying Outputs

This section covers the following topics:

- Output Connection
- Output Verification

**Note**
Before you begin, ensure that you have completed your Output Worksheet.

**Output Connection**

Connect the outputs to the desired external destinations, such as program monitors, preview monitors, transmission, routing switchers, VTRs, etc.

Connect auxiliary outputs to external destinations, such as monitors, VTRs, routing switchers, etc.

**Output Boards**

- Fill in the desired destination for each output signal.

**Output Verification**

For verification of your outputs, ensure that some form of monitoring is available at the destination of each specific output. The destination device itself may be a monitor, however, if the destination is a VTR or a routing switcher, ensure that you can monitor the input signal to the specific device.

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This ...</th>
</tr>
</thead>
</table>
| **Program**           | Synergy 1 Q/MD: Press different crosspoint buttons on the BKGD bus.  
                        | Synergy 1.5 Q/MD: Press different crosspoint buttons on the PGM bus of MLE 2.  
                        | Synergy 2 Q/MD: Press different crosspoint buttons on the PGM bus of MLE 2.  
                        | Synergy 2.5 Q/MD: Press different crosspoint buttons on the PGM bus of MLE 3. |
| **MLE 1 PGM**         | Press different crosspoint buttons on the BKGD bus. |
| **MLE 1 PV**          | Press different crosspoint buttons on the PST bus. |
| **MLE 2 PGM**         | (Synergy 1.5, 2 and 2.5 Q/MD only) Press different crosspoint buttons on the BKGD bus of MLE 2. |
## Output Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This ... (all switchers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE 2 PV</td>
<td>(Synergy 1.5, 2 and 2.5 Q/MD only) Press different crosspoint buttons on the PST bus of MLE 2.</td>
</tr>
<tr>
<td>MLE 3 PGM</td>
<td>(Synergy 2.5 Q/MD only) Press different crosspoint buttons on the BKGD bus of MLE 3.</td>
</tr>
<tr>
<td>MLE 3 PV</td>
<td>(Synergy 2.5 Q/MD only) Press different crosspoint buttons on the PST bus of MLE 3.</td>
</tr>
</tbody>
</table>

## Auxiliary Output Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This ... (all switchers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank 1 Assign 1</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 1, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 2</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 2, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 3</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 3, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 4</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 4, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 5</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 5, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 6</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 6, then switch between inputs on AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 7</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 7, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 1 Assign 8</td>
<td>In the AUX BUS ASSIGN group, press BANK 1 then ASSIGN 8, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 1</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 1, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 2</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 2, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 3</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 3, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 4</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 4, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 5</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 5, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 6</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 6, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 7</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 7, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 2 Assign 8</td>
<td>In the AUX BUS ASSIGN group, press BANK 2 then ASSIGN 8, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 1</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 1, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>To Verify This Output</td>
<td>Do This ... (all switchers)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Bank 3 Assign 2</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 2, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 3</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 3, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 4</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 4, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 5</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 5, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 6</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 6, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 7</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 7, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 3 Assign 8</td>
<td>In the AUX BUS ASSIGN group, press BANK 3 then ASSIGN 8, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 1</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 1, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 2</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 2, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 3</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 3, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 4</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 4, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 5</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 5, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 6</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 6, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 7</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 7, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 4 Assign 8</td>
<td>In the AUX BUS ASSIGN group, press BANK 4 then ASSIGN 8, then switch between inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 1</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 1 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 2</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 2 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 3</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 3 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 4</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 4 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 5</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 5 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 6</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 1 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 5 Assign 7</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 7 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
</tbody>
</table>
### Auxiliary Output Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This ... (all switchers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank 5 Assign 8</td>
<td>In the Aux Bus Output Menu, press the Bank 5 softkey then ASSIGN 8 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 1</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 1 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 2</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 2 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 3</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 3 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 4</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 4 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 5</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 5 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 6</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 6 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 7</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 7 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
<tr>
<td>Bank 6 Assign 8</td>
<td>In the Aux Bus Output Menu, press the Bank 6 softkey then ASSIGN 8 in the AUX BUS ASSIGN group, then switch been inputs on the AUX Bus.</td>
</tr>
</tbody>
</table>

### Special Output Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This ... (all switchers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAN</td>
<td>(All Switchers) Output depends on clean feed point of origin. Refer to the section “Clean Feed Setup” on page 8-17 for more information.</td>
</tr>
<tr>
<td>PV</td>
<td>(All Switchers) Place different sources on each individual MLE bus. In the PREVIEW BUS group, switch between PGM and PV buttons on each MLE.</td>
</tr>
<tr>
<td>OVL</td>
<td>(All Switchers, Preview Overlay Option must be installed.) In the PREVIEW OVERLAY group, switch between the various overlay options. In the PREVIEW BUS group, switch between PGM and PV buttons on each MLE and verify that the overlay output tracks.</td>
</tr>
</tbody>
</table>
**Mix/DSK Option**

The Mix/DSK option provides a mixer and Keyers for the bottom (Program/Preset) MLE in a half MLE switcher. This option must be installed in order to use the Program/Preset MLE in a **Synergy 1.5** and **2.5 Q/MD**.

---

**Note**

Turning this option Off for your Half MLE switcher will prevent you from using your Program/Preset MLE. Turning this feature On for a full MLE switcher will revert your full Program/Preset MLE to a half MLE.

---

The Mix/DSK option assigns and locks certain BNCs on the Output Board to the main switcher outputs. These assignments are as follows:

- **Output #B01** — This output is locked to **Program**.
- **Output #B02** — This output is locked to **Program** (same as B01).
- **Output #B03** — This output is locked to **Mix Preview** (without Overlay).
- **Output #B04** — This output is locked to **Mix Preview** (same as B03).
- **Output #B05** — This output is locked to **Mix Clean 1**, which is taken before Downstream Key 1.
- **Output #B06** — This output is locked to **Mix Clean 2**, which is taken before Downstream Key 2.
- **Output #B07** — This output is set, but not locked, to **PRV w/ OVL** (Preview with Overlay).

---

**Operating Tip**

Output #B07 is automatically set to Preview with Overlay when you set up a Mix/DSK. This can be changed later.

---

If you have a half-MLE switcher, you may have both Mix and MultiDSK options installed. The BNC assignments are different in this case. Refer to the section “Mix/MultiDSK” on page 8-14 for details.

**Mix/DSK Setup**

Use the following procedure to turn the Mix/DSK option on:

---

**Note**

The Mix/DSK option must be purchased and installed before you can activate it.

---

1. Navigate to the **Output Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output.
2. Press **Mix/DSK MultiDSK** to display the **Mix/DSK Menu**.

<table>
<thead>
<tr>
<th>Output (1-2)</th>
<th>Board: Board B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix/DSK: Yes</td>
<td>No</td>
</tr>
<tr>
<td>MultiDSK: No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

3. Activate the Mix/DSK option as follows:

**Note**
As there is only one output board on the Synergy Q/MD switchers, the **Board** knob will be fixed at **Board B**.

- Use the **Mix/DSK** knob to select **Yes**.

**Important**
When **Mix/DSK** is turned On or Off, a Recall Factory Default Settings must be performed. Refer to the section “Recalling Factory Default Settings” on page 11-32 and complete the procedure for **Recalling Switcher Registers**.

This completes the procedure for turning the Mix/DSK option on.

**Mix/DSK Operation**

The Mix/DSK option provides a limited Mixer and Keyers to the Program/Preset MLE of your switcher. For the operation of the Program/Preset MLE on a half MLE switcher, the following restrictions apply:

- You can perform **Cuts** and **Dissolves**, but not **Wipes** or **DVE** effects.
- You can perform **Auto Select Keys** and **Self Keys**, but not **Chroma Keys** or **Preset Pattern Keys**.
- You can perform **Mask** and **Key Invert** effects, but not **Matte Fill** or **Wash** effects.
MultiDSK Option

The MultiDSK option provides 2 additional Downstream Keyers for your Program/Preset MLE. For the **Synergy 1 Q/MD** this option provides two Downstream Keyers, DSK 1 and DSK 2, and for the **Synergy 1.5 through 2.5 Q/MD** this option provides two additional Downstream Keyers, DSK 3 and DSK 4. Refer to Chapter 7, “Keying”, in the *Synergy Q/MD/X Operator’s Manual*, for more information on using MultiDSK.

The MultiDSK option assigns and locks certain BNCs on the Output Board to the main switcher outputs. These assignments are as follows:

- **Output #B01** — This output is locked to **Program**.
- **Output #B02** — This output is locked to **Program** (same as B01).
- **Output #B03** — This output is locked to **Multi Preview** (without Overlay).
- **Output #B04** — This output is locked to **Multi Preview** (same as B03).
- **Output #B05** — This output is locked to **Multi Clean 3**, which is taken before Downstream Key 3.
- **Output #B06** — This output is locked to **Multi Clean 4**, which is taken before Downstream Key 4.
- **Output #B07** — This output is set, but not locked, to **PRV w/ OVL** (Preview with Overlay).

**Note**

On a *Synergy 1 Q/MD*, Mix Clean 3 is taken before Downstream Keyer 1.

On a *Synergy 1 Q/MD*, Mix Clean 4 is taken before Downstream Keyer 2.

**Operating Tip**

Output #B07 is automatically set to Preview with Overlay when you set up a MultiDSK. This can be changed later.

If you have a half-MLE switcher, you may have both Mix and MultiDSK options installed. The BNC assignments are different in this case. Refer to the section “Mix/MultiDSK” on page 8-14 for details.

MultiDSK Setup

Use the following procedure to turn the MultiDSK option on:

**Note**

The MultiDSK option must be purchased and installed before you can activate it.

1. Navigate to the **Output Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output.
2. Press **Mix/DSK MultiDSK** to display the **MultiDSK Menu**.

<table>
<thead>
<tr>
<th>Output (1-2)</th>
<th>Board: Board B</th>
</tr>
</thead>
<tbody>
<tr>
<td>This menu selects the configuration of the DSK output board.</td>
<td></td>
</tr>
<tr>
<td>Mix/DSK:</td>
<td>No</td>
</tr>
<tr>
<td>MultiDSK:</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mix/DSK</th>
<th>Output Boards</th>
<th>Output DBNCs</th>
<th>Clean Feed</th>
<th>Fade To Attack</th>
<th>MLE Tally</th>
</tr>
</thead>
</table>

**Output — MultiDSK Menu**

3. Activate the MultiDSK option as follows:

**Note** As there is only one output board on the Synergy Q/MD switchers, the **Board** knob will be fixed at **Board B**.

- Use the **MultiDSK** knob to select **Yes**.

This completes the procedure for turning the MultiDSK option on. Refer to Chapter 7, “Keying”, in the *Synergy Q/MD/X Operator’s Manual* for more information on working with MultiDSK Keys.
Half-MLE switchers (Synergy 1.5 Q/MD and Synergy 2.5 Q/MD) can have both Mix/DSK and MultiDSK options installed at the same time. The assigned and locked BNCs are different than when only one of the options is present. The assignments are as follows:

- **Output #B01** — This output is locked to **Program**.
- **Output #B02** — This output is locked to **Program** (same as B01).
- **Output #B03** — This output is locked to **Mix/Multi Preview** (without Overlay).

**Note**

The Mix/Multi Preview output is a dedicated preview for the Mix/MultiDSK Keys. This preview is not assignable to any other Output BNC and only includes the Mix/MultiDSK Keys.

- **Output #B04** — This output is locked to **Mix/Multi Preview** (same as B03).
- **Output #B05** — This output is locked to **Mix/Multi Clean 1**, which is taken before Downstream Key 1.
- **Output #B06** — This output is locked to **Mix/Multi Clean 2**, which is taken before Downstream Key 2.
- **Output #B07** — This output is locked to **Mix/Multi Clean 3**, which is taken before Downstream Key 3.
- **Output #B08** — This output is locked to **Mix/Multi Clean 4**, which is taken before Downstream Key 4.
- **Output #B09** — This output is locked to **Program** (same as B01).
- **Output #B10** — This output is locked to **Program** (same as B01).
AuxKeys Option

The AuxKeys™ option can be used as either an A/B Mixer (Mix between two inputs on an Aux Bus) or a Mixer/Keyer (Mix and AutoSelect Key). Switcher outputs are assigned to AuxKeys in groups of four. Mix or Key operations can be previewed and clean feed is also available, similar to a standard MLE. Refer to Chapter 7, “Keying” in the Synergy Q/MD/X Operator’s Manual for more information on using the AuxKeys option.

**Important**  
**AuxKeys** cannot be used to pass or manipulate non-native video format signals. If you are using an Aux Bus as a video pass-through for a non-native video format signal, you will not be able apply AuxKeys to that Aux Bus.

The AuxKeys option allows you to assign and lock certain BNCs on the Output Board to the main switcher outputs. The BNCs on each Output Board are separated into groups of 4. Assigning one of these groups to either Aux Keys or Aux Mix/Keys locks the first few BNCs in that group, depending on which option you select.

An example of possible Output BNC assignments are as follows:

**Aux Mixer Example:**
- Output #B09 — This output is locked to **Aux Program**.
- Output #B10 — This output is locked to **Aux Preview**.

**Aux Mix/Keyer Example:**
- Output #B09 — This output is locked to **Aux Program**.
- Output #B10 — This output is locked to **Aux Program**.
- Output #B11 — This output is locked to **Aux Preview**.
- Output #B12 — This output is locked to **Aux Clean Feed**.

**AuxKeys Setup**

Use the following procedure to turn the AuxKeys option on:

**Important**  
Do not use an Aux Bus that is already configured for the SmartConversion™ option. If you do, you will receive an error message when selecting a source on that Aux Bus. Refer to Chapter 13, “SmartConversion™” for more information on configuring SmartConversion™.

1. Navigate to the **Output Menu** as follows:
   - Press HOME → MORE → Setup → Installation → Output.
2. Press **Output Boards** to display the **Output Boards Menu**.

![Output Boards Menu](image)

3. Activate the AuxKeys option as follows:

   - Use the **Output Group** knob to select the group of 4 BNCs that you want to assign to the Aux Mixer or Aux Mixer/Keyer.

   **Note**
   
   Output BNCs on Video Output Boards that are not installed on the frame appear gray. You can still select one of those BNCs but a warning message will appear indicating it is not installed.

   **Operating Tip**
   
   If you intend to install the MultiDSK or Mix DSK options, you should not use output blocks #B01-B04, or #B05-B08 as these blocks are assigned and locked by these options.

   - Use the **Configuration** knob to select the AuxKey configuration you want. You can select between the following:

     ~ **Outputs** — Select this option to assign the selected output group as standard outputs. This frees up this output group to allow you to assign standard switcher outputs to all the BNCs in the group.

     ~ **Aux Mix** — Select this option to assign the selected output group as an Aux Mixer. This will allow you to perform Background dissolves in the aux bus.

     ~ **Aux Mix/Key** — Select this option to assign the selected output group as an Aux Mixer/Keyer. This will allow you to perform Background and Key 1 dissolves in the aux bus.

     ~ **Aux Mix/Pre** — Select this option to assign the selected output group as an Aux Key pre-key. This will allow you to create a properly timed external loop that re-enters an Aux Key back into the switcher as a video source.

     Aux Key pre-keys cannot be re-entered onto another Aux Bus that is already configured as an Aux Key pre-key.

   - Use the **Aux Bus** knob to select the **Aux Bus Bank** and **Assign** button that you want to assign the AuxKey to.

   **Important**
   
   On the Synergy 1 Q/MD you must assign the **AuxKeys** to Bank 1, Aux 1 (1:1) or Bank 1, Aux 2 (1:2) so that there is an Aux button you can use to access the AuxKeys.

   **Operating Tip**
   
   You can route the AuxKeys output to an input to provide an additional Mixer and Keyer to your main switcher output.

This completes the procedure for turning the AuxKeys option on.
Additional Output Setup

The **Output Setup Menu** also allows you to set up four specific output parameters:

- Clean Feed Setup
- Fade To Black Setup
- MLE Tally Setup

Each topic is discussed in detail in the following sections.

**Clean Feed Setup**

The **Clean Feed Menu** allows you to set the point from which the clean feed signal is derived. The selected signal then appears on the Clean Feed outputs, as configured in the section “Configuring the Outputs” on page 8-3.

Use the following procedure to set up the **Clean Feed** output.

1. Navigate to the **Output Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output.
2. Press **Clean Feed** to display the **Clean Feed Menu**.

   ![Clean Feed Menu]

3. Use the **MLE** knob to select the *single MLE* from which the feed originates. Only one MLE can be selected at a time.

4. Use the **Clean from** knob to select the point from which the output is taken in the video path of the MLE. You can select between the following:
   - **Before Keys** — Select this option to have the clean feed output pulled after the program/preset bus, but before the two keys are added.
   - **Btwn Key 1&2** — Select this option to have the clean feed output pulled downstream of the first MLE keyer, but before the second key.

This completes the procedure for turning on the **Clean Feed** output.

**Fade To Black Setup**

The **Fade To Black Menu** allows you to select the combination of MLEs that you want to fade to black when a **Fade to Black** transition is initiated. You can select any number of MLEs, each of which will fade simultaneously.

The function is useful for dual aspect ratio productions, in which one MLE is routed to the NTSC transmitter (in 4x3 format) and another MLE is routed to DTV transmitter (in 16x9 format). Both MLEs must fade simultaneously.
Use the following procedure to select the MLEs that you want to fade to black:

1. Navigate to the **Output Menu 1-2** as follows:
   - Press `HOME` ➔ `MORE` ➔ `Setup` ➔ `Installation` ➔ `Output`.
2. Press **Fade To Black** to display the **Fade To Black Menu**.
   
   ![Fade To Black Menu]

3. Toggle the desired MLEs **On** or **Off**, as required.

This completes the procedure for selecting the MLEs that you want to fade to black.

**MLE Tally Setup**

The **MLE Tally** feature allows you to force a selected MLE to always function as if it is on air, regardless of whether or not it is re-entered on the **Program/Preset Bus**. For instance, you may wish to send the output of MLE 1 to an external device, such as a VTR, while the Program/Preset bus is on air. In this configuration, you may want both MLE 1 and the Program/Preset Bus to be tallied. To achieve this, the **MLE Tally** feature must be used.

Use the following procedure to select the desired tally function for an MLE:

1. Navigate to the **Output Menu 1-2** as follows:
   - Press `HOME` ➔ `MORE` ➔ `Setup` ➔ `Installation` ➔ `Output`.
2. Press **MLE Tally** to display the **MLE Tally Menu**.
   
   ![MLE Tally Menu]

3. Use the **MLE** knob to select the MLE for which you want to assign a tally function.
4. Use the **Tally** knob to select the desired tally function:
   - **Always** — Select this option to tally the selected MLE regardless of what is selected on the **Program/Preset Bus**. The red **ON** LED will always be lit, and all sources selected on the MLE will tally accordingly. Use this selection for dual-aspect ratio configurations, as discussed above.
   - **On Air** — Select this option when you want an MLE to be tallied only when it is selected on the **Program/Preset Bus**.
Once selected, the MLE tally settings remain in effect until changed.

**Ancillary Data Setup**

The Ancillary Data Menu allows you to select lines in the vertical/horizontal blanking area of the video stream, which can then be stripped or passed. This menu is useful in situations where you wish to pass embedded audio or closed captioning.

You can also define the line where the image starts, to prevent any switcher effects (such as keys and wipes) from modifying lines before the selected line. This protects information such as closed-captioning, which may reside beyond the normal blanking area.

Refer to the following figure for a visual description of vertical/horizontal blanking (the figure represents the 480i video format. Field/Frame line numbers will vary depending on the video format your switcher is operating in.

![Vertical/Horizontal Blanking Area](image)

**Vertical Blanking**
- Image Starts

**Image Area**

**Horizontal Blanking**
- Line 0 (even)
- Line 20 (even)
- Line 262 (even)
- Line 263 (odd)
- Line 283 (odd)
- Line 525 (odd)

**Note**
To enable the video stream to be passed through the horizontal area located within the vertical blanking (the shaded area), both the horizontal blanking and the vertical line must be set to **Pass**.

Progressive video formats do not have even and odd fields. Menu items that indicate even and odd fields display a single number, representing the frame, when you are running in a progressive video format. Refer to the section “**Video Formats**” on page 2-12 for more information on interlaced and progressive video formats.

**Note**
Ancillary data parameters are set independently for each video format. Switching between video formats recalls the last-saved parameters for that video format.

Use the following procedure to select ancillary data parameters.

1. Navigate to the Output Menu 2-2 as follows:
   - Press **HOME ➔ MORE ➔ Setup ➔ Installation ➔ Output ➔ MORE**.
2. Press **Ancillary Data** to display the **Ancillary Data Menu**.

### Output — Ancillary Data Menu

**Ancillary Data** menu components:

- **Current Video Format**
  - The current video mode the switcher is operating in. There are separate ancillary data settings for each video mode.

- **Legend** with colors indicating whether a line is:
  - **Passed** — When a line is passed, the original line data is preserved.
  - **Stripped** — When a line is stripped, the switcher substitutes black for that line.
  - **Stripped (Switching Line)** — The switching line is always stripped and cannot be changed.

- **Horizontal bar graph**
  - The bar graph starts on the left with a box representing the first line of video in the vertical blanking. Above the graph is a small inverted triangle selector (used as a pointer) and below the graph are 1 or 2 lines (1 for progressive and 2 for interlaced video formats) of numbers and graduation marks. The pointer indicates which box (representing a line of video) is being modified in the menu. The latter 1 or 2 lines of numbers and graduations identify the line numbers that the boxes represent. If your switcher is running in an interlaced video format, the first line identifies the line number for the **Odd** field and the lower second line for the **Even** field. If your switcher is running in a progressive video format a single number, representing the frame, is shown.

- **Horizontal Blanking Box**
  - This floating box represents the Horizontal Blanking area of all the video lines.

- **Knobs area**
  - **Field (Line)** knob
  - **Pass/Strip** knob
  - **Image Starts** knob

3. Use the **Field (Line)** knob to select the desired field (line). Note that the pointer on the menu moves to indicate the selected line in the graphical display. To use the menu, first rotate the top knob to select the line or box to be edited. If you are running in a progressive video format, only one number, corresponding to the frame, is displayed.

4. To select the **Horizontal Blanking** box (on the far right of the bar graph) rotate the **Field (Line)** knob to its maximum value clockwise. The text to the left of the top knob indicates the selection. For video lines, the knob normally selects a pair of lines, one in the **Odd** field and a corresponding line in the **Even** field. The text beside the top knob shows the line number in parenthesis to the right of the Field type.
5. Use the **Pass/Strip** knob to select either **Pass** or **Strip** for the line selected by the top Knob. On the bar graph, the box representing the selected line will change color to show Passed or Stripped, as per the legend.

In the **Horizontal Blanking** case, stripping removes any embedded audio data in the blanking area of all the video.

6. Use the **Image Starts** knob to select the image start point. As the line number increases, the bar graph displays additional boxes with line numbers to reflect this change. You can then pass or strip these lines as required. Refer to the following diagram.

The bottom knob controls the line number that the switcher considers as the first line of active video (i.e. the line on which the image starts). By default this is the first line after the vertical blanking. In some cases it may be desirable to protect the first few lines of normal video from being modified by the switcher. For example: In 480i systems, closed captioning may be present a few lines past the vertical blanking.

- To prevent video effects such as keying from destroying the closed captioning of a background selection, use the **Image Starts** knob to adjust the first line number so it is after the closed caption line. The bar graph will now display additional boxes for the lines that the switcher will protect as shown in the figure below.

7. Press the **Default Anc Data** button to restore the ancillary data setting to their default values for the current video format.

This completes the procedure for selecting ancillary data parameters.

Contact Ross Video Technical Support for any additional assistance with **Ancillary Data** setup.
Switch on Field Setup

The **Switch On** feature allows you to select when the Synergy Q/MD switcher triggers a transition from one video source to the next when you are running in an interlaced video format. Each interlaced video frame is composed of an **Odd Field** and an **Even Field**.

**Important**

This section does not apply if you are running in a progressive scan video format.

- Selecting Field 1 (F1) on the **Output Menu** enables the switcher to trigger the second video source after the **Odd Field** of the first source is drawn.
- Selecting Field 2 (F2) on the **Output Menu** enables the switcher to trigger the second video source after the **Even Field** of the first source is drawn.

Use the following procedure to set up the **Switch On** feature:

1. Navigate to the **Output Menu 2-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output ⇒ MORE.

2. Toggle the **Switch on** softkey to select F1 or F2.
   - **F1** — Select F1 (Odd Field/Field 1) to trigger the transition to the next video source after the Odd Field of the first source. This is the default setting.
   - **F2** — Select F2 (Even Field/Field 2) to trigger the transition to the next video source after the Even Field of the first source.

This completes the procedure to set up the **Switch On** feature.
Basic Communications Setup

In This Chapter

This chapter provides instructions for setting up communications parameters and options to allow your switcher to communicate with external devices.

The following topics are discussed:

- Communications Overview
- Remote Port Expander (BSS4)
- Remote Port Expander Communications Setup (BSS4)
- Connecting Equipment to the Remote Port Expander (BSS4)
- Custom Device Setup
- Pbus Protocol Setup
- Serial Tally Protocol Setup
- Under Monitor Display Input Devices
Communications Overview

The eight (five on the Synergy 1 control panel) 9-pin “D”-type connectors on the rear of the control panel are provided for serial communication with remote peripheral devices, such as VTRs, disk recorders, video servers, audio boards, and other serial controlled devices. With the exception of the Editor setup, all peripheral equipment discussed in this chapter is connected to these ports.

If you have installed a Remote Port Expander (BSS4) to the Synergy switcher, there are four additional remote ports labelled A, B, C and D, corresponding to the Slave Ports on the BSS4 that will start with the number of the remote port that the BSS4 is connected to.

The figure below illustrates the location of the eight remote control ports on the rear of the Synergy 2 and 3 control panels.

![Synergy 2 — Control Panel](image1)

The figure below illustrates the location of the five remote control ports on the rear of the Synergy 1 control panel.

![Synergy 1 — Control Panel](image2)

Using the figures above for reference, complete the following remote control worksheet. To avoid marking up the Engineering Manual, use the worksheet provided in Appendix B, “Installation Worksheets” to make extra copies.

Fill in the serial controlled device, and the remote control port (on the device) that is used for serial control.
## Remote Control Worksheet

<table>
<thead>
<tr>
<th>Remote Connector</th>
<th>Serial Controlled Device</th>
<th>Device Serial Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Port Expander (BSS4)

The RS-422 Four Port Buffered Smart Switch (Model RS422BSS4) connects to one of the Remote Ports on the back of the Synergy Q/MD control panel to allow you to control up to four serial devices from that one port. This can increase the total number of remote ports on the Synergy Q/MD control panel from 8 (5 on the Synergy 1 control panel) to 32 (20 on the Synergy 1 control panel), depending on the number of BSS4 switches you have.

Important

The maximum number of BSS4 remote ports you can use at any one time may vary depending on the type of equipment you are connecting.

Refer to Chapter 29, “Hardware Options” for information on cabling and connecting the BSS4 to the Synergy Q/MD switcher.

Remote Port Expander Communications Setup (BSS4)

Use the following procedure to configure the BSS4 Remote Port Expander:

1. Navigate to the Communications Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press Type to display the Type Menu.

3. Assign a com port to the BSS4 as follows:
   • Use the Com Port knob to select the remote port on the Synergy Q/MD switcher that is connected to the BSS4.
   • Use the Device knob to select Expander.

4. Press Select Device to display the Select Device Menu.
5. Assign the BSS4 to the Expander communications port as follows:
   • Use the **Com Port** knob to select the communications port you want to assign the specific BSS4 to.
   • Use the **Device** knob to select BSS4.

6. Press **Com Settings** to display the **Communications Settings Menu**.

7. Set the communications protocol for the BSS4 as follows:
   • Use the **Com Port** knob to select the BSS4 you want to set the communications settings for.
   • Use the **Baud** knob to select **115200** as the baud rate for the BSS4.
   • The **Parity** knob is fixed at **NONE**.

8. Press **Com Type** to display the **Communications Type Menu**.

9. Select the type of serial communication that will be used to communicate with the BSS4 as follows:
   • Use the **Com Port** knob to select the BSS4 you want to set the communications type for.
   • Use the **Type** knob to select **RS-422** as the type of serial communication for the selected port.

   **Note**
   The BSS4 only supports RS-422 communication. Any device using RS-232 communication requires an RS-232 to RS-232 converter. Refer to the documentation for your device to ensure you are using the correct type of serial communication.

10. Press **HOME** to display the **Confirm Changes Screen**.

11. Press **Confirm** to accept the changes you have made to communications set up of the switcher.
When you press **Confirm**, a second screen is displayed prompting you to program the BSS4 Remote Port Expander.

![BSS4 — Program BSS4 Screen](image)

**Note**  
If you press **Cancel**, a warning message will be displayed and you will have to perform the set up of the BSS4 again.

12. Move the **SET UP SWITCH** on the BSS4 to **PROG**.

![BSS4 Remote Port Expander — Set Up Switch](image)

13. Disconnect the **BSS4 Power Supply** from the BSS4 to cycle the power **Off**.
14. Reconnect the **BSS4 Power Supply** to the BSS4 to cycle the power **On**.
15. Press **Continue** on the Synergy control panel.

**Note**  
If you get an error message stating that the BSS4 could not be programmed, confirm your settings and try to program the BSS4 again.

When you press **Continue** a screen is displayed informing you that the BSS4 Remote Port Expander has been successfully programmed.

![BSS4 — Successful Program BSS4 Screen](image)

16. Move the **SET UP SWITCH** on the BSS4 to **NORM**.
17. Disconnect the **BSS4 Power Supply** from the BSS4 to cycle the power **Off**.
18. Reconnect the **BSS4 Power Supply** to the BSS4 to cycle the power **On**.
19. Press **Continue** on the Synergy Q/MD control panel.

This completes the procedure for installing a BSS4 Remote Port Expander on the Synergy Q/MD switcher.
You will now notice that there are four new remote ports on the Communications Menu. These ports will be labelled A, B, C and D, corresponding to the Slave Ports on the BSS4, and will start with the number of the remote port that the BSS4 is connected to.

For example, if the BSS4 is connected to Remote Port 1 on the control panel, then the four Extended Remote Ports will be Remote 1A, Remote 1B, Remote 1C, and Remote 1D.

### Connecting Equipment to the Remote Port Expander (BSS4)

When installed, the BSS4 Remote Port Expander gives you four expanded remote ports that you can connect most of the same serial equipment to as you would any of the standard remote ports.

- **Devices connected to the BSS4 must use the RS-422 protocol. Those devices that require RS-232 protocol will require a RS-422 to RS-232 converter.**
- **Devices that use a Baud rate other than the current rate that the port on the BSS4 is set for will require programming of the BSS4. Refer to the section “Programming the BSS4 for Peripheral Devices” on page 9-8 for more information on programming the BSS4.**
- **Devices that use a Parity other than the current rate that the port on the BSS4 is set for will require programming of the BSS4. Refer to the section “Programming the BSS4 for Peripheral Devices” on page 9-8 for more information on programming the BSS4.**
- **If you cancel the upgrade procedure of the BSS4 you will have to remove the device from the Communications Menu, confirm the removal, and then set up the device again in order to program the BSS4.**
- **A device is connected and set up on an expanded BSS4 port in the same manner as it is on any other remote port on the Synergy Q/MD switcher. You connect the device to the port on the BSS4, select that port on the Communications Type Menu and follow the procedures for connecting that device. If the device used a Baud or Parity that is different than what the port was set to before, you will have to program the BSS4. Refer**
to the section “Programming the BSS4 for Peripheral Devices” on page 9-8 for more information.

The Slave Ports A, B, C and D on the BSS4 correspond to the Remote #A, Remote #B, Remote #C, and Remote #D ports on the Communications Setup Menu of the Synergy Q/MD switcher. The # will be the number of the Remote Port that the BSS4 is installed on. For example, if the BSS4 is connected to Remote Port 3, the corresponding expanded BSS4 ports would appear as Remote 3A, Remote 3B, Remote 3C and Remote 3D. You connect peripheral devices to these ports in the same manner you would any of the other Remote Ports on the Q/MD control panel.

**Programming the BSS4 for Peripheral Devices**

If you set up a device that uses a baud rate or parity that is different than what the remote port on the BSS4 was set to before, you will have to program the BSS4.

Use the following procedure to program the BSS4:

1. Install and set up communications for your device as you would for a device connected to a standard remote port.

2. After you confirm the set up of the device from the Communications Menu, the Program BSS4 Screen is displayed.

   The following devices need to be programmed:
   BSS4  (#1)
   For each device, please move the setup switch to 'Program' then cycle the power on the device and press 'Continue'

3. Move the SET UP SWITCH on the BSS4 to PROG.
4. Disconnect the **BSS4 Power Supply** from the BSS4 to cycle the power **Off**.

5. Reconnect the **BSS4 Power Supply** to the BSS4 to cycle the power **On**.

6. Press **Continue** on the Synergy Q/MD control panel.

**Note**

If you press **Cancel**, a warning message is displayed and you will have to perform the set up of the BSS4 again.

```
The switcher successfully programmed the following devices:
BSS4 (01)
For each device, move the setup switch back to 'Normal' then cycle the power on the device and press 'Continue'
```

```
BSS4 — Successful Program BSS4 Screen
```

7. Move the **SET UP SWITCH** on the BSS4 to **NORM**.

8. Disconnect the **BSS4 Power Supply** from the BSS4 to cycle the power **Off**.

9. Reconnect the **BSS4 Power Supply** to the BSS4 to cycle the power **On**.

10. Press **Continue** on the Synergy Q/MD control panel.

This completes the procedure for programming the BSS4 Remote Port Expander.
Custom Device Setup

The Custom Device Setup procedure allows you to set up communications parameters with custom external devices.

Note

The Custom Device Setup is an advanced feature requiring technical knowledge of serial protocols. Refer to Appendix D, “Custom Device Serial Protocols” for detailed information and set up procedures.
Pbus Protocol Setup

Use the **Pbus Protocol Setup** procedure to set up communications parameters with a Pbus device that can control up to 24 peripheral devices from a single remote port on the Synergy Q/MD switcher.

Ensure that the **Pbus Protocol** option is installed. If not, please contact Ross Video for details. Refer to the section “**Installed Options**” on page 6-27 for instructions on verifying the status of installed options.

Use the following procedure to configure a Synergy Q/MD switcher communication port for a Peripheral Interface II Protocol device:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Communications**.
2. Press **Type** to display the **Type Menu**.
3. Assign a communication port to the Pbus as follows:
   - Use the **Com Port** knob to select the remote port on the Synergy Q/MD switcher that is connected to the Pbus device.
   - Use the **Device** knob to select **Pbus**.
4. Press **Select Device** to display the **Select Device Menu**.
5. Select the Pbus protocol for the Pbus communications port as follows:
   - Use the **Com Port** knob to select the Synergy Q/MD remote port that the Peripheral Interface II Protocol is controlling.
   - Use the **Device** knob to select **Pbus**.
6. Press the **Com Settings** to display the **Com Settings Menu**.

    ![Com Settings Menu](image)

7. Set the communications protocols for the Pbus device as follows:

   **Note**
   Refer to your Pbus device documentation for the specific Baud and Parity settings of your Pbus device.
   
   - Use the **Com Port** knob to select the Pbus port you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Pbus device.
   - Use the **Parity** knob to select the parity, **NONE**, **ODD**, or **EVEN** for the Pbus device.

8. Press **Com Type** to display the **Com Type Menu**.

    ![Com Type Menu](image)

9. Select the type of serial communications that will be used to communicate with the Pbus device as follows:

   **Note**
   Refer to your Pbus device documentation for the specific communications type of your Pbus device.
   
   - Use the **Com Port** knob to select the Pbus device you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications (RS-232, RS-422, RS-232 Null, or RS-422 Null) for the selected port.
10. Press **Extra Options** to display the **Extra Options Menu**.

<table>
<thead>
<tr>
<th>Communications (1-2)</th>
<th>Protocol: Pbus</th>
<th>Com Port:</th>
<th>Query command strict or relaxed</th>
<th>Option:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Query Cmd</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Silent</td>
</tr>
</tbody>
</table>

**Communications — Extra Options Menu**

11. Select the type of querying command for the Pbus device as follows:
   - Use the **Com Port** knob to select the Pbus device you want to set the querying command type for.
   - Use the **Option** knob to select **Query Cmd**.
   - Use the **Value** knob to select the type of Query Command you want. You can select between the following:
     - **Strict** — Select this option to be able to control only devices connected to your Pbus device that respond to the Query Command
     - **Relaxed** — Select this option to be able to control all devices connected to your Pbus device whether they respond to the Query Command or not.
     - **Silent** — Select this option to not send status information from the switcher to your Pbus device.

**Note**

When you have completed setting up a device, or attempt to leave the **Communications Menu**, you will be prompted to **Confirm** or **Cancel** your changes to the installation settings of the switcher. If you want to keep the changes you have made, press **Confirm**, and the new setting will be stored.

This completes the procedures for setup of the Peripheral Interface II Protocol option.

Refer to the section, “**Switcher Personality**”, in the chapter, “**Switcher Basics**”, of the **Synergy Q/MD/X Operator’s Manual** for operating settings.

Refer to the section “**Pbus**” on page 10-35 for procedures on creating custom controls using the **Pbus Protocol** option.
Serial Tally Protocol Setup

Ensure that the Serial Tally software option is installed. If not, please contact Ross Video for details. Refer to the section “Installed Options” on page 6-27 for instructions on verifying the status of installed options.

The following topics are discussed:

• Contributional Serial Tallies Protocol Setup

Contributional Serial Tallies Protocol Setup

Use the Contribution Serial Tally Protocol Setup procedure to set up communication parameters with tally system interface equipment using industry standard protocol. Note that the standard parallel tally interface will continue to operate normally when this option is enabled.

Use the following procedure to configure the Contribution Serial Tally Protocol:

1. Navigate to the Communications Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press Type to display the Type Menu.

3. Assign a com port to the tally system as follows:
   • Use the Com Port knob to select the remote port, or peripheral port, on the Synergy Q/MD switcher that is connected to the tally system.
   • Use the Device knob to select Serial Tally.

4. Press Select Device to display the Select Device Menu.
5. Select the tally system you want to assign to the tally system communications port as follows:
   • Use the **Com Port** knob to select the communications port you want to assign a specific tally interface to.
   • Use the **Device** knob to select the type of tally interface that is connected to the port. You can select between the following:
     ~ **NONE** — Use this option to not assign a tally interface to the selected com port.
     ~ **Contrib** — Use this option to assign a **Contributional Serial Tally Interface** device to the selected com port.

6. Press **Com Settings** to display the **Com Settings Menu**.

<table>
<thead>
<tr>
<th><strong>Com Port</strong></th>
<th><strong>Contrib</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RS-232</td>
</tr>
<tr>
<td></td>
<td>RS-422</td>
</tr>
</tbody>
</table>

   **Communications — Com Settings Menu**

7. Set the communications protocols for the tally interface as follows:
   • Use the **Com Port** knob to select the tally interface you are setting the communications settings for.
   • Use the **Baud** knob to select the baud rate for the tally interface.
   • Use the **Parity** knob to select the parity, **NONE**, **ODD**, or **EVEN** for the tally interface.

8. Press **Com Type** to display the **Com Type Menu**.

<table>
<thead>
<tr>
<th><strong>Type</strong></th>
<th><strong>Com Port</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td></td>
</tr>
<tr>
<td>RS-422</td>
<td></td>
</tr>
</tbody>
</table>

   **Communications — Com Type Menu**

9. Select the type of serial communication that will be used to communicate with the tally interface as follows:
   • Use the **Com Port** knob to select the tally interface you want to set the communications type for.
   • Use the **Type** knob to select the type of serial communications (RS-232, or RS-422) for the selected port.
10. Press **Extra Options** to display the **Extra Options Menu**.

11. Assign an update rate to the tally interface as follows:
   - Use the **Com Port** knob to select the tally interface you are setting the rate for.
   - Use the **Option** knob to select **Rate**.
   - Use the **Value** knob to select the rate, in fields, between update messages sent by the switcher to the tally interface equipment. The default value of **26** is the recommended setting, but you can choose any value between **2** and **60**, inclusive, if you desire.

12. Assign a data transfer size to the tally interface as follows:
   - Use the **Com Port** knob to select the tally interface you are setting the message size for.
   - Use the **Option** knob to select **Data Txfr**.
   - Use the **Value** knob to select either **Minimal**, **Normal** or **Complete** as the message size protocol for the tally interface. **Complete** is the recommended setting for this option.
13. Assign a start message to the communications with the tally interface as follows:
   • Use the **Com Port** knob to select the tally interface you are setting the start message for.
   • Use the **Option** knob to select **Start**.
   • Use the **Value** knob to select **None** or **Init** as the start message for the tally interface. **None** is the recommended setting for this option.

   ![Communications Menu](image)

   **Communications — Extra Options (At Black) Menu**

14. Assign an At Black action to the tally interface as follows:
   • Use the **Com Port** knob to select the tally interface you are setting the At Black action for.
   • Use the **Option** knob to select **At Black**.
   • Use the **Value** knob to select the At Black action for the tally interface. You can select between the following:
     ~ **All Off** — Select this option to have the switcher report that nothing is on-air when the switcher is at black.
     ~ **Active On** — Select this option to have the switcher not report anything different when the switcher is at black.

   **Note**
   When you have completed setting up a device, or attempt to leave the **Communications Menu**, you will be prompted to **Confirm** or **Cancel** your changes to the installation settings of the switcher. If you want to keep the changes you have made, press **Confirm**, and the new setting will be stored.

This completes the procedures for setup of the **Contribution Serial Tally Protocol** option. If you require further information on the various options and their associated values, contact Ross Video Technical Support at the number listed in the front of this manual.
Under Monitor Display Input Devices

The Under Monitor Display Input Device (UMD Input) allows a UMD controller to provide names for video sources that are routed to the Synergy Q/MD switcher. These names are displayed on the crosspoint mnemonics and menus for the video sources.

Ensure that the Serial Tally option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options” on page 6-27 for instructions on verifying the status of installed options.

Under Monitor Display Device Communications Connections

In order to properly connect the UMD device to the switcher, you will need the following:

- **UMD Input Interface Cable** — A serial cable with a male 9-pin, D-type connector on one end. Refer to the documentation that came with your UMD Input device for information on the communications port that connects to the Synergy Q/MD switcher. Refer to the section “Control Panel Pinouts” on page 30-15 for pinout information.

UMD Input Device Communications Setup

Use the following procedure to configure a Synergy Q/MD switcher communications port for a UMD Input device:

1. Navigate to the Communications Menus as follows:

   - Press HOME ⇒ More ⇒ Setup ⇒ Installation ⇒ Communications.

2. Assign a communications port to the UMD Input as follows:

   - Use the **Com Port** knob to select the communications port on the Synergy Q/MD switcher that is connected, or assigned, to the UMD Input device.
   - Use the **Device** knob to select **UMD Input**.

3. Press **Select Device**.
4. Select the UMD Input protocol for the UMD Input communications port as follows:
   * Use the **Device** knob to select the type of UMD Input you want to assign to the selected port. You can choose between the following:
     - **TSL UMD** — Select this option to assign the native Television Systems Limited (TSL) UMD protocol to the selected port.

5. Press **Com Type**.

6. Select the type of serial communications that is used to communicate with the UMD Input device as follows:
   * Use the **Type** knob to select **RS-422**.

7. Press **Com Settings**.

8. Set the communications protocols for the UMD Input device as follows:
   * Use the **Baud** knob to select 38400.
   * Use the **Parity** knob to select **EVEN**.

9. Press **HOME** to display the **Installation Change Confirmation Screen**.

10. Accept or reject the changes you have made as follows:
    * Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the switcher communications port for a UMD Input device.

**UMD Input Device BNC Setup**

In order for the Synergy Q/MD switcher to associate a mnemonic name with an input, each Input BNC must be associated with a UMD address. As the source routed to the switcher changes, the mnemonic name for that Input BNC also changes.

Use the following procedure to assign a particular UMD Input address to an Input BNC:

1. Navigate to the **BNC Menu 3-3** as follows:
   • Press **HOME ⇒ More ⇒ Setup ⇒ Installation ⇒ BNC ⇒ More ⇒ More**.

2. Press **UMD Inputs** on the **BNC Menu 3-3**.

3. Assign a BNC to a UMD address as follows:
   • Use the **BNC** knob on the **BNC Menu 3-3** to select the Input BNC that you want to set the UMD address for.
   • Use the **UMD #** knob on the **BNC Menu 3-3** to select the UMD Input address that you want to assign to the selected Input BNC. Select **Off** to not assign a UMD address to the selected Input BNC.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.

5. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.

This completes the procedure for assigning a particular UMD Input address to an Input BNC.
Custom Controls

In This Chapter

This chapter provides instructions for setting up and naming custom control banks, and programming, naming, and editing your custom control buttons. The following topics are discussed:

- Custom Controls
- Custom Control Banks
- Programming Control Panel Functions
- Programming Special Functions
- Time Clock Functions
- Special Functions
- Pbus
- Naming Custom Controls
- Editing Custom Control Macros
- Copying or Moving Custom Controls
- Deleting Custom Controls
- Saving and Recalling Custom Controls
Custom Controls

The **Custom Control** function allows you to program sequences of keystrokes (called “macros”) and other special switcher functions, and store them in dedicated buttons and banks in the **Custom Control** group. Once programmed, a macro can be played back by pressing **one button** in the **Custom Control** group. A custom control macro can be as simple as triggering an output GPI pulse, or as complex as recalling a specific memory register, performing a switcher transition, and flying a group of keys — all with one-button simplicity.

The figures below illustrate each the **Custom Control Group** of each Synergy Q/MD control panel. Note that **sample** labels are provided.

**Synergy 1 Custom Controls**

The following figure illustrates the **Custom Control Group** for the **Synergy 1** control panel. A total of **24** registers are provided, up to **12** of which can be assigned as **banks** to increase the total number of available registers.

![Synergy 1 Control Panel — Custom Control Group](image)

Buttons are numbered to simplify the programming procedure. The numbering is 1 to 24 in ascending order, from left to right, and top to bottom.

**Note**

The Synergy 1 control panel does not support the **Mnemonic Display** option.

**Synergy 2 Custom Controls**

The following figure illustrates the **Custom Control Group** for the **Synergy 1.5** and 2 control panel. A total of **17** registers are provided, up to **12** of which can be assigned as **banks** to increase the total number of available registers.

![Synergy 2 Control Panel — Custom Control Group](image)

Buttons are numbered to simplify the programming procedure. The numbering is 1 to 17 in ascending order, from left to right.
Synergy 2.5 Custom Controls

The following figure illustrates the Custom Control Group for the Synergy 2.5 control panel. A total of 30 registers are provided, up to 12 of which can be assigned as banks to increase the total number of available registers.

Buttons are numbered to simplify the programming procedure. The numbering is 1 to 30 in ascending order, from left to right.

Custom control functionality falls into several different categories. These categories have been identified as follows:

- **Custom Control Banks** — Up to twelve banks can be enabled, and you can select any of the available custom control buttons on which to place the bank buttons themselves. Each bank stores a separate set of custom controls.

- **Naming Custom Controls** — A custom control function can be named for quick reference in the menus and, if installed, on the mnemonic displays.

- **Control Panel Functions** — A custom control button can be programmed to play back a series of control panel button presses — such as recalling memory registers, initiating auto transitions, taking a selected source, bringing up a CG, and calling other custom control macros.

- **VTR Functions** — A custom control button can be programmed to perform a specific transport command such as play, cue and rewind. Commands apply to serial controlled devices such as VTRs, Video Servers, and Audio Servers. The VTR Remote Control, Video Server Control or Audio Server Control option must be installed, respectively. Any combination of options can be installed.

- **Time Clock Functions** — A custom control button can be programmed to start, stop, or reset the preview overlay clock. The Preview Overlay Option must be installed.

- **Special Functions** — A custom control button can be programmed to perform a variety of special functions controlling GPIs, audio external devices, menu retrieval, transitions, and inserting pauses and holds to the custom control.

- **PIP-II Functions** — A custom control button can be programmed to send messages to devices using this optional software feature.

- **Monitor Wall Functions** — A custom control button can be programmed to send messages to monitor walls.

- **Audio Server Functions** — A custom control button can be programmed to send messages to audio servers.

- **Router Functions** — A custom control button can be programmed to send messages to audio servers.

- **Robotic Cameras** — A custom control button can be programmed to send messages to robotic cameras.
- **Character Generators** — A custom control button can be programmed to send messages to character generators.
- **Monitor Walls** — A custom control button can be programmed to send messages to audio servers.
- **Audio Server Functions** — A custom control button can be programmed to send messages to audio servers.
- **Saving and Recalling Custom Controls** — A custom control function can be stored to and recalled from the internal hard drive or a USB key.
- **Copying and Moving Custom Controls** — Custom controls can be copied and moved between banks and buttons.
- **Deleting Custom Controls** — A custom control function can be deleted from a button.
- **Editing Custom Controls** — A custom control macro can be viewed and modified by inserting or deleting events, as desired.

**Note**

When recording a memory recall in a custom control macro, it may be necessary to add a pause of between 1-10 frames after the memory recall in the macro. Refer to the section “Custom Control Pauses” on page 10-34 for details on inserting pauses in a custom control macro.
Custom Control Banks

Before programming the actual Custom Control buttons themselves, you must determine whether or not you want to enable custom control “Banks.” This feature effectively multiplies the total number of custom control buttons that you have available.

Two types of banks are available; Normal and Audio. Normal banks are for storing normal custom controls dealing with typical switcher video functions. Audio banks are used when custom controls are created for use when the switcher is in Audio Custom Control mode, and remotely operates an audio mixing board through the PGM and PST bus crosspoints. This mode is discussed later in this chapter.

Up to twelve banks can be enabled, and you can select any of the available custom control buttons on which to place the bank buttons themselves. Each bank stores a separate set of custom controls.

**Note**
It is possible to record a custom control macro to a button that is assigned as a bank button. However, this is only useful for audio functions, as there is no means by which you could access a regular custom control macro assigned to a bank button.

Custom Control Bank Setup

Use the following procedure to setup custom control banks:

1. Navigate to the Installation Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE.
2. Press Custom Controls to display the Custom Controls Bank Setup Menu.

![Custom Controls Bank Setup Menu](image)

3. Assign a custom control bank type as follows:
   - Use the Bank knob to select the desired bank that you wish to enable (from 1 to 8).
   - Use the Bttn knob to select the desired custom control button that you wish to assign as the bank. If you need to disable a bank, rotate the Bttn knob until the label NONE is displayed.

   As you rotate the Bank and Bttn knobs, note that in the Custom Control Group, the button currently associated with the knob selection lights. This function provides a clear visual “assist” for each bank-to-button association.

   - Use the Type knob to select the custom control bank type you are creating. You can choose from the following:
10–6  • Custom Controls Synergy Q/MD Engineering Manual (v9.1 MD)

~ **Audio** — Select this option for macros which communicate with outboard audio mixers.

When an **Audio Bank** button is pressed and held, the **PGM/PST** buses operate in **Audio Custom Control Mode**. In this mode, each crosspoint represents the audio channel or group assigned to the corresponding custom control button. This mode also shows the current audio channels, or groups, assigned to the **PGM/PST** buses.

For example, crosspoint 1 will represent the audio channel assigned to custom control 1.

~ **Normal** — Select this option for macros which perform any function *except* communicating with outboard audio mixers.

- Repeat these selections for each bank you wish to enable.

4. When all banks are enabled as desired, press **HOME** and then **Confirm** to save the new settings, or proceed to the next section “**Naming Custom Controls**”.

**Operating Tip**

If you enable banks and do not have the Mnemonic Display option, or have a **Synergy 1** control panel, be sure to re-label the keycaps on the switcher panel accordingly.

This completes the procedure for setting up custom control banks.

**Naming Custom Control Banks**

Use the following procedure to name custom control banks:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Custom Controls**.

2. Press **Modify Bank Name** (to display the **Custom Control Bank Name Menu 1-2**).

This menu is specifically designed for naming custom control banks.

**Note**

The **Synergy 1** control panel does not support the Mnemonics Display option and does not show the **Mnemonic** preview in the **Custom Control Bank Names Menu (1-2)**.

The **Main Area** provides an array of letters and numbers. The reverse video *highlight* indicates the “selected” character — the position of which is controlled by
the two upper scroll knobs. The Current Name, Mnemonic, and New Name fields are located below the array.

**Note**

If the Mnemonic Display option is purchased and installed, the Mnemonic field displays the bank name as it will appear in the associated mnemonic display. Additional mnemonic display configurations are discussed in the section “Customizing Mnemonic Displays — Banks” on page 10-8.

In the New Name field, the “active” character — the one that you are changing — is indicated by the black highlighting of the letter.

- The **Label Area** provides an array of tools for naming and editing your physical names.
- The **Scroll Area** provides three functions that are controlled by their respective knobs:
  - The **Horizontal** knob moves the highlight horizontally.
  - The **Vertical** knob moves the highlight vertically.
  - The **Bank number** knob selects the bank that you want to name. As you scroll through your banks the Current Name field tracks each name.

3. To name a bank, rotate the **Bank number** knob until the desired bank number is shown — the one that you want to name. Please note:
  - As you rotate the knob, the Current Name Field changes to show the current name (as stored in switcher memory).
  - The factory default format for all bank names is:
    
    [Bank][space][number]
    
    For example, Bank 1 or Bank12. This format makes it easy to associate names with actual banks.

4. To name your bank, use the **Horizontal** and **Vertical** knobs to select the desired character. The highlighted position in the **New Name Field** changes as you select each character. A maximum of 8 characters may be entered.
  - Press **Space** to add a space at the highlighted position. If a letter is in the active position, it will be deleted.
  - Press **Prev Letter** to move the highlight one space to the left.
  - Press **Next Letter** to move the highlight one space to the right.

As you rotate the **Horizontal** and **Vertical** knobs, the buttons on MLE 1 of the control panel light and correspond to each character (in sequence). If desired, you can press the MLE button to select a character.

5. When the name entered is correct, press **Accept New Name**.

If you exit the installation menus without first pressing **Accept New Name**, you are asked if you wish to abandon any changes you have made to the name. Choose from the following:

- Press **Yes** to abandon changes and move to the new bank number. The name reverts to its previous name as stored in memory.
- Press **No** to retain changes without moving to the new bank number.
6. Repeat steps 3 through 5 for each bank that you want to name.

At this point it is recommended that you name each bank.

7. To return the currently modified custom control bank name to its default title, press Default.

8. When all banks are named as desired, press HOME and then Confirm to save the new settings, or proceed to the next section “Customizing Mnemonic Displays — Banks”.

This completes the procedure for naming custom control banks.

**Customizing Mnemonic Displays — Banks**

The Synergy 1 control panel does not support the Mnemonic Display option.

If the Mnemonic Display option is purchased and installed, use the following procedure to customize the display appearance:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Custom Controls.

2. Press Modify Bank Name (to display the Custom Control Bank Name Menu 1-2).

3. Press MORE (to display the Custom Control Bank Names Menu 2-2).

Use Custom Control Bank Names Menu 2-2 to adjust how bank names will appear in their associated mnemonic displays.

In the main area, the Personality settings for the mnemonic display font and color are indicated. In this naming menu they are referred to as the Standard settings.


A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.
4. To select a bank name for adjustment, rotate the **Bank number** knob.

The selected bank name/number is displayed in the mnemonic display area of the menu as you select banks from the list.

5. To adjust the size of the font that will appear in the mnemonic display, rotate the **Font** knob to select from the following choices:

   - **Standard**, which represents the option listed in the main menu area, as defined in the **Personality Menu**.
   - **Small**, which permits up to 6 characters per line.
   - **Small Invert**, which permits up to 6 characters per line, and draws light text on a dark background.
   - **Medium**, which permits up to 4 characters per line.
   - **Medium Invert**, which permits up to 4 characters per line, and draws light text on a dark background.
   - **Large**, which permits only 2 characters.
   - **Large Invert**, which permits only 2 characters, and draws light text on a dark background.

The selected mnemonic display changes on the switcher when you exit the **Installation Menus**.

6. You can select which character of the bank name will be the first one to appear in the mnemonic display.

Use the **Prev Start Pos** and **Next Start Pos** softkeys to move the cursor through the bank name. The selected character will be the first one in the name to appear in the display. This function is especially useful if you are using one of the large font options.

7. To adjust the color that will appear in the mnemonic display, rotate the **Color** knob to select from the following choices:

   - **Standard** — Select this option to use the default mnemonic format as set from the **Personality Menu**.
   - **Green** — Select this option to use green as the display color.
   - **Yellow** — Select this option to use yellow as the display color.
   - **Orange** — Select this option to use orange as the display color.
   - **None** — Select this option to use no background color for the display.

The selected mnemonic display on the switcher changes when you exit the **Installation Menus**.

8. When you have completed your mnemonic adjustments, press **Accept New Name** to register the new name and display style of the bank in memory.

If you exit the installation menus without first pressing **Accept New Name**, you are asked if you wish to abandon any changes you have made to the name. Choose from the following:
• Press Yes to abandon changes and move to the new bank number. The name reverts to its previous name as stored in memory.

• Press No to retain changes without moving to the new bank number.

9. To adjust the mnemonic display style of another bank name, rotate the Bank number knob.

The selected bank name/number is displayed in the mnemonic display area of the menu as you select numbers from the list.

10. Repeat steps 4 through 8 for each bank name whose mnemonic display you wish to adjust.

11. When all mnemonics are adjusted as desired, press HOME and then Continue to save the new settings.

This completes the procedure for setting up custom control banks.
Programming Control Panel Functions

Use the following procedure to program a custom control button with basic functions:

**Important** Memory recalls from custom controls will override the current Effects Dissolve, Keys Only, and Auto Recall settings to whatever settings were in place when the custom control was recorded.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

   ![Custom Controls Menu 1-2](image)

   **Custom Controls Menu 1-2**

   The Main Area provides the status of the Custom Control buffer, as well as the name and status of the custom control selected on the menu. If you have already programmed one or more macros, a percentage value is displayed that indicates how “full” the buffers are.

   The Scroll Area provides lists of the enabled banks, and a full list of custom control buttons. Not all of the custom control buttons exist on every control panel.

2. Select the Custom Control bank and button that you want to record to as follows:
   - Use the Bank knob to select the custom control bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button that you wish to program. You can also press the button directly on the panel.

**Note** Buttons with an asterisk (*) next to them in the list are already programmed, however, they can be edited. Refer to the section “Editing Custom Control Macros” on page 10-42 for details.
3. Press **Start Recording** to display the **Recording Menu**.

![Recording Menu](image)

**Custom Controls (1-2) to 9-2**

**Selected:** Bank 1 Button 1 [Custom8]

**Recording...**

**Bank:** 1

**Button:** Custom8 1

**Custom Control Legend:**

# = normal custom control button

<table>
<thead>
<tr>
<th>Finish Recording</th>
<th>Cancel Recording</th>
<th>Insert Special</th>
</tr>
</thead>
</table>

**Custom Controls — Recording Menu**

**Note**

Press **Cancel Recording** to terminate the programming procedure. The macro will **not** be recorded.

4. With the recording in progress, press the buttons on the control panel that you would like to have played back — in order. All subsequent keystrokes will be remembered, **in the exact order that you press them**. The following is a list of examples of custom controls that can be recorded:

**Important**

Custom Controls will not recall the sources assigned to a particular bus map, only the crosspoint buttons that were pressed. If you are using different bus maps, you must ensure that the same bus map is used when you run the custom control as when you created the custom control.

5. Insert any special functions you want. You can insert any of the following:

- **VTR Functions** — Refer to the chapters “VTRs (Betacam)” or “Video Servers (VDCP)”.
- **Time Clock Functions** — Refer to the section “Time Clock Functions” on page 10-18.
- **Special Functions** — Refer to the section “Special Functions” on page 10-20.
- **Pbus** — Refer to the section “Pbus” on page 10-35.
- **Character Generator Custom Controls** — Refer to the chapter “Character Generators”.
- **Router Custom Controls** — Refer to the chapter, “Routers”.
- **Robotic Camera Custom Controls** — Refer to the chapter, “Robotic Cameras”.
- **Audio Server Custom Controls** — Refer to the chapter, “Audio Servers”.
- **Monitor Wall Custom Controls** — Refer to the chapter, “Monitor Walls”.

6. Press **Finish Recording** when you have finished recording the macro.
You will notice an asterisk next to the custom control you just recorded, indicating that this custom control contains information.

This completes the procedure for recording a normal custom control. To play back your macro, press the custom control button on the switcher panel. (This is the button you selected in step 2 above).

**Tips for Creating Custom Controls**

A control panel custom control allows you to automate a series of button presses into a single macro. There are, however, a number of things that you must keep in mind when creating a custom control in order to create a custom control that will produce the desired effect. These tips are as follows:

- If you are including a memory recall in the custom control, you must ensure the Auto Recall settings are the same as when the memory was stored. This ensures a consistent output.

- A custom control only records that a specific button was pressed, and does not record the state that the button was in. For example, if you create a macro that toggles a function such as a key modifier, the system will alternately turn that function on and off each time it is played.

- To program a custom control that will recall a memory and then perform a transition, you must recall the memory on the MLE you want to perform the transition on, then use the Cut or Auto Trans buttons to perform the transition. A custom control cannot record the movement of a fader.

- A custom control will not automatically compensate for the time a memory recall or transition will require to complete. In these cases, you must insert a custom control pause after the event that requires time to complete. Refer to the section “Custom Control Pauses” on page 10-34 for more information.

- You can insert a Custom Control Hold command into a custom control that will hold the custom control at a specific point until the continue command is received. The custom control is continued by either pressing the custom control button again, or by a GPI Input trigger. Refer to the section “Custom Control Holds” on page 10-31 for more information.

- You can create a Looping Custom Control by inserting a Loop CC event into the custom control.

- If you are creating a long or Looping Custom Control, you can stop that custom control by pressing the custom control button. This applies only to the custom control assigned to that button.

- You can insert a Run Custom Control command into a custom control that will automatically run another custom control. If the Multiple Custom Control feature is active, both custom controls can run at the same time. If the Multiple Custom Control feature is inactive, only the custom control that contains the Run Custom Control command will run.
feature is turned off, inserting a Run Custom Control command ends the recording, and playing, of the first custom control. Refer to the section “Running Multiple Custom Controls” on page 10-16 for information on running multiple custom controls. If a custom control starts multiple custom controls, you must stop each one individually, or use the Stop Other Custom Control command.

- You can run multiple custom controls at the same time by pressing the corresponding custom control button. If a custom control is already running, pressing the button again will stop it.

- You can insert a Select Custom Control Bank command into a custom control that will select a different custom control bank when the custom control is done. To insert the Select Custom Control Bank command into a custom control, double-press the custom control button for the bank you want to select as you are recording the custom control. This will end the recording of the custom control. A custom control can have only one Select Custom Control Bank or Run Custom Control command.

**Relative Custom Controls**

**Important** Relative Custom Controls can only be properly recorded and recalled on upper MLEs that are re-entered onto the PGM/PST MLE. If the MLE is not re-entered, you will not be able to properly record or recall a relative custom control. Instead, the relative custom control will act like a normal custom control when recalled.

Relative Custom Controls store the MLE re-entry position so that they can be taken on-air from any MLE that is re-entered on the PGM/PST MLE. For example, if you have MLE 2 re-entered into MLE 3 (Configuration 1), of a Synergy 2.5 Q/MD switcher, and Record a Custom Control on MLE 2, you can only recall that custom control on MLE 2, in the same configuration. If, however, you have MLE 1 re-entered into MLE 3 (Configuration 2), the Relative Custom Control will be recalled on MLE 1.

Relative Custom Controls are not MLE specific, as normal custom controls, but instead are re-entry specific. This means that the re-entry order, or levels that the Relative Custom Control was recorded on, do not need to be the same in order to recall that custom control. For example, if we again record a Relative Custom Control on MLE 2, of a Synergy 2.5 Q/MD, which is re-entered into MLE 3 (Configuration 1), we can recall that Relative Custom Control with more or fewer MLEs. If we have MLE 1 re-entered into MLE 2 and MLE 2 re-entered into MLE 3 (Configuration 3), the Relative Custom Control will be recalled on MLE 1. If we have no MLEs re-entered, (Configuration 4) the Relative Custom Control will be recalled on MLE 3.
Use the following procedure to program a relative custom control button with basic functions:

1. Set up your MLE re-entry configuration to record the relative custom control at the Re-entry level you want.

2. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

3. Select the Custom Control bank and button that you want to record to as follows:
   - Use the Bank knob to select the custom control bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button that you wish to program. You can also press the button directly on the panel.

Note: Buttons with an at (@) next to them in the list are already programmed with a relative custom control, however, they can be overwritten or edited. Refer to the section “Editing Custom Control Macros” on page 10-42 for more information.

Important: If you record a relative custom control across multiple re-entered MLEs, at least the same number of MLEs must be re-entered in order to recall the entire custom control. For example, if a two MLE relative custom control is recalled on one MLE, the actions to be recalled on the second MLE will be ignored.

Note: You must record a relative custom control on an MLE that is re-entered onto the PGM/PST MLE for it to run properly.
4. Press **Start Relative Recording** to display the **Recording Menu**.

5. With the recording in progress, press the buttons on the control panel that you would like to have played back, in order. All subsequent keystrokes will be remembered, *in the exact order that you press them*.

6. Insert any special functions you want as follows:
   - Press **Insert Special** to display the **Insert Special Menu 1-2**.
   - Refer to the section “Programming Special Functions” on page 10-18 for information on inserting special functions.

7. Press **Finish Recording** when you have finished recording the macro.

---

**Note**

Press **Cancel Recording** to terminate the programming procedure. The macro will *not* be recorded.

---

You will notice an “@” symbol next to the custom control you just recorded, indicating that this relative custom control contains information.

This completes the procedure for recording a relative custom control.

---

**Running Multiple Custom Controls**

The Multiple Custom Controls feature allows you to have a single custom control start multiple other custom controls, or you can manually start multiple custom controls using the corresponding custom control buttons. All the custom controls will continue to play out until they reach the end, or loop.

---

**Operating Tip**

You can insert a **Stop Other Custom Controls** command that will stop all other running custom controls, except the one that is currently running. Refer to the section “Stop Other Custom Controls” on page 10-31 for more information.
If the Multiple Custom Controls feature is turned off, a Run Custom Control command ends the current custom control. Pressing another custom control button also stops the first custom control and starts the second.
Programming Special Functions

The following sections describe how to program your custom controls with various other special functions. Refer to the section “Editing Custom Control Macros” on page 10-42 for more information on inserting events into existing custom control macros.

The following functions are covered in this section:

- Time Clock Functions
- Special Functions
- Pbus

Time Clock Functions

The Synergy Q/MD switcher allows you to program custom control buttons with Time Clock functions.

Use the following procedure to program one or more custom control buttons with special Time Clock functions.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Time Clock to display the Insert Time Clock Menu. This menu allows you to choose specific Time Clock control functions to assign to the button.
6. Select a Time Clock function to insert as follows:
Use the **Function** knob to select the function that you want to assign to the custom control. Use the table “**Time Clock Custom Control Functions**” on page 10–19 to determine which function you want to insert.

**Note**
The middle **Reset Time** knob only applies to the insert **Reset** command. No value will be displayed for other commands.

**Time Clock Custom Control Functions**

<table>
<thead>
<tr>
<th>Time Clock Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Up</td>
<td>Starts the <strong>Preview Overlay</strong> clock counting up from zero.</td>
</tr>
<tr>
<td>Count Down</td>
<td>Starts the <strong>Preview Overlay</strong> clock counting down from the preset time to zero.</td>
</tr>
<tr>
<td>Count Down/Up</td>
<td>Starts the <strong>Preview Overlay</strong> clock counting down from the preset time to zero, when it will then start counting up from zero until you press <strong>Reset</strong> or <strong>Stop</strong>.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the <strong>Preview Overlay</strong> clock.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the <strong>Preview Overlay</strong> clock to the preset time.</td>
</tr>
</tbody>
</table>

**Operating Tip**

Time Clock functions can be strung together, allowing one custom control button to perform multiple functions when it is pressed. For example, you can have the **Reset** function following by the **Count Down** function, allowing a single custom control macro to reset the Time Clock and start it counting down.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording**, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming one or more custom control buttons with special **Time Clock** functions.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Special Functions

Custom control buttons can be programmed to perform a variety of special functions for operational convenience and efficiency. These functions include the following:

- Reset GPI
- Trigger GPI
- Automation
- Go To Menu
- Transition Keys and Cut Keys
- Run Sequence
- Safe Title
- Custom Control Loops
- Stop Other Custom Controls
- Custom Control Holds
- Custom Control Pauses

For device specific custom controls, such as for robotic cameras, or audio mixer, refer to the applicable device chapter in the *Synergy Q/MD* or *Q/MD-X Engineering Manual, Volume II*.

**Reset GPI**

Use the following procedure to program a GPI reset:

1. Navigate to the *Custom Controls Menu 1-2* as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Special to display the Special Menu.

**Operating Tip**

As a recommendation, keep special functions grouped together on your physical custom control buttons.
6. Assign the reset GPI to a GPI output as follows:
   • Use the Selection knob to select Reset GPI.
   • Use the GPI Output knob to select the GPI output port you want to reset.

   **Note**
   The names that appear in the GPI Output list will also be shown when editing the custom control. The names are programmed on the GPI Output Setup Menu. Refer to the section “Standard GPI Setup” on page 11-17 for details.

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press UP ONE to display the Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

   This completes the procedure for programming a GPI reset.

**Trigger GPI**

Use the following procedure to program a GPI output trigger:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

   ![Operating Tip]
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

   ![Insert Special — Special Menu]

6. Assign the trigger GPI to a GPI output as follows:
   - Use the **Selection** knob to select **Trigger GPI**.
   - Use the middle **GPI Output** knob to select the GPI output port you want to trigger.

   ![Note]
   The names that appear in the **GPI Output** list will also be shown when editing the custom control. The names are programmed on the **GPI Output Setup Menu**. Refer to the section “Standard GPI Setup” on page 11-17 for details.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.
8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.
9. Press **UP ONE** to display the **Recording Menu**.

   ![Custom Controls — Recording Menu]

   Custom Controls — Recording Menu
10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming a GPI output trigger.

**Automation**

Use the **Automation** function to create custom controls that accept commands from an external automation system.

Use the following procedure to create an Automation custom control macro:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ➔ Custom Controls**.

2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

3. Press **Start Recording** to display the **Recording Menu**.

4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **Special** to display the **Special Menu**.

6. Assign an automation function to the selected custom control macro as follows:
   - Use the **Selection** knob to select **Automation**.
   - Use the **Command** knob to select the command you want the macro to perform. You can select between the following:
     - **Keys Off Air** — Select this option when you want all on-air *Keys*, on all MLEs, to be dissolved off-air when the custom control is run.
     - **Act MLE Trans** — Select this option when you want all MLEs that are contributing the PGM output, except for the PGM/PST MLE, to be transitioned according to the settings in the **MLE Transition Group**. For example, if MLE 1, of a **Synergy 2.5 Q/MD Switcher**, is re-entered onto
MLE 2 and MLE 2 is re-entered onto MLE 3, the Active MLE Trans custom control will perform a transition on both MLE 1 and MLE 2.

**Important**

If you have more than one re-entry set up for a shot, the Active MLE Trans custom control will transition all on-air MLEs. If you have an MLE re-entered onto the BKGD bus of another MLE, the Active MLE Trans custom control will transition the MLE re-entry with whatever you have selected on the PST bus of that MLE.

7. Press **Insert** to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the Recording Menu.

10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating an automation custom control macro.

**Go To Menu**

Use **Go To Menu** to create custom controls that automatically display Squeeze & Tease MD menus. You must be flying a key when you run the custom control for the Squeeze & Tease MD menu to display.

Use the following procedure to create a Squeeze & Tease MD Go To Menu custom control macro:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

3. **Operating Tip**

   As a recommendation, keep special functions grouped together on your physical custom control buttons.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **Special** to display the **Special Menu**.

![Insert Special — Special Menu](image)

6. Assign which menu is displayed from the selected custom control macro as follows:
   - Use the **Selection** knob to select **Go To Menu**.
   - Use the **Type** knob to select **3D**.
   - Use the **Menu** knob to select the menu you want to display when the custom control is run. You can select between the following:
     - **Position/Crop** — Select this option to display the **S&T MD Position/Crop Menu 1-2** for the active **Fly Key** when the custom control is run.
     - **Border** — Select this option to display the **S&T MD Border Menu** for the active **Fly Key** when the custom control is run.
     - **Sequence** — Select this option to display the **S&T Sequence Menu 1-2** for the active **Fly Key** when the custom control is run.
     - **Preprocessor** — Select this option to display the **S&T MD Preprocessor Menu** for the active **Fly Key** when the custom control is run.
     - **WARP** — Select this option to display the **S&T WARP Menu** for the active **Fly Key** when the custom control is run.
     - **Ch Management** — Select this option to display the **Channel Management Menu** for the active **Fly Key** when the custom control is run.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

**Note**

When you run a **Go To Menu** custom control, the menu that is displayed will be determined by the current active **MLE** and **Keyer**. If **Key 2** is active on **MLE 2**, the menu will be displayed for **Key 2** on **MLE 2**.
9. Press **UP ONE** to display the **Recording Menu**.

<table>
<thead>
<tr>
<th>Custom Controls (1-2)</th>
<th>Bank:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording...</td>
<td></td>
</tr>
<tr>
<td>Selected: Bank 1 Button 1 [Custom81]</td>
<td></td>
</tr>
<tr>
<td>Custom Control Legend:</td>
<td></td>
</tr>
<tr>
<td># = normal custom control button</td>
<td></td>
</tr>
</tbody>
</table>

**Custom Controls — Recording Menu**

10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating a Squeeze & Tease MD **Go To Menu** custom control macro.

**Transition Keys and Cut Keys**

- **Note**: The **Trans Keys** and **Cut Keys** functions cannot initiate a transition if a transition is already in progress on the associated MLE.

Use the **Trans Keys** or **Cut Keys** feature to perform key transitions or cuts with a custom control.

Use the following procedure to perform key transitions with a custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

- **Operating Tip**: As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.
6. Assign which key transitions to perform as follows:

- Use the **Selection** knob to select **Trans Keys** (to perform an auto transition) or **Cut Keys** (to perform a cut).
- Use the **For** knob to select the MLE or MultiDSK that you want to transition the Keys for. You can select between the following:

  ~ **MLE 1** — Select this option to transition the Keys on MLE 1.
  ~ **MLE 2** — Select this option to transition the Keys on MLE 2.
  ~ **MLE 3** — Select this option to transition the Keys on MLE 3.
  ~ **MLE 4** — Select this option to transition the Keys on MLE 4.
  ~ **DSK 3/4** — Select this option to transition the **MultiDSK Downstream Keyers**.

- Use the **To** knob to select the Keys you want to transition. You can select between the following:

  ~ **Key1 Off** — Select this option to have Key 1 dissolve **off-air** when the custom control is run.
  ~ **Key2 Off** — Select this option to have Key 2 dissolve **off-air** when the custom control is run.
  ~ **Key1+2 Off** — Select this option to have both Key 1 and Key 2 dissolve **off-air** when the custom control is run.
  ~ **Key1 On** — Select this option to have Key 1 dissolve **on-air** when the custom control is run.
  ~ **Key2 On** — Select this option to have Key 2 dissolve **on-air** when the custom control is run.
  ~ **Key1+2 On** — Select this option to have both Key 1 and Key 2 dissolve **on-air** when the custom control is run.
  ~ **Key1 Only** — Select this option to have the switcher dissolve Key 1 and Key 2 so that only Key 1 is **on-air** when the custom control is run. For example, if Key 1 is **off-air** and Key 2 is **on-air**, this custom control would dissolve Key 1 **on-air**, and at the same time dissolve Key 2 **off-air**.
  ~ **Key2 Only** — Select this option to have the switcher dissolve Key 1 and Key 2 so that only Key 2 is **on-air** when the custom control is run.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

---

**Note**

The number of MLEs you have available will depend on your switcher. For this menu, the **DSKs** associated with the **PGM/PST MLE** are referred to as **Keys**.
9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for performing key transitions with a custom control.

**Run Sequence**

The Run Sequence custom control allows you to have a custom control run a sequence on the selected MLE and Keyer. This allows you to run a dissolve or wipe and still run a sequence in the same MLE.

Use the following procedure to insert a run sequence custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME** ⇒ **Custom Controls**.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button **directly** on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.
6. Insert a Run Sequence CC as follows:

---

---
• Use the Function knob to select Run Sequence.
• Use the MLE knob to select the MLE that you want to have the sequence run on.
• Use the Key knob to select the Keyer that you want to have the sequence run on.

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press UP ONE to display the Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for inserting a run sequence custom control.

**Safe Title**

Use the Safe Title feature to program a custom control button to recall a specific user-configured safe title setting. Refer to Chapter 10, “Peripheral Control and More” in the Synergy Q/MD/X Operator’s Manual for more information on setting up the safe title.

**Note**

The safe title function will only recall a stores Safe Title setting and will not turn the safe title on or off.

Use the following procedure to recall a safe title setting with a custom control button:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   • Use the Bank knob to select the custom control bank you want to record the custom control to.
   • Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

**Operating Tip**

As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press **Special** to display the **Special Menu**.

6. Assign a safe title to be recalled as follows:
   - Use the **Selection** knob to select **Safe Title**.
   - Use the **Safe ID** knob to select the stored Safe Title set up that you want to recall when you run the custom control.

7. Press **Insert** to enter the safe title into your custom control macro.

8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for recalling a safe title setting with a custom control button.

**Custom Control Loops**

The Loop Custom Control command allows you to have a custom control run continuously until you stop it, or a Stop Custom Control command is executed from another custom control.

Use the following procedure to insert a Loop Custom Control command into a custom control:

1. Navigate to the **Custom Controls Menus** as follows:
   - Press **HOME** ⇒ **Custom Controls**.
2. Select the custom control button you want to record to.
3. Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.
4. Insert a Loop command into the custom control as follows:
   - Use the **Function** knob to select **Loop CC**.
5. Press UP ONE to display the Custom Controls Menus.
6. Press Finish Recording on the Custom Control Menu 1-2 to finish recording to the custom control. The custom control button stops flashing.

This completes the procedure for inserting a Loop Custom Control command into a custom control.

**Stop Other Custom Controls**

The Stop Other Custom Control command allows you place a command in a custom control that will stop all other running custom controls, except the one the command is in. This can be used to stop other looping custom controls at a specific point.

Use the following procedure to insert a Stop Other command into a custom control:

1. Navigate to the Custom Controls Menus as follows:
   - Press HOME ➔ Custom Controls.
2. Select the custom control button you want to record to.
3. Press Start Recording ➔ Insert Special ➔ Special.
4. Insert a Stop Other command into the custom control as follows:
   - Use the Function knob to select Stop Other CC.
   - Press Insert to insert the selected command into the custom control and display the Insert Special Menu.
5. Press UP ONE to display the Custom Controls Menus.
6. Press Finish Recording on the Custom Control Menu 1-2 to finish recording to the custom control. The custom control button stops flashing.

This completes the procedure for inserting a Stop Other command into a custom control.

**Custom Control Holds**

Use the Custom Control Hold feature to place “holds” within a custom control sequence. When entered, these holds specify a point to stop and wait for a user button-press (of the same custom control) or an external trigger (Editor or GPI). The macro then executes from that point until it reaches its end or another embedded hold.

The Hold CC allows the user to manually determine in real time, how long a macro is stopped. For example, a macro is initiated by the operator and when it reaches the Hold CC, it stops playing. The operator then waits until the interview (or whatever) is finished, presses the macro button again, and the macro resumes playing.

A hold is automatically inserted when you perform a Still-Store capture during the recording of a custom control.
1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

   ![Operating Tip](image)
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Special to display the Special Menu.

   ![Insert Special — Special Menu](image)

6. Assign a Custom Control Hold as follows:
   - Use the Selection knob to select Hold CC.
   - Use the Popup knob to select the type of popup notification you want to appear when the hold is performed. You can select between the following:

     ![Note](image)
     When a macro is held, the name of the macro appears in the Main Menu and Custom Controls Menu. The Hold CC also extends the time that the associated custom control button will remain lit until the macro is continued or cancelled.

     ~ No Popup — Select this option to have only a message displayed on the Main Menu or the Custom Control Menu when a custom control hold is being performed.
Main Menu — Custom Control Held

Custom Controls Menu — Custom Control Held

～ 1-Time Popup — Select this option to have a popup appear on any menu when a custom control is being held. This popup will only appear once.

7. Press **Insert** to enter the Custom Control Hold into your custom control macro.
8. Press **UP ONE** to return to the Custom Controls Recording Menu.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for placing a Hold CC within a custom control sequence.
**Custom Control Pauses**

Use the **Custom Control Pauses** feature to place “pauses” within a custom control sequence. With a pause inserted, a sequence can have a duration rather than being executed instantaneously. With multiple pauses placed in between macro events, controlled switching between sources becomes possible. Pressing the custom control button again during the wait time will immediately resume the macro.

Use the following procedure to place a pause within a custom control macro:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press HOME ⇒ **Custom Controls**.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

   ![Insert Special — Special Menu](image)

6. Assign a pause to the custom control as follows:
   - Use the **Selection** knob to select **Pause CC**.
   - Use the **Seconds** knob to set the duration of the pause in seconds.
   - Use the **Frames** knob to set the duration of the pause in frames.

**Operating Tip**

As a recommendation, keep special functions grouped together on your physical custom control buttons.

**Note**

Similar to a Custom Control Hold, a Pause will display a message on the Main Menu or the Custom Control Menu indicating that the custom control is paused.
7. Press **Insert** to enter the Custom Control Hold into your custom control macro.

8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for placing a pause within a custom control macro.

**Pbus**

A custom control button can be programmed to send messages to devices using the **Pbus** protocol.

**Note**

Ensure that the **Pbus** option is installed and that the Pbus device you want to control is properly connected and configured with the Synergy Switcher. Refer to the section “**Pbus Protocol Setup**” on page 9-11 for more information on setting up a Pbus device.

Use the following procedure to create a custom control that will send commands to devices using the Pbus protocol:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   • Use the Bank knob to select the custom control bank you want to record the custom control to.
   • Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

   ![Operating Tip]

   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press PBUS to display the Insert PIP-II Menu.

   ![Insert Special — Insert PIP-II Menu]

6. Assign a command to a Pbus device for the custom control as follows:
   • Use the Selection knob to select the Pbus device you want to assign a command to. You can select between the following:

   ![Note]

   The Ports are identified by the remote port on the Synergy control panel that the Pbus device is connected to. For example, if a Pbus device is connected to Remote Port 1 on the control panel, the ports for the Pbus device will be labelled as Port R1 DevXX.

   ~ **ALL** — Select this option to have the Pbus command sent to all Pbus devices connected on the selected remote port.
   ~ **DevXX** — Select this option to have the Pbus command sent to a specific Pbus device (Dev 0 to Dev23) attached to the selected remote port.
- Use the **Command** knob to select the command you want to send to the selected Pbus device. You can select between the following:
  - **Trigger** — Select this option to have a specific trigger value (0 to 15) sent to the Pbus device when the custom control is run.
  - **Store** — Select this option to have the Pbus device store a specific memory value (0 to 4095) when the custom control is run.
  - **Recall** — Select this option to have the Pbus device recall a specific memory value (0 to 4095) when the custom control is run.

- Use the **Value** knob to select the **Trigger**, **Store** or **Recall** Value that you want.

**Note**

Although the Pbus protocol allows for memories up to 4095, your specific device may not support this many. Refer to the documentation that came with your device to determine the number of memories you have available.

7. Press **Insert** to enter the Pbus command into your custom control macro.

8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating a custom control that will send commands to devices using the Pbus protocol.
Naming Custom Controls

A custom control button can be named for ready identification in the menus, and in the mnemonic displays if that option is installed.

Once your custom control buttons have been programmed, be sure to properly name and label them. Refer to the section “Control Panel Pushbutton Inserts” on page 4-25 for instructions on labeling the actual buttons.

Use the following procedure to apply a name to a custom control button.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to set the name for:
   • Use the Bank knob to select the custom control bank with the custom control you want to set the name for.
   • Use the Button knob to select the custom control button that you want to set the name for. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) in the list have already been programmed.
3. Press Modify Name to display the Custom Control Name Menu 1-2.

   Custom Control Name Menu 1-2, with Optional Mnemonic Field

   - Use the Horizontal knob to move the cursor horizontally up or down a row to select a letter.
   - Use the Vertical knob to move the cursor vertically up or down a column to select a letter.

   Note
   The Synergy 1 control panel does not support the Mnemonics Display option and does not show the Mnemonic preview in the Custom Control Name Menu.

4. Assign a New Name to the custom control as follows, or continue to the next step to enter a Preset Name:

   Operating Tip
   A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

   • Use the Horizontal knob to move the cursor horizontally up or down a row to select a letter.
   • Use the Vertical knob to move the cursor vertically up or down a column to select a letter.

   Note
   As you rotate the Horizontal and Vertical knobs, note that the MLE pushbuttons that correspond to each character (in sequence) light. If desired, you can press the MLE pushbutton to select a character.
• Press **Next Letter** to accept the currently selected letter and begin selection of the next letter.

**Note**

If you make a mistake, you can use the **Prev Letter** button to go back and adjust a letter.

• Press **Space** if you want to enter a space in the name.

5. Assign a **Preset Name** to the custom control as follows:

**Note**

If you start editing the name immediately, and then decide at some point to choose a preset name instead, **all characters** in the custom name will be replaced by the preset name.

• Press **Preset Names** to display the **Preset Names Menu**.

<table>
<thead>
<tr>
<th>Preset Names</th>
<th>1CDk#st</th>
<th>CDk#Set</th>
<th>Chk#Strt</th>
<th>DUE End</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Name: [Custom1]</td>
<td>New Name: [Custom1]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Preset Names Menu**

**Operating Tip**

A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

• Use the **Name** knob to select a preset name (a prefix) from the list of typical custom control names.

• Press **Select** to accept the preset name, or **Cancel** to return to the previous menu.

**Operating Tip**

You can edit a preset name on the **Custom Name Menu** just as you would a **New Name** you entered. Refer to step 4 above.

6. Press **Accept New Name** to save the new name.

**Note**

If you exit the installation menus without first pressing **Accept New Name**, the following screen is displayed.

The entry “ --- ” has changed to “ --- ”, abandon the changes?

• Press **Yes** to abandon changes and move to the new custom control number. The name reverts to its previous name as stored in memory.

• Press **No** to retain changes without moving to the new custom control number.

This completes the procedure for naming your custom controls.
## Customizing Mnemonic Displays — Buttons

**Note** The Synergy 1 control panel does not support the Mnemonic Display option and does not have the Custom Controls Name Menu (2-2).

If the Mnemonic Display option is purchased and installed, use the following procedure to customize the display appearance:

1. Navigate to the Custom Control Name Menu 2-2 as follows:
   - Press HOME ⇒ Custom Controls ⇒ Modify Name ⇒ MORE.

![Custom Control Name Menu 2-2](image)

2. Adjust the appearance of the Mnemonic Display name for the custom control as follows:
   - Use the Font knob to select the size of the font. You can select from the following:
     - **Standard** — Select this option to use the default mnemonic format as set from the Personality Menu.
     - **Small** — Select this option to use a small font that permits up to 6 characters per line.
     - **Small Invert** — Select this option to use a small font that permits up to 6 characters per line, and draws light text on a dark background.
     - **Medium** — Select this option to use a medium font that permits up to 4 characters per line.
     - **Medium Invert** — Select this option to use a medium font that permits up to 4 characters per line, and draws light text on a dark background.
     - **Large** — Select this option to use a large font that permits only 2 characters per line.
     - **Large Invert** — Select this option to use a large font that permits only 2 characters per line, and draws light text on a dark background.
     - **NONE** — Select this option to use no font in the mnemonic display. The display will only show the selected background color, with no text.
   - Use the Color knob to select the color of the display. You can select from the following:
3. Select how the name will appear in the mnemonic display as follows:
   - Press **Next Start Pos** to adjust the point in the name where the text on the mnemonic display starts. For example, if you have the name **Custom01**, you can press the **Next Start Pos** button until the cursor is over the 0 to have only 01 appear on the mnemonic display.
   - Press **Prev Start Pos** to move the cursor in the opposite direction as the **Next Start Pos**.

4. Press **Accept New Name** to save the display style in memory.

   **Note**
   If you exit the installation menus without first pressing **Accept New Name**, the following screen is displayed.

   
   This entry “ --- ” has been changed to “ --- ”. Abandon the changes?
   
   - Press **Yes** to abandon changes and move to the new custom control number. The name reverts to its previous name as stored in memory.
   - Press **No** to retain changes without moving to the new custom control number.

This completes the procedure for naming and customizing the look of your custom controls.
Editing Custom Control Macros

After your custom control buttons have been programmed, you may wish to review and edit the contents. Events can easily be inserted or deleted through the Custom Controls Menu.

Use the following procedure to edit a custom control button:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the Custom Control bank and button that you want to edit as follows:
   - Use the Bank knob to select the custom control bank that you want to edit the custom control on.
   - Use the Button knob to select the custom control that you wish to edit.

   **Note** Buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be edited.

3. Press Edit to display the Edit Custom Control Menu.

The main area displays the location of the custom control that you are editing (Bank 1 Button 1 [Custom01]), and the contents of the custom control, including the number of events, the duration of the macro, and details of the event highlighted in the scroll area.

**Note** If your macro includes pauses or holds, a timeline will be displayed showing these events.

The Scroll Area provides a list of the events currently programmed into the custom control button.

**Note** If the custom control has been programmed to recall a memory, as in the example above, the memory name is displayed in the main area. If memories from more than one MLE are being recalled, the name from the highest MLE is displayed.

- The Scroll Area provides a list of the events currently programmed into the custom control button.
- The Label Area provides softkeys for inserting, deleting, and running the events, as required. The can select between the following:
  - Go To Start — Select this function to go to the start of the macro.
~ **Insert Events** — Select this function to insert an event before the currently highlighted event. Refer to the section “Inserting Events” on page 10-44 for more information on inserting events.

~ **Delete Event** — Select this function to delete the currently highlighted event. This cannot be undone.

~ **Modify Event** — Select this function to modify the currently highlighted event. The Modify Event function will take you to the Insert Special - Special Menu that was used to create the event.

**Note**

Only certain functions found on the Special Menu, such as Pause CC, can be modified.

~ **Run Single Event** — Select this function to run the currently highlighted event. Only the selected custom control event will be played.

~ **Run From Here** — Select this function to run the custom control, starting from the currently highlighted position.

This completes the procedure for editing a custom control. Refer to the section “Inserting Events” on page 10-44 for more information on inserting an event into a custom control.

**Modifying Events**

The Modify Event function allows you to modify certain events in an already existing custom control. Only events such as Pause CC can be modified.

Use the following procedure to modify an event in a custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the Custom Control bank and button that you want to edit to as follows:
   - Use the Bank knob to select the custom control bank that you want to edit the custom control on.
   - Use the Button knob to select the custom control that you wish to edit.

**Note**

Only buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be edited.

3. Press Edit to display the Edit Custom Control Menu.

   ![Edit Custom Control Menu]

   **Edit Custom Control Menu**

4. Use the Event knob to select the event you want to modify.
5. Press **Modify Event** to display the **Modify Event Menu**.

![Modify Event Menu](image1)

**Edit Custom Control — Modify Event Menu (Pause CC)**

6. Modify the event in the same manner that you inserted it originally. Refer to the section “**Programming Special Functions**” on page 10-18 for more information on inserting special functions.

7. Press **Insert** to save your changes.

8. Press **UP ONE** to display the **Inserting Menu**.

![Inserting Menu](image2)

**Custom Controls — Inserting Menu**

9. Press **Finish Inserting** to finish inserting to the selected custom control.

![Operating Tip](image3)

**Operating Tip**

Press **Cancel Inserting** to return to the previous menu without recording any of the insertions you made.

This completes the procedure for modifying a custom control event.

**Inserting Events**

The **Edit Custom Control Inserting Menu** provides a means by which you can append a variety of events to an already existing custom control macro. Events are inserted immediately before the event that is currently highlighted in the scroll area.

Use the following procedure to insert events into a custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ➔ Custom Controls**.

2. Select the Custom Control bank and button that you want to insert an event into as follows:
   - Use the **Bank** knob to select the custom control bank that you want to edit the custom control on.
• Use the **Button** knob to select the custom control that you wish to edit.

**Note**

Only buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be edited.

3. Press **Edit** to display the **Edit Custom Control Menu**.

```
Edit Custom Control
Bank 1 Button 1 (Custom01)

Event: 2 of 4  Pause  Length: 4:00
Duration: 3:00

Go To  Insert  Delete  Modify  Run  Run
      Events  Event  Single Event

Set Keys
Pause 100
Set Keys
Pause 100
END
```

4. Select the location to insert an event into a custom control as follows:

• Use the **Event** knob to select the location in the custom control macro that you want to insert an event. The new event will be inserted before the selected event.

• Press **Insert Event** to display the **Inserting Menu**.

```
Edit Custom Control — Insert Events Menu
```

5. Insert any **Control Panel** events into the custom control macro as follows:

• Enter the new event or events that you want to insert at the selected location in the same way you would record new events. Refer to the section “Programming Control Panel Functions” on page 10-11 for more information on inserting control panel events.

6. Insert any **Special** events into the custom control macro as follows:

• Press **Insert Special** to display the **Insert Special Menu 1-2**.

```
Insert Special Menu 1-2
```

---

*Synergy Q/MD Engineering Manual (v9.1 MD)*

*Custom Controls • 10–45*
• Enter the new event or events that you want to insert at the selected location in the same way you would record new events. Refer to the section “Programming Special Functions” on page 10-18 for more information on inserting special events.

• Press UP ONE to display the Inserting Menu.

<table>
<thead>
<tr>
<th>Edit Custom Control</th>
<th>Bank 1 Button 1 (CustomB1)</th>
<th>Inserting...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Special</td>
<td>Finish Inserting</td>
<td>Cancel Inserting</td>
</tr>
</tbody>
</table>

7. Press Finish Inserting to finish inserting to the selected custom control.

☐ Operating Tip

Press Cancel Inserting to return to the previous menu without recording any of the insertions you made.

This completes the procedure for editing your custom control buttons.
Copying or Moving Custom Controls

When a custom control has been programmed, the commands in that custom control can be copied, or moved, to any other custom control on the switcher. This allows you to duplicate custom controls on different banks, or re-organize the custom controls.

Use the following procedure to copy or move a custom control:

1. Navigate to the Manage Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls ⇒ Copy/Move Macros.

2. Use the Source knob to select the custom control you want to copy or move. The name of the custom control is followed by the bank the custom control is on, and the number of the custom control.

3. Use the Destination knob to select the custom control that you want to copy, or move, the source custom control to. The name of the custom control is followed by the bank the custom control is on, and the number of the custom control.

4. Copy a custom control as follows:
   - Press Copy to copy the source custom control to the destination. Both custom controls will contain the same commands.

5. Move a custom control as follows:
   - Press Move to move the source custom control to the destination. The commands in the source custom control are moved to the destination. The source custom control will be empty after the move.

This completes the procedure for copying or moving a custom control.
Deleting Custom Controls

Use the following procedure to delete a custom control function from a button.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the Custom Control bank and button that you want to delete to as follows:
   - Use the Bank knob to select the custom control bank that you want to edit the custom control on.
   - Use the Button knob to select the custom control that you wish to edit.

   Note: Only buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be deleted.

3. Press Delete Macro.

   Confirmation — Delete Custom Control

   • Press Yes to delete the custom control macro.
   • Press No to cancel the procedure without deleting the macro.

This completes the procedure for deleting custom control macros.
Saving and Recalling Custom Controls

For archive purposes and to keep safe backup copies of your valuable macros, it is recommended that you store your custom control functions to the switcher hard drive or a USB key. This also allows you to keep a library of custom functions that can be recalled as required for your current production configuration.

- Refer to the section “Saving Registers” in the *Synergy Q/MD/X Operator’s Manual* for instructions on saving custom control (and other types of) registers.
- Refer to the section “Recalling Registers” in the *Synergy Q/MD/X Operator’s Manual* for instructions on recalling custom control (and other types of) registers.

**Note**

You cannot store to or recall from the hard drive or a USB key while a custom control function is playing.
Video Checksums Custom Controls

The Video Checksums custom control is a diagnostic tool that allows technical support and other Ross Video Staff to diagnose the operation of specific switcher functions based on the video output of the MLEs. When a checksum is inserted into a custom control macro, the switcher records the values that are returned at that point. When the custom control is run again, the switcher will compare the new values that are returned against the stored values and report either an error or a validation at the end of the custom control.

Types of Checksums

There are two types of checksums that can be computed in a custom control: short and long. The difference between these types is based on the checksum register(s) and video stream(s) used to compute and verify the checksum values.

Each MLE has four checksum registers:

- FE out (Front End FPGA out)
- Vid in (Video Processor in)
- Vid out (Video Processor out)
- FE in (Front End FPGA in)

A short checksum allows you to pick which of these four registers is used to compute the checksum. As stated above, checksum values are based on specific video output so selecting a short checksum also allows you to select which video stream to use as follows:

- **FE out** and Vid in checksums
  - Background
  - Preset
  - K1A/K2A
  - K1V
  - Trans_mix 0/1
  - K2V
- **Vid out** and FE in checksums
  - Program
  - Prview
  - Clean

A long checksum calculates checksum values for each of the four checksum registers with each of the video streams. No user intervention is required.

Setting Up a Checksum Custom Control

Use the following procedure to add a Checksum to a custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ➔ Custom Controls.
2. Select the custom control button you want to record to as follows:
3. Press **MORE** to display the **Custom Control Menu 2-2**.

4. Activate the Checksums feature as follows:
   - Toggle the **Checksums** softkey to turn this feature **On** or **Off**:
     - **On** — When the Checksum feature is **On**, you can use the buttons in the **Mattes Group** to add checksum events for specific MLEs or all MLEs to the custom control.
     - **Off** — When the Checksum feature is **Off** the buttons in the **Mattes Group** perform normally.

**Note**

The **Checksums On/Off** setting does not affect how a custom control is played back, only how it is recorded.

5. Press **Short** or **Long** to select the type of checksum to perform. If you select a short checksum, you must also:
   - Use the **Checksum reg** knob to select which checksum register to use in calculations. Refer to the section “**Types of Checksums**” on page 10-50 for information on selecting checksum registers.

**Note**

Selecting **All** will run checksums on each of the registers with the video stream last selected for that register. To change video streams for a particular checksum register, select that register specifically.

   - Use the **Input Video** knob (**FE out** and **Vid in** checksums) to select the input video stream to use in calculations.
Selecting Input Video Stream

OR

• Use the the **Output Video** knob (Vid out and FE in checksums) to select the output video stream to use in calculations.

Selecting Output Video Stream

6. Press **MORE** to display the **Custom Control Menu 1-2**.
7. Press **Start Recording** to display the **Recording Menu**.

<table>
<thead>
<tr>
<th>Custom Controls (1-2)</th>
<th>Bank: Bank 1 (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording...</td>
<td></td>
</tr>
<tr>
<td>Selected: Bank 1 Button 1 [Custom@1]</td>
<td>Button: Custom@1</td>
</tr>
<tr>
<td>Custom Control Legend:</td>
<td></td>
</tr>
<tr>
<td># - normal custom control button</td>
<td></td>
</tr>
</tbody>
</table>

---

**Custom Controls — Recording Menu**

**Note**

In order for the checksum values to be validated, the video signal used when running a test must be the same that was used when the test was recorded. Only stills or internally generated signals, such as color patterns, should be used in checksum custom controls.

---

8. Add standard events into your macro as needed.

**Important**

A 4 frame **Pause CC** should be added to the custom control macro before each checksum if the video signal has been changed. This is to ensure that enough time has passed to allow the new video signals to propagate through the switcher. Refer to the section “**Custom Control Pauses**” on page 10-34 for more information on inserting a pause.

---

9. Add **Checksum** events to the custom control macro as follows:

**Operating Tip**

You can record your macro and add the checksum events to it later using the Edit feature. Refer to the section “**Editing Custom Control Macros**” on page 10-42 for more information.

- Press the appropriate button in the **Mattes Group** to add a checksum event.

**Synergy 2 Q/MD — Mattes Group**

You can select between the following:

- **BKGD1/KEY1** — Press the **BKGD1/KEY1** button to add a checksum event for **MLE 1** to the custom control.
- **BKGD2/KEY2** — Press the **BKGD2/KEY2** button to add a checksum event for **MLE 2** to the custom control.
- **BORD1** — Press the **BORD1** button to add a checksum event for **MLE 3** to the custom control.
~ BORD2 — Press the BORD2 button to add a checksum event for MLE 4 to the custom control.

~ PATT — Press the PATT button to add a checksum event for each MLE to the custom control.

10. Add any additional standard events into your macro as needed.

11. Press UP ONE to return to the Custom Controls Recording Menu.

<table>
<thead>
<tr>
<th>Custom Controls (1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording...</td>
</tr>
<tr>
<td>Selected: Bank 1 Button 1 [Custom01]</td>
</tr>
<tr>
<td>Button: Custom01 # 1</td>
</tr>
</tbody>
</table>

Custom Control Legend:

# = normal custom control button

12. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for adding a Checksum to a custom control.

### Using a Checksum Custom Control

The Checksum custom control will record and display the checksum validation in one of four different ways. This option must be set before the custom control is run to have the validation perform the actions you want.

Use the following procedure to use a Checksum custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.
2. Press MORE to display the Custom Controls Menu 2-2.
3. Press Checksum Diff Action to display the Checksum Difference Menu.

<table>
<thead>
<tr>
<th>Custom Controls (2-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action when checksum diff found:</td>
</tr>
<tr>
<td>No action Log Change Wait macro</td>
</tr>
</tbody>
</table>

Checksum Difference Menu

4. Select the action you want the switcher take when a checksum custom control is complete as follows:
• Use the **Action when checksum diff found** knob to select the action you want the switcher to take when a checksum custom is run. You can select between the following:

**Note**

Unless you select **No action**, a pop-up message will be displayed when the checksum custom control is finished indicating the results.

~ **No Action** — Select this option to have no action taken when the checksum custom control is run.

~ **Log change** — Select this option to have any changes in the checksum values recorded to a system log that can be viewed by a Ross Video employee. A pop-up message will be displayed when the custom control is finished.

~ **Halt macro** — Select this option to have any changes in the checksum values halt the custom control macro and display the checksum event that returned a different value. A pop-up message will be displayed indicating the problem.

~ **Recalc c'sums** — Select this option to have the currently returned checksums stored as the new reference values for the checksums. The existing stored checksums values will be replaced with the new values. A pop-up message will be displayed if any of the checksum values were replaced.

5. Press **HOME** to display the **Main Menu 1-2**.

6. Press the custom control button you assigned the checksum custom control to in order to run the custom control.

This completes the procedure for running a checksum custom control.
Additional Installation Setups

In This Chapter

This chapter provides instructions for additional installation setup procedures. The following topics are discussed:

• Aux Bus Setup
• Remote Aux Panel GPI Setup
• Standard GPI Setup
• Reference
• Recalling Factory Default Settings
• Lock/Unlock Installation
• Set System Time
Aux Bus Setup

The **Aux Bus Setup Menu** allows you to set up Aux (Auxiliary) panels, and assign certain “rights” to those panels. The setup procedures cover both *local* and *remote* Aux panels.

- The “*Local*” Aux panel consists of the **Aux Bus** (on the switcher control panel), plus the **Aux Bus Assign Group**, as shown below (on the Synergy 2.5 Q/MD control panel):

---

**Synergy 2.5 Q/MD Aux Bus and Aux Bus Assign Group**

- An **Assignable Remote Aux Panel** controls *all* Aux Bus outputs, as shown below:

---

**Synergy 2.5 Q/MD Assignable Remote Aux Panel**

---

**Note** The following setup procedures include information for a feature that allows the manual override of the Aux panel selection via GPI trigger.

### Modifying Aux Bus Names

Each Aux Bus can be named to represent the function that it will actually control.

Use the following procedure to modify the name of the Aux Bus:

1. Navigate to the **Aux Bus Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus**.
2. Press **Modify Name** to display the **Aux Bus Names Menu**.
The **Main Area** provides an array of letters and numbers. The reverse video highlight indicates the “selected” character — the position of which is controlled by the two upper scroll knobs. The **Current Name** and **New Name** fields are located below the array. In the **New Name** field, the reverse video highlight indicates the “active” character — the one that you are changing.

• The **Label Area** provides an array of tools for naming and editing your Aux Bus names.

• The **Scroll Area** provides three functions that are controlled by their respective **Scroll Knobs**:
  ~ The **Horizontal** knob moves the highlight horizontally.
  ~ The **Vertical** knob moves the highlight vertically.
  ~ The **Aux Bus** knob selects the Aux Bus that you want to name. The Aux Buses are identified as (A:B), where A represents the **Bank Number** and B represents the **Aux Bus** on that Bank.

3. Use the **Aux Bus** knob to select the Aux Bus you want to change the name of.

4. Use the **Horizontal** and **Vertical** knobs to select the desired character. The highlighted position in the **New Name Field** changes as you select each character. Please note:
   • The maximum number of characters allowed is eight.
   • Press **Space** to add a space at the highlighted position. When a letter is in the active position, it will be deleted.
   • Press **Prev Letter** to move the highlight one space to the left.
   • Press **Next Letter** to move the highlight one space to the right.

5. Press **Accept New Name** to register the new name in memory. The new name is transferred to the **Current Name Field**.

6. Repeat steps 3 through 5 for each additional Aux Bus that you want to name.

**Operating Tip**
A Standard PS/2 keyboard can be used to enter the **New Name** for the selected Aux Bus.

**Note**
As you rotate the knob, both the **Current Name** and **New Name** fields change to display the Aux Bus names (as stored in switcher memory). The factory default name for **all Aux Busses** is **[Bnk#Aux#]**.

**Note**
If you exit the installation menus without first pressing **Accept New Name**, the following screen is displayed.
Change Name Without Saving Screen

- Press **Yes** to proceed without saving the changes you made to the name.
- Press **No** to return to the previous menu and accept the new name.

This completes the procedure for modifying the name of an Aux Bus.

**Setting Up Local Aux Panels**

Use the following procedure to set up your local Aux panel:

1. Navigate to the **Aux Bus Setup Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus**.
2. Press **Local Panel** to display the **Local Panel Menu**.

This menu allows you to set specific switching parameters (or “rights”) for each of the Aux Buses that are accessible from the control panel (in the **Aux Bus Assign Group**). Each bus can be set up individually.

3. Configure a local aux bus as follows:
   - Use the **Aux Bus** knob to select the Aux Bus that you want to configure.
   - Use the **Mode** knob to select the mode for the selected local bus. You can select between the following:
     ~ **OFF** — Select this option to turn the specific Aux Bus Off, effectively disabling access to the bus from the control panel. When the button in the **Aux Bus Assign Group** is pressed, it lights momentarily, but it will not “take.” The bus can, however, be controlled by a Remote Aux panel.
     ~ **Regular** — Select this option to place the specific Aux Bus in normal operating mode. The bus can be selected and sources can be changed from the control panel. This mode also allows both local and remote panels to control the Aux Bus.
~ **Follow** — Select this option to place the specific Aux Bus in follow (or “view only”) mode. You can select the bus in the **Aux Bus Assign Group** and follow what crosspoints are being selected (remotely), but you cannot change crosspoints. In this configuration, the bus is controlled from another location.

This completes the procedure for setting up a local Aux Panel.

**Assigning Aux Bus Tallies**

When an Aux Bus is used to route video to an external device (such as a VTR), this procedure sets up the method for tallying that bus. By selecting certain parameters, you can tally the bus (lighting the red “**ON**” LED on the Aux Panel) whenever the device is used on-air, or as part of the composite on air image.

![Remote Aux Panel Tally](image)

**Remote Aux Panel Tally**

**Note**

For example, by telling the switcher that **Bnk1, Aux1** feeds VTR 1, the switcher will tally **Bnk1, Aux1** whenever VTR 1 is taken on air.

Use the following procedure to select the Aux Bus tally method:

1. Navigate to the **Aux Bus Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus**.
2. Press **Ext Device Assign** to display the **External Device Assignment Menu**.

![Aux Bus — External Device Assignment Menu](image)

3. Assign an Input BNC and tally method to an Aux Bus as follows:
   - Use the **Aux Bus** knob to select the Aux Bus that connected to the input of the external device.
   - Use the **BNC** knob to select the Input BNC that is connected to the output of the external device.
   - Use the **Tally when** knob to select how the Aux Bus is tallied. You can select between the following:
     ~ **No Tally** — Select this option to prevent the Aux Bus from being tallied, regardless of what is selected on air.
~ **XPT On Air** — Select this option to tally the Aux Bus whenever the selected BNC (from step 4 above) is used on air.

~ **GPI & XPT On** — Select this option to tally the Aux Bus whenever the selected BNC is used on air, and whenever an assigned “input” GPI is enabled. *Both criteria* must be active in order for the Aux Bus to tally properly.

4. If you selected **GPI & XPT On** in the previous setup, an input GPI port must be associated with the Aux Bus that you chose. If you did not select **GPI & XPT On**, proceed to the end of the procedure.

5. Press **GPI Tally Assign** to display the **GPI Tally Assign Menu**.

6. Assign a GPI to an Aux Bus as follows:
   - Use the **Aux Bus** knob to select the Aux Bus that you want to associate with a GPI input trigger.
   - Use the **GPI** knob to select the input GPI port that you want to associate with the Aux Bus.
   - Use the **Polarity** knob to select if the GPI triggers on a low or high-level pulse.

This completes the procedure for setting up an Aux Bus tally method.

### Setting Up Remote Aux Panels

To set up a Remote Aux Panel, you must first assign an Aux port to Remote Aux Panels, and then assign each Remote Aux Panel to an Aux Bus.

Use the following procedure to configure the switcher to communicate with a Remote Aux Panel:

1. Navigate to the **Communications Menus** as follows:
   - Press **HOME ➔ More ➔ Setup ➔ Installation ➔ Comm Setup**.
2. Press **Type** on the **Communications Menu 1-2**.

3. Assign a Remote Aux port to the Remote Aux Panel as follows:
• Use the **Com Port** knob to select the communications port on the Q/MD switcher that is connected to the Remote Aux Panel.
• Use the **Device** knob to select **Remote Aux**.
• Use the **Aux Buses** knob to select the range of aux buses that you want to make available to the remote aux panels connected to the selected port.

**Note**

All the Remote Aux Panels that are connected to the selected Aux port, or to other Remote Aux Panels that are connected to the port, are restricted to Aux Buses in the range you select.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
5. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.
6. Navigate to the **Remote Panels Menus** as follows:
7. Press **Remote Panel Setup** on the **Remote Panels Menu**. This places all the Remote Aux Panels connected to the switcher into assignment programming mode. The red **On-Air** indicator on the Remote Aux Panels flash (Figure 11.1).

   **Remote Panel Setup Menu**

![Remote Panel Setup Menu]

**Figure 11.1 On-Air Indicator (Tally)**

8. In assignment programming mode, the first **12** crosspoint buttons (Figure 11.2) represent Aux Bus outputs in the range specified in **Step (3.)** above.

   **Figure 11.2 Aux Bus Output Buttons**
9. Each aux panel can be assigned to all the available aux buses. The aux panel can be set up for each aux bus in one of three modes. Press the Aux Bus Output buttons on the Remote Aux Panel repeatedly until the required mode is selected for the aux bus. You can choose between the following:

- **Off** — The aux panel is not assigned to the selected aux bus. The button is not lit.
- **Regular** — The aux panel is assigned to the selected aux bus, allowing full control. The button is lit steadily.
- **Follow** — The aux panel is assigned to the selected aux bus, allowing you to view what crosspoints are selected on that aux bus, but you cannot control the aux bus. The button is flashing.

10. Press **Accept** on the **Remote Panel Setup Menu** to store the new settings and exit programming mode.

This completes the procedure for configuring the switcher to communicate with a Remote Aux Panel.
Remote Aux Panel GPI Setup

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

<table>
<thead>
<tr>
<th>Remote GPI</th>
<th>Group / Offset / Physical GPI</th>
<th>Assigned Aux Bus</th>
<th>Assigned BNC</th>
<th>Type/Edge</th>
<th>Physical Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Aux GPI 5</td>
<td>Group 1, Offset 0, GPI 5</td>
<td>Bnk1Aux1</td>
<td>C03 (Cam 4)</td>
<td>Cam 4 Joystick</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Group 1, Offset 0, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Group 1, Offset 0, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Group 1, Offset 0, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Group 1, Offset 0, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Group 1, Offset 0, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Group 1, Offset 0, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Group 1, Offset 0, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Group 1, Offset 0, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Group 2, Offset 1, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Group 2, Offset 1, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Group 2, Offset 1, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Group 2, Offset 1, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Group 2, Offset 1, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Group 2, Offset 1, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Group 2, Offset 1, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Group 2, Offset 1, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Group 3, Offset 2, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Group 3, Offset 2, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Each remote GPI port is dedicated exclusively to the control of Aux Bus signal selection, such as via a contact closure from a CCU. No other functions can be assigned to these remote GPIs.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.

Remote Aux Panel GPI Input Worksheet

Complete the following Remote Aux Panel GPI Input worksheet, or use the worksheet provided in Appendix C, “Installation Worksheets”.

Remote Aux Panel GPI Input Worksheet

Using the 8 GPI input ports on the Remote Aux Panel, a camera operator can manually override the Aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected Aux Bus crosspoint and manually switch to a selected Output BNC using a button on the joystick of the camera control unit.

The 8 GPIs on each panel can be offset by multiples of 8 to allowing each remote panel to use different GPI ports, to the maximum of 64 GPIs. For example, Remote Aux Panel 1 can be set to use GPIs 1 through 8. By setting Remote Aux Panel 2 to a +1 offset, it will use GPIs 9 through 16. The panels can be programmed to ignore all 8 GPIs, if desired.
<table>
<thead>
<tr>
<th>Remote GPI</th>
<th>Group / Offset / Physical GPI</th>
<th>Assigned Aux Bus</th>
<th>Assigned BNC</th>
<th>Type/Edge</th>
<th>Physical Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Group 3, Offset 2, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Group 3, Offset 2, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Group 3, Offset 2, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Group 3, Offset 2, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Group 3, Offset 2, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Group 3, Offset 2, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Group 4, Offset 3, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Group 4, Offset 3, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Group 4, Offset 3, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Group 4, Offset 3, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Group 4, Offset 3, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Group 4, Offset 3, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Group 4, Offset 3, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Group 4, Offset 4, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Group 5, Offset 4, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Group 5, Offset 4, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Group 5, Offset 4, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Group 5, Offset 4, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Group 5, Offset 4, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Group 5, Offset 4, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Group 5, Offset 4, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Group 5, Offset 4, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Group 6, Offset 5, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Group 6, Offset 5, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Group 6, Offset 5, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Group 6, Offset 5, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Group 6, Offset 5, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Group 6, Offset 5, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Group 6, Offset 5, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Group 6, Offset 5, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Group 7, Offset 6, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Group 7, Offset 6, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Group 7, Offset 6, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Group 7, Offset 6, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Group 7, Offset 6, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Group 7, Offset 6, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Aux Panel GPI Connection

In this section, you will wire each remote Aux panel GPI port to the designated joystick switch on a selected camera CCU. If you wish to connect GPIs on more than one panel to different CCU joysticks, each connector must be wired at this time. The GPI connector is located on the rear of each remote Aux panel.

- Using the “Remote Aux Panel GPI Input Worksheet” as a guide, label the rear of each panel with its assigned group and offset. A sample label is shown below.

- Using the “Remote Aux Panel GPI Pinout Table” provided in Appendix A, together with the data from your “Remote Aux Panel GPI Input Worksheet” wire the appropriate GPI ports to each designated Camera CCU. Refer to the Installation Manual for your camera for pinout information on the Joystick contact closure on the camera. Momentary action, normally-open switches are recommended.

<table>
<thead>
<tr>
<th>Remote GPI</th>
<th>Group / Offset / Physical GPI</th>
<th>Assigned Aux Bus</th>
<th>Assigned BNC</th>
<th>Type/Edge</th>
<th>Physical Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td>Group 7, Offset 6, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Group 7, Offset 6, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Group 8, Offset 7, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>Group 8, Offset 7, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Group 8, Offset 7, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Group 8, Offset 7, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Group 8, Offset 7, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Group 8, Offset 7, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Group 8, Offset 7, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Group 8, Offset 7, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Refer to Appendix A, “Specifications” for Aux panel GPI connector specifications.

- The GPI Port on the Remote Aux Panel is a 9-pin D-Type female connector.
- GPI In 1-8: Active low, short-to-ground to activate
- Run all GPI cables in accordance with good engineering practice, and ensure that the cable will not be subjected to physical abuse.
Remote Aux Panel GPI Programming

In this section, you will program your remote Aux panels for the desired group and offset. You can also test the GPI connections locally. Refer to your Remote Aux Panel GPI Input Worksheet to verify the groups and offsets for all buses.

1. Navigate to the **Aux Bus Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.
2. Press Remote Panels to display the Remote Panels Menu.

**Note**

All Remote Aux Panels are now in programming mode, the On-Air Indicator on the panel are flashing and the button in the Aux Bus Assign Group are not lit.

4. Press **CLEAN FEED** on the Remote Aux Panel to switch the panel from “assignment” programming mode to “GPI” programming mode. The CLEAN FEED button flashes to indicate that GPI programming mode is active.

With the GPI programming mode in effect, the first eight crosspoints on each panel allow you to set the group and offset for the selected panel.

**Note**

Only one Group and offset can be assigned to a Remote Aux Panel at a time.
6. Test your GPIs locally for valid contact closures by pressing each joystick button on the CCUs that are connected to this panel.

As you press the CCU joystick buttons, the LEDs in the second group of eight crosspoints on the panel will indicate when each GPI has been shorted to ground, as shown below.

![Remote Aux Panel Button GPI Contact Closure Status Buttons](image)

**Important**

GPI status buttons are numbered from left to right, starting at GPI 8 and counting down to GPI 1. These correspond to the 8 available ports on each panel, and also correspond to the arrangement of GPI icons on the Remote Panel Setup Menu.

When each GPI is shorted to ground, the corresponding GPI Icon on the Remote Panel Setup Menu will light. Refer to the section “Monitoring CCU Joystick Selections” on page 11-15 for more information on GPI icons.

7. Press Accept on the Remote Panel Setup Menu to store the new settings on the Remote Aux Panel and exit programming mode.

Refer to Appendix A, “Specifications” for a comprehensive table that lists all normal, GPI, and special diagnostic Aux panel programming modes.

### Setting Up CCU Joystick Aux Control

Once the remote GPIs have been wired, and the remote panels have been programmed with the proper offsets, you can now assign each remote GPI to an Aux Bus and an Input BNC on the switcher, and select the desired trigger type for it.

Use the following procedure to configure your CCU joystick Aux control as follows:

1. Navigate to the Aux Bus Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.
2. Press Remote Panels to display the Remote Panels Menu.
3. Press Remote GPI Assignment to display the Remote GPIs/CCU Joystick Control Menu.
The menu allows you to select a remote GPI (1 - 64), assign it to a specific Aux Bus (Bnk1Aux1 through Bnk6Aux8 or NONE), and associate that GPI with a specific Input BNC (C01 through D16).

4. Assign a Remote GPI input to an Aux Bus and Input BNC as follows:
   • Use the **Remote** knob to select the remote GPI that you want to assign to an Aux Bus.
   • Use the **Aux Bus** knob to select the Aux Bus that you want to assign the GPI input to.

   **Note**
   The current version of the **Remote Aux Panels** can only support Aux Buses Bank1, Aux1 through Bank2, Aux4. Setting the **Aux Bus** knob to a value not within this range will result in the Remote Aux Panel not being able to route the video properly.
   The **Synergy 1 Q/MD Remote Aux Panels** can only support Aux Buses Bank1, Aux1 through Bank2, Aux2.

   • Use the **BNC** knob to select the Input BNC that you want to be selected on the Remote Aux Panel when the selected GPI input is triggered.

   **Note**
   The text (in the main area) above the **Remote GPI Type** label indicates the type of trigger selected for the highlighted remote GPI. This information tracks each GPI as you rotate the **Remote** knob.

5. Press **Remote GPI Type** to display the **Remote GPI Type Menu**.

6. Set the type for the Remote GPI inputs as follows:

   **Note**
   The default type is the **Low-Override** trigger.

   • Use the **Remote** knob to select the remote GPI input that you want to set up the type for.
   • Use the **Type** knob to select the type of control that you want to assign to the selected GPI input. You can select between the following:
     ~ **Low-Override** — This type of input trigger causes a temporary override on contact closure (high to low signal). When the contact opens again (low to high signal), any override on this Aux Bus is ended, and the Aux Bus output returns to its selected crosspoint.
     ~ **Low-Toggle** — This type of input trigger causes an override on initial contact closure (high to low signal) if no override exists currently on this Aux Bus.
The override remains in effect until the contact is closed a second time (assuming no other action has ended the override).

~ **High-Toggle** — This type of input trigger is similar to the **Low-Toggle**, except that an override is triggered when a contact is opened (low to high signals).

~ **Latch** — Select this option for an input trigger that will override the Aux Bus output with the selected crosspoint until overridden by another CCU joystick, a remote aux panel crosspoint button selection, or a switcher Aux Bus crosspoint button selection.

~ **Off** — This setting disables the selected remote GPI.

---

### Note

The text (in the main area) above the **Remote GPI Assignment** label indicates the Aux Bus and BNC assigned to the highlighted remote GPI. This information tracks each GPI as you rotate the **Remote** knob.

7. Verify that the proper Input BNCs have been selected as follows:

   - Go to each of the Remote Aux Panels that you have set up overrides on.
   - Manually select **BLACK** on the Remote Aux Panel.
   - Press each CCU joystick button in succession, and verify that the desired BNC is selected, overriding **BLACK**.
   - Verify that when you release the joystick button, or press it a second time, **BLACK** is once again selected.

Please note the following important points regarding the use of Override-type remote GPIs connected to CCU Joystick buttons:

   - The selected override remains latched for as long as the Joystick button is held down. The panel returns to its previous “normal” assignment when the button is released.
   - If a second Joystick button is pressed while the first is being held, the second BNC will override the current selection on the panel. In this situation, if either Joystick button is released, the panel returns to the previous “normal” assignment.

All three GPI trigger types act as an override of the actual crosspoint selected, but can also be cancelled (overridden) simply by pressing another crosspoint.

### Monitoring CCU Joystick Selections

The status of the remote Aux panel GPIs can be viewed on the **Remote Panel Menu**.

Use the following procedure to review the current status of a Remote Aux Panel:

1. Navigate to the **Aux Bus Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.
2. Press **Remote Panels** (to display the **Remote Panels Menu**).
3. Press **Remote Panel Setup** to display the **Remote Panel Setup Menu**.
The Main Area is divided into three columns:

- The left-hand column lists the eight available GPI groups. These groups are assigned during programming mode.
- The middle column lists the status of each GPI port, using two types of GPI icons.

<table>
<thead>
<tr>
<th>GPI group 1:</th>
<th>GPI group 2:</th>
<th>GPI group 3:</th>
<th>GPI group 4:</th>
<th>GPI group 5:</th>
<th>GPI group 6:</th>
<th>GPI group 7:</th>
<th>GPI group 8:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aux1: Run Aux, Lowest Ver 92.12</td>
<td>Aux2: Run Aux, No Version returned</td>
<td>Aux3: Run Aux, No Version returned</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Press the **Inquire GPIs** softkey to poll the remote panels for the status of all connected GPIs.

This completes the procedure for reviewing the status of your Remote Aux Panels.
Standard GPI Setup

The GPI I/O Setup Menu allows you to set up your 10 “standard” GPI Input ports and 10 GPI Output ports. All 20 ports are provided on the GPI I/O connector. Refer to the section “GPI I/O and System Fail Relay Connections” on page 3-36 for wiring instructions. Before setting up your GPIs, please complete the following worksheets.

Operating Tip

To avoid marking up the Engineering Manual, use the worksheet provided in Appendix C “Installation Worksheets” to make extra copies.

Standard GPI Input Worksheet

Complete the following Standard GPI Input Worksheet for each standard GPI input port (1 to 10):

- In the Event Type column, fill in the type of event that you want to trigger. Choose between:
  ~ Off
  ~ Auto
  ~ Cut
  ~ Cust Ctrl
  ~ Mem Recall

- In the Event Area column, fill in the area of the switcher where you would like the event to occur. You can select between the following:
  ~ MLE 1
  ~ MLE 2
  ~ MLE 3
  ~ Fade to black (DSK)
  ~ MultiDSK 3
  ~ MultiDSK 4
  ~ Custom Control name and number
  ~ Memory name and number

- In the Polarity column, fill in the polarity of the input trigger. Choose between:
  ~ Low
  ~ High
## Standard GPI Input Worksheet

<table>
<thead>
<tr>
<th>Standard GPI Input #</th>
<th>Event Type</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample GPI Input #1</td>
<td>Auto</td>
<td>MLE 1</td>
<td>Low</td>
</tr>
<tr>
<td>Sample GPI Input #2</td>
<td>Cut</td>
<td>Fade to black</td>
<td>High</td>
</tr>
<tr>
<td>Sample GPI Input #3</td>
<td>Cust Ctrl</td>
<td>Custom08 1#08</td>
<td>High</td>
</tr>
</tbody>
</table>

## Standard GPI Output Worksheet

Complete the following Standard GPI Output worksheet. To avoid marking up the *Engineering Manual*, use the worksheet provided in Appendix C, “Installation Worksheets” to make extra copies.

For each GPI output port (1 to 10):

- In the **Output Name** column, fill in the desired GPI Output name (up to eight characters).
- In the **Trigger Type** column, fill in the output trigger type. Choose between:
  - Edge
  - Level
- In the **Trigger Level** column, fill in the polarity of the output trigger. Choose between:
  - Low
  - High
Programming Standard GPI Inputs

Use the following procedure to set up your standard GPI ports:

1. Navigate to the **GPI I/O Input Setup Menu** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ GPI I/O ⇒ Inputs**.

   **GPI Input Setup Menu**

   This menu allows you to associate each GPI Input with an *area* and *button* on the switcher that you would like to trigger, when that specific GPI input pulse is received from an external device.

   - The **Main Area** provides a mini “help” message.
   - The **Label Area** provides access to additional GPI I/O setup menus.
   - The **Scroll Area** provides three functions that are controlled by their respective **Scroll Knobs**:
     - The **GPI Input** knob selects the GPI Input port (1 to 10) to which you want to assign a switcher event type and location (area).
     - The **Function** knob selects between **Off, Auto, Cut, Cust Ctrl, and Mem Recall**. Specific functions are listed below.
The label of the bottom knob changes depending on the selection made with the Function knob. Each specific function is detailed below:

**Functions:**

- **Select OFF** to perform no transition when an incoming pulse is received from an external device.
- When **Auto** or **Cut** is selected and an “MLE” area is chosen, the **CUT** or **AUTO TRANS** button in the MLE Transition Group is triggered — when a specific GPI input pulse is received from the external device.

**GPI Trigger Types and Locations — MLE 1 Transition Group**

- When **Auto** or **Cut** is chosen and the “Fade to Black” area is selected, the **CUT** or **FADE** button in the Fade to Black group is triggered — when a specific GPI input pulse is received from the external device.

**GPI Transition Type and Trigger Locations — Fade to Black Group**

- When **Cust Ctrl** is selected, the label for the bottom knob changes to **Cust Ctrl** and the values change to a list of the custom control buttons in the format **Custom## 1###**, which consists of the custom control name (default is **Custom##**), either a blank space or an asterisk (the “used” indicator), bank (1-8), button type (as defined in the legend area), and button numbers (01-99). This allows a GPI input to trigger a complex series of operation that have been assigned to a custom control button.

<table>
<thead>
<tr>
<th>GPI I/O</th>
<th>GPI Input:</th>
<th>Function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this menu to match GPI inputs to specific</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut, Auto Transition, Custom Control buttons, and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory Recalls.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Control Legend:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>v = custom control contains macro</td>
<td></td>
<td></td>
</tr>
<tr>
<td># = normal custom control button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cust Ctrl:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#1</td>
<td>Tally on</td>
<td>View</td>
</tr>
<tr>
<td>Custom#2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom#14</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**GPI Input Setup Menu — “Cust Ctrl” selected**
The custom control button on the switcher panel that corresponds to the active line for the bottom Cust Ctrl knob lights up during the selection process. The lighted button changes as the knob is turned.

If the current custom control setting is for a control button in a bank, and that bank has a button assigned to activate it, then both the bank button and the control button will light.

It is also possible to specify the custom control setting by pressing the actual custom control button.

- When Mem Recall is selected, the label for the bottom knob changes to Memory and the values change to a list of memories (Memory0 to Memory99) that can be recalled by triggering a GPI input.

2. Using the information from the Event Type and Event Area columns in your Standard GPI Input Worksheet, select the first GPI input that you want to program. Assign a “function” and select an “area” of the switcher, or “Cust Ctrl”, or “Mem Recall” to trigger.

Note that if the label USED appears to the right of the GPI input port number, it indicates that the selected port is already in use by the Aux Bus, as assigned on the Aux Bus GPI Tally Assign Menu. Refer to the section “Assigning Aux Bus Tallies” on page 11-5 for instructions.

For reference, the figure below illustrates the USED label on the GPI Input Setup Menu.
3. To set the polarity of each GPI input port, press **GPI Polarity** to display the **GPI Polarity Menu**.

![GPI Input Polarity Menu](image)

- The **Main Area** provides a mini “help” message.
- The **Label Area** provides access to additional GPI setup menus.
- The **Scroll Area** provides two functions that are controlled by their respective **Scroll Knobs**:
  ~ The **GPI Input** knob selects the GPI input (1 to 10) for which you want to set the polarity.
  ~ The **Polarity** knob selects the input polarity — **Low** or **High**.

4. Using the information from the **Polarity** column in your **Standard GPI Input Worksheet**, assign a polarity to each GPI input (that you set up in step 3 above).
   - When **Low** is assigned, the incoming GPI line is normally high. The selected GPI triggers when the line goes low (to ground).
   - When **High** is assigned, the incoming GPI line is normally low. The selected GPI triggers when the line goes high (released from ground).

Refer to the **Installation Manual** for your source device for details on the specific type of GPI pulse that the device provides.

5. Repeat steps 2 through 4 for each remaining GPI input.

This completes the procedure for setting up standard GPI ports.

**Programming Standard GPI Outputs**

Use the following procedure to set up your standard GPI outputs:

1. Navigate to the **GPI I/O Setup Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **GPI I/O**.

2. Each standard GPI output can be named, to represent the function that it will actually control — such as **PrevStil** (select previous still) or **Roll VTR**. To name GPI outputs, press **Name Outputs**. The **GPI Name Outputs Menu** appears.
The **Main Area** provides an array of letters and numbers. The reverse video *highlight* indicates the “selected” character — the position of which is controlled by the two upper scroll knobs. The **Current Name** and **New Name** fields are located below the array. In the **New Name** field, the reverse video *highlight* indicates the “active” character — the one that you are changing.

The **Label Area** provides an array of tools for naming and editing your physical GPI output names.

The **Scroll Area** provides three functions that are controlled by their respective **Scroll Knobs**:
- The **Horizontal** knob moves the highlight horizontally.
- The **Vertical** knob moves the highlight vertically.
- The **Output number** knob selects the GPI output that you want to name. As you scroll through the ports, the **Current Name** field tracks each name.

3. Using the data from the **Output Name** column in your **Standard GPI Output Worksheet**, rotate the **Output number** knob until the desired GPI output is shown — the one that you want to name.

Please note:
- As you rotate the knob, both the **Current Name** and **New Name** fields change to show the output names (as stored in switcher memory).
- The factory default name for *all outputs* is **UNKNOWN**.

4. Use the **Horizontal** and **Vertical** knobs to select the desired character. The highlighted position in the **New Name** field changes as you select each character. Please note:
- The maximum number of characters allowed is eight.
- Press **Space** to add a space at the highlighted position. If a letter is in the active position, it will be deleted.
- Press **Prev Letter** to move the highlight one space to the left.
- Press **Next Letter** to move the highlight one space to the right.

5. Press **Accept New Name** to register the new name in memory. The new name is transferred to the **Current Name** field.

6. Repeat steps 3 through 5 for each additional GPI output that you want to name. Note that if you change the output number without first pressing **Accept New Name**, a message appears asking if you wish to abandon any changes. Choose from the following:
- Press **Yes** to abandon changes and move to the new output. The name reverts to its previous name as stored in memory.
- Press **No** to retain changes without moving to the new output.
Once you have named all of the desired GPI outputs, press UP ONE to return to the GPI I/O Setup Menu.

7. To set the parameters for each GPI output, press Outputs. The GPI Output Setup Menu appears.

<table>
<thead>
<tr>
<th>GPI 1-0</th>
<th>GPI Output:</th>
<th>Trigger:</th>
<th>Level:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this menu to set up GPI output functions,</td>
<td>PREP-STL 1 1</td>
<td>Edge</td>
<td>Low</td>
</tr>
<tr>
<td>GPI Output Setup Menu</td>
<td>UNKNOWN (2)</td>
<td>Level</td>
<td>High</td>
</tr>
</tbody>
</table>

When a selected GPI output is activated, it obeys the trigger and level parameters that you have entered.

- The **Main Area** provides a mini “help” message.
- The **Label Area** provides access to additional GPI setup menus.
- The **Scroll Area** provides three functions that are controlled by their respective Scroll Knobs:
  - The **GPI Output** knob selects the output port (1 to 10) that you want to set up. Note that your custom names are listed (as entered on the GPI Name Outputs Menu).
  - The **Trigger** knob selects the output trigger type — Edge or Level.
  - The **Level** knob selects the output level — Low or High.

8. Using the information from the **Trigger Type** and **Trigger Level** columns in your Standard GPI Output Worksheet, set up the desired parameters for each GPI output (that you named in steps 2 through 6 above). These parameters affect the pulses sent from the Synergy Q/MD switcher to each destination device:

- When **Level** is assigned, the GPI output line is held at the selected state (low or high) until triggered, whereupon the line switches to the opposite state — and holds there.
- When **Edge** is assigned, the GPI output line is held at the selected state (low or high) until triggered, whereupon the line switches to the opposite state momentarily — and returns immediately to the original state.
- When **Low** is assigned, the GPI output line is normally high. When the output is triggered, the line goes low (to ground).
- When **High** is assigned, the GPI output line is normally low. When the output is triggered, the line goes high (released from ground).

Refer to your the Installation Manual of your device for details on the specific type of GPI pulse that the device needs to receive.
Tally on GPIs

Use the **Tally on GPIs** function to specify for each tally if it should be forced on by one of the GPI inputs.

The top knob selects a tally number, while the middle knob specifies which GPI input (or **NONE**) should force the tally on. Multiple tallies can be forced on by one GPI input. This forcing is independent of the tallies being used to indicate, for example, which crosspoints are active. It is not possible to tell from the tally side if it is on because of a crosspoint being used or because of the GPI forcing.

GPI Information

Use the **View GPI I/O** menu to display all the information about the GPI inputs and outputs in a concise format.

For each GPI input, the display shows its transition type, area or custom control button and its polarity, if it has been assigned to trigger one of these operations. The display will show the associated Aux Bus, if one has been assigned to a GPI in the **Aux Bus Setup** procedure, and will show a list of tallies that it forces if the GPI has been set up accordingly. If the text cannot all show in the display, it can be scrolled up and down with the middle knob.

This completes our discussion of setting up GPI inputs and outputs. Refer to the section, “**GPI Control**”, in the chapter, “**Peripheral Control and More**”, of the **Synergy Q/MD/X Operator’s Manual** for operational information.
Reference

The Flexible Reference system in the Synergy Q/MD switcher allows you to use any Interlaced video format as the reference to operate the switcher in any video format (choosing a progressive video format as a reference limits you to operating the switcher only in that same video format). For example, if you have a 1080i 59.94Hz input reference you can operate the switcher in 720p 59.94Hz, but not 1080i 50Hz. However, if you have a 720p 59.94Hz input reference, you can only operate the switcher in 720p 59.94Hz. If you need to change frequencies, you can have multiple input references and switch between them as needed.

Compatible Video Formats

The following table lists the video formats you can use with the different reference types.

<table>
<thead>
<tr>
<th>Input Reference</th>
<th>Usable Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>480i</td>
<td>• 480i, 480i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94 Hz</td>
</tr>
<tr>
<td>576i</td>
<td>• 576i, 576i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50 Hz</td>
</tr>
<tr>
<td>720p 59.94 Hz</td>
<td>• 720p 59.94 Hz</td>
</tr>
<tr>
<td>720p 50 Hz</td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td>1080i 59.94 Hz</td>
<td>• 480i, 480i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94 Hz</td>
</tr>
<tr>
<td></td>
<td>• 720p 60 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 60 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 30 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 29.97 Hz</td>
</tr>
<tr>
<td>1080i 50 Hz</td>
<td>• 576i, 576i/16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50 Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080pSF 25 Hz</td>
</tr>
<tr>
<td>1080p 24 Hz</td>
<td>• 1080p 24 H</td>
</tr>
<tr>
<td>1080pSF 24 Hz</td>
<td>• 1080pSF 24 Hz</td>
</tr>
<tr>
<td>1080pSF 23.98 Hz</td>
<td>• 1080pSF 23.98 Hz</td>
</tr>
</tbody>
</table>

Synergy Q/MD switchers allow you to use any interlaced video format to operate the switcher in any format of the same frequency; however, the use of 480i or 576i (Composite Sync) reference signals for High Definition (720p or 1080i) video modes is not recommended. Using a composite sync reference signal for High Definition video modes will result in excessive jitter on the video output of the switcher, falling outside the range specified by SMPTE-292M. This may result in downstream equipment being unable to properly receive these signals.
The use of composite sync reference formats is recommended for Standard Definition video modes only, and will provide stable outputs with jitter performance in compliance with SMPTE-259M specifications.

Reference Setup

Use the following procedure to set the reference format of the switcher:

Important

When you switch reference formats, you must perform a soft reset (ALL+ALL) in order to load the default rates for the format you have set. Refer to the section “Video Formats” on page 2-12 for more information.

1. Navigate to the Reference Menu as follows:

   - Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ MORE ➔ Reference.

   **Reference Menu**

   The Reference Menu displays the Current Video Format that the switcher is operating in. Below this line you have the frequencies, scan type, resolutions, switching lines, and pixel aspect ratio.

2. Select the Video Input Board that is providing the reference as follows:

   • Use the Ref from Input Board knob to select the Video Input Board you have connected the reference to. You can select between the following:

     ~ **Board C** — Select this option to use the reference signal that is connected to the Video Input Board that is installed in Slot C at the back of the frame.

     ~ **Board D** — Select this option to use the reference signal that is connected to the Video Input Board that is installed in Slot D at the back of the frame.

3. Select the reference format for the switcher as follows:

   • Use the Ref Format knob to select the reference format of the input reference. You can select between the following:

     - Reference Format
       - 1080i 59.94
       - 1080i 59.94
       - 1728p 59.94
       - 1280i 50
       - 1920x1080
       - 1728p 59.94
       - 1080i 59.94
       - 1080i 50

   • Video Input Format
     - BNC Format
       - Internal
     - BNC Format

   Note

   You can have two references connected to the switcher, but only a Video Input Board without crosspoint (Ross Part Number 4800A-060A) can be used to provide reference in Slot D.

   • Use the Ref from Input Board knob to select the Video Input Board you have connected the reference to. You can select between the following:

   Note

   Video Input Boards that are not installed, or do not have a reference input, appear gray.
~ **480i** — Select this option if the reference you have connected to the Video Input Board is **480** interlaced in a **4:3** aspect ratio.

~ **576i** — Select this option if the reference you have connected to the Video Input Board is **576** interlaced in a **4:3** aspect ratio.

~ **720p 59.94** — Select this option if the reference you have connected to the Video Input Board is **720** progressive at a frequency of **59.94 Hz**.

~ **720p 50** — Select this option if the reference you have connected to the Video Input Board is **720** progressive at a frequency of **50 Hz**.

~ **1080i 59.94** — Select this option if the reference you have connected to the Video Input Board is **1080** interlaced at a frequency of **59.94 Hz**.

~ **1080i 50** — Select this option if the reference you have connected to the Video Input Board is **1080** interlaced at a frequency of **50 Hz**.

~ **1080p 24** — Select this option if the reference you have connected to the Video Input Board is **1080** progressive at a frequency of **24 Hz**.

~ **1080pSF 24** — Select this option if the reference you have connected to the Video Input Board is **1080** progressive segmented frames at a frequency of **24 Hz**.

~ **1080pSF 23.98** — Select this option if the reference you have connected to the Video Input Board is **1080** progressive segmented frames at a frequency of **23.98 Hz**.

4. Select the video format for the switcher as follows:

<table>
<thead>
<tr>
<th>Note</th>
<th>Video formats incompatible with the selected reference video format are grayed out and cannot be selected. Changing the reference video format changes the available video formats.</th>
</tr>
</thead>
</table>

| Important | If you are using a 720p input reference, you will not be able to operate in any format other than 720p. Similarly if you are using a 1080pSF reference, you will not be able to operate in any format other than 1080pSF. The Progressive Scan format does not contain field information for timing an Interlaced format. |

| ~ **480i** | — Select this option to have the switcher operate in a **480** interlaced format in a **4:3** aspect ratio. |
| ~ **480i 16:9** | — Select this option to have the switcher operate in a **480** interlaced format in a **16:9** aspect ratio. |
| ~ **576i** | — Select this option to have the switcher operate in a **576** interlaced format in a **4:3** aspect ratio. |
| ~ **576i 16:9** | — Select this option to have the switcher operate in a **576** interlaced format in a **16:9** aspect ratio. |
| ~ **720p 59.94** | — Select this option to have the switcher operate in a **720** progressive format at a frequency of **59.94 Hz**. |
~ 720p 60 — Select this option to have the switcher operate in a 720 progressive format at a frequency of 60 Hz.

~ 720p 50 — Select this option to have the switcher operate in a 720 progressive format at a frequency of 50 Hz.

~ 1080i 59.94 — Select this option to have the switcher operate in a 1080 interlaced format at a frequency of 59.94 Hz.

~ 1080i 60 — Select this option to have the switcher operate in a 1080 interlaced format at a frequency of 60 Hz.

~ 1080i 50 — Select this option to have the switcher operate in a 1080 interlaced format at a frequency of 50 Hz.

~ 1080p 24 — Select this option to have the switcher operate in a 1080 progressive format at a frequency of 24 Hz.

~ 1080pSF 29.97 — Select this option to have the switcher operate in a 1080 progressive segmented frames format at a frequency of 29.97 Hz.

~ 1080pSF 30 — Select this option to have the switcher operate in a 1080 progressive segmented frames format at a frequency of 30 Hz.

~ 1080pSF 25 — Select this option to have the switcher operate in a 1080 progressive segmented frames format at a frequency of 25 Hz.

5. Reset the video format of all Input BNCs to the video format of the switcher as follows:
   - Press Reset Input BNC Format to have the switcher set all Input BNCs to the same video format that the switcher is currently operating in.

6. Press HOME to display the Installation Change Confirmation Screen.

7. Accept or reject the changes you have made as follows:
   - Press Confirm to accept the changes.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting the reference format for the switcher.

**Internal and External Reference**

Normally, you use an externally generated reference to synchronize video signals in your switcher. However, Synergy Q/MD switchers can generate an internal reference signal for use when no external reference is present. This is useful for demonstration or testing purposes and is not intended for production applications. The internal reference signal can only synchronize internally generated sources (e.g., Global-Stores). External crosspoints can not be synchronized to an internal reference signal.

The switcher can generate the following internal reference signals:

- **1080i 59.94** — generates an internal reference of 1080 interlaced at a frequency of 59.94 Hz.
- **1080i 50** — generates an internal reference of 1080 interlaced at a frequency of 50 Hz.
- **1080p 24** — generates an internal reference of 1080 progressive at a frequency of 24 Hz.
- **1080pSF 24** — generates an internal reference of 1080 progressive segmented frames at a frequency of 24 Hz.
• **1080pSF 23.98** — generates an internal reference of 1080 progressive segmented frames at a frequency of 23.98 Hz.

Use the following procedure to change between internal and external reference signals:

**Important**

Internally generated reference signals can not synchronize external video sources. Do not use an internally generated reference signal for production work.

1. Navigate to the **Reference Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Reference.

<table>
<thead>
<tr>
<th>Reference</th>
<th>Current Video Format: 1080i 59.94</th>
<th>Ref Format: 1080i 59.94</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames/sec</td>
<td>29.97Hz</td>
<td></td>
</tr>
<tr>
<td>Fields/sec</td>
<td>59.94Hz</td>
<td></td>
</tr>
<tr>
<td>Scan Type: Interlaced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Frame Resolution: 2300 × 1125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Video Resolution: 1920 × 1080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switching Line (F1-P2): 7-569</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pixel Aspect Ratio: 1.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Format: 1080i 59.94</th>
<th>Reference Format: 1080i 59.94</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC Format</td>
<td>Int/Ext</td>
</tr>
</tbody>
</table>

**Reference Menu Showing an External Reference Signal**

2. Toggle between internally generated and externally generated reference signals by pressing **Reference Int/Ext**.
   - Selecting an internal reference signal limits the options available on the **Ref Format** knob to **1080i 59.94**, **1080i 50**, **1080p 24**, **1080pSF 24**, and **1080pSF 23.98**.
   - Selecting an external reference signal allows all the options on the **Ref Format** knob as described in the section “**Reference Setup**” on page 11-27.

This completes the procedure for changing between internal and external reference signals.

**Defaulting Output Bus Video Formats**

You can rapidly set all MLE and Aux Bus outputs to the same video format as the currently defined system video format. If most of the buses on your Synergy Q/MD switcher use the system video output format, this is an easy way to set them without having to configure each one separately.

Use the following procedure to set the default video format for all MLE and Aux Bus outputs:

1. Navigate to the **Reference Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Reference.

<table>
<thead>
<tr>
<th>Reference</th>
<th>Current Video Format: 1080i 59.94</th>
<th>Ref Format: 1080i 59.94</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames/sec</td>
<td>29.97Hz</td>
<td></td>
</tr>
<tr>
<td>Fields/sec</td>
<td>59.94Hz</td>
<td></td>
</tr>
<tr>
<td>Scan Type: Interlaced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Frame Resolution: 2300 × 1125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Video Resolution: 1920 × 1080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switching Line (F1-P2): 7-569</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pixel Aspect Ratio: 1.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Format: 1080i 59.94</th>
<th>Reference Format: 1080i 59.94</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC Format</td>
<td>Int/Ext</td>
</tr>
</tbody>
</table>

**Reference Menu**
2. Press **Reset Output BNC Format** to set all output BNCs to the system output video format.

   You will be presented with a confirmation screen and must confirm or cancel the changes by selecting:
   
   ~ **Confirm** — All MLE and Aux Bus output video formats will be changed to match the current system video output format.
   
   ~ **Cancel** — No changes to the output video formats will be made.

   This completes the procedure to set the default video format for MLE and Aux Bus outputs.
Recalling Factory Default Settings

This section provides instructions for resetting the switcher to factory default values. These values are *preset* at the factory, and cannot be overwritten by the user. Typically, once all of your switcher setups and configurations have been completed and successfully stored on disk, you will *not need* to perform this step.

However, you *may* need to recall one (or more) set of default values in the following situations:

- If you sense a problem within one of the register categories
- If you feel the need to restart a series of setups or configurations from a base default setting
- If you wish to *clear out* a set of registers (e.g., resetting all memory registers to zero)
- If you wish to reset all control panel values

Switcher default values fall into eight categories of registers.

- **Personality Registers**
  This set of registers stores default values for user-configurable areas. When reset, the following areas will return to factory default values:
  
  - Favorite CG Setup
  - Time Clock Direction
  - Transitions (on which the Time Clock resets)
  - Time Clock Reset Time
  - Time Clock Position
  - VTR Time Code Position
  - Source ID Position
  - Mnemonics
  - PIP-II Memory
  - Audio Transitions
  - Preset Black
  - Fade to Black
  - All Preview Overlay
  - User Wipes
  - CG Mode, Channel and file/folder settings
  - Double Press Rate
  - Memory Bank Cycle Max
  - Memory Attributes
  - Matte Limit
  - Auto-Recall
  - DSK Cut
  - S&T MD Button Pattern
  - Panel Sleep Time
  - Bus Map Assignment

- **Memory Registers**
  This set of registers stores default values for the *Global Memory System* and individual MLE *Memory* groups. When reset, all memory registers are essentially cleared out (or erased).

- **Switcher Registers**
  This set of registers stores default settings for the control panel, similar to those discussed in the “Preliminary Functional Check” section in Chapter 4. When reset, the control panel (and all associated crosspoints, keyers, and MLE settings) is essentially cleared to zero.
• **Installation Registers**
  This set of registers stores default settings for all switcher setup and software-based configurations. When reset, the following areas will return to factory default values:

  - BNC Input Names
  - BNC Input Types
  - Tally Configuration
  - Alpha Setup
  - Auto Key Configuration
  - Panel Button Assignments
  - Aux Bus Setup
  - Isolated MultiDSK Mode
  - Output Setup
  - Clean Feed Setup
  - GPI Input / Output Setup
  - Device Setup
  - Editor Communications Setup
  - Custom Banks
  - Custom Device Setup

• **Custom Control Registers**
  This set of registers stores the functions that you have programmed into the Custom Control group. These functions can include VTR remote control commands, DVE control commands, and other panel-specific macros (programmable keys). When reset, all registers are cleared (empty).

• **Default VTR Clips**
  This set of registers stores all VTR clips in timecode format. When reset, all registers are cleared out, and all clips are erased.

• **NV-RAM**
  When reset, the Non-Volatile RAM of the switcher is cleared.

• **S&T**
  This set of registers stores the Squeeze & Tease MD Sequences that you have programmed. When reset, all programmed sequences are cleared.

• **Bus Maps**
  This set of registers stores the Bus Maps that you have created. When reset, all the Bus Maps you have created are cleared. The default bus map is not affected by the factory recall.

**Recall Factory Procedure**

Use the following procedure to restore factory default values.

**Note**
When a Factory Recall is performed there will be a **10** second pause as the switcher recalls the default settings.

1. As a precaution, ensure that any setups, memory registers or special configurations are stored to disk. Once you recall default registers, **there is no undo** function! Refer to Chapter 10, “Memory and Disk Functions” of the Synergy Q/MD/X Operator’s Manual for complete instructions.

2. Navigate to the Installation Menu 2-2 as follows:

   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE**.
3. Press **Recall Factory** to display the **Recall Factory Menu 1-2**.

<table>
<thead>
<tr>
<th>Recall Factory (1-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>This menu lets you reset different parts of the switcher to their factory default settings.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Personality</th>
<th>Memories</th>
<th>Switcher</th>
<th>Installation</th>
<th>Custom</th>
<th>Default</th>
<th>UTR Clips</th>
</tr>
</thead>
</table>

**Recall Factory Menu 1-2**

The **Main Area** provides a mini “help” message, while the **Scroll Area** is blank. The **Label Area** lists the categories of default registers that you can restore. Any combination of registers can be restored.

**Important**

When restoring multiple categories to their default values, wait at least 5 seconds between each category. Failure to do so could result in the default process aborting.

4. Press **Personality** to restore **Personality Registers** to their default values. The **Default Personality Screen** will be displayed.

**Default Personality Screen**

- Press **Yes** to reset all **Personality Registers**.
- Press **No** to retain the current set of **Personality Registers** and exit the menu safely.

5. Press **Memories** to reset all memories. The **Default Memories Screen** is displayed.

**Default Memories Screen**

- Press **Yes** to clear all **Memory Registers**.
- Press **No** to retain the current set of **Memory Registers** and exit the menu safely.
6. Press **Switcher** to restore **Switcher Registers** (control panel settings) to their default values. The **Default Switcher Screen** is displayed:

```
WARNING:
This will reset the switcher, resetting all crosspoints, keyers, etc. Are you sure?

Yes  No
```

**Default Switcher Screen**

- Press **Yes** to reset all **Switcher Registers**. The control panel will be reset and all crosspoints and keyers will be cleared.
- Press **No** to retain the current set of **Switcher Registers** and exit the menu safely. The control panel will not be reset.

7. Press **Installation** to restore **Installation Registers** to their default values. The **Default Hardware Screen** is displayed:

```
WARNING:
This will reset your hardware configuration. Are you sure?

Yes  No
```

**Default Hardware Screen**

- Press **Yes** to reset all **Installation Registers**.
- Press **No** to retain the current set of **Installation Registers** and exit the menu safely.

8. Press **Custom Controls** to restore all **Custom Control Registers** to their default values. The **Default Custom Controls Screen** is displayed:

```
WARNING:
This will reset your custom controls. Are you sure?

Yes  No
```

**Default Custom Controls Screen**

- Press **Yes** to reset all **Custom Control Registers**.
- Press **No** to retain the current set of **Custom Control Registers** and exit the menu safely.
9. Press **Default VTR Clips** to reset the contents of the VTR clip registers. The **Default VTR Clips Screen** is displayed:

```
WARNING:
This will reset your VTR Clips.
Are you sure?

Yes  No
```

**Default VTR Clips Screen**

- Press **Yes** to reset VTR Clips.
- Press **No** to retain the current set of VTR Clip registers, and exit the menu safely.

10. Press **MORE** to display the **Recall Factory Menu 2-2**.

```
Recall Factory Menu 2-2
This menu lets you reset different parts of the switcher to their factory default settings.

<table>
<thead>
<tr>
<th>Default NV-RAM</th>
<th>Default SAT</th>
<th>Default Bus Maps</th>
</tr>
</thead>
</table>

```

**Recall Factory Menu 2-2**

11. Press **Default NV-RAM** to reset the contents the Non-Volatile RAM, including Key effects, locked memories and some personality settings. The **Default NV-RAM Screen** is displayed:

```
WARNING:
This will reset NV-RAM, defaulting keyer effects, memory write protections, and some personality settings.
Are you sure?

Yes  No
```

**Default NV-RAM Screen**

- Press **Yes** to reset NV-RAM.
- Press **No** to retain the current NV-RAM, and exit the menu safely.
12. Press **Default ST3D** to erase all of the Squeeze & Tease MD Sequences you have programmed. The **Default ST3D Screen** is displayed:

![Default ST3D Screen](image)

- Press **Yes** to delete all Squeeze & Tease MD Sequences.
- Press **No** to retain the current Squeeze & Tease MD Sequences and exit the menu safely.

13. Press **Default Bus Maps** to clear all the bus maps you have created, except for the default bus map. The **Default Bus Maps Screen** is displayed:

![Default Bus Maps Screen](image)

- Press **Yes** to clear all 16 of the user defined Bus Maps.
- Press **No** to retain the current Bus Maps and exit the menu safely.

This completes the procedure for restoring factory default values.
Lock/Unlock Installation

The Lock/Unlock Installation feature allows you to password protect the Installation Menus. Setting a password helps prevent unauthorized modification of switcher installation settings. Setting a password also prevents recalling of installation registers.

When the Lock/Unlock Installation feature is active, a Warning Screen is displayed when you attempt to navigate to the Installation Menu stating that the installation settings are locked and any changes will not be saved.

Use the following procedure to lock or unlock the installation settings of the switcher:

1. Navigate to the Lock/Unlock Installation Menu as follows:

   ![Lock/Unlock Installation Menu]

   **Note**
   If the Lock/Unlock Installation feature is active, and a password has been defined, the Enter Installation Password Menu is displayed. Enter the password in the New Name field and press Accept New Name to display the Lock/Unlock Installation Menu.

2. Turn the installation lock on or off as follows:
   - Toggle Install’n Lock on the Lock/Unlock Installation Menu to On or Off:
     - On — Select this option to turn the installation lock feature on.
     - Off — Select this option to turn the installation lock feature off.

3. Set a password for the installation lock as follows:
   - Press Add/Change Password on the Lock/Unlock Installation Menu to display the Change Installation Password Menu. If a password has already been set, the button is labelled Change Password.
• Enter the new password in the New Password field on the Change Installation Password Menu.

• Press Accept New Name on the Change Installation Password Menu to save the new password.

This completes the procedure for locking or unlocking the installation settings of the switcher.
Set System Time

The System Time allows you to set the current date and time on the hardware clocks on both the frame and the Q/MD control panel.

Use the following procedure to set the system time:

1. Navigate to the Set System Time Menu as follows:

   **Note**
   The time shown on the menu is the time when the Set System Time Menu was first accessed, and not the current time.

2. Set the current date as follows:
   - Press Date on the Set System Time Menu.
   - Use the Year knob on the Set System Time Menu to select the current year.
   - Use the Month knob on the Set System Time Menu to select the current month.
   - Use the Day knob on the Set System Time Menu to select the current day.

3. Set the current time as follows:
   - Press Time on the Set System Time Menu.
   - Use the Hour knob on the Set System Time Menu to select the current hour.
   - Use the Minute knob on the Set System Time Menu to select the current minute.
   - Use the Second knob on the Set System Time Menu to select the current second.

4. Set Daylight Saving Time as follows:
   - Set DST on the Set System Time Menu to turn Daylight Saving Time On or Off.

5. Press Set on the Set System Time Menu to set the hardware clock on the Q/MD control panel and frame to the selected date and time.

This completes the procedure for setting the system time.
Completing Setup

In This Chapter

This chapter provides instructions for additional installation setup procedures. The following topics are discussed:

- About Synergy Q/MD File Storage
- Saving Configurations
- Recalling Configurations
- Favorite CG Setup
About Synergy Q/MD File Storage

The Synergy Q/MD file storage system arranges those portions of the switcher that are software-configurable (and user-configurable) into the following categories of registers.

- **Memory Registers**
  This category stores and recalls MLE settings or “snapshots” of the various switcher MLEs. A memory register can be programmed from several locations on the panel: in the Global Memory System group or in an individual MLE Memory group. If the Squeeze & Tease MD option is installed, all 100 S&T MD memories are stored in a separate memory file.

- **Custom Control Registers**
  This category stores and recalls the functions that you have programmed into the Custom Control group of the switcher. These functions can include external device control commands and other panel-specific macros (programmable keys).

- **Personality Registers**
  This category stores and recalls settings that are user-configurable, and which apply to a particular style of operation rather than to basic installation parameters. The following data is contained in the file:

  - Favorite CG Setup
  - Time Clock Direction
  - Transitions (on which the Time Clock resets)
  - Time Clock Reset Time
  - Time Clock Position
  - VTR Time Code Position
  - Source ID Position
  - Mnemonics
  - PIP-II Memory
  - Audio Transitions
  - Preset Black
  - Fade to Black
  - All Preview Overlay
  - User Wipes
  - CG Mode, Channel and file/folder settings
  - Double Press Rate
  - Memory Bank Cycle Max
  - Memory Attributes
  - Matte Limit
  - Auto-Recall
  - DSK Cut and Isolation Settings
  - S&T MD Button Pattern
  - Panel Sleep Time
  - Bus Map Assignment

- **VTR Clip Registers**
  This category stores and recalls VTR clip registers (in timecode format).
• **Installation Registers**

This category stores and recalls all setup and configuration settings. The following data is contained in the file:

- BNC Input Names
- BNC Input Types
- Tally Configuration
- Alpha Setup
- Auto Key Configuration
- Panel Button Assignments
- Aux Bus Setup
- Output Setup
- Clean Feed Setup
- GPI Input / Output Setup
- Device Setup
- Editor Communications Setup
- Custom Banks
- Custom Device Setup

• **3D Sequence Registers**

This category stores and recalls all Squeeze & Tease MD Sequence registers.

• **Bus Map Registers**

This category stores and recalls all 17 of the Bus Maps used to assign video sources to crosspoint buttons. There are 16 user defined bus maps, and a single default bus map.

• **All Individual Memories Registers**

This category stores switcher memories individually to their own separate files.

The file storage and recall system is accessible via the **Disk Menu**. This menu provides complete flexibility with regard to registers. You can independently store or recall individual categories as desired (without affecting other files), or you can store all categories at once.

**Note**

You cannot store or recall while a custom control function is playing.

Even though all the data listed above is stored in the non-volatile “flash” memory of the switcher, it is always wise to keep an archive or “engineering” backup on hand that contains your important setups and configurations. Not only does this provide security in case you need to re-program the Synergy Q/MD switcher, but it also allows you to have a variety of switcher files available (on multiple USB Drives or Hard Drive Setups), should you need to load different configurations — for different clients or different production situations. Refer to the section “**Backing Up Setups to an External Computer**” on page 6–19 for more information on backing up your switcher files.
Saving Configurations

Once all of your switcher assignments and configurations have been completed, it is strongly recommended that you save these setups. The installation procedure covers three categories of registers — Custom Control, Personality, and Installation. As a result, all three categories should be stored.

Switcher files such as memories, custom controls, personality settings, VTR clip registers, installation settings and Squeeze & Tease sequences are stored in switcher setups. Each setup can contain a complete set of these switcher files that you can use to quickly store and recall different switcher configurations. Individual setups can also be stored on an external computer. Refer to the section “Back up Setups to an External Computer” on page 6–19 for more information.

Use the following procedure to save your setup configurations:

1. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.
2. Press Dest/Source to display the Destination/Source Menu.

   ![Dest/Source Menu]

3. Select the storage device that you want to use to store the files as follows:
   - Use the top knob to select the storage device you want to store the files to. You can select between the following:
     - Hard Drive — This option will allow you to store the files on the internal hard drive.
     - USB — This option will allow you to store the files on a USB key inserted into the control panel USB port.
   - Use the Set Names knob to select a Setup, or location, for the storage of the files.
4. Press Store to display the Disk Store Menu 1-2.

   ![Disk Store Menu 1-2]
5. Select the category of registers that you want to store as follows:

**Note**

As the software upgrade process automatically returns the switcher to default values, it is recommended that you store all of your setups.

- Press **All** to store all categories of registers.
- Press **Memories** to store only Memory Registers.
- Press **Custom Controls** to store Custom Controls Registers.
- Press **Personality** to store only Personality Registers.
- Press **VTR Clips** to store only VTR Clips Registers.
- Press **Installation** to store only Installation Registers.
- Press **3D Sequences** to store only Squeeze & Tease MD Sequences.
- Press **Bus Maps** to store only Bus Maps.

6. Name your Setup as follows:

- Press **MORE** to display the Disk Store Menu 2-2.
- Press **Name Setup** to display the Setup Names Menu.

**Note**

A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

- Use the bottom **Setup Number** to select the Setup you want to rename.
- Enter a New Name for the setup.
- Press **Accept New Name** to accept the new name.

This completes the procedure for saving your setups.
Recalling Configurations

As required, you can recall all categories of configuration registers, or you can simply recall the desired individual category.

Use the following procedure to recall your setup configurations:

1. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.
2. Press Dest/Source to display the Dest/Source Menu.

3. Select the storage device that you want to use to recall the files from as follows:
   - Use the top knob to select the storage device you want to recall the files from. You can select between the following:
     - Hard Drive — This option will allow you to recall the files from the internal hard drive.
     - USB — This option allows you to name the files on a USB key plugged into the control panel USB port.
   - If you are saving to the internal hard drive, use the Set Names knob to select the Setup you want to name. There are 100 (00 through 99) setups available from which to recall files.
4. Press Recall to display the Disk Recall Menu 1-2.

**Note**
Ensure that any custom setups are stored to another Setup before you recall a setup. When a register is recalled, the existing register information is replaced with the recalled.
5. Select the category of registers that you want to store as follows:

- Press **All** to recall all categories of registers from a storage device.
- Press **Memories** to recall only **Memory Registers** from a storage device.
- Press **Custom Controls** to recall only **Custom Control Registers** from a storage device.
- Press **Personality** to recall only **Personality Registers** from a storage device.
- Press **VTR Clips** to recall only **VTR Clip Registers** from a storage device.
- Press **Installation** to recall only **Installation Registers** from a storage device.
- Press **3D Sequences** to recall only **3D Sequence Registers** from a storage device.
- Press **Bus Maps** to recall only **Bus Maps** from a storage device.

This completes the procedure for recalling your setups from a storage device.
**Favorite CG Setup**

This setup procedure allows you to select a “favorite” CG that you want to assign to the **CHAR GEN** button in the **MLE Key 2 Group** of an upper MLE. The location of the button is shown below:

![CHAR GEN (Favorite CG) Button Location](image)

The button allows you to instantly recall and select your most frequently-used character generator, without having to hunt for it on the **Key Bus** — thus saving two steps during production: (1) selecting the key type, and (2) selecting the key source.

Use the following procedure to program the “favorite” CG button:

1. Press and **hold** the **CHAR GEN** button in the Keyer of any MLE.
2. On the selected **Key Bus** of the MLE, press the button for your most frequently used CG.
3. Release both buttons. The selected CG is now stored in memory, and will be recalled each time **CHAR GEN** is pressed — in any MLE.

This completes the procedure for programming the “favorite” CG button.

Please note:

- If you have a key type already set up when you press **CHAR GEN**, the entire keyer is cleared. In addition to the favorite CG, the system will automatically select **AUTO SELECT** and (if an Auto Key has been properly set up during installation), **KEY MEM**.
- The “favorite” CG programming function is global. Regardless of where you program the function, all **CHAR GEN** buttons (in all MLEs) will now recall the selected CG.
In This Chapter

This chapter provides instructions for connecting, and setting up Up-Down converter hardware and using the SmartConversion™ features of the Synergy Q/MD switcher.

The following topics are discussed:

- SmartConversion Overview
- Creating Conversion Loops
- Configuring SmartConversion
SmartConversion Overview

Synergy Q/MD switchers can operate with high-definition (in a wide variety of formats) as well as standard-definition video. To mix video signals, Synergy Q/MD switchers require all video signals to be in the same format. This means that mixing standard and high-definition video requires a conversion to one of the formats (such as converting standard-definition to high-definition).

Converting Video

SmartConversion uses an expandable approach to video format conversion. Typically, not all the video sources in your switcher need to be converted simultaneously as it would be a rare case to need all video sources on-air at the same time. Thus, you can have fewer converters than video sources and route only those that need conversion at the present time through the converters. As video sources are taken on and off-air, converters become busy and free depending on the number of sources that need conversion at one time. Optimizing the number of converters to the expected number of simultaneous video conversions you require allows you to realize a significant cost savings over having to purchase one converter for every video input.

SmartConversion utilizes external up/down converters to handle video format conversion. This allows you the freedom to select up/down converters that best meet the needs of your facility. You can add converters at any time and can use up to 32 up/down converters with a Synergy Q/MD switcher.

Conversion Loops

The up/down converters are connected to your switcher to form a conversion loop. A conversion loop refers to the path that a video stream takes when it needs to be converted to a different format. When you push a crosspoint button on your switcher and its associated video source is in a format that needs to be converted, the video stream is automatically routed out through an Aux Bus to the up/down converter. Once converted to the appropriate format, the video is routed back from the up/down converter to an input on your Synergy Q/MD switcher.

You can specify that certain switcher video buses do not need conversion as well as specifying that certain buses need dedicated converters. SmartConversion converts video sources between formats on-the-fly and, once configured, is transparent to the operator. You can also change input video formats on-the-fly (when an input signal is provided in a different format than is set on your switcher) without having to reconfigure your switcher.
Creating Conversion Loops

The Synergy Q/MD switcher uses a conversion loop to pass video to an up/down converter and then to receive the converted video back. Creating this loop involves both physical installation as well as software configuration. The main steps involved are:

- Planning Your Conversion Loops
- Cabling Your Conversion Loops
- Configuring Your Switcher

Once the loops have been cabled and configured, you can proceed to configure the SmartConversion features of the Synergy Q/MD switcher.

Planning Your Conversion Loops

Take into account the following conversion scenarios:

- How many video conversions do you need to perform at one time?
- Do you want to lock one or more conversion loops to a specific bus so it is always available to that bus?
- Do you want to designate one or more buses as not needing conversion and, therefore, never requiring conversion loop resources?
- How many different conversion formats do you require (e.g., do you need to up-convert to both 720p and 1080i)?
- How many conversion loops of each converted video format do you need?

Answering these questions will lead you to the total number of conversion loops that you will need to cable and configure. You will also know how to subdivide the conversion loops based on the output video format they provide and if they are locked to a certain bus.

When planning your conversion loops, keep in mind that each one requires one Aux Bus output for the switcher to send the video to the up/down converter and one input for the up/down converter to send the converted video back to your switcher. Also note that you need to define the input video format for the up/down converter so the switcher knows where to send video that needs to be converted and the output format from the up/down converter so that you can configure the input BNC on your switcher to match.

Conversion Loop Worksheet

Use the following worksheet to help you plan your conversion loops. To avoid marking up this document, photocopy the worksheet and use that copy to plan your conversion loops.
<table>
<thead>
<tr>
<th>Conversion Loop</th>
<th>Output Video Format (From Switcher)</th>
<th>Converted Video Format (From Converter)</th>
<th>Aux Bus</th>
<th>Output BNC (To Converter)</th>
<th>Input BNC (From Converter)</th>
<th>Locked to Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td>480i 60</td>
<td>1080i 59.94</td>
<td>Bank 1 Bus 1</td>
<td>B16</td>
<td>D16</td>
<td>None</td>
</tr>
<tr>
<td>Sample 2</td>
<td>1080pSF 29.97</td>
<td>1080i 59.94</td>
<td>Bank 1 Bus 2</td>
<td>B15</td>
<td>D15</td>
<td>None</td>
</tr>
<tr>
<td>Sample 3</td>
<td>720p 59.94</td>
<td>1080i 59.94</td>
<td>Bank 1 Bus 3</td>
<td>B14</td>
<td>D14</td>
<td>MLE 3 BGKD+PST</td>
</tr>
<tr>
<td>Sample 4</td>
<td>720p 59.94</td>
<td>1080i 59.94</td>
<td>Bank 1 Bus 4</td>
<td>B13</td>
<td>D13</td>
<td>MLE 3 BGKD+PST</td>
</tr>
</tbody>
</table>
Cabling Your Conversion Loops

As discussed in the section “Planning Your Conversion Loops” on page 13–3, a conversion loop is created by connecting an up/down converter between an Aux-Bus output and an Input. The video to be converted is routed out the Aux Bus and into the up/down converter. Once converted to the proper format, the video is routed back into the switcher via the input.

Use the following procedure to cable a converter loop between your Synergy Q/MD switcher and an up/down converter:

1. Locate the Aux Bus output on the Q/MD frame that corresponds to your Conversion Loop Worksheet. Refer to the section “Configuring the Outputs” on page 8–3 if you need information on setting output BNCs as Aux Bus outputs.

You may find it convenient to have your Conversion Loop Worksheet available as you perform the Conversion Loop cabling.

2. Connect the Aux Bus output (refer to column 5 of your Conversion Loop Worksheet) to the input of your up/down converter using industry-standard coaxial cable. Use cabling techniques in accordance with good engineering practice. Consult the documentation for your particular up/down converter for information on which port to connect to.

3. Locate the input on the Q/MD frame that corresponds to column 6 on your Conversion Loop Worksheet.

Connect the output of your up/down converter to the input of the Q/MD frame using industry standard coaxial cable. Use cabling techniques in accordance with good engineering practice.
4. Connect the power supply to your up/down converter.
5. Configure your up/down converter so that it converts the appropriate input formats and provides the appropriate output video format as indicated on your Conversion Loop Worksheet. Consult the documentation for your specific up/down converter for assistance.

This completes the procedure to cable a converter loop between your Synergy Q/MD switcher and an up/down converter. Repeat this procedure for each loop on your Conversion Loop Worksheet.

**Configuring Your Switcher**

Once you have completed cabling your conversion loops, you need to configure the Synergy Q/MD switcher to recognize them.

Use the following procedure to configure your Synergy Q/MD switcher to recognize a converter loop:

1. Navigate to the **External Device Assign Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus** ⇒ **Ext Device Assign**.

2. Define a conversion loop as follows:
   - Use the **Aux Bus** knob to select the Aux Bus that is cabled to your up/down converter. This is the outbound portion of the conversion loop.
   - Use the **BNC** knob to select the input BNC that is cabled to your up/down converter. This is the inbound portion of the conversion loop.
   - Use the **Tally when** knob to select how the Aux Bus is tallied. While there are multiple options, select SmartConversion the **XPT On Air** setting.

3. Repeat Step 2 for each conversion loop you have cabled.

This completes the procedure to configure your Synergy Q/MD switcher to recognize a converter loop.
Configuring SmartConversion

Once you have cabled your conversion loops and configured your Synergy Q/MD switcher to recognize them, you still need to configure your switcher with information on the video formats of all inputs, bus outputs, and SmartConversion options.

The steps to configure your Synergy Q/MD switcher for SmartConversion are:

- Configuring Aux Bus Output Formats
- Configuring Inputs
- Configuring Conversion Options
- Displaying Available Converters

Configuring Aux Bus Output Formats

The Synergy Q/MD switcher needs to be configured with the output video format of each Aux Bus that is part of a Conversion Loop. This information allows the switcher to correctly route video sources to the appropriate up/down converters as needed.

Setting the Aux Bus Video Format

Use the following procedure to set the video format for each Aux Bus:

1. Navigate to the Output Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output ⇒ MORE.
2. Press Aux Bus Format to display the Aux Bus Format Menu.

   ![](aux_bus_format_menu.png)

   "Aux Bus Format Menu"

3. Set the video format for each Aux Bus as follows:
   - Use the Aux Bus knob to select the Aux Bus you want to set the video format for (refer to column 4 of your Conversion Loop Worksheet).
   - Use the Format knob to select the video format for the Aux Bus (refer to column 2 of your Conversion Loop Worksheet). This is the input video format of the up/down converter that is connected to this Aux Bus.

   Note

   The video format list shows all formats the switcher is capable of operating in. Each Aux Bus defaults to the system output video format. Refer to the section “Reference” on page 11–26 for information on setting the system output format.

This completes the procedure to set the video format for each Aux Bus.
**Defaulting Output Bus Video Formats**

You can rapidly set all MLE and Aux Bus outputs to the same video format as the currently defined system video format. If most of the buses on your Synergy Q/MD switcher use the system video output format, this is an easy way to set them without having to configure each one separately.

Use the following procedure to set the default video format for all MLE and Aux Bus outputs:

1. Navigate to the **Reference Menu** as follows:
   - Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ MORE ➔ Reference.

   ![Reference Menu]

2. Press **Default Output BNC Types** to set all output BNCs to the system output video format.

   You will be presented with a confirmation screen and must confirm or cancel the changes by selecting:
   - **Confirm** — All MLE and Aux Bus output video formats will be changed to match the current system video output format.
   - **Cancel** — No changes to the output video formats will be made.

This completes the procedure to set the default video format for MLE and Aux Bus outputs.

**Configuring Inputs**

The Synergy Q/MD switcher needs to be configured with the video format of each input BNC. This, in combination with the MLE and Aux Bus output video formats defined in the previous section, allows the Synergy Q/MD switcher to determine whether the video from a particular input BNC does not match the output video format on the current bus and needs to be converted.

Use the following procedure to set the video format for each input BNC:

1. Navigate to the **BNC Menu 1-2** as follows:
   - Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ BNC.

2. Press **BNC Type** to display the **BNC Type Menu**.

   ![BNC Type Menu]
3. Set the video format for each input BNC as follows:
   
   - Use the **BNC** knob to select the BNC you want to set the video format for (refer to column 6 of your Conversion Loop Worksheet).
   
   - Use the **Format** knob to select the video format for the input BNC (refer to column 3 of your Conversion Loop Worksheet).

   The video format list shows all formats the switcher is capable of operating in. Each MLE defaults to the system output format your switcher is operating in. Refer to the section “Reference” on page 11–26 for information on setting the system output format.

   **Note**

   This completes the procedure to set the video format for each input BNC.

   **Defaulting Input Video Formats**

   You can rapidly set all input BNCs to the same video format as the currently defined system output video format. This is a good way to start configuration if you are only using a few video sources that are of different formats as you only have to modify the video formats of those inputs which are different.

   Use the following procedure to set the default video format for all input BNCs:

   1. Navigate to the **Reference Menu** as follows:
      
      - Press **HOME** \(\Rightarrow\) **MORE** \(\Rightarrow\) **Setup** \(\Rightarrow\) **Installation** \(\Rightarrow\) **MORE** \(\Rightarrow\) **Reference**.

      **Reference Menu**

      | Video Format | Ref Format |
      |--------------|-----------|
      | 1080i 59.94  | 1720p 59.94 |
      | Integration  | 1080i 59.94 |

   2. Press **Reset Format Input BNCs** to set all input BNCs to the system output video format.

   You will be presented with a confirmation screen and must confirm or cancel the changes by selecting:

   - **Confirm** — All input BNC video formats will be changed to match the current system video output format.

   - **Cancel** — No changes to the input video formats will be made.

   This completes the procedure to set the default video format for input BNCs.
Activating Conversion Loops

Each Conversion Loop must be activated in order for SmartConversion to use it.

Use the following procedure to activate a Conversion Loop:

1. Navigate to the SmartConversion Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ SmartConversion.
2. Press Aux To Converters to display the Aux To Converters Menu.

3. Mark an Aux Bus as being used for SmartConversion as follows:
   - Use the Aux Bus knob to select an Aux Bus you have cabled and configured as being part of a Conversion Loop.
   - Use the Used For Converter knob to select whether the specified Aux Bus is to be used for SmartConversion. You can select from the following:
     ~ Yes — The specified Aux Bus output is attached to an up/down converter and is to be used for SmartConversion
     ~ No — The specified Aux Bus output is not to be used for SmartConversion.
   - Use the Delay in Fields knob to specify the delay (in fields) that the up/down converter adds to the video stream. You can specify a delay of 0-60 fields. See your up/down converter documentation for the appropriate value.

The middle portion of the menu screen shows a summary of your settings. As you use the Aux Bus knob to scroll through the various Aux Buses, their settings will be displayed in this area of the menu screen.

4. Repeat steps 1-3 for each conversion loop you have cabled and configured.

This completes the procedure to activate a Conversion Loop.

Selecting Output Video Formats of External Converters

The final step in the Conversion Loop definition process is to define the video formats that each up/down converters provide as output. You must manually set each up/down converter to output the desired video format and then specify that same output video format to your Synergy Q/MD switcher.
Use the following procedure to specify the output video format of an up/down converter:

1. Set the output video format on your up/down converter. Refer to the documentation for your specific up/down converter for details on how to configure video conversion settings.

2. Navigate to the **SmartConversion Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ SmartConversion.

3. Press **Converter Formats** to display the **Converter Formats Menu**.

4. Specify an output video format for an up/down converter connected to an Aux Bus as follows:
   - Use the **Aux Bus** knob to select an Aux Bus you have connected to an up/down converter.
   - The **Converter Input Format** knob mirrors the setting you made in the **Aux Bus Format Menu**. Ensure that it is set to the proper input video format for your up/down converter.
   - Use the **Converter Output Format** knob to select the video format provided by the up/down converter connected to the Aux Bus selected above.

**Important** You can select from any of the output formats supported by the Synergy Q/MD switcher but be sure that you select a video format compatible with your reference video format. Refer to the section “**Reference**” on page 11–26 for information on video formats and reference settings.

The middle section of the menu screen shows a summary of your settings. As you use the **Bus** knob to scroll through the various Buses, their settings will be displayed in this area of the menu screen.

The **Converter Input Format** knob mirrors the setting you made in the section “**Configuring Aux Bus Output Formats**” on page 13–7.

The **Converter Output Format** knob will override (but not mirror) the setting you made in the section “**Configuring Inputs**” on page 13–8. If you use this knob, the input format you set in the **BNC Type Menu** will be ignored.

**Important** Ensure that you specify the correct video format for each up/down converter. Setting the video format to something other than the video format provided by the up/down converter can have unpredictable results.
Changes you make with the Converter Input Format knob are reflected in the Aux Bus Format Menu and vice versa. However, changes you make with the Converter Output Format are used for SmartConversion but are not reflected in the BNC Type Menu.

This completes the procedure to specify the output video format of an up/down converter.

**Configuring Conversion Options**

Once all the Conversion Loops have been cabled, configured, and activated, you can configure SmartConversion options. These options define whether certain switcher buses are prevented from using Conversion Loops and whether some Conversion Loops are locked to a certain bus. Tailoring these settings allow you to maximize Conversion Loop resources in your production environment.

**Configuring Bus Disabling**

Bus Disabling allows you to specify that a particular switcher bus does not need any conversion. Doing so helps you to alleviate converter resource shortages when switching video sources on a bus marked as not needing conversion. This is especially useful in keeping up/down converters from being consumed if someone changes sources on an Aux Bus.

Use the following procedure to configure Bus Disabling:

1. Navigate to the SmartConversion Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ SmartConversion.
2. Press Bus Disabling to display the Bus Disabling Menu.

```
<table>
<thead>
<tr>
<th>Switcher Bus</th>
<th>Enabled</th>
<th>Bus:</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE1 Program</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MLE1 Preset</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MLE1 K1 Video</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MLE1 K1 Alpha</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MLE1 K2 Video</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MLE1 K2 Alpha</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>MLE1 Utility1</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Bus Disabling Menu
```

3. Specify whether a particular bus can use SmartConversion as follows:
   - Use the Bus knob to select a bus. You can select from the following:
     - None — The specified up/down converter is not locked to a specific bus pair.
     - MLE 1 Program — MLE 1 Program (Background) bus.
     - MLE 1 Preset — MLE 1 Preset bus.
     - MLE 1 KEY 1V — MLE 1 Key bus, Key 1 video.
     - MLE 1 KEY 1A — MLE 1 Key bus, Key 1 alpha.
     - MLE 1 KEY 2V — MLE 1 Key bus, Key 2 video.
     - MLE 1 KEY 2A — MLE 1 Key bus, Key 2 alpha.
     - MLE 1 Util — MLE 1 Utility bus.
     - MLE 2 Program — MLE 2 Program (Background) bus.
~ MLE 2 Preset — MLE 2 Preset bus.
~ MLE 2 KEY 1V — MLE 2 Key bus, Key 1 video.
~ MLE 2 KEY 1A — MLE 2 Key bus, Key 1 alpha.
~ MLE 2 KEY 2V — MLE 2 Key bus, Key 2 video.
~ MLE 2 KEY 2A — MLE 2 Key bus, Key 2 alpha.
~ MLE 2 Util — MLE 2 Utility bus.
~ MLE 3 Preset — MLE 3 Preset bus.
~ MLE 3 KEY 1V — MLE 3 Key bus, Key 1 video.
~ MLE 3 KEY 1A — MLE 3 Key bus, Key 1 alpha.
~ MLE 3 KEY 2V — MLE 3 Key bus, Key 2 video.
~ MLE 3 KEY 2A — MLE 3 Key bus, Key 2 alpha.
~ MLE 3 Util — MLE 3 Utility bus.
~ MLE 1 KEY 1 BackV — MLE 1 Key bus, Key 1 backside video.
~ MLE 1 KEY 1 BackA — MLE 1 Key bus, Key 1 backside alpha.
~ MLE 1 KEY 2 BackV — MLE 1 Key bus, Key 2 backside video.
~ MLE 1 KEY 2 BackA — MLE 1 Key bus, Key 2 backside alpha.
~ MLE 2 KEY 2 BackV — MLE 2 Key bus, Key 2 backside video.
~ MLE 2 KEY 2 BackA — MLE 2 Key bus, Key 2 backside alpha.
~ MLE 3 KEY 1 BackV — MLE 3 Key bus, Key 1 backside video.
~ MLE 3 KEY 1 BackA — MLE 3 Key bus, Key 1 backside alpha.
~ MLE 3 KEY 2 BackV — MLE 3 Key bus, Key 2 backside video.
~ MLE 3 KEY 2 BackA — MLE 3 Key bus, Key 2 backside alpha.

**Aux Buses** — All Aux Buses not assigned to external devices are listed and available for conversion.

- Use the **Conversion Enabled** knob to select whether the specified bus can use SmartConversion. You can select from the following:
  - **Yes** — The specified bus will use SmartConversion.
  - **No** — The specified bus will not use SmartConversion.

**Note**

Aux Buses are set to **No** by default. Aux Mixer-Keyers are set to **Yes** by default.

4. The middle portion of the menu screen shows a summary of your settings. As you use the **Bus** knob to scroll through the various Buses, their settings will be displayed in this area of the menu screen.

This completes the procedure to configure Bus Disabling.
**Configuring Converter Locking**

Converter Locking allows you to specify that an up/down converter is dedicated to a specific bus. This allows that bus to always have a converter available regardless of the SmartConversion resources being used by other buses. The main Program and Preset Buses are ideal candidates for converter locking.

### Important

Buses are always locked in pairs. Program + Preset buses are always paired and Key buses have Video + Key Alpha video signals always paired.

Use the following procedure to lock an up/down converter to a bus pair:

1. Navigate to the SmartConversion Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ SmartConversion.
2. Press Converter Locking to display the Converter Locking Menu.

#### Converter Locking Menu

<table>
<thead>
<tr>
<th>Aux Bus:</th>
<th>Lock To Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE 1 BKGD+PST</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 1 KEY 1</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 1 KEY 2</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 1 Util</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 2 BKGD+PST</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 2 KEY 1</td>
<td>NONE</td>
</tr>
<tr>
<td>MLE 2 KEY 2</td>
<td>NONE</td>
</tr>
</tbody>
</table>

3. Specify an up/down converter as being locked to a specific bus pair as follows:
   - Use the Converter knob to select the Aux Bus that the desired converter is connected to.
   - Use the Bus/Pair knob to select the specific bus pair to lock the converter to. You can select from the following:
     - **None** — The specified up/down converter is not locked to a specific bus pair.
     - **MLE 1 BKGD+PST** — The specified up/down converter is locked to the Background + Preset bus pair on MLE 1.
     - **MLE 1 KEY 1** — The specified up/down converter is locked to the Key 1 Video + Alpha bus pair on MLE 1.
     - **MLE 1 KEY 2** — The specified up/down converter is locked to the Key 2 Video + Alpha bus pair on MLE 1.
     - **MLE 1 Util** — The specified up/down converter is locked to the Utility bus on MLE1.
     - **MLE 2 BKGD+PST** — The specified up/down converter is locked to the Background + Preset bus pair on MLE 2.
     - **MLE 2 KEY 1** — The specified up/down converter is locked to the Key 1 Video + Alpha bus pair on MLE 2.
     - **MLE 2 KEY 2** — The specified up/down converter is locked to the Key 2 Video + Alpha bus pair on MLE 2.
MLE 2 Util — The specified up/down converter is locked to the Utility 1 Video + Alpha bus pair on MLE 2.

MLE 3 BKGD+PST — The specified up/down converter is locked to the Background + Preset bus pair on MLE 3.

MLE 3 KEY 1 — The specified up/down converter is locked to the Key 1 Video + Alpha bus pair on MLE 3.

MLE 3 KEY 2 — The specified up/down converter is locked to the Key 2 Video + Alpha bus pair on MLE 3.

MLE 3 Util — The specified up/down converter is locked to the Utility 1 Video + Alpha bus pair on MLE 3.

Aux Buses — All Aux Buses not assigned to external devices are listed and available for locking.

Note

It is possible to lock multiple up/down converters to the same bus pair. This is useful if you wish to have converters of different format types always available to a certain bus pair. You should always lock at least two converters to a bus pair to ensure that both buses in the pair have access to a converter at the same time.

The middle portion of the menu screen shows a summary of your settings. As you use the Converter knob to scroll through the various Aux Buses with up/down converters connected to them, their settings will be displayed in this area of the menu screen.

This completes the procedure to lock an up/down converter to a bus pair.

Displaying Available Converters

You can configure your Synergy Q/MD switcher to display the number of free up/down converters in the Fade To Black Display. The number displayed reflects the total number of available converters (without regard to Bus Disabling, Converter Locking, or conversion formats). This is an optional step that does not need to be performed but you may find it convenient to have the number of free up/down converters displayed on your switcher panel.

Use the following procedure to display the number of free up/down converters in the Fade To Black Display:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select FTB Display.
3. Use the Value knob to select the desired setting for the Fade To Black Display. You can choose between the following:
   - SmrtConv — The Fade To Black Display shows the number of available up/down converters.
   - FTB — The Fade To Black Display shows the standard fade to black frames display.

This completes the procedure to display the number of free up/down converters in the Fade To Black Display.
**Glossary of Terms**

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another in which one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
Hue — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

Internal Key — The use of a primary input to produce a key effect.

Key — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

Key Fill — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

Key Invert — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The KEY INV push-button selects this effect.

Key Mask — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

Key Source — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

Key Video — See Key Source.

Linear Keys — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The KEY MEM button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to your requirements.

Line Frequency — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

Luminance Key — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

Mask — See Key Mask.

Matte — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

Matte Key — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

Memory — The memory feature provides storage and recall of complete switcher setups.

MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labeled “KEY”, “PGM”, and “PST”.

PV Output — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key fill.
**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

**Tally** — An indicator which illuminates when the associated push-button or control is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

**Wipe** — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics

2D Squeeze & Tease DVE ................................... 1-19
3D Sequence
  registers ..................................................... 12-3
3D Squeeze & Tease DVE ................................... 1-19
4400A-010 ........................................................ 2-6
4400A-060A .................................................... 2-5
4400A-060B .................................................... 2-5
4400A-060C .................................................... 2-5
4800A-001 ........................................................ 2-5
4800A-040 ........................................................ 2-5
4800A-047 ........................................................ 2-6
4800A-064 ........................................................ 2-5

A
Abbreviations ................................................... 1-5
AC adapter ...................................................... 3-29
Active
  Video .......................................................... 8-19
Active MLE Transition, Custom Control ........ 10-23
A-D, definition .............................................. 1-5
Adapter, Aux ................................................ 4-5
Adjust display contrast .................................. 5-7
Advanced border generator .......................... 1-20
Advanced Chroma Keying .............................. 1-8, 1-16
After keys, clean feed .................................. 8-17
All Individual Memories
  registers ..................................................... 12-3
Alpha
  shaped ....................................................... 7-13
  signal connection ....................................... 4-20
  unshaped ................................................... 7-13
Alpha, Input BNC .......................................... 7-11
Alpha, Input BNC Type .................................. 7-9
Analog reference input .................................. 2-11
Ancillary data menu ..................................... 8-19
Architecture
  CPU .......................................................... 2-17
  system ....................................................... 2-1
Arm mode, ROLL VTR .................................... 1-25
Assign
  aux bus tallies ........................................... 11-5
  AuxBkgdCut button .................................. 7-19, 7-20
  AuxBkgdTrans button ................................ 7-19, 7-20
  AuxKeyCut button .................................... 7-19
  AuxKeyTrans button .................................. 7-19
  black to bus map ...................................... 7-18
  Bus Hold button ....................................... 7-20
  color background to bus map .................... 7-18
Audio
  embedded .................................................. 8-19
Audio custom control banks ..................... 10-5
Audio mixer
  small audio mixer interface ........................ 1-24
Audio Mixer option
  large .......................................................... 1-24
Audio Server
  custom control functions ....................... 10-3, 10-4
Audio server
  remote control .......................................... 3-30
Audio Server Control option ..................... 1-25, 6-30
  DigiCart .................................................. 1-25
Audio Server, BNC Type, see VTR
Auto key setup menu ................................ 7-13
Auto Key, Still-Store setup .......................... 7-14
AUTO, GPI .................................................. 11-19
Automated Testing Tool, see Checksums
Automation Custom Control ....................... 10-23
Aux
  Bus, DVE outputs ...................................... 8-6
  panel override ......................................... 11-2
  panel, assignment programming mode ........ 11-12
  panel, GPI programming mode .................. 11-12
  panel, GPIs ............................................. 11-9
Aux Adapter, RJ-12 to DB9 ......................... 4-5
Aux Bus
  assign tally ............................................ 11-5
  CCU joystick override setup ..................... 11-13
  external device assign ............................. 11-5
  follow mode ............................................ 11-5
  GPI Tally Assign ..................................... 11-6
  local panel ............................................. 11-2
  mode ...................................................... 11-4
  monitor CCU joystick override .............. 11-15
  no tally .................................................. 11-5
  OFF mode, regular mode ......................... 11-4
remote panel GPI override.............................. 11-9
remote panels menu...................................... 11-12
setup local panels...........................................11-4
setup menu...................................................11-2
XPT on air......................................................11-6
Aux Bus output BNCs ......................................8-5
Aux Buses
Output BNCs ..................................................8-5
AUX connectors
1, 2, 3 ............................................................ 3-6
Aux Mix setup ..................................................8-15
Aux Mix/Key setup ..........................................8-15
Aux panel
AC adapter, overview ....................................3-29
cable retainer, overview .................................3-29
cabling ..........................................................4-4
cabling, Synergy 1 MD .....................................4-5
echo connector, overview .................................3-29
GPI connector, overview ................................3-28
installation ......................................................3-28
main connector, overview ...............................3-28
power connector, overview ..............................3-28
rear connector layout .....................................3-28
rear layout ........................................................3-28
Aux panels
Remote GPI Assignment ................................11-13
remote GPI type ..............................................11-14
Aux panels, remote, see Remote aux panel
Aux, definition..................................................1-5
AuxBkgdCut, button ........................................7-19, 7-20
AuxBkgdTrans, button .....................................7-19, 7-20
AuxKeyCut, button ..........................................7-19
AuxKeys ..........................................................1-8, 1-18
applications ......................................................1-19
option ..............................................................8-15
setup ..............................................................8-15
AuxKeys option ..............................................1-18, 6-31
AuxKeyTrans, button ......................................7-19

B
Backup system..................................................12-5
Banks
audio vs normal .............................................10-5
custom control functions .................................10-3, 10-5
default, restting names to .................................10-8
Select Custom Control Bank event ......................10-14
setup, custom control .....................................10-5
types .............................................................10-5
Basic troubleshooting ......................................4-18
Baud rate
Pbus port .........................................................9-12
Serial Tally port .............................................9-15
Before keys, clean feed ....................................8-17
BKGD 1, 2 ..........................................................7-18
BLACK ...........................................................7-18
Blanking
horizontal .......................................................8-19
vertical .........................................................8-19
Block diagram ..................................................2-2
BNC
configuration ..................................................7-1, 7-2, 8-1
name inputs .....................................................7-2
names menu ....................................................7-2
Setup
UMD Input ......................................................9-20
setup menu .....................................................7-2
type menu .....................................................8-3
BNC Type, Input BNC ........................................7-7
Board
labelling ..........................................................2-18
Boards
system, overview ...........................................2-5
Boards, front ...................................................3-19
Boards, rear .....................................................3-21
Bottom MLE
reference description ......................................1-4
BSS4 Connections ...........................................9-7
BSS4, Remote Port Expander .............................9-4
Bus
Peripheral bus II ..............................................1-25
Bus Hold, button ..............................................7-20
Bus Maps ........................................................7-17
assign black ..................................................7-18
assign color background ................................7-18
assigning to multiple buses ............................7-25
copying ..........................................................7-22
Default ..........................................................7-23
all buses .........................................................7-23
single bus .......................................................7-23
editing ............................................................7-17
individual bus assignment ...............................7-24
Key Bus Shift ....................................................7-21
naming ...........................................................7-21
registers ..........................................................12-3
reset ................................................................. 11-37
Reverse Key Shift behavior................................. 7-20
Shift ...................................................................... 7-21

Buses
video routing ............................................................ 2-7

Buttons
custom control group, Synergy 1 ......................... 10-2
custom control group, Synergy 1.5 ....................... 10-2
custom control group, Synergy 2 ......................... 10-2
custom control group, Synergy 3 ......................... 10-3
deleting custom controls ...................................... 10-4
editing custom controls ....................................... 10-4
FLY KEY.................................................................. 1-20
mnemonic displays ............................................... 10-40
programming a custom control button .................. 10-11
ROLL VTR ............................................................. 1-25
special functions .................................................. 10-3
VTR CLIP ............................................................. 1-24

Buttons, panel.......................................................... 7-17

Cable Retainer, Aux panel ........................................ 3-29
Cabling
connection chart .................................................. 4-2
control ................................................................. 4-3
control panel ........................................................ 1-16
remote Aux panel .................................................. 4-4
remote Aux panel, Synergy 1 MD......................... 4-5
Call Custom Control event .................................... 10-13
Camera Controller option, robotic ......................... 1-24
CCU
joystick control menu ......................................... 11-13, 11-14
joystick control, monitor GPI functions .................. 11-15
joystick override crosspoint setup ....................... 11-13
CG
setup favorite ....................................................... 12-8
CG, definition ....................................................... 1-5
CHAR GEN .......................................................... 12-8
Character Generator
custom control functions ..................................... 10-4
Chassis
front layout ......................................................... 2-3
rear connector panel diagram .............................. 3-7
rear layout .......................................................... 2-4
Check
inputs .................................................................. 7-27
keys ................................................................... 7-28

Checksums
Custom Control .................................................. 10-50
Types ................................................................. 10-50
Chroma Key
memory .................................................................. 1-17
Circuit Board, front .............................................. 3-19
Circuit Board, installing ...................................... 3-19
Circuit Board, rear .............................................. 3-21
Circuit Board, removing ...................................... 3-19
Circuit boards
labeling ............................................................... 2-18
Clean Feed
MLE 1 ................................................................. 8-4
MLE 2 ................................................................. 8-4
MLE 3 ................................................................. 8-4
Clean feed ................................................................ 2-3
after keys ............................................................. 8-17
aux panel programming mode ................................ 11-12
before keys .......................................................... 8-17
menu ................................................................. 8-17
point of origin ....................................................... 8-17
setup ................................................................. 8-17
Clean Feed output BNC ........................................... 8-5
Clean feed outputs .............................................. 1-12
Clearance, control panel ...................................... 3-12
Closed Caption..................................................... 8-19
Communications
Contribution Serial Tally Protocol setup ............... 9-14
Pbus setup ........................................................... 9-11
Remote Port Expander (BSS4) ............................ 9-4
setup ................................................................. 9-1
set custom device ............................................... 9-10
UMD Input setup .................................................. 9-18
Configuration
BNC ...................................................................... 7-1, 7-2, 8-1
Connection
alpha signals ....................................................... 4-20
input ................................................................. 4-23
key signals .......................................................... 4-20
outputs ............................................................... 8-6
primary output .................................................... 8-6
primary video ...................................................... 4-20
reference ............................................................ 4-20
remote aux panel GPIs ......................................... 11-11
Connector
AUX 1, 2, 3 .......................................................... 3-6
control panel ....................................................... 3-9
looping.............................................................. 10-13
menu................................................................. 10-42
mnemonic displays for bank names........ 10-8
mnemonic displays for button names ...... 10-40
modify events .................................................... 10-43
monitor wall functions ................................. 10-3, 10-4
moving............................................................... 10-4, 10-47
naming functions ................................................ 10-3
naming of............................................................ 10-38
Pause................................................................. 10-34
pause................................................................. 10-34
Pbus ................................................................. 10-36
Pbus protocol functions ................................. 10-3
Pbus protocol...................................................... 10-35
program modes .................................................. 10-3
program special functions ............................ 10-20
program time clock functions ....................... 10-18
programming safe title ...................................... 10-29
programming special functions ..................... 10-18
registers .......................................................... 11-33, 12-2
Relative............................................................. 10-15
reset GPI outputs ................................................ 10-20
reset registers .................................................... 11-35
robotic camera functions .................................. 10-3
router functions .................................................. 10-3
Run Custom Control event ............................... 10-13
Run Sequence .................................................... 10-28
Safe Title ........................................................... 10-30
save to disk ........................................................ 10-49
saving and recalling functions ....................... 10-4
Select Custom Control Bank event .................. 10-14
Server functions ................................................. 10-3
Special Commands
Safe Title ........................................................... 10-30
Stop Other.......................................................... 10-31
special functions ................................................. 10-3
start recording, definition ............................... 10-12
Stop command ..................................................... 10-13
time clock functions ......................................... 10-3
tips ................................................................. 10-13
Trans Keys .......................................................... 10-27
transition keys ..................................................... 10-26
trigger GPI outputs ............................................. 10-21
VTR functions ..................................................... 10-3
Custom device
setup communications ...................................... 9-10
Customer service .............................................. 1-27
CUT, GPI............................................................ 11-19
Cutout dimensions ............................................. 3-11

D

D-A, definition .................................................... 1-5
DA, definition ..................................................... 1-5
Data storage ...................................................... 1-15
DDR, definition ................................................... 1-5
Default
BNC names ........................................................ 7-4
factory settings ................................................. 11-32
Default a single Bus Map ................................. 7-23
Default all Bus Maps ......................................... 7-23
Definitions
abbreviations ..................................................... 1-5
terms ............................................................... 1-4
Deleting custom control functions ................. 10-4
Diagnostics
TX/RX test ........................................................ 6-23
Diagram, block ................................................... 2-2
Digicart
custom control functions ................................... 10-3
Digital
inputs ............................................................... 1-10
outputs, configurable ......................................... 1-10
reference connection ........................................ 4-7
system .............................................................. 1-7
Disable, N/S indicators ....................................... 7-15
Disk
menu ............................................................... 12-3
save custom control macros ............................. 10-49
setup backup ..................................................... 6-19
store menu ....................................................... 12-4
Display
adjust contrast ................................................... 5-7
manual and automatic ....................................... 5-2
system control .................................................... 5-2
Displays and Indicators ..................................... 1-16
Documentation
abbreviations ..................................................... 1-5
conventions ....................................................... 1-3
related publications ......................................... 1-6
terms ............................................................... 1-4
Downloading Setups from switcher .................... 6-19
DSK
definition ........................................................ 1-5
external, system option ..................................... 1-19
Mix/DSK .......................................................... 8-10
Mix/MultiDSK ................................................... 8-14
### MultiDSK ..................................................... 8-12
### DSK 3 and 4 ............................................... 8-12, 8-14
### Dual Border Generator .................................. 1-21
### DVE
   - Aux Bus outputs ........................................ 8-6
   - definition............................................... 1-15
### DVR, definition ........................................... 1-5

**E**

- Echo connector, Aux panel.......................... 3-29
- Edge trigger, GPI......................................... 11-24
- Editing custom control functions ................. 10-4
- Editor Interface
   - control................................................ 3-30
   - Editor Interface option............................ 1-23, 6-30
- Effects, pre-built ...................................... 1-21
- Electronics frame
   - installation.......................................... 3-14
   - reference description.............................. 1-4
- Embedded Audio ....................................... 8-19
- Encrypt code.......................................... 6-29
- End-of-life disposal.................................. 2-8
- Environmental Information ......................... 2-8
- Equipment overview.................................. 3-3
- Even Field transition ................................ 8-22
- Event memory system ................................ 1-15
- Extended Tallies option ............................... 1-26
- External Backup ....................................... 6-19
- External Still Store
   - remote control....................................... 3-30
- External Still Store, Input BNC Type ............... 7-9
- Extra Effects Processor, XFX....................... 1-21
- Extra Half MLE option ................................. 6-31
- Extra Options
   - serial tally............................................ 9-16

**F**

- Factory default, restore settings.................... 11-32
- Fade to Black.......................................... 8-18
   - GPI...................................................... 11-20
   - menu................................................ 8-17, 8-18
   - setup................................................ 8-17
- Favorite CG setup..................................... 12-8
- Features
   - Global-Store......................................... 1-11
     - inputs, serial digital.......................... 1-10
     - keyboard port................................... 1-14
     - outputs, configurable serial digital........ 1-10
     - reference input.................................. 1-11
- Field 1 and Field 2 ................................... 2-12
- Field and Frame information ......................... 2-14
- Fields ..................................................... 2-12
- File
   - custctrl.syn......................................... 12-2
   - disk icons.......................................... 12-4
   - install.syn.......................................... 12-3
   - memory.syn......................................... 12-2
   - pers.syn............................................. 12-2
   - vtr.syn............................................... 12-2
- Files
   - port monitor........................................ 6-23
- FlexiClean............................................... 1-12
- Follow, Aux Bus mode ................................ 11-5
- Format, Input BNCs .................................... 11-29
- Frame
   - boards menu........................................ 6-28
     - connectors........................................ 3-6
   - CPU, overview...................................... 2-5
   - GPI I/O connectors, overview .................... 3-8
   - installation......................................... 3-14
   - LAN connectors, overview ........................ 3-8
   - peripheral connectors, overview................ 3-8
   - power connection.................................. 3-25
   - power connectors, overview ..................... 3-7
   - power fail LED...................................... 3-25
   - power supply........................................ 1-26
   - processor............................................ 2-16
   - redundant power supply........................... 3-25
   - reference description.............................. 1-4
   - size.................................................... 1-7
   - spare parts kit..................................... 1-26
   - time code input, overview ......................... 3-9
   - USP ports, overview............................... 3-9
- Frame connector
   - Synergy 1, overview................................. 3-5
- Frame CPU Board........................................ 2-5
- Frame Rates, using.................................... 2-14
- Frames ................................................... 2-12
- Frequency .............................................. 2-14
- Front chassis layout.................................. 2-3
- Front Circuit Boards.................................. 3-19
Full
reset ............................................................ 4-10
software reset............................................. 4-11
Full MLE
reference description .................................. 1-4
Functional check ........................................ 4-16

G
General Purpose Interface, see GPI
Generator
matte.......................................................... 1-12
pattern......................................................... 1-12
Global-Store.................................................. 1-8, 1-11, 1-17
Go to menu, custom control....................... 10-24
Go To Start, custom controls....................... 10-42
GPI
area ........................................................... 11-20
AUTO, Cust Ctrl, CUT, OFF ....................... 11-19
aux panel ...................................................... 11-9
aux panel connector................................. 3-28
aux panel override ..................................... 11-2
CCU joystick override setup ....................... 11-13
custom control trigger ............................... 11-20
description
edge trigger .............................................. 11-24
fade to black ............................................. 11-20
Function..................................................... 11-19
I/O.............................................................. 3-8
icons ....................................................... 11-13, 11-16
information menu ..................................... 11-25
input polarity menu ................................... 11-22
input worksheet, standard......................... 11-17
inputs........................................................ 1-16
level trigger .............................................. 11-24
memory recall trigger............................... 11-21
name outputs menu ................................... 11-22
output setup menu ..................................... 11-24
output worksheet, standard...................... 11-18
outputs....................................................... 1-16
program standard inputs ......................... 11-19
program standard outputs ....................... 11-22
remote aux panel connection ..................... 11-11
remote Aux panel input worksheet.............. 11-9
remote aux panel input worksheet ............... 11-9
remote Aux panel programming .................. 11-12
reset outputs via custom control ............... 10-20
set tally on GPI menu ............................... 11-25
setup menu............................................... 11-19, 11-22
setup standard.......................................... 11-17
tally assign menu ..................................... 11-6
trigger outputs via custom control .......... 10-21
USED label................................................. 11-21
GPI trigger
High-Toggle ............................................... 11-15
Latch.......................................................... 11-15
Low-Override ............................................ 11-14
Low-Toggle .............................................. 11-14
Off ......................................................... 11-15
Gray Input BNC ......................................... 7-8

H
Half MLE ...................................................... 1-11
reference description ................................ 1-4
Half MLE, see Mix/DSK
Hard disk drive......................................... 1-15
Hard Restart, switcher............................... 6-8, 6-15
Hardware installation.............................. 3-1, 3-11
HD, definition ............................................ 1-5
Help
features................................................... 5-8
menu....................................................... 5-8
more info menu ........................................ 5-8
pop-up...................................................... 5-9
Highlights
AuxKeys.................................................... 1-8
compact size ........................................... 1-7
compatibility ............................................ 1-9
digital system.......................................... 1-7
growth path ............................................. 1-9
input matrix.............................................. 1-7
MediaCache............................................. 1-8
mnemonics .............................................. 1-7
multi-definition....................................... 1-7
MultiDSK .................................................. 1-8
preview overlay ....................................... 1-7
Squeeze & Tease MD ............................... 1-7, 1-21
Still-Store ............................................... 1-8
UltraChrome.......................................... 1-8
Hold CC ................................................... 10-31
Hold, inserting in custom control ............... 10-31
HOME button........................................... 5-4
Horizontal Blanking Setup ....................... 8-19
Horizontal Scan Lines .............................. 2-12
Synergy Q/MD Engineering Manual (v9.1 MD)  Index • IX–9

signal connection................................................. 4-20
transition with custom control.......................... 10-26
Key Bus Shift .......................................................... 7-21
using ...................................................................... 7-20
Key sequences .......................................................... 1-21
Keyboard
   System Control Menus ........................................... 5-5
   Keyboard connector
      Synergy 1.......................................................... 3-6
      Synergy 2.......................................................... 3-6
      Synergy 3.......................................................... 3-6
   Keyboard port ...................................................... 1-14
   Keyers ............................................................... 1-11
   Keys Off Air, Custom Control .................................. 10-23
Knobs
   hierarchy ............................................................ 5-4
   scroll ................................................................... 5-4

L
Label area ............................................................... 5-4
Labelling boards .................................................... 2-18
LAN connectors
   overview .................................................................. 3-8
   Large Audio Mixer
      remote control .................................................. 3-30
   Large Audio Mixer option .................................... 6-30
   Large display menu ............................................. 5-7
Layout
   front chassis ........................................................ 2-3
   rear chassis ........................................................ 2-4
   LCD screen .......................................................... 5-2
   LED indicator
      frame .................................................................. 3-25
      Panel .................................................................. 3-25
      Power Fail ............................................................ 3-25, 3-26
Level trigger, GPI .................................................... 11-24
Lighting ................................................................. 1-20
Local panel ............................................................. 11-2
LOCK MENU button ............................................. 5-5
Lock/Unlock Installation ......................................... 11-38
Look Ahead Preview output
   MLE 1 ................................................................. 8-4
   MLE 2 ................................................................. 8-4
   MLE 3 ................................................................. 8-4
Looping Custom Controls ....................................... 10-13

M
Macros
   custom control, editing ...................................... 10-42
Main
   connector, Aux panel ......................................... 3-28
   menu 1 .................................................................. 7-2
   menu, software version ....................................... 5-3
Main menu
   area ....................................................................... 5-3
Managing Upgrade Manager Account .................. 6-17
Matte generators .................................................... 1-12
MD, definition ........................................................ 1-5
MediaCache ............................................................ 1-8, 1-17
MediaCache for Global-Store ................................ 1-17
MediaCache option ................................................. 6-31
Mem Recall, GPI .................................................... 11-21
Memory
   registers .............................................................. 11-32, 12-2
   reset registers ..................................................... 11-34
   memory.syn .......................................................... 12-2
Menu
   auto key setup .................................................... 7-13
   aux bus external device assignment .................. 11-5
   Aux Bus remote panels ........................................ 11-12
   Aux Bus setup ..................................................... 11-2
   BNC names .......................................................... 7-2
   BNC setup .......................................................... 7-2
   BNC type ............................................................. 8-3
   CCU joystick override ........................................ 11-13, 11-14
   clean feed .......................................................... 8-17
   control buttons .................................................... 5-4
   custom control ..................................................... 10-42
   disk ..................................................................... 12-3
   disk store ............................................................ 12-4
   fade to black ...................................................... 8-17, 8-18
   go to, in custom control ...................................... 10-24
   GPI information ................................................... 11-25
   GPI input polarity ............................................... 11-22
   GPI name outputs .............................................. 11-22
   GPI output setup ................................................ 11-24
   GPI setup ............................................................ 11-19, 11-22
   GPI tally assign ................................................... 11-6
   help ..................................................................... 5-8
   HOME .................................................................. 5-4
   insert Pbus ........................................................... 10-36
   insert special ...................................................... 10-20, 10-22
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>label area</td>
<td>5-4</td>
</tr>
<tr>
<td>large display</td>
<td>5-7</td>
</tr>
<tr>
<td>LOCK MENU</td>
<td>5-5</td>
</tr>
<tr>
<td>main area</td>
<td>5-3</td>
</tr>
<tr>
<td>MLE tally</td>
<td>8-17, 8-18</td>
</tr>
<tr>
<td>MORE</td>
<td>5-5</td>
</tr>
<tr>
<td>more info</td>
<td>5-8</td>
</tr>
<tr>
<td>name</td>
<td>5-3</td>
</tr>
<tr>
<td>positioner icons</td>
<td>5-6</td>
</tr>
<tr>
<td>preset names</td>
<td>7-4</td>
</tr>
<tr>
<td>recall factory 1</td>
<td>11-34</td>
</tr>
<tr>
<td>Remote GPI Assignment</td>
<td>11-13</td>
</tr>
<tr>
<td>Remote GPI Type</td>
<td>11-14</td>
</tr>
<tr>
<td>remote panels</td>
<td>11-15</td>
</tr>
<tr>
<td>screen capture</td>
<td>5-10</td>
</tr>
<tr>
<td>scroll area</td>
<td>5-4</td>
</tr>
<tr>
<td>standard GPI setup</td>
<td>11-17</td>
</tr>
<tr>
<td>system basics</td>
<td>5-3</td>
</tr>
<tr>
<td>system, using</td>
<td>5-2</td>
</tr>
<tr>
<td>tally on GPI</td>
<td>11-25</td>
</tr>
<tr>
<td>tally setup</td>
<td>7-10</td>
</tr>
<tr>
<td>TX/RX test</td>
<td>6-23</td>
</tr>
<tr>
<td>UP ONE</td>
<td>5-4</td>
</tr>
</tbody>
</table>

### Menus

- Custom Control Bank Name Menu ........................................... 10-6, 10-8
- custom controls bank setup ............................................. 10-5

### Midplane

- 2-6

### Mix/DSK

- operation ......................................................... 8-11
- setup ........................................................................ 8-10

### Mix/MultiDSK option .................................................. 6-31

### Mix/DSK

- definition ......................................................... 1-5
- fade to black ..................................................... 8-17
- half MLE ................................................................. 1-11
- keyers ...................................................................... 1-11
- processor ................................................................... 2-16
- resetting .................................................................... 4-10, 4-11
- tally .......................................................................... 8-18
- tally menu ................................................................... 8-17, 8-18

### MLE 1 MD option ........................................................ 6-31

### MLE 2 MD option ........................................................ 6-31

### MLE, Active, Transition, Custom Control ................................ 10-23

### MLE-Store ...................................................................... 1-21

### Mnemonics display

- for BNC input names ................................................................ 7-5

### Modify

- Events in a custom control ............................................. 10-43
- Modify bank name, custom control ...................................... 10-6

### Monitor

- CCU joystick override GPI functions .................................. 11-15
- connection ....................................................................... 4-7

### Monitor Wall

- custom control functions ............................................. 10-3, 10-4
- Monitor wall ..................................................................... 1-25
- Monitor Wall System option ............................................ 6-31
- MORE button .................................................................... 5-5
- More button ....................................................................... 5-3
- More Info Menu .................................................................. 5-8
- moving custom control functions ...................................... 10-4
- Moving Custom Controls .................................................. 10-47

### MultiDSK

- option .......................................................................... 1-8, 1-19, 6-31, 8-12
- setup ............................................................................. 8-12
- Multiple Custom Controls .............................................. 10-13
- running .......................................................................... 10-16

### N

- N/S Disable ................................................................. 7-15

### Name

- BNC inputs ........................................................................ 7-2
- default BNC input ......................................................... 7-4
- GPI outputs ...................................................................... 11-22
- Naming control functions ............................................. 10-3
- Naming custom control banks ......................................... 10-6
- Naming custom controls ............................................... 10-38
- Network setup .................................................................. 6-2
- Network Still & Clip Server Option ................................... 1-18
- No tally, Aux Bus ......................................................... 11-5
- Non-Sync, disable ......................................................... 7-15
- Normal custom control banks ......................................... 10-5
- NV-RAM, reset ............................................................... 11-36
Odd Field transition ................................................. 8-22
Off Mode, Aux Bus...................................................... 11-4
OFF, GPI .................................................................... 11-19
Off, Input BNC Type ................................................... 7-8
Opening/Closing the frame door, QMD/X ................. 3-16
Operator
reference description .................................................. 1-4
Option
codes, store and recall ............................................. 6-33
Mix/DSK ...................................................................... 8-10
Remote Port Expander (BSS4) ..................................... 9-4
Options
audio mixer, large .................................................... 1-24
audio server control ................................................. 1-25, 10-3
AuxKeys ...................................................................... 1-18
camera controller ..................................................... 1-24
custom control banks, enable ................................... 10-5
editor interface ........................................................ 1-23
extended tallies ......................................................... 1-26
installed panel boards ............................................. 6-28
MediaCache for Global-Store .................................... 1-17
mnemonics .................................................................. 1-15, 1-21, 10-7
MultiDSK ...................................................................... 1-19
network still & clip server .......................................... 1-18
peripheral bus II .......................................................... 1-25
peripheral interface II protocol, See Pbus
preview overlay ........................................................ 10-3
redundant power ........................................................ 1-26
remote aux panel ....................................................... 1-22
routing switcher ........................................................ 1-24
serial digital inputs ..................................................... 1-17
serial port expander, control panel ......................... 1-17
serial tally ..................................................................... 1-25
Small Audio Mixer Interface .................................... 1-24
spare parts ................................................................. 1-26
Squeeze & Tease 2D, 3D ............................................ 1-19
still store ...................................................................... 1-24
video server control ................................................. 1-25, 10-3
VTR remote control ................................................. 1-24, 10-3
Options, installed ........................................................ 6-27
Output
ancillary data ............................................................. 8-19
connection ................................................................... 8-6
connection, primary .................................................. 8-6
connectors ................................................................. 3-8
from input board ....................................................... 2-7
setup ......................................................................... 8-17
verification ............................................................... 8-6
Output BNC
Aux Bus ..................................................................... 8-5
Clean Feed .................................................................. 8-5
Clean Feed, MLE 1 ..................................................... 8-4
Clean Feed, MLE 2 ..................................................... 8-4
Clean Feed, MLE 3 ..................................................... 8-4
Look Ahead Preview, MLE 1 ...................................... 8-4
Look Ahead Preview, MLE 2 ...................................... 8-4
Look Ahead Preview, MLE 3 ...................................... 8-4
Preview, main .......................................................... 8-4
Preview, MLE 1 ........................................................ 8-4
Preview, MLE 2 ........................................................ 8-4
Preview, MLE 3 ........................................................ 8-4
Program, main .......................................................... 8-4
Program, MLE 1 ........................................................ 8-4
Program, MLE 2 ........................................................ 8-4
Program, MLE 3 ........................................................ 8-4
Output BNCs
Aux Bus ..................................................................... 8-5
Output Board ............................................................ 2-5
functionality .............................................................. 2-16
Outputs
configurable serial digital ......................................... 1-10
Override, aux panel .................................................. 1-23
Overview ................................................................. 1-7
Video Formats .......................................................... 2-12
Panel
boards menu ............................................................ 6-28
control cable installation ......................................... 4-3
power fail LED .......................................................... 3-25
rear connectors, diagram ......................................... 3-7
Panel buttons
AuxBkgdCut .............................................................. 7-19, 7-20
AuxBkgdTrans ........................................................... 7-19, 7-20
AuxKeyCut ................................................................. 7-19
AuxKeyTrans ............................................................. 7-19
Bus Hold ..................................................................... 7-20
setup ......................................................................... 7-17
Pattern generators .................................................... 1-12
Pause, inserting in custom control ......................... 10-34
Pbus communications ........................................ 9-11
custom control functions
  custom controls ................................................. 10-36
port baud rate ......................................................... 9-12
  remote control .................................................... 3-30
Pbus option .......................................................... 6-30
Pbus protocols, See Pbus
Peripheral Bus II option ........................................... 1-25
Peripheral Bus option ................................................ 6-30
Peripheral connectors
  overview ............................................................ 3-8
Peripheral Interface II Protocol See Pbus
pers.syn .............................................................. 12-2
Personality
  registers ............................................................ 11-32, 12-2
  reset registers ...................................................... 11-34
PGM
  definition .......................................................... 1-5
  MLE ................................................................ 1-11
Phase-locked loop ..................................................... 2-11
Planar Controls, advanced ........................................ 1-20
Planar Transforms .................................................... 1-20
Play mode, ROLL VTR ............................................... 1-25
Polarity, GPI ........................................................... 11-22
Pop-up Help .............................................................. 5-9
Port Expander, remote ............................................. 9-4
Port Monitor
  files .................................................................. 6-23
Positioner
  icon, circular ........................................................ 5-6
  icon, left-right ....................................................... 5-6
  icon, up-down ........................................................ 5-6
  icons .................................................................. 5-4, 5-6
Power
  connectors, control panel ..................................... 3-7
  fail LED ............................................................... 3-26
  fail overview ........................................................ 3-25
  failure recovery ..................................................... 3-26
  remote Aux panel ................................................ 3-29
  system .................................................................. 4-9
Power connection
  installing frame ..................................................... 3-25
Power connectors
  frame, overview ..................................................... 3-7
Power Supply
  redundant power option ........................................ 1-26
Power supply, redundant
  installation ............................................................. 3-25
PST PATT, definition ................................................... 1-5
Serial Tally............................................................. 9-14
Preliminary cable connections chart ......................... 4-2
Preliminary cabling ................................................... 4-1
Preset names menu ................................................... 7-4
Preview
  overlay option ....................................................... 10-3
Preview output
  MLE 1 ................................................................ 8-4
  MLE 2 ................................................................ 8-4
  MLE 3 ................................................................ 8-4
Preview output, main ................................................ 8-4
Preview Overlay
  Safe Title Custom Control .................................... 10-30
Preview overlay ......................................................... 1-7, 1-13
  mask preview ........................................................ 1-14
  SMPTE safe formats .............................................. 1-14
  source identification ............................................. 1-14
  time clock ............................................................. 1-14
  VTR time code ....................................................... 1-14
Preview Overlay output .............................................. 8-4
Primary
  system boards ....................................................... 2-5
  video connection ................................................... 4-20
Primary fuse
  Synergy 1 ............................................................. 3-5
Primary power inlet
  Synergy 1 ............................................................. 3-5
Primary power switch
  Synergy 1 ............................................................. 3-5
Proc Amps option ....................................................... 6-31
Processor
  control panel ........................................................ 2-17
  frame ................................................................. 2-16
  Video .................................................................. 2-16
Processor effects ......................................................... 1-20
Product
  highlights ............................................................. 1-7
  overview ............................................................... 1-7
Program output, main ................................................ 8-4
Program output
  MLE 1 ................................................................ 8-4
  MLE 2 ................................................................ 8-4
  MLE 3 ................................................................ 8-4
Programming control panel functions ....................... 10-11
Programming Mode, Remote Aux Panel ................. 11-12
Progressive Scan ......................................................... 2-12, 2-13
Protocol
  Serial Tally ............................................................ 9-14
  PST PATT, definition .............................................. 1-5
### Reference Description

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PST, definition</td>
<td>1-5</td>
</tr>
<tr>
<td>Pushbutton inserts</td>
<td></td>
</tr>
<tr>
<td>Aux Bus panel</td>
<td>4-26</td>
</tr>
<tr>
<td>control panel</td>
<td>4-25</td>
</tr>
<tr>
<td>installing</td>
<td>4-25</td>
</tr>
<tr>
<td>PV, definition</td>
<td>1-4</td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Rear Circuit Boards</td>
<td>3-21</td>
</tr>
<tr>
<td>Rear connectors</td>
<td></td>
</tr>
<tr>
<td>chassis</td>
<td>3-7</td>
</tr>
<tr>
<td>control panel</td>
<td>3-4</td>
</tr>
<tr>
<td>Rear connectors, chassis</td>
<td>2-4</td>
</tr>
<tr>
<td>Recall</td>
<td></td>
</tr>
<tr>
<td>custom control functions</td>
<td>10-4</td>
</tr>
<tr>
<td>factory menu 1</td>
<td>11-34</td>
</tr>
<tr>
<td>factory procedure</td>
<td>11-33</td>
</tr>
<tr>
<td>Recalling</td>
<td></td>
</tr>
<tr>
<td>option codes</td>
<td>6-33</td>
</tr>
<tr>
<td>Recording</td>
<td></td>
</tr>
<tr>
<td>cancel custom control</td>
<td>1-3</td>
</tr>
<tr>
<td>custom controls</td>
<td>10-12</td>
</tr>
<tr>
<td>finish custom control</td>
<td>10-12</td>
</tr>
<tr>
<td>recording custom controls</td>
<td>10-12</td>
</tr>
<tr>
<td>Recording custom controls</td>
<td>10-11</td>
</tr>
<tr>
<td>Recovery from power failure</td>
<td>3-26</td>
</tr>
<tr>
<td>Redundant fuse</td>
<td></td>
</tr>
<tr>
<td>Synergy 1</td>
<td>3-5</td>
</tr>
<tr>
<td>Redundant power inlet</td>
<td></td>
</tr>
<tr>
<td>Synergy 1</td>
<td>3-5</td>
</tr>
<tr>
<td>Redundant Power option</td>
<td>1-26</td>
</tr>
<tr>
<td>Redundant power switch</td>
<td></td>
</tr>
<tr>
<td>Synergy 1</td>
<td>3-5</td>
</tr>
<tr>
<td>Reference</td>
<td></td>
</tr>
<tr>
<td>connection</td>
<td>4-7</td>
</tr>
<tr>
<td>Input BNCs reset</td>
<td>11-29</td>
</tr>
<tr>
<td>setting</td>
<td>11-26</td>
</tr>
<tr>
<td>setup</td>
<td>11-27</td>
</tr>
<tr>
<td>Reference Processor</td>
<td></td>
</tr>
<tr>
<td>reference processor</td>
<td>11-32</td>
</tr>
<tr>
<td>phase-locked loop</td>
<td>2-11</td>
</tr>
<tr>
<td>Registers</td>
<td></td>
</tr>
<tr>
<td>custom control</td>
<td>11-33</td>
</tr>
<tr>
<td>installation</td>
<td>11-33</td>
</tr>
<tr>
<td>memory</td>
<td>11-32</td>
</tr>
<tr>
<td>personality</td>
<td>11-32</td>
</tr>
<tr>
<td>restoring</td>
<td>6-21</td>
</tr>
<tr>
<td>storing</td>
<td>12-6</td>
</tr>
<tr>
<td>switcher</td>
<td>12-4</td>
</tr>
<tr>
<td>VTR clips</td>
<td>12-2</td>
</tr>
<tr>
<td>Regular, Aux Bus mode</td>
<td>11-4</td>
</tr>
<tr>
<td>Related publications</td>
<td>1-6</td>
</tr>
<tr>
<td>Relative Custom Controls</td>
<td>10-15</td>
</tr>
<tr>
<td>Remote</td>
<td></td>
</tr>
<tr>
<td>aux panel AC adapter</td>
<td>3-29</td>
</tr>
<tr>
<td>aux panel cabling</td>
<td>4-4</td>
</tr>
<tr>
<td>aux panel cabling, Synergy 1 MD</td>
<td>4-5</td>
</tr>
<tr>
<td>aux panel echo connector</td>
<td>3-29</td>
</tr>
<tr>
<td>aux panel GPI connector</td>
<td>3-28</td>
</tr>
<tr>
<td>aux panel installation</td>
<td>3-28</td>
</tr>
<tr>
<td>aux panel main connector</td>
<td>3-28</td>
</tr>
<tr>
<td>aux panel override</td>
<td>11-2, 11-9</td>
</tr>
<tr>
<td>control connector</td>
<td>3-6, 3-30</td>
</tr>
<tr>
<td>control, audio server</td>
<td>3-30</td>
</tr>
<tr>
<td>control, External Still Store</td>
<td>3-30</td>
</tr>
<tr>
<td>control, large audio mixer</td>
<td>3-30</td>
</tr>
<tr>
<td>control, Pbus</td>
<td>3-30</td>
</tr>
<tr>
<td>control, robotic camera</td>
<td>3-30</td>
</tr>
<tr>
<td>control, router</td>
<td>3-30</td>
</tr>
<tr>
<td>control, serial tally</td>
<td>3-30</td>
</tr>
<tr>
<td>control, small audio mixer</td>
<td>3-30</td>
</tr>
<tr>
<td>control, video server</td>
<td>3-30</td>
</tr>
<tr>
<td>control, VTR</td>
<td>3-30</td>
</tr>
<tr>
<td>Editor Interface</td>
<td>3-30</td>
</tr>
<tr>
<td>panels menu</td>
<td>11-15</td>
</tr>
<tr>
<td>Remote aux panel</td>
<td></td>
</tr>
<tr>
<td>remote override</td>
<td>1-23</td>
</tr>
<tr>
<td>Remote Aux Panel programming mode</td>
<td>11-12</td>
</tr>
<tr>
<td>Remote Aux Panels</td>
<td></td>
</tr>
<tr>
<td>comm setup</td>
<td>11-6</td>
</tr>
<tr>
<td>Remote aux panels</td>
<td></td>
</tr>
<tr>
<td>assignable</td>
<td>1-22</td>
</tr>
</tbody>
</table>

**Synergy Q/MD Engineering Manual (v9.1 MD)**

Index • IX–13
<table>
<thead>
<tr>
<th>Index Synergy Q/MD Engineering Manual (v9.1 MD)</th>
</tr>
</thead>
</table>
| **comparison** .................................................. 1-23  
**positioning** .................................................. 1-23  
**Remote control connectors** ....................................... 3-5  
**Remote Port connections, (BSS4)** ............................... 9-7  
**Removing Circuit Boards** ......................................... 3-19  
**Removing the frame door, MD/X** .................................... 3-17  
**Repair policy** ..................................................... -2-7  
**Reset**  
  **Bus Maps** .......................................................... 11-37  
  **custom control registers** ...................................... 11-35  
  **full** .................................................................. 4-10  
  **installation registers** ........................................... 11-35  
  **memory registers** ................................................. 11-34  
  **NV-RAM** ............................................................... 11-36  
  **personality registers** ............................................ 11-34  
  **software** .............................................................. 4-10, 4-11  
  **Squeeze & Tease Sequences** .................................... 11-37  
  **switcher registers** ............................................... 11-35  
  **system** ................................................................ 4-10  
  **VTR clip registers** ................................................. 11-36  
**Reset GPI outputs via custom control** ............................. 10-20  
**Reset Input BNCs Format** ............................................. 11-29  
**Resetting individual MLEs** .......................................... 4-10, 4-11  
**Restart, switcher** ...................................................... 4-10  
**Restore factory default settings** ..................................... 11-32  
**Restoring registers** .................................................. 6-21, 12-6  
**Reverse Key SHIFT, see Key Bus Shift** .............................. 2-14  
**RGB Color Corrector option** ........................................ 6-31  
**Robotic Cam, Input BNC Type** ...................................... 7-9  
**Robotic Camera**  
  **remote control** ...................................................... 3-30  
  **robotic camera** .................................................... 3-30  
  **custom control functions** ..................................... 10-3  
**Robotic System option** .............................................. 6-30  
**ROLL VTR**  
  **arm mode** ........................................................... 1-25  
  **play mode** .......................................................... 1-25  
**Router**  
  **custom control functions** .................................. 10-3  
  **remote control** ................................................... 3-30  
**Router option** ......................................................... 6-30  
**Router, Input BNC Type** ............................................ 7-9  
**Routing Switcher Interface option** ................................ 1-21  
**Routing Switcher option** .......................................... 1-24  
  **supported routers** ............................................... 1-25  
**Routing, video** ......................................................... 2-7  
**Run Custom Control event, insert** ................................ 10-13  
**Run Sequence Custom Control** .................................... 10-28  
| **S**  
**S&T 3D**  
  **go to menu custom control macro** .............................. 10-24  
**Serial Tally Card** .................................................... 2-6  
**Safe Title Custom Controls** ....................................... 10-30  
**Save**  
  **custom control macros to disk** ................................. 10-49  
**Saving custom control functions** .................................. 10-4  
**Scan**  
  **Frequency** .......................................................... 2-14  
  **Interlaced** .......................................................... 2-12  
  **Progressive** ........................................................ 2-12, 2-13  
  **scan** .................................................................... 2-14  
  **Scan Frequency** .................................................... 2-14  
  **Scan Lines** .......................................................... 2-12  
**Screen capture menu process** ...................................... 5-10  
**Screws, mounting** ...................................................... 3-13  
**Scroll**  
  **area** ................................................................. 5-4  
  **knobs** ................................................................. 5-4  
**SD, definition** .......................................................... 1-5  
**SDI**  
  **reference description** ............................................ 1-4  
  **Select Custom Control Bank event, insert** .................... 10-14  
**Serial digital inputs** .................................................. 1-10, 1-17  
**Serial digital outputs** ................................................ 1-10  
**Serial numbers, installation** ....................................... 3-2, 6-27, 6-29  
**Serial Port Expander** ............................................... 1-17  
**Serial Tally**  
  **port baud rate** ..................................................... 9-15  
  **remote control** .................................................... 3-30  
  **Serial Tally option** ................................................. 1-25, 6-30  
  **Serial Tally Protocol** .............................................. 9-14  
**Server**  
  **custom control functions** .................................. 10-3  
**Service, customer** ..................................................... 1-27  
**Setting Time/Date** .................................................... 11-40  
**Setup**  
  **auto key** ............................................................ 7-13  
  **Aux Bus** ............................................................ 11-2  
  **BNC types** .......................................................... 8-3  
  **CCU joystick Aux control** .................................... 11-13  
  **clean feed** ......................................................... 8-17  |
communications .................................................. 9-1
favorite CG .................................................. 12-8
GPI outputs .................................................. 11-24
local aux bus panels ........................................ 11-4
network ....................................................... 6-2
output .......................................................... 8-17
remote aux panel GPIs ........................................ 11-12
standard GPI .................................................. 11-17
standard GPI inputs ........................................ 11-19
standard GPI outputs ........................................ 11-22
Still-Store auto key ......................................... 7-14
tallies ........................................................... 7-10
Setups
downloading from switcher .................................. 6-19
external storage .............................................. 6-19
overview ........................................................ 12-4
restoring .................................................... 6-21, 12-6
storing ......................................................... 12-4
uploading to switcher ....................................... 6-20
Shaped Alpha ................................................... 7-13
SHIFT
ing ............................................................... 7-20
Shift crosspoint buses ....................................... 7-21
Shift Lock, Key Bus .......................................... 7-21
Shifted Crosspoint Buttons .................................. 7-20
Shutdown, switcher ......................................... 4-14
Small Audio Mixer
remote control ................................................ 3-30
Small Audio Mixer Interface ................................ 1-24
Small Audio Mixer option ................................... 6-30
Smart Conversion .............................................. 13-1
 Conversion Loop .............................................. 13-2
Soft key
menu functions .................................................. 5-4
Soft key labels .................................................. 1-3
Soft keys
overview ........................................................ 5-4
Software
options, installing ............................................ 6-29
reset ............................................................... 4-10, 4-11
upgrade procedure ......................................... 6-9
version on main menu ....................................... 5-3
Software Options
Audio Server Control ........................................ 6-30
AuxKeys .......................................................... 6-31
Editor Interface ............................................... 6-30
Extra Half MLE ............................................... 6-30
Large Audio Mixer ........................................... 6-30
MediaCache ................................................... 6-31
Mix/DSK .......................................................... 6-31
MLE 1 MD ....................................................... 6-31
MLE 2 MD ....................................................... 6-31
Monitor Wall .................................................... 6-31
MultiDSK .......................................................... 6-31
Peripheral Bus ............................................... 6-30
Proc Amps ....................................................... 6-31
RGB Color Corrector ....................................... 6-31
Robotic System ............................................... 6-30
Router ............................................................. 6-30
Serial Tally ...................................................... 6-30
Small Audio Mixer ........................................... 6-30
Still Store, external ........................................... 6-30
Video Server Control ........................................ 6-30
VTR Remote Control ......................................... 6-30
XFX Borders .................................................... 6-32
XFX MediaCache ............................................. 6-32
XFX MLE-Store ................................................ 6-31
Spare Parts Kit option ........................................ 1-26
Special
custom control functions ................................... 10-3
program automation ......................................... 10-23
program custom control pauses ......................... 10-34
program GPI resets ......................................... 10-20
program GPI triggers ....................................... 10-21
Special Functions, custom controls .................. 10-20–10-34
Squeeze & Tease
MD Card .......................................................... 2-6
reset sequences ................................................ 11-37
Squeeze & Tease 3D
video flow ....................................................... 2-9
Squeeze & Tease Carrier ...................................... 2-6
Squeeze & Tease MD ............................................ 1-7, 1-19, 1-21
border generator, advanced picture frame .......... 1-20
effects, pre-built ............................................. 1-21
fly key ............................................................ 1-20
key sequences .................................................. 1-21
lighting ........................................................... 1-20
planar controls, advanced ................................ 1-20
planar transforms ............................................. 1-20
processor effects ............................................. 1-20
timelines, user-built ......................................... 1-21
Squeeze & Tease MD Card ................................... 2-6
Squeeze & Tease MD Carrier Board
functionality .................................................... 2-16
timeout ............................................................ 4-18
turn on power ................................................... 4-9
System Cards
S&T MD ........................................................... 2-6
XFX Extra Effects ............................................ 2-5
System control area ........................................... 1-15
System Control Menu ............................................ 5-5
System Options, see Options
System Time/Date .............................................. 11-40
T
Tallies
extended tallies option .................................. 1-26
Outputs ........................................................... 1-16
Tallies, Input BNC ............................................... 7-10
Tally
assign aux bus ................................................. 11-5
connection ...................................................... 3-32
connectors ......................................................... 3-7
MLE ................................................................... 8-18
Tally connector
Synergy 1 .......................................................... 3-6
TD, definition ......................................................... 1-5
Technical support ................................................ 1-27
Test
TX/RX ............................................................ 6-23
Time clock
custom control functions .................................. 10-3
insert menu ................................................... 10-18
program custom control functions .............. 10-18
table of custom control functions ................. 10-19
Time Code Input
overview ........................................................... 3-9
Time/Date, setting .............................................. 11-40
Timelines, user-built ........................................ 1-21
Timeout ........................................................... 4-18
Trigger GPI outputs via custom control .......... 10-21
Troubleshooting, basic ..................................... 4-18
TSL UMD
communications setup ................................... 9-19
TX/RX test menu .............................................. 6-23

U
UltraChrome ..................................................... 1-8, 1-16
UMD Input
BNC Setup ....................................................... 9-20
communications ............................................... 9-18
TSL UMD ........................................................ 9-19
Unlock Installation ............................................ 11-38
Unpacking .......................................................... 3-2
Unshaped Alpha .............................................. 7-13
Unshaped, alpha .............................................. 7-13
UP ONE button ................................................ 5-4
Upgrade Manager
Account, creating ........................................... 6-17
Account, managing ......................................... 6-17
Setups download ............................................ 6-19
Setups upload ................................................ 6-20
Upgrade procedure ........................................ 6-9
Upgrading Setups to switcher ...................... 6-20
USB drive .......................................................... 1-15
USB Key
custom controls, saving and recalling ........... 10-4
USB ports
overview ........................................................... 3-9
USED label, GPI setup menu ......................... 11-21
User
reference description ........................................ 1-4
Using
custom control mnemonic displays .............. 10-8
custom control, basics .................................. 10-11
Using Frame Rates ........................................... 2-14
V
VCR, definition .................................................. 1-5
VDCP Protocol ................................................. 1-18
Verification
outputs .............................................................. 8-6
Version
on main menu ................................................... 5-3
Vertical Blanking Setup ..................................... 8-19
Video
routing .............................................................. 2-7
server remote control ...................................... 3-30
Video Formats explained .............................. 2-12
Video Formats, Input BNC ......................... 2-12
Video Formats, setting .................................... 11-26
Video Processor Board ..................................... 2-5
Video processor board
crosspoint matrix ........................................... 2-8
functionality .................................................... 2-16
inputs ............................................................ 2-8
outputs ............................................................ 2-8
Video server control ...................................... 1-18
Video Server Control option ...................... 1-25, 6-30
Video Server, BNC Type, see VTR

Synergy Q/MD Engineering Manual (v9.1 MD)
Video system
  reference description..................................... 1-4
Video, Input BNC Type ........................................ 7-9
VTR
  clip registers.................................................. 12-2
  clip, reset registers ....................................... 11-36
  custom control functions ......................... 10-3
  remote control.............................................. 3-30
VTR Remote Control option .......... 1-24, 6-30
  clip .......................................................... 1-24
  clip, media ID ............................................ 1-24
  clip, timecode............................................. 1-24
  ROLL VTR.................................................. 1-25
VTR, definition .............................................. 1-5
VTR, Input BNC Type ........................................ 7-8

W
Warranty ............................................................ 2-7
Web Interface..................................................... 6-4
  upgrading the switcher............................... 6-9
Wipe
  generators.................................................... 1-11
Worksheet
  GPI remote aux panel................................ 11-9
  input.......................................................... 4-20, 8-2
  remote control............................................ 9-2
  standard GPI input...................................... 11-17
  standard GPI output................................. 11-18

X
XFX Borders option............................... 6-32
XFX Extra Effects Card ......................... 2-5
XFX Extra Effects Processor.................. 1-21
XFX MediaCache option......................... 6-32
XFX MLE-Store option........................... 6-31
XPT on air, Aux Bus................................. 11-6